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PREFACE

Preface

ShoreTel is now part of Mitel. Together, we look forward to helping you power connections that are
brilliantly simple.

The MiVoice Connect Maintenance Guide describes how to troubleshoot and solve problems that can
arise in a highly complex system.

Conventions Used
For More Information

Conventions Used

Courier font

For code examples and information that you type.
UPPERCASE WORDS

For keywords related to the Mitel system.
WARNING (alert)

For preventing data loss or equipment damage (if instructions are not followed).
Italic text

For variable parameters that can change depending on usage.
For document names and path names.

For command names.
< > (brackets)

For items supplied by user and variables in event codes.

For More Information

MiVoice Connect Planning and Installation Guide

Comprehensive guide to planning and implementing full-featured, enterprise-class VolP system.
MiVoice Connect System Administration Guide

Detailed reference guide for administering the MiVoice Connect system.
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Connect Architecture

This chapter describes the Connect architecture, and its components.
Overview

Connect system is a single platform and user interface that provides business communications from
MiVoice, MiCloud, or the hybrid applications.The Connect system provides a single-image system
across all locations with complete feature transparency and integration of all PBXs, voicemail systems,
automated attendants, and Automatic Call Distribution (ACD) systems. The Connect system simplifies
the way the organizations deploy, manage, scale, and secure their phone systems and provides a
common user experience regardless of the deployment model. The Connect system provides a platform
that makes each switch and site an independent call processor which continues to operate seamlessly in
the event of Wide Area Network (WAN) failure.

* System Management

* Benefits

* Connect Architecture

* MiVoice Connect Deployment

System Management

The Connect system provides a browser-based network management application called Connect Director
that provides a single management interface for all voice services and applications across all locations.
The Connect system provides automated software distribution for all components on the system. When
you add a new voice switch to the system, it is automatically upgraded to the current software release

by the server. Existing voice switches download the current software when you reboot the switches.

The Headquarters server does not upgrade Distributed Voice Servers (DVS); these must be upgraded
independently.

The management software also provides a complete suite of maintenance tools. The Diagnostics &
Monitoring system, which is available through Connect Director, provides detailed status information
about the components in your Mitel system. It also provides a system dashboard, a topology map, alerts,
call quality information, and remote packet capture functionality.

When you add a new user to the system, that user automatically receives a dialing plan, voicemail,
an extension, a mail box, an auto-attendant profile, and an email reminder to download the desktop
software. You can also add the user to a workgroup, if required.

Figure 1 : Connect Single-Image Architecture
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Benefits

The Connect system is a highly distributed, flexible, easy to deploy, easy to use and manage, and
reliable voice communication system.

* Reliability: All the components operate together as a single system. As a result, in the event of a
WAN outage each site can function independently, and in the event of a hardware failure phones will
register to a spare voice switch anywhere in the network so that not a single call is dropped.

¢ Flexibility: This approach allows Mitel to offer flexibility in implementation strategies and control.

You can choose to deploy any combination of purpose-built, solid state physical appliances, or
virtual appliances installed on industry-standard x86 servers. This ensures that the Mitel Unified
Communications (UC) systems scale easily and is suited for companies having multiple sites.

» Ease: Mitel presents a single interface to system administrators and end users alike. The Connect
Director and Connect client Ul software reduce training, configuration and maintenance hours and
increase end-user adoption rates.

¢ Voice Application Features: Applications including voicemail, unified messaging, auto-attendant,
basic ACD and Call Detail Reporting (CDR) are distributed through the enterprise as integral
components of the Mitel UC platform core software. The Mitel UC platform provides enhanced
communication solution applications such as Collaboration for Web, Connect Contact Center, Connect
Mobility, and advanced applications from Professional Services and third-party technology partners.

¢ Solution and Advanced Application Integration: The UC platform is an end-to-end, all-in-one
communication solution. Connect Contact Center, Collaboration for Web, Connect Mobility integrate
into the Mitel UC platform’s single-image architecture and automatically extend the functionality of
Connect Director and Connect client management and user interfaces. UC platform is based on open
standards to easily deploy the additional software solutions and business process applications. Mitel
advanced applications integrates with Microsoft Outlook, Salesforce.com, Customer Relationship
Management (CRM) applications, Interactive Voice Response (IVR) contact center tools, voicemail-to-
text converters, emergency notification solutions.

¢ Call Detail Reporting (CDR): Integrated CDR tracks all call activity for users, trunks, and workgroups.
Historical logs provide a management tool for monitoring employee workflow, inbound and outbound
activity, and trunk utilization. The integrated call accounting system manages communication costs by
using account codes to associate customer or project accounts to all calls and by enabling password
access to advanced calling permissions.
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¢ Call Control: The UC platform architecture distributes core voice communications capabilities across
all core system components. A single system serves multiple locations and provides stand-alone
survivability at every site in the event of a network or hardware failure. Each switch works with all
other voice switches to create a single, transparent, and easily managed UC solution. Every voice
switch hosts the call control application including IP-PBX and supports IP Phones, SIP phones and
devices, and analog phones and devices. Voice Switches also provide network interfaces to bridge the
communications beyond the enterprise by supporting SIP, analog, and ISDN trunking.

¢ Voicemail and Unified Messaging: Unified Messaging features can be deployed either centralized in
a data center or distributed across the network on industry-standard servers or voice switches. Mitel
provides a voicemail solution that uses advanced call routing rules. When combined with the Connect
client and Connect Mobility, users can integrate their voicemail inside Microsoft Outlook inbox, and can
direct the calls based on the calendar.

¢ Auto-attendant and Automated Call Distribution (ACD): Mitel's embedded auto-attendant provides
automated call answering and routing. Outgoing prompts can be customized and linked to the time of
day and/or day of the week. Mitel distributed workgroups feature provides basic ACD functionality for
call centers. Simple call routing, overflows, announcements, historical reports and real-time alerts are
integrated into the core platform software. Distributed workgroup ensures that the agents in remote
sites or branches are available independent of any network outages.

¢ Additional reliability is provided by the following capabilities:

- An embedded, real-time operating system and call control architecture, enables all switches to
communicate with each other and distribute call processing across the network.

- N+1 redundancy ensures that if a voice switch fails or is isolated by a network fault, the phones
supported by that switch automatically fail over to another voice switch—either at that site or a
shared resource at a data center as long as the phone has the ability to reach the spare switch on
the data network.

- PSTN Fail over: If the WAN is down or over-utilized for voice traffic, or if bandwidth limits extension-
to-extension calls between sites, calls can automatically route over the PSTN to provide seamless
communication.

- Ethernet Port Fail over: Voice switches provides redundant network up-links. If the upstream
network device fails, voice switches automatically fail over to the redundant link to provide
continuous operation.

- Power Fail over: Voice switch provides power fail transfer. If a complete power outage exceeds
reserve power duration, one analog trunk on the voice switch automatically connects to one analog
telephone to provide emergency dial tone.

Connect Architecture
Connect system consists of:

* Voice Switches: provides voice switching and core PBX functionality.
* Secure Access Layer: protects phones, trunks, and the Connect application against all security risks.

* Application Layer: consists of the higher-level applications, such as Voice mail, Connect Contact
Center, Connect Mobility, Collaboration for Web.

¢ Solution: provides open APIs for both Mitel and third party users.

* Management Framework: tailors management interfaces depending on deployment model system,
so you can direct your IT resources towards the other strategic business initiatives.

Figure 2 : Connect Architecture
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The Connect system includes:

e Connect Director

* Mitel Servers

* Voice Switches

¢ Service Appliances

e |P Endpoints

e Virtualized PBX and UC Components
e Connect Client Applications
¢ Connect Mobility

e Connect Contact Center

e Connect Edge Gateway

e Connect Deployment

Connect Director

Connect Director is a web-based application for managing the Connect system from anywhere on an IP
network. Using Connect Director, you can configure, manage, and maintain all aspects of the Connect
system. Connect Director includes maintenance pages to view status and issue maintenance commands
for system components, including remote servers. Connect Director is hosted by primary HQ server and
cannot be accessed if the HQ server is unavailable.

Connect Director provides simultaneous access to Connect Director by multiple users. The database is
locked during save transactions in Connect Director to ensure the data integrity. If another user tries to
save changes while the database is locked, Connect Director advises the user that the changes were not
saved; the user needs to save the changes again.

Through administrative permissions, the Connect system allows various levels of access to Connect
Director. By default, the initial system administrator has access to everything on the system. You can
assign other users one of several built-in roles, or you can define roles for more limited purposes such as
allowing site administrators, directory list managers, and read-only users to perform specific tasks.

Mitel Servers

Each Connect system includes a main server called the Headquarters server. Systems may optionally
include distributed applications servers, called Distributed Voice Servers (DVSs). Each server provides
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a local instance of TMS that supports applications such as voicemail, workgroups and Connect client.
Each instance of TMS manages its local soft switch and can be configured to manage voice switches
as well. The DVSs rely on the HQ server for configuration changes, but otherwise DVSs can operate
independently of the HQ server.

Headquarters Server (HQ)

The Headquarters server is the main Connect server and hosts the voice applications platform and the
management web site (Connect Director), as well as the integrated voice applications. The Headquarters
server is located at the largest site that contains the majority of users. The Headquarters server hosts a
soft switch that provides extensions for the auto-attendant, workgroups, and virtual users.

Distributed Voice Servers (DVS)

DVS provides increased system reliability by distributing key services and applications at remote sites.
Each DVS includes an instance of TMS that connects to and manages the local soft switch. DVSs can be
configured to support distributed voice applications such as voice mail, workgroups, account codes, auto
attendant and a distributed database. DVSs have TAPI access to the local soft switch. If a distributed
database is optionally enabled on the DVS, the distributed TMS maintains a copy of the configuration
database that allows it to provide call control and voice mail service during the outage. Each DVS
manages its own soft switch, as well as voice switches assigned to it.

Voice Switches

Voice switches provide physical connectivity for the PSTN and analog phones, and logical connectivity
for IP endpoints on a reliable, highly scalable platform for the call control software. The voice switches
and service appliances receive the configuration information via TMS.

All physical Voice Switches have flash memory that allows permanent storage of the call control software
and configuration information. The Voice Switches have no moving parts (that is, no hard drive) other
than a highly reliable fan. The switches include the necessary DSP technology to enable features like
echo cancellation, voice compression, and silence suppression.

The switch acts as a media gateway for the PSTN and analog phones by encoding the analog voice and
transmitting it to the other endpoint over the IP network using RTP. The switch also uses NCC to send
events to TMS about digit collection, caller ID, call establishment. TMS makes this information available
to the server applications. These applications are not necessary for many calls (such as those between
two phones or a trunk and a phone, which can be established with only the switches controlling the
phones and trunks), but they can enhance the user experience. For example, Connect client can provide
information about the call to the user's desktop.

Service Appliances

The Service Appliance is a sealed appliance, optimized for resiliency and security, capable of running
Mitel services. The Service Appliance can host Audio Conferencing, Web Conferencing and Instant
Messaging services.

Service appliances are deployed in the same manner as other voice switches and managed similarly to
the voicemail-enabled switches. Director windows configure conference settings and provide status for
the Service Appliance. Network settings are configured using a serial cable or the Service Appliance's
switch command line interface (svccl i ). The management of the services running on the Service
Appliance switch is done via the Service Manager command line interface (svccl i ). The stcli and
svecli commands are accessible through a serial cable or remotely through SSH.

IP Endpoints

The Mitel system manages calls and applications for three types of IP endpoints: IP phones, Soft phones,
and conference bridges. IP endpoints are identified by IP address and can exist anywhere on the
network. All IP endpoints are supported by voice switches, which must have sufficient capacity for all the
IP endpoints in the system. IP endpoints are configured in the system with Connect Director.
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Virtualized PBX and UC Components

The PBX and UC software is built upon a distributed architecture. Multiple instances of each server type
such as Phone Switch, Trunk Switch, DVS, and Conference Bridge are deployed in each cluster and the
workload is distributed. Because of the distributed architecture, a failure to a server instance generally
impacts a localized subset of the user population.

The server types run on a Linux platform that contains a service manager. The service manager
automatically terminate and restarts processes that exhibit the following failures:

* A CPU consumption threshold that has been exceeded.
* A memory consumption threshold that has been exceeded.

Similar to Windows services, the service manager attempts to restart a process up to a predefined
limit. The service manager is monitored by a separate watcher process which automatically restarts the
service manager if it stopped running.

Connect Client Applications

Client applications, such as Connect client, interact with TMS using the Client Application Server (CAS)
for call and data handling. Connect client provides desktop call control as well as voicemail, directory,
and call logging features. Users of supported versions of Microsoft Outlook can integrate their voicemail,
contacts, and calendar with the Mitel system.

Connect Mobility

The Connect Mobility is designed to create network transition points between Wi-Fi and Cellular where
calls are expected to handover. The Mobility Router (SMR), a platform for mobile convergence, provides
seamless location-based voice handover as users roam between Wi-Fi and cellular networks, uses
various metrics, such as voice quality, signal strength, packet loss, jitter, Signal to Noise Ratio (SNR),
and battery life to make decisions on how calls are routed. When users are within the building, calls
generally stay on Wi-Fi. As users walk outside, the Connect for iOS or Android and the Mobility Router
jointly make a routing decision to provide seamless, zero-impact handover of an existing call. While
within the building, the solution preserves the native Access Point-to-Access Point (AP-to-AP) roaming
behavior of the Wireless Local Area Network (WLAN).

The SMR service is deployed using its own application-level HA solution. Users are statically assigned
to a specific SMR instance. The Connect for iOS or Android connects to its SMR instance directly via
RAST. If the SMR application HA capability is not deployed, there is no fail over if the SMR server is not
responsive.

For each user, the SMR creates a SIP connection to the user's home Phone Switch, i.e. it does not
connect via the Phone SBC. Recovery from a failure of the home Phone Switch is automatic. A user is
dynamically re-assigned to another Phone Switch and the SMR is automatically redirected to the new
home Phone Switch.

Connect Contact Center

The Connect Contact Center software can be used by remote agents to connect to the Mitel network
through the Connect Edge Gateway for advanced multimedia call center solutions. The Connect Contact
Center services are deployed on Windows DVS. Windows DVS have the same underlying fault detection
and recovery capabilities as the Linux DVS. Incoming calls to an IVR is sent to a backup destination if
the Connect Contact Center service is unresponsive. This service has an application-level HA feature
that allows a backup instance to be deployed on a separate server so that it can take over if the primary
Connect Contact Center service becomes completely non-functional.

Connect Edge Gateway

The Connect Edge Gateway is a remote access solution offering to Mitel MiVoice Connect customers.
The Connect Edge Gateway enables users to connect securely to their solution by using the following
endpoints:

e [P 400 series phone (all models)
e Connect client
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¢ Connect Contact Center
e Collaboration for Web

Figure 3 : Connect Edge Gateway
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Connect Edge Gateway uses RAST protocol (UDP-based) to control over an expanded codecs list. This
appliance also provides end-to-end encryption for all traffic and does not require installation of a VPN
client on any endpoint. Connect Edge Gateway also uses reverse proxy to manage the Connect client,
and Collaboration for Web and uses TURN server to manage softphone audio from the client and
Collaboration for Web.

To connect remotely to the Mitel network, all MiVoice Connect customers need an active Internet
connection. The Connect Edge Gateway is deployed on the premises of the customer, and hence there
is no requirement for a third-party VPN client. You can access and configure the Connect Edge Gateway
through Connect Director.

MiVoice Connect Deployment

Mitel MiVoice Connect

MiVoice Connect is an end-to-end UC solution that customer own, maintain and control their platform
including IP-PBX telephony services, desk phones, and applications such as Connect client, Connect
Mobility, Collaboration for Web, and Connect Director.

A typical large multi-site deployment has the following components:

Figure 4 : MiVoice Connect Deployment
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Apps (Eg: ECC)

* HQ server: Home of the master database (DB), Connect Director, manage some switches.

* Secondary HQ server (optional): To implement redundancy.

Distributed Voice Server (DVS): One or more distributed servers managing switches with an optional
distributed database (DDB). DVS can either be on Windows Operating System (WinDVS) or Linux
Operating System (Linux DVS).

¢ Switch: Tens to hundreds of switches to manage end points, provide call control/media capabilities.
Unified Communications in a Box (UCB): A few conference bridge appliances.

¢ Phone: Several thousand MGCP and/or SIP end points.

* Connect client: Several hundreds to thousand stand-alone or web-based client applications.

External applications: A DVS dedicated to an external application such as Connect Contact Center,
Syntellect or a Call recording server.

Connect Mobility: Several hundred Connect Mobility clients.

Mobility Router: One or more Mobility Routers.

WAN: A wide area network for inter-site communications.

Edge Gateway: An appliance for secure access of Mitel services by remote endpoints.

Connect HYBRID

Connect HYBRID enables companies to deploy MiCloud Connect and MiVoice Connect systems
to different locations, and provides automated directory integration, extension-to-extension dialing,
and Caller ID between the MiCloud Connect and MiVoice Connect systems. This feature requires a
telephony-enabled MiCloud Connect account, and Mitel staff facilitate installation of the feature.
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Mitel Server

This chapter provides an overview of Mitel servers.

* Overview

* Diagnostic and Troubleshooting Information
* Windows Postmortem Debugging

* Services

* Connect Server File System

* Registry

* Connect Release Numbering Scheme

Overview

The Connect voice over IP telephony solution is a suite of software modules, applications, and services
running on a Mitel server. Every Connect system includes a main server called the Headquarters server.
In a single-site system, the Headquarters server may be the only Mitel server. More complex systems
may include Distributed Voice Servers (DVS) to add reliability for applications and switches on remote
sites or to support distributed applications. The Headquarters server remains the main server and must
be available to interact with the DVS servers for full system functionality.

Headquarters Server

The Headquarters server is the main Connect server and hosts the voice applications platform and the
management web site (Connect Director), as well as the integrated voice applications. Typically, the
Headquarters server is located at the largest site that contains the majority of users.

The Headquarters server hosts a SoftSwitch that provides extensions for the Auto-Attendant,
Workgroups, and virtual users.

Distributed Voice Servers (DVS)

The Connect system also supports remote distributed voice servers (DVSs). DVSs provide increased
system reliability by distributing key services and applications at remote sites. Each DVS includes an
instance of TMS that connects to and manages the local softswitch. The softswitch provides extensions
for use by the local Auto-Attendant, Workgroups, and virtual users.

Distributed voice servers can also be configured to support distributed voice applications such as voice
mail, workgroups, account codes, auto attendant and a distributed database. DVSs have TAPI access

to the local SoftSwitch. If a distributed database is optionally enabled on the DVS, the distributed TMS
maintains a copy of the configuration database that allows it to provide call control and voice mail service
during the outage. Each DVS manages its own softswitch, as well as voice switches assigned to it.

Remote DVSs are valuable for the following purposes:

e They reduce bandwidth usage because local users’ calls to voice mail are answered by the local voice
mail application and do not pass across the WAN.

¢ They increase system scale by extending the unified messaging and desktop call control services to
additional users of the applications.

¢ They increase system scale and reliability by providing distributed switch management, call control
services, and unified messaging.

* They increase system reliability by locating workgroups on other servers and providing a location for
backup workgroups to reside if a workgroup’s primary server becomes unavailable.

* They enable integration of value added applications such as ECC, Recording Servers, and more.

Call control is provided by Headquarters and distributed voice servers even if full network connectivity is
unavailable. However, calls to unreachable endpoints cannot be made, and call detail recording requires
Headquarters server communication. To add reliability to your remote server, consider using redundant
network paths to the Headquarters server.
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The following sections provide more detail on the communications, services, and applications.

Configuration Communications

Connect system processes use Open Database Connectivity (ODBC) objects to share information from
the configuration database among themselves and to write configuration information to the database.
Static configuration parameters are written to the database by Connect Director, and system components
access the database to read/write current state information. User configuration options are written to the
database from the Connect client and the telephone interface (voice mail options). Connect Director is
accessed via a web browser.

The service ST-ZIN, running on the Headquarters server, manages these COM communications for
all services. There is a single writable instance of the database on the Headquarters server, even if
distributed databases are created on distributed voice servers.

Each service on a distributed server caches a copy of the configuration database in internal data
structures. When a distributed server loses connection to the Headquarters server, changes made to
the Headquarters configuration database are no longer received by the distributed server. However,
services continue to function with the most recent configuration data until connectivity is restored. When
the connection is restored, the distributed server automatically receives and incorporates any changes
made to the Headquarters database during the outage.

If a distributed server restarts without a connection to the Headquarters database, then services are
started but are not functional. When the network connection is restored, the configuration is retrieved and
again cached by each service and services become functional.

Connect client applications, such as the Connect client, use Client Application Server (CAS) for data
handling. CAS communicates with clients via HTTP. Connect Director accesses the configuration
database though IIS.

You can use the Component Service Manager to view COM objects installed by the software.
Component Service Manager is located in the Administrative Tools folder available from the Windows
Start menu.

Do not change any permission or security settings for Connect components.

Features accessible from the voice mail phone interface that require write access to the database, such
as Extension Assignment and Call Handling Mode changes, are not supported during an outage unless a
local distributed database instance is in use.

Figure 5: Server Database Communications shows how Mitel services use Open Database Connectivity
(ODBC) to access the configuration database, and thus maintain the system status.

Figure 5 : Server Database Communications
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The Connect system relies on a variety of services to perform processes within the system. This section
describes some of the key services.

Internet Information Service (IIS)

The Mitel server uses IIS to implement Connect Director’s browser-based interface. You can use the
Internet Services Manager to view the configuration of the Connect Director Web site. Mitel installs the
site configuration using the installation program. Changing the default configuration installed by Mitel
might cause Connect Director or other system components to fail.

Note:

If the anonymous access user ID is modified or its password is changed, TMS does not start. Changing
the properties of this user may require you to rebuild the server to recover.

FTP Services

Both the Headquarters and DVS servers make an FTP service available for fallback use by Voice
Switches. While this does not have to be active on a continuous basis, the FTP site needs to be active for
the fallback capability to work. Mitel recommends that the FTP site always be available.

The Mitel server also uses the FTP service to transfer prompts between applications.

Legacy IP phones use the FTP server to download configuration information and the application program
when they boot. (IP 400-Series phones uses HTTP for this purpose.) The IP phones download these files
from the server that is controlling the switch managing the IP phone.

To view the FTP site properties, use the Internet Services Manager. Anonymous FTP access must be
maintained in order for all applications to use it.
SMTP Services

The software uses SMTP to send email notifications (for example, when new client software is available
for installation). The voice mail system uses SMTP to transport composed messages between the
distributed servers. SMTP services are also required by the Event Notification feature.

The installer does not make any specific configurations to the SMTP service. The applications deposit
outbound email on the server for forwarding elsewhere.
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For proper operation of the Mitel services, the hosting enterprise must have an email server configured
to accept and forward SMTP mail. This is usually the exchange server or primary email server for the
company.

Client Application Server (CAS)

The Client Application Server (CAS) is a proprietary protocol that uses HTTP messages to communicate
between client PCs and Mitel servers. The CAS protocol communicates configuration updates such as
call handling mode settings and Outlook integration. Network devices, such as firewalls and proxies,
must not automatically close these pending requests.

Note:

If the System Directory email address begins with digits, the CAS server response to a voicemail query
returns stating incorrect email address.

IP Phone Services

IP phones in a Connect system rely on two services running on the Headquarters server and distributed
servers:

e Sysmgmt: Runs on all servers.
* |P Phone Display Service/CAS: Runs on all servers.

The IP Phone Configuration Service (IPCS) manages the IP phone configuration process, including
configuration file downloads and the database updates.

IP Phone Display Service/CAS controls any actions by the IP phone display not controlled by the device’s
firmware or switches.

Applications

This section provides information about applications that run on the Mitel server.

Event Watch

Event Watch monitors the NT Event Log and delivers email notifications of selected events. Event
notifications are configured from the Events Filter page in Connect Director.

For more information about Events, see the MiVoice Connect System Administration Guide.

Call Detail Reporting (CDR)

TMS uses COM to write call data to the Call Detail Report database. The Connect system tracks all call
activity and generates call detail records into a database as well as into a text file on the Mitel server. The
call detail records are used to generate CDR reports.

For more information on Call Detail Reports, see the MiVoice Connect System Administration Guide.

Call Control Communications

The servers provides call control for server applications and for Distributed Routing Service (DRS).

Telephony Application Programming Interface (TAPI)

The Mitel server and its client applications use a Telephony Application Programming Interface (TAPI) to
direct applications and provide the system with call control Server TAPI Communications

The TMS application service acts as the TAPI service provider and is responsible for managing the
system’s TAPI lines and routing information to other applications. When TMS starts up, it creates a TAPI
line device for each endpoint in the system. Access to these TAPI lines is provided through Remote TAPI
Service Provider (RPCTSP.tsp). This is installed on each of the systems that run Connect clients (such
as the Connect client), HQ, and distributed servers. Every application with access to these TAPI lines
receives new calls, call state information, and line device information from TMS via RPCTSP.tsp.

The Telephony Management Service (TMS) uses NCC to communicate with the Voice Switches, and
a combination of RPC and Windows sockets (Winsock) to communicate with a Remote TAPI Service
Provider.

19



MITEL SERVER

To view the properties of the Remote TAPI Service Provider, open the Phone and Modem Options tab in
the Windows Control Panel.

Note:

Never modify the TAPI properties of the Remote TAPI Service Provider. Modified TAPI properties can
cause Mitel clients or applications to fail.

Figure 6 : Server TAPI Communications
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Distributed Routing Service (DRS)

DRS on each server provides routing information when switches cannot route the call in the local site
and require intersite call routing information. An enhanced SIP protocol is used for communications
between the switch and DRS. (See the Server Call Control and Media Communicationsfigure in the
Media Communications on page 20 section)

Media Communications

Media, from the perspective of the server, connects voice mail and the Auto-Attendant to switches and
endpoints via the media driver. Media travels through the Connect system using Real-Time Protocol
(RTP).

A voice mail message is normal RTP traffic, unless it is a recorded voice mail message moving from
one server to another. Voice mail media streams conform to the G.711 codec. If a switch or IP phone

is configured to use G.729 or ADPCM (for example, for an intersite call), a media server proxy is used
to transcode between G.729/ADPCM and G.711. Since the media server proxy is a switch resource,
there are a limited number of G.729 proxies. If there are insufficient G.729 proxies, then ADPCM is used
instead.

Server Call Control and Media Communications shows the switch-to-switch call control and media
communications flows.

Figure 7 : Server Call Control and Media Communications
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Integrated Server Applications

There are several integrated TAPI applications running on the server. These applications use TAPI to
send and receive call control information, and can also manipulate calls. These applications also use ZIN
Manager and ODBC to access and update the configuration database.

Voice Mail

Voice mail is a TAPI application that supports 254 simultaneous voice mail or Auto-Attendant
connections. The voice mail system on the Windows HQ server and Windows Distributed Voice Server
(DVS) uses SMTP to transport composed messages between the distributed servers. The Linux DVS
uses Qmail. Media streams to voice mail use RTP packets to send media.

Voice messages are stored on the server’s hard drive in the VMS MESSAGE subdirectory of the
Shoreline Data directory. Voice mail messages are stored as. wav files. To help you calculate storage
requirements, one hour of messages requires approximately 30 MB of disk space.

The voice mail application consists of the following services: Port Manager and Mail Server. The Port
Manager uses TAPI to interact with TMS. The Connect system also supports linking to legacy voice mail
systems using AMIS and SMDI protocols.

Distributed Voice Mail

If the Headquarters server loses network connectivity, the distributed voice mail application allows
softswitches on Distributed Voice Servers to continue handling voicemail calls and access the auto-
attendant.

During an outage, users can access voice mail only through their phone interface. Those using the
Connect client are not able to access their voice mailboxes until connectivity is restored.

Voicemail messages to mailboxes hosted at other sites are stored and forwarded when connectivity to
the destination voice mail service is restored.

Workgroups

Workgroups is an integrated Automated Call Distribution (ACD) application. Running on any HQ or DVS
server, this TAPI application is responsible for routing and queueing calls directed to workgroups.

In the larger enterprise, there may be small- to medium-sized groups working together as a contact
center. The Contact Center Solution is a server-based ACD and reporting package that includes the
ability to queue and distribute calls, and provide agent and supervisor functions, as well as deliver reports
on the call center activity.
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Account Code Collection Service (ACC)

The Account Code Collection Service (ACC) is a TAPI application running on any HQ or DVS server.
When it is enabled, it allows account codes to be required or optional for outbound calls. When a
restricted PSTN call is attempted, and account code collection is enabled, the Voice Switch redirects the
call to ACC.

Account Code Collection Service is responsible for:

* Prompting the user for the account code

e Collecting and validating the account code

¢ Attaching the account code to the call for reporting purposes
e Performing a blind transfer to the external number

If the managing server is down, or ACC is not available, the call is directed to the Backup Auto-Attendant.
TMS provides the following information to ACC:

e Dialed number

e User group

» Backup Auto-Attendant and correct menu number
¢ Account Code settings for each user group

CAS exposes a list of account code names and numbers within the Connect client to facilitate the
account selection process for the user.

Softswitch

Softswitch is used to host virtual users who are not assigned a physical telephone port on any Voice
Switch. The softswitch for each HQ or DVS server hosts all voice mail, Auto-Attendant, and Workgroup
extensions as well as route points managed by that server.

When softswitch is down loss of connectivity to the softswitch makes the voice mail, Auto-Attendant,
Workgroups, and route points supported by that softswitch unavailable.

The softswitch receives and transmits information using the same communication paths and protocols as
the other switches in the system.

A softswitch is automatically created for every server added to the Connect system. By default, the name
of the softswitch is the same as the name of the Mitel server hosting the switch, as specified on the
Application Server page in Connect Director.

Server Maintenance

Server software upgrades take place any time new software is loaded. The Setup program detects the
installed software and automatically converts any system files or databases.

Upgrading from one minor version to another automatically converts any system files or databases. Minor
upgrades typically add incremental features to the software or correct product defects found in previous
releases.

Diagnostic and Troubleshooting Information

The Connect system provides information about the operational status of the servers and services,
as well as diagnostic and troubleshooting tools to resolve an event or error that might occur while the
system is running or during installation.

The following tools are described in this section:

¢ Monitoring tools included in Connect Director
 Installer logging

* Eventlog

* system logs

e cfg utility
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Monitoring Servers through Connect Director

You can monitor the components in your Connect system in the Diagnostics & Monitoring system that
you can access through Connect Director. With the Diagnostics & Monitoring system, you can monitor
server status and other aspects of the Connect system. For more information, see the Monitoring and
Diagnosing chapter in the MiVoice Connect System Administration Guide.

You can also view system and application events in the Event Log, which you can access through
Connect Director.

Installer Logging

Some logging information can be gathered by the installer technology native to the operating system.
Mitel includes added proprietary code that provides more detail in the log files to assist you in
troubleshooting software installation. This proprietary code adds information about calls to the installer
and return values from all custom action functions invoked by the installer.

Log files are generated in the user profile temp directory and start with msi and end with . | og. Sort the
directory if there are many log files or if there is any doubt as to which log file to look at.

Configuring Installer Logging

Perform the following procedure on the server that is going to run the software before the software is
installed on the system:

1. Click on the Start bar and select Run.
2. Type regedit to access the Registry Editor window.
3. Navigate to the following path:

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Pol i ci es\ M crosoft\ W ndows\ I nstal |l er]
Right-click in the blank pane at the right of the window and select New > String Value.
Name the file Logging.

Right-click on the file and select Modify.

In the Value data field, type voicewarmup!

Click OK.

©ONo ok~

There are no obvious signs that installer logging is enabled. However, after you have enabled the feature
(and performed a software installation), you can check the temp directory for log text files at the following
location:

C:\ Docunent sandSet t i ngs\ user nane\ Local Setti ngs\ Tenp
Note:

» After installer logging is enabled, you might see installation logs in the temp directory for other non-
Mitel software installations.

* To view the log files, you might have to change the setting for the file view features in Windows
Explorer so that hidden files, directories, and file extensions are visible.

Using the Event Log

The Connect system uses the Windows Event Log to report information and errors. Use the event logs
in conjunction with the Diagnostics Monitoring system to determine the overall health of the system. The
event log gathers information about event history. For example, the event log may provide information
about an overnight SGT1 outage that was corrected but is no longer evident in the Diagnostics
Monitoring system.

Each system task reports when it starts and stops. These messages can be helpful in determining
whether the system started correctly. Events, such as switches losing connection to the server or
rebooting, are also reported. For a list of all event codes, see Event Types on page 180.

Using the System Logs

The Connect system stores engineering-level log files that record transaction information about every
event in the Connect system. The logs are used to help Mitel with debugging problems that may arise
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during system operation. In most cases, these logs require the assistance of Mitel Customer Support to
understand.

Two utilities, one with a graphical user interface and the other with a command-line interface, can be
used to automate the collection of server logs, Windows (OS) logs, and databases. Both applications
have the same functional capabilities and offer two different ways for accomplishing the same tasks.

Using the Graphical User Interface

The GUI can be executed from MS Windows or from a command window.

1.

1.

Launch the graphical version of the Server Log Collection Utility by clicking on the following
executable:

<ShoreTel install directory>\slogWn.exe

<ShoreTel install directory> is the location of the server files. The default installation location of server
files is as follows:

C:\ Program Fi | es\ Shorel i ne Communi cat i ons\ Shor ewar e Server

The Server Log Utility displays the Banner panel.
Press Next to proceed.

. On the Date Selection panel, specify the dates to collect log files. The program collects files only for

a contiguous date set. The default selection is today’s date.

Press Next to proceed.

On the Log Selection Method panel, specify the log file selection method and the destination
directory.

* To select all log files for inclusion in the archive, select the Default radio button. Press Next to
begin archiving all available log files.

¢ To manually select the desired log files for inclusion in the archive, select the Custom radio
button.Press Next to open the Log Selection panel. This panel prompts you to select the log files
for inclusion in the archive.

* To select the Destination Directory, press Browse.
Note:

The destination directory is listed above the Browse button

The program opens a Browse for Folder panel for selecting the destination directory.

. On the Log Selection panel, specify the log files that the program archives. System information

might be gathered separately.
Note:

The utility does not display this panel if you select Default in the Log Selection Method panel.

¢ The four options at the top of the panel select multiple log files. When you select one of these
options, all log files included by that selection are selected and cannot be edited.

¢ Select ALL to include all files in the archives.

» All available log files are listed below the first four options at the top of the panel. You can select
one file, all files, or any combination of files

. Press Next to begin saving log files.

The utility displays the Archiving panel while the program saves the selected files. The Next
and Back buttons are disabled while the program is saving the files. The Cancel button remains
available.

. Press Next after the Save process is completed to display the FTP Upload panel. After archiving the

files, the program presents an option to upload the archive file to a remote FTP server.

After archiving the files, the program presents an option to upload the archive file to a remote FTP
server.

. Enter valid settings for all FTP parameters, then press Upload.
. Press Next to proceed to the Completion panel.

The Completion panel indicates that the log files and databases were successfully archived to the
specified directory.
Press Finish to close the utility.
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Using the Command-Line Application

The command-line version of the Server Log Collection Utility provides the identical functionality as the
GUI from the windows command prompt.

The following program launches the Command Line version of the Server Log Collection Utility:
ShoreTel install directory>\ServerLog. exe

Note:

ShoreTel install directory>isthe location of the server files.

The default installation location of server files is as follows:

C:\ Progranti | es\ Shorel i ne Conmuni cati ons\ Shor eware Server

Table 1 lists and describes available command-line parameters.

Table 1: Command Line Parameters and Description

Command Description

d destDir> Set Destination Directory.

Note: This is a mandatory parameter.

-dl datel> Set Start Date. date1 — mmddyy.

-d2 date2> Set End Date. date2 — mmddyy.

If -dl is not specified date1> and date2> are both set to the current
date.

If -dl1 is specified, d2 becomes a mandatory parameter where date2>
must be greater than or equal to date1> and less
than (date1> + 7 days).

- CDRDB Retrieve current CDR Database Log

- CONDB Retrieve current Configuration Database Log

- CRASH Retrieve Crash Dump Logs

- NTEL Retrieve NT Event Logs

-TRI G Retrieve Trigger Logs

-DB Retrieve Database Logs

-DIR Retrieve Director Logs

- DS Retrieve DataServices Logs

- WGS Retrieve Workgroup Server Logs

-VM Retrieve Voice mail Logs

-1 PDS Retrieve IPDS Logs

-1 PCS Retrieve IPCS Logs

- DRS Retrieve DRS Logs

-CSl S Retrieve CSIS Logs

- ACC Retrieve ACC Logs

- CDR Retrieve CDR Logs

- TAPI Retrieve TAPI Logs

- DTAS Retrieve DTAS Logs

- SS Retrieve SoftSwitch Log

- TV Retrieve TMS Logs

- ALLCONDB Retrieve All Configuration Database Logs

25



MITEL SERVER

Command Description

- ALLCDRDB Retrieve All CDR Database Logs

-ALLW N Retrieve All Current Windows Logs (Mitel, NT
Event, Crash Dump)

- ALLDBS Retrieve All Database Logs (CDR, Config)

- ALLLOGS Retrieve All Current Logs

-ALL Retrieve All retrievable logs and databases

- f Upload the archive to the specified FTP server

pat h> user > pass> Specifies the FTP destination location when
uploading the archive to an FTP server

-V Display version number of command line program,
then exit

-h Display name and description of command line
parameters, then exit

Examples

The following command line copies Voice Mail logs generated between 2 March 2007 and 6 March 2007
to C:\ LogsDi r directory:

Server Log. exe -d1 030207 -d2 030607 -VM —-d “C:\LogsDir”

The following command line copies all voice mail logs generated today:

Server Log. exe -VM —d “C:\LogsDir”

The following command line generates an error message because only one date is specified:

Server Log. exe -d1 030207 -VM —d “c:\LogsDir”

Using the Trunk Test Tool

The Trunk Test tool is a TAPI application that monitors real-time activity on a trunk. You can find the tool
in the program folder. The Trunk Test tool allows you to select a trunk to view by site, rather than viewing
all trunks across your enterprise.

The tool is divided into two sections. The top section lists all the trunks in the system and their current
status. The bottom section gives real-time monitoring information about the currently highlighted trunk. If
this tool remains running on the server with an excessive number of lines selected, the server might have
performance problems.

The interface for the Trunk Test Tool contains the following components:

¢ The File menu allows you to save log information to disk or print it.

e The Edit menu allows you to copy and paste data from the Trunk Test window.

* The View menu allows you to turn on and off the status and toolbars, and open the Trunk Helper
Settings dialog box. The Trunk Helper Settings dialog box allows you to set the server you want
to monitor, select an extension to dial out with, and set the number of lines of data to collect for each
trunk.

¢ The Operations menu allows you to make or drop calls, view the properties of selected trunks, place
trunks in service, and remove them from service. You can also access this menu by right clicking a
selected trunk.

¢ The Help menu displays the version number of the Trunk Test tool.

Using the cfg Utility

The cfg utility is a command-line tool that provides detailed information about the voicemail application.
It is available on all voicemail servers, including Windows DVS, Linux DVS, and voicemail-enabled
switches. The cf g. exe file resides in the following path:

C.\Program Fi |l es\ shorel i ne comuni cati ons\ Shorewar e server

26



MITEL SERVER

To start cfg:

1. Open a command line window pointing to the \ shor el i ne comuni cat i ons\ Shor ewar e server
directory.
2. Type cfg and press ENTER.

When you see the prompt /*Local*//->, cfg is ready.

All commands are entered at the above prompt. Results are displayed in the command line window
or in the voicemail logs.

Note:

Some cfg utility commands might damage the system if used incorrectly. Make sure you
understand the commands before you use them.

Table 2 lists and describes the commands available through the cfg utility. Variables are shown in italics.

Table 2: Table 2: cfg Commands

Command Parameters Description Comments

call p p — phone number Make a call from the
voicemail application
and play a prompt.

cl osem Close the open
voicemail box.
dmask 0x 0x — mask hex Set voicemail debug To see a list of available
mask in hex. flags, enter without a
parameter.
exit Leave cfg.
| aam t t— List Auto-Attendant Displays mapping of
menu mapping. trunks to Auto-Attendant
e 1-DID menus.
e 2-DNIS
e 3—Trunk
lall f f— 1 for more details List all mail boxes in the | Enter without “1” for a
system. summary of system mail
boxes and with “1” for
more detail.
lanp mf m = mail box Turns the message

waiting light on/off for a

f=(1=on, 0 = off) specified mail box.
list pb b b - (0—last name, 1 — | Dump dial by names
first name) directory to the voice
mail log.
I mboxf f =1 for more details List mail box Enter without “1” for
information. a summary of system
mail box information,
including messages IDs.
[ ms List mail box schedule.
| msgm m — message ID List details about a Message IDs can be
specific message. found by using Inbox.
| oadc Load all voicemail
configuration from the
database.
| oadm Load all mail box Requires that a mail box
configuration from the be open when you issue
database. the command.
| serv List information about all
servers.

27



MITEL SERVER

Command Parameters Description Comments
| sys List all voicemail system
parameters.
I sntp List status of distributed
voicemail.
It api List status of TAPI lines

opened by voicemail.

nsi nf o Dump voice mail
internal table to the
voicemail log.

openm # # — mail box Open specified mail
box.
psinfo Dump port server

information to the
voicemail log.

pur ge Remove message in the | Requires that a mail box
deleted queue. be open when you issue

the command.

shstr str — string Search help for a string. | Searches only from the

beginning.

starth Remove old deleted
messages.

Sy mui Run message Sends current MWI
waiting indication status to all phones in
synchronization. the system.

ver List cfg version.

? List help commands.

Windows Postmortem Debugging

Note: Mitel recommends using Windows Error Reporting on the Microsoft Windows operating system
that is used for MiVoice Connect applications.

For Windows 2012 and later, refer to the following Microsoft article for information about enabling
postmortem debugging:

https://docs.microsoft.com/en-us/windows-hardware/drivers/debugger/enabling-postmortem-debugging
For Windows 2008 R2 and earlier, use Dr. Watson.

Dr. Watson is an application debugging program included with the Microsoft Windows operating system.
Mitel recommends using the Dr. Watson application if you are running on Windows 2003 Server.

Note:

Windows Error Reporting (WER) was enhanced in Windows Vista SP1 and Windows Server 2008 to
allow collection of local crash dumps. The enhanced WER feature has a number of benefits over the
older built-in crash handling of Dr. Watson. For more information, see Microsoft's website.

To enable Dr. Watson:

1. Open the Control Panel and then double-click System.

2. Click on the Advanced tab.

3. Click Error Reporting (Error Reporting Window). Disable it, or if you choose to enable it, leave it
enabled just for the Windows operating system. Leave the Programs check box clear.

This must be done whenever a new machine is built or ghosted.

4. Install Dr. Watson from the command line by typing drwtsn32 -i.

5. Run drwt sn32 to configure it. A window is opened (similar to the one shown in Configuring Dr.
Watson).

6. Under Crash Dump Type, select the Mini radio button.

7. Select the Visual notification check box. This ensures that you are aware when a dump occurs.
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8. Select the Create Crash Dump File check box.

9. Optionally, in case the dump file might be overwritten, it may be helpful to enable the following
options by selecting the associated check boxes:

* Dump Symbol Table

* Dump All Thread Contexts

¢ Append to Existing Log File
10. Click OK to store your changes.

To collect Dr. Watson dumps:
e Dumps for a logged in user appear under:

C.\Docunents and Settings\Al |l Users\Application Data\M crosoft\Dr Watson
e Dumps for services appear under:

¥syst ent oot % PCHEALTH\ ERRORREP\ User Dunps
Figure 8 : Error Reporting Window

reported to Microsoft to help improve future
products.

- !! “fou can choose to have software enors

' Disable error reporting

V¥ But notify me when critical errors occur

{~ Enable ermor reporting

¥ Windows operating systen

I” Broarams Choose Frograms.. |

| oK I Cancel ]

Figure 9 : Configuring Dr. Watson
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Dr. Watson for Windows

Log File Path: Jatin:ln Data“Microsoft®Dr Watson  Browse...

Crash Dump: JC:"-..DDcuments and Settings*All Browse...

[

ave File: J Browse...

Mumber of Instructions: 10

Mumber of Emors To Save: 10

Crash Dump Type: € Full & Mini ¢ NT4 compatible Ful
— Options
[T Dump Symbol Table
¥ Dump Al Thread Cortexts
¥ Append To Existing Log File
[ Wisual Notification
™ Sound Natfication
¥ Create Crash Dump File

Application Emors Views | Clear |

C:Program FilestIrntemet Explorerisxplore exe Jeedfade ke

[~
[

] | Cancel Help

Services

The Mitel server is made up of multiple processes working together to provide applications that include
voicemail, Connect Director, and Workgroups. Each process runs as a Windows Service, which starts

automatically when the server starts.

Table 3 on page 40 lists and describes each service and its underlying process. All services run on the
Headquarters Server. Services that also run on distributed voice servers are marked in the “Distributed

Server”’ column.

Table 3: Service Descriptions

Service Name Service ID Process Description Distributed
Server
ShoreTel ShoreTel-
Authenticator AuthenticatorServicg
Service
ShoreTel ShoreTel-
Bootstrapper BootstrapperServicq
Service
ShoreTel Connect | ShoreTel-
Sync Service ConnectSync
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Service Name

Service ID

Process

Description

Distributed
Server

ShoreTel Key
Notifier

ShoreTel_KeyNotifig

—

This service
pushes the
authentication

keys into the web
socket server
(ST-WSS) so that
it can complete
authentication of its
clients.

Call Accounting

ShoreTel-CDR

TmsCDR.exe

Records call
information

(call accounting
information, call
queuing data, and
media stream data)
and writes it to the
CDR database

ShoreWare CSIS
Server

ShoreTel-
CSISSVC

CSISSvc.exe

Provides legacy
clients (ST12 or
earlier) with an
interface to the
Mitel server

ShoreWare CSIS
Virtual Machine
Server

ShoreTel-
CSISVMSVC

Provides
notification for
clients and
voicemail

ShoreWare
Database Update
Server

ShoreTel-
DBUpdateSvc

DBUpdateSvc.exe

Accepts database
updates from
remote computers

ShoreTel Connect
Director

ShoreTel-Director

Provides
diagnostics

and monitoring
capabilities for
Connect system
components

ShoreTel Connect
Director Proxy

ShoreTel-
DirectorProxy

Provides a Web
Server and a
reverse proxy
for the Director
Service

ShoreWare
Distributed Routing
Service

ShoreTel-DRS

DRS.exe

Allows the Connect
system to scale
beyond 100
switches

When active,

this service
provides location
information for
routing intersite
calls and additional
routing information
for trunk group
selection.

ShoreWare Event
Service

ShoreTel-EventSvc

CEService.exe

Distributes
events to Mitel
applications and
services
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Service Name Service ID Process Description Distributed
Server
ShoreTel-IMAA ShoreTel-IMAA IMAAService.exe Collects archives
Service from IM servers
into a central
location; runs on
HQ server.
ShoreWare Event | ShoreTel- EventWatch.exe Monitors the NT
Watch Server EventWatch Event Log and
delivers email
notifications of
selected events
ShoreTel ShoreTel This service
Monitoring Service | MonitoringService enables the
monitoring
processes

necessary for
the Diagnostics
Monitoring system.

ShoreWare Voice
Mail Message
Server

ShoreTel-MailServ

MailServ.exe

Provides

user mailbox
capabilities, AMIS
features, and
system auto-
attendant menus. It
also manages the
voicemail message
store.

ShoreTel-
MYSQLCDR

ShoreTel-
MYSQLCDR

This service is a
database process
related to the Call
Detail Record
database.

ShoreTel-
MY SQLConfig

ShoreTel-
MY SQLConfig

mysqld.exe

This service is a
database process
related to the
configuration
database for
Connect Director.

ShoreTel-
MYSQLMonitor

ShoreTel-
MYSQLMonitor

This service

is a database
process related

to the monitoring
database for

the Diagnostics
Monitoring system.

ShoreWare Client
Application Server

ShoreTel-IPDS

IPDS.exe

Manages voice
mail clients and IP
phone display not
controlled by the
device’s firmware
or switches.
Responsible

for managing
changes made to
the database by
the clients.

ShoreWare
Notification Server

ShoreTel-Notify

TriggerServer.exe

Notifies server
applications of
changes to the
configuration

ShoreWare Voice
Mail Port Manager

ShoreTel-PortMgr

Service component
of the voice mail
system
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Service Name

Service ID

Process

Description

Distributed
Server

ShoreWare Port
Mapper

ShoreTel-Portmap

PortMap.exe

Initiates RPC
communication
connections
between the
Telephony
Management
Server (TMS) and
Voice Switches

ShoreWare
Remote Logging
Service

ShoreTel-
RemotelLogSvc

LogService.exe

Accepts logging
from remote
computers

ShoreTel Remote
Packet Capture
Service

ShoreTel-RPCAP

Runs remote
packet capture
operations

for diagnostic
purposes

ShoreTel-SAMS

ShoreTel-SAMS

Provides services
to Connect Director

application
ShoreWare ShoreTel- VTSMain.exe The SoftSwitch
Software SoftSwitch hosts call
Telephony Switch endpoints for voice

mail, Workgroup,

route points,

and other IVR

extensions.

Virtual users are

hosted on the

Headquarters

SoftSwitch.
ShoreTel System | ShoreTel- SysMgrSvc.exe Provides IP phone
Management SysMgrSvc registration and
Service other functions
ShoreWare ShoreTel-TMS Tms.exe The telephony
Telephony platform for Mitel
Management applications,

Service (TMS)

services, and
third-party TAPI

applications
ShoreWare ShoreTel- Provides transport
Transport Server | TransportSvc services for Mitel
applications and
services
ShoreTel Voice ShoreTel- VmEmSyncSvc.exe| Provides voicemail
Mail Synchronizer |VmEmSync and email
synchronization
ShoreTel Web ShoreTel- WebFrameWork.exe Provides support
Framework Server | WebFrameworkSvc for Connect client

and interactions
with Client
Application Service

ShoreWare
Workgroup Server

ShoreTel-WGSvc

Manages
workgroups and
queues

CMCA Service CMCA Conference bridge
application
File Transfer FTService Transfers files

Service

using SMTP
(gmail) engine
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Service Name Service ID Process Description Distributed
Server
IM Service IMService XMPP-based
Instant Messaging
engine
Media Service STMedia/STTS Media engine
QMail Service QMailService SMTP service on
Linux servers
Services Manager SMgr Services Manager
Service for starting,
stopping, and
monitoring services
SM Service SMService Backend service
that enables
service CLI access

Connect Server File System

Table 4 lists the directories where the Connect server installs its files.

The Windows System user and the IPBX user created by the Connect installer require full access to all
the Mitel directories. All other users can be granted access on an as-needed basis.

Note:

The server installs files with default access permissions. System administrators might want to ensure a

more secure environment.

To ensure the security of sensitive and/or personal information, confine access to the VMS and Database
directories strictly to administrator, system, and IPBX users.

Table 4: Server File System

Directory

Description

Default Path

Mitel Server

Contains all server system files
and dlls. This directory is located
on the drive where program files
are stored.

dri ve>\ Program

Fi | es\ Shoreline

Comuni cat i ons\ Shor ewar e
Server

Connect Director

Contains all Connect Director
Web site files. This directory
is located on the drive where
program files are stored.

dri ve>\ Program

Fi | es\ Shoreline
Comuni cat i ons\ Shor ewar e
di rector

Presenter

Installed on systems with
Conferencing Services. Contains
the files, applications and dlls
required to enable screen
sharing capabilities for Web
Conference Services. This
directory is located on the drive
where program files are stored.

drive>\ Program

Fi | es\ Shorel i ne

Comuni cat i ons\ Shor eTel
Present er

Shoreline Data

Contains all the dynamic
information the server uses to
run the system. This directory
and all sub-directories may be
saved as part of a backup and
used for full system recovery.

dri ve>\ Shoreline Data
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Directory

Description

Default Path

Call Records 2

Contains all call record files and
databases

The MySQL database is ODBC
compliant. Parameter settings

required to access CDR records
in the MySQL database include:

* DRIVER - {MySQL ODBC
3.51 Driver}

* SERVER - localhost (or
the server where MySQL is
installed)

e DATABASE — Shorewarecdr
e USER - st_cdrreport
e password — passwordcdrreport

Database Contains the configuration
database that stores all system
configuration information
dvs Contains the files and
configuration information used
by the Linux Distributed Voice
Server (DVS)
Logs Contains all debugging logs drives\ Shorel i ne Data
\ Logs
Prompts Contains copies of the auto drive>\ Shorel i ne Data
attendant and workgroup menu \P
prompts ronpts
Scripts Contains scripts for starting dri ve>\ Shorel i ne Data
and stopping services that are \Scri ot
used during system backup and cripts
restore and by Double-Take.
SoftSwitch Contains files needed to runthe | 4, ve>\ Shorel i ne Dat a
SoftSwitch ;
\ Sof t Swi t ch
Templates Contains configuration files dri ve>\ Shorel i ne Data

needed for IP phones

\ Tenpl at es

35



MITEL SERVER

Directory

Description

Default Path

VMS

Contains all the files and
configuration information used
by the voice mail system. The
files in this directory and its sub-
directories are very dynamic.

Note:

Never open these files.
Opening any of the
configuration files may cause
the voice mail system to
become corrupted in part or
completely, and can cause loss
of voice mail messages.

* MESSAGE: Contains all voice
mail messages as.wav files,
along with an .enl pointer file
for each message.

* NetTempln: Used by
distributed voice mail servers

* Servers

¢ SHORETEL: Contains a
subdirectory folder for each
voice mailbox configured
on the system. Each user,
menu, and distribution list
includes a mailbox. There
are also system mail boxes
for voice mail access and
forwarding. Each of the sub-
directories contain the names
and greetings for that mailbox,
as well as configuration and
pointer files.

dri ve>\ Shoreline Data
\ VMBS

dri ve>\ Shoreline Data
\ VMVB\ MESSAGE

| ocal drive>\Shoreline
Dat a\ VMS\ Net Tenpl n

dri ve>\ Shoreline Data
\ VMB\ Ser ver s

dri ve>\ Shoreline Data
\ VMB\ SHORETEL

Inetpub\ftproot

This is the default FTP directory
installed by IIS.

drive>\1lnet pub\ftproot

ts

Contains the boot files and
system software for supported
languages

tsa

Contains the boot files and
system software for all full-width
voice switches

tsb

Contains the boot files and
system software for all Mitel ST-
model switches

tsk

Contains the boot files and
system software for all half-width
Voice Switch SG30, SG30BRI,
SG50, SG90, SG90BRI, SGT1k,
SGE1k, SG220T1, SG220E1,
and SG220T1A switches

tsk1

Contains the boot files and
system software for all voice
mailbox model switches SG50V,
SG90V, SG90BRIV

36



MITEL SERVER

Directory Description Default Path

tsu Contains the boot files and
system software for the Service
Appliance 100 (SA100) and
Service Appliance 400 (SA400)

tsv Contains the system software for
virtual phone and trunk switches

Registry

The software uses the Windows registry to store various parameters used by the Connect system. These
registry keys reside at the following paths:

* For 32-bit operating systems:

HKEY_LOCAL_MACHI NE\ SOFTWARE\ Shor el i ne Tel ewor ks
e For 64-bit operating systems:

HKEY_LOCAL_MACHI NE\ SOFTWARE\ Ww6432Node\ Shor el i ne Tel ewor ks

Maximum Transmission Unit (MTU) Size for Connections

The default Maximum Transmission Unit (MTU) setting for PPP (Point-to-Point Protocol) clients, VPN
(Virtual Private Network) clients, PPP servers, or VPN servers running Routing and Remote Access on
Connect systems is 1400. To change the MTU value, you must edit the registry. For further information,
contact Mitel Technical Support.

Telephony Management Service (TMS)

A Connect server can be configured with a registry entry that TMS pushes to the server's managed
switches. The registry entry typically configures and invokes some custom behavior in the switch. For
example, when an administrator modifies the SwitchDebug value in the registry to configure the switch,
TMS automatically reloads the value and pushes it to the managed switches. Other registry changes,
such as CDRDataExpiration, are automatically reloaded by TMS so that TMS immediately starts using
the new value.

When a registry change needs to be system-wide, the administrator must manually change the registry
on every distributed server. On a large system, manual updates can be slow, repetitive, and error-prone.

To address this challenge, an administrator can configure a TMS registry entry on the HQ server, and
then TMS automatically propagates the registry entry to all distributed servers. Each distributed server
updates its local registry, which causes TMS to automatically reload its registry settings. Each distributed
TMS then uses the new registry setting. If the registry setting is SwitchDebug, each distributed server
pushes SwitchDebug to its managed switches.

It's possible to prevent updating a DVS, if needed. For example, this would be necessary when
upgrading a system where a DVS has different settings from the HQ server. You can prevent the registry
setting from being pushed to DVS by putting its name into the TMS registry setting NoHQPushSettings.

Both Windows DVS and Linux DVS are supported. Voice Mail Switch and SA100/SA400 Server
Appliance do not get any registry pushes.

Changes on Servers (and Clients)

An administrator can add the string value HKLM Sof t war e\ Shor el i ne Tel ewor ks\ Tel ephony
Managenment Server\ Settings\ NoHQPushSetti ngs, butitis not installed. When the administrator
changes a pushable TMS registry setting, TMS creates a backup as follows:

* CDRDataExpirationBackup

¢ DRDataCacheSizeBackup

* LogAssertsAsNTEventsBackup
* SwitchDebugBackup

* LogEvent108Backup
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Connect Release Numbering Scheme

In the Connect release number schema, the first number is the major build, the second number is the
minor build, the third is the number of the build, and the fourth number is always 0.

The Mitel version numbering schema for various components is as follows:

Major = release; minor = update within release; build = build number of the minor/major combo; fourth
number =0

DVD or Package major.minor.build.0

Example: 14.3.1601.0
Server major.minor.build.0

Example: 14.3.1601.0
Remote Server major.minor.build.0

Example: 14.3.1602.0
Client major.minor.build.0

Example: 14.3.1603.0
Switch major.minor.build.0

Example: 14.3.1604.0

Patches are software fixes that update a specific version of software and cannot be applied to previous
major or minor versions.
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Voice Switches

This chapter describes maintenance considerations for Voice Switches.

Overview

VOICE SWITCHES

Voice Switches provide physical connectivity for the PSTN and analog phones, and logical connectivity
for IP endpoints on a reliable, highly scalable platform for the call control software. The call control

software runs on the operating system of the switch, for example Linux or VxWorks ®

Refer to the MiVoice Connect System Administration Guide for information about Virtual Switches.

The following table shows the available types of Voice Switches and the operating systems they use.

Table 5: Voice Switches Operating Systems

SG Voice
Switches

ST Voice
Switches

Voicemail Model
Voice Switches

Softswitches

Virtual Switches

Operating system
is VxWorks ©

Operating system
is Linux

Operating system
is Linux

Operating system
is Windows or
Linux

Operating system
is Linux

Switch-to-switch
communication via
CLI commands.

Switch-to-switch
communication via
CLI commands.

Switch-to-switch
communication via
CLI commands.

Switch-to-switch
communication via
CLI commands.

Switch-to-switch
communication via
CLI commands.

All physical Voice Switches have flash memory that allows permanent storage of the call control software
and configuration information. The Voice Switches have no moving parts (that is, no hard drive) other
than a highly reliable fan. The switches include the necessary DSP technology to enable toll-quality voice
with features such as echo cancellation, voice compression, and silence suppression.

TMS propagates configuration data from the database to each switch upon reboot of either TMS or the
switch. The data sent is a subset of configuration data specific to that switch. TMS also maintains this
data by propagating changes to the database to those switches affected by the change. The TMS/Switch
configuration interface uses the same Network Call Control protocol that is used for other TMS/Switch
communication. The NCC protocol is based on Sun RPC. You can obtain the configuration data that
TMS sends to any specific switch with a CLI command. For more information, see Commands Available
Through CLI on page 52.

Switches share their switch-specific configuration with other switches in the system using the UDP-based
Location Service Protocol (LSP). Switches keep current with other switches by propagating their changes
and receiving them from other switches. For information about viewing switch-to-switch communications,
see Commands Available Through CLI on page 52.

Note:

For physical Voice Switches, switch-specific configuration is in FLASH but configuration for other
switches is in RAM. After rebooting, the switch syncs with LSP to keep current with these configuration
changes.

The Voice Switches communicate call control information on a peer-to-peer basis. When Distributed
Routing Service (DRS) is enabled, switches exchange LSP messages only with other switches at the
same site. DRS communicates directly with the database to keep the database configuration current.
TMS tells each switch how to find DRS as part of the configuration process described earlier. When DRS
is enabled, switches generally give DRS an opportunity to resolve numbers, so that its more complete
view of the system can be leveraged to find the best contact. If the switch knows where an intra-site
extension is, it does not involve DRS.

For analog phones, the switch detects whether the phone is on or off hook, collects digits from the
phone, and (based on digits collected) determines when a call is established. If necessary, the switch
communicates with other switches (in some cases this may not be necessary, such as when the call is to
an endpoint directly on the switch) to establish a call between the appropriate endpoints.
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The switch acts as a media gateway for the PSTN and analog phones by encoding the analog voice
and transmitting it to the other endpoint over the IP network using RTP. The switch also uses NCC to
send events to TMS about digit collection, caller ID, call establishment, and so forth. TMS makes this
information available to the server applications. These applications are not necessary for many calls
(such as those between two phones or a trunk and a phone, which can be established with only the
switches controlling the phones and trunks), but they can enhance the user experience. For example,
Connect client can provide information about the call to the user's desktop.

After the call is established, TMS monitors the call and logs call information on the Call Detail Report
(CDR) database.

* Voice Switches Software Upgrades
* Voice Switch Boot Options

* Voice Switch Utilities

» Diagnostics

* Connecting to a Voice Switch

* Power over Ethernet Switches (PoE)

Voice Switches Software Upgrades

You can see the status of Voice Switches using the Diagnostics and Monitoring system which is available
through Connect Director. To view the status of the switch, you navigate to the Maintenance > Status
and Maintenance > Appliances page. You also can view the status of all switches by site in the
Maintenance > Status and Maintenance > Sites page.

When a switch update is required, the value in the Service column of the list pane on the Maintenance >
Status and Maintenance > Appliances page is one of the following:

¢ Firmware Update Available indicates that a patch is available and an upgrade is required to load the
patch. When a switch is in this state, it is fully functional and in communication with TMS and the other
switches in the system.

¢ Firmware Mismatch indicates that you must upgrade the switch before it can communicate with the
TMS server. A switch with mismatched firmware can communicate with other switches of the same
version and manage calls, but cannot support server and client applications.

You can use the Maintenance > Status and Maintenance > Appliances page to upgrade the switch
software, or you upgrade switch software manually with the burnflash utility.

Virtual Switches Software Upgrade Options

Complete the following steps to choose the system to use as a source for software upgrades for virtual
switches:

1. In Connect Director, click Administration > Appliances/Servers > Options > Appliance Options.
2. The default upgrade option is Connect Managing Server. Select one of the options to download the
software for future upgrades:

¢ Connect Managing Server: Using this server is ideal when the companies that prefer connect
software to be distributed from the HQ and managing Windows DVS. When this option is selected,
Virtual Voice Switches and Service Appliances (Collaboration) will download their software from
their respective managing HQs or Windows DVS servers. However, Linux DVS and appliances
managed by Linux DVS servers will download their software from the HQ servers.

The following table provides a list of components and the software;download location for Connect
Managing Server.

Table 6: Software Upgrade Option using Connect Managing Server

Component Software Download from Location
Headquarters Headquarters Server Installer (exe)
Windows DVS Remote Server Installer (exe)
Linux DVS (virtual) Headquarters only

40



VOICE SWITCHES

Component Software Download from Location

Voice Switch (physical) Managing Server (Headquarters, Windows DVS or Linux
DVS)

Voice Switch (virtual) Managing Server (Headquarters or Windows DVS)
Exception: if Managing Server is Linux DVS, then
Headquarters

Service Appliance - SA100 or SA400 [ Managing Server (Headquarters or Windows DVS)

(physical) Exception: if Managing Server is Linux DVS, then
Headquarters

Service Appliance (Virtual) Managing Server (Headquarters or Windows DVS)
Exception: if Managing Server is Linux DVS, then
Headquarters

IP Phone Managing Server (Headquarters, Windows DVS or Linux
DVS)

Connect Client Managing Server (Headquarters, Windows DVS or Linux
DVS)

3. Define admin and root passwords. Each must be between 4 and 26 characters.

Refer to the MiVoice Connect System Administration Guide for information about Virtual Switches.

Staged Upgrades for ST Family and Virtual Switches

In Connect, you can download the Connect software on Connect appliances before performing an

actual upgrade. This speeds up the upgrade process as you do not have to wait for the software to be
distributed to all the appliances across the network during the maintenance window. Models supporting a
staged upgrade include:

e ST24A/ST48A

e ST50A/ST100A

e ST100DA

e ST1D/ST2D

e ST200/ST500

* Voicemail Switches (SG50V and SG90V)
¢ Virtual Switches (IP Phone and Trunk)

These switches include dual partitions, which allows the switch to perform a background download to
store upgraded firmware on a secondary partition. The switch then installs the firmware on the main
partition when the download has completed and the switch is rebooted or an upgrade is initiated.

Note:
These switches also can be upgraded using the regular upgrade process as described in Upgrade Switch

Software Without Using Staged Upgrade on page 42.
Note:

You can schedule the download. Refer to the steps below.
Complete the following steps to perform a two-stage upgrade on a Voice Switch:

1. Install Staging_Firmware software on the HQ Server and Windows DVS. This step will create a
directory under \'i net pub\ f t proot\ Swi t ches\ <bui | d nunber >, and in the <bui | d nunber >,
directory there will be a switch folder (dvs, tsb,tsu,tsv).

Note:

The process of installing software from “Connect Managing Server” on the HQ Server and
Windows DVS will add files for the following devices:

e Linux DVS

¢ Connect Edge Gateway

¢ Virtual Switches

» Service Appliance (Collaboration)
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2. When the software is installed on the server, open Connect Director and click Maintenance >
Status and Maintenance > Sites.
To upgrade all Voice Switches on a particular site, select the appropriate site.
4. Select Download Software in Command, and then select Download to Appliance(s) in the
Command sub list.
Note:

d

The Download Software and Download to Appliance(s) command combination applies only to
ST Generation Switches, Voicemail Switches, Virtual Switches, and Linux DVS. Refer to Upgrade
Switch Software in One Step without Using Staged Upgrade;for information about upgrading SG
Generation Switches.

5. Click Apply.

6. In the dialog box that appears, specify the following information:

* Version — Select the firmware version you installed on the server in step 1.

» Sites— This read-only information lists the switches associated with the site.

e Stagger Rate— Select the number of devices you want to install on simultaneously.
¢ Schedule— Select immediate or specify a date and time you want to install on.

7. Click OK to accept the download or select Cancel to cancel it.
Note:

If necessary, you can cancel a pending firmware download before the download has started:

a.  Navigate to Maintenance > Status and Maintenance > Sites.
b.  Select the appropriate site.
c.  Select Download Software in Command, and then select Cancel Pending Download in the
Command sub list.
d.  Click Apply.
8. After the firmware download is complete, you can upgrade the software on your ST Voice Switches
as follows:

a. To upgrade all Voice Switches on a particular site, select the appropriate site.

b. Select Update Software in Command, and then select Update Appliance(s) or Update
Appliance When Idle in the Command sub list.

c. Click Apply.

d. Review the location and firmware version information that is displayed, and then click OK to
accept the update or select Cancel to cancel it.

You can view the progress of the download and update processes in the Maintenance > Status and
Maintenance > Sites page or the Maintenance > Status and Maintenance > Appliances page.

ST Voice Switches will either reboot immediately if you selected Update, or they will reboot when the
upgrade is completed during idle time if you selected Update When Idle.

Upgrade Switch Software Without Using Staged Upgrade

1. Launch Connect Director.
2. Complete one of the following steps:

¢ To select an individual Voice Switch for upgrade, navigate to the Maintenance > Status and
Maintenance > Appliances page and select the appropriate appliance(s).
* To select a site for which to upgrade all associated Voice Switches, navigate to the Maintenance >
Status and Maintenance > Sites page and select the appropriate site.
3. Select Reboot and Reset in Command, and then select Reboot Appliance(s) or Reboot
Appliance(s) When Idle in the Command sub list.
4. Click Apply.
5. In the Confirmation dialog box, click OK.

Manually Upgrading the Switch’s Software
You can use the burnflash utility to upgrade a switch manually.

From the server command line, enter the bur nf | ash command in this format:
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C:\ Program Fi | es\ Shor el i neConmruni cat i ons\ Shor ewar eSer ver >bur nfl ash -s <swi tch
| P Address>

Voice Switch Boot Options

When a Voice Switch boots, it requires an IP address to connect to the network and an application
program. Voice Switches are set to use a DHCP server for an IP address and to retrieve the application
from the switch’s flash memory.

Mitel;recommends using static IP parameters configured via the serial port, as this is much more reliable.
If DHCP is to be used, Mitel strongly recommends using DHCP reservations for each switch so that the
DHCP lease is not lost.

If a DHCP server is not available, you can set the IP address manually from the switch’s maintenance
port.

The standard method for booting a Voice Switch is to boot from the switch’s flash memory. When a Voice
Switch is first powered on, it reads the boot parameters stored on the boot ROM, which instructs the
switch to load software from flash memory. When the software starts, it loads its configuration, which is
also stored in flash memory.

SG Generation Switch Boot Options

Booting from FTP is available for instances when you cannot boot the switch from flash memory. When
you boot a switch from FTP, the operating system and software load from the FTP site identified in the
boot parameters. The loaded configuration is a configuration received from the TMS server.

If the switch fails to load the application from flash and does not have the IP address of the Mitel server,
you can set the IP address and boot parameters by connecting to the maintenance port and using the
configuration menu. The configuration menu allows you to set the IP address of the switch and enter the
Mitel server (boot host) IP address.

ST Generation Switch Boot Options

ST generation switches boot only from flash. You can download the firmware image to flash via FTP or
HTTP. The loaded configuration is a configuration received from the TMS server.

If the switch fails to load the application from flash and does not have the IP address of the Mitel server,
you can set the IP address and boot parameters by connecting to the maintenance port and using the
configuration menu. The configuration menu allows you to set the IP address of the switch and enter the
Mitel server (boot host) IP address.

IP Address from DHCP

The switch sends requests for an IP address to the DHCP server ten times at increasing intervals. When
the switch receives a response from the DHCP server, the boot process begins. If the switch fails to get
an IP address from the DHCP server, it uses the last assigned IP address. The switch continues sending
IP address requests to the DHCP server.

If the DHCP server sends a conflicting IP address while the switch is using an address from a previous
state, the entire system restarts. Use long lease times to prevent to prevent this. Mitel recommends either
static IP parameters or DHCP reservations.

If the switch does not receive an IP address from the DHCP server and an address is not available from
a previous state, the switch continues polling the DHCP server until it receives an address.

Setting SG Voice Switch IP Addresses with VxWorks®

If the switch or voicemail-enabled switch is not configured with an IP address and fails to boot from
flash, it cannot download the application and configuration from the FTP server;or the HTTP location in
the case of ST switches. In this case, you can manually set the IP address and boot parameters from

VxWorks® or Linux, which are accessible from the maintenance port. Boot parameter changes do not
take effect until the switch is rebooted.

Note:
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This command line interface is not available through Telnet.
Connecting to the Maintenance Port of a Voice Switch

1. Connect a straight serial cable between a personal computer and the Voice Switch.

2. Use a terminal emulation program such as Tera Term Pro or PuTTY freeware to open a connection to
the switch.

3. Apply these values to the terminal settings:

e Speed: 19.2 Kbs

* Data bit: 8 bits

e Stop bit: 1

* Parity: No parity

¢ Flow Control: None

The CLI Main Menu

The CLI main menu automatically appears at system startup. You can also invoke the menu at any time
by entering a question mark ?.

The following table describes the commands available in the CLI main menu.

Table 7: Commands in CLI Main Menu

Command Description Notes
0 Exit Exit from CLI of voicemail-
enabled switch and go to the
Linux shell.
1 Show version Lists version numbers for

firmware and boot ROM in
addition to the base version and
the CPU board version.

2 Show system configuration Displays the switch’s boot and IP

configuration.
Note:
The Image Server address

field in the Show system
configuration screen should
be blank or should show the

IP address of the HQ server
or the managing server. If you
must modify this setting, choose
item (3) at the main STCLI
menu to change the system
configuration, and then choose
option F to set or change the
optional image server address.
3 Change system configuration Takes you to the system

configuration menu where you
can set a switch’s boot and IP

configuration.
4 Reboot Reboots the switch
Shutdown Shutdown the voicemail-enabled

switch and be ready to power-off.

6 Archive Logs Archive log files in / cf/

shor el i nedat a/ Logs
directory and core files in /cf/core
directory and save the archive
filein /i net pub/ftproot
directory in the server.
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Command

Description

Notes

Help

Enter a ? to print this menu.

To select an option in Voice Switch CLI, enter the number associated with the menu item and press

ENTER.

Boot and IP Configuration Options

When you choose Change System Configuration from the CLI main menu, a menu of boot and IP
configuration options appears.

The following table describes the boot and IP configuration options.

Table 8: Boot and IP Configuration Options

Command ST Voice Switches Voicemail-Enabled SG Voice Switches
and Virtual Switches Switch Description
Description
0 Return to previous Return to previous Return to previous
menu menu menu
1 Change Voice Switch Change IP address Change IP address
Service IP address
Change IP subnet mask | Change IP subnet mask
Change the gateway IP | Change the gateway IP
address address
4 Change server IP Change server IP Change server IP
) ) address.
address: address:
Note: Note:
This is the IP address This is the IP address
the Mitel server with the Mitel server with
the FTP service for the | the FTP service for the
switch. switch.
Change boot method
Change boot method Enable/disable DHCP
Enable/disable DHCP Enable/disable DHCP Change network speed
and duplex mode
8 Change network speed | Change network speed
and duplex mode and duplex mode
D Set/change domain Set/change domain
name name
F Set/change optional
image server address
P Set/change primary Set/change primary Set/change primary
DNS IP address DNS IP address DNS IP address
S Set/change secondary | Set/change secondary
DNS IP address DNS IP address
T Set/change network
time server IP address
* Display current Display current
configuration. configuration.
? Help Help Help

After you have set your IP address and boot options, enter ? to return to the main menu. You must reboot
the switch for the new setting to take effect.
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Accessing Voice Switch CLI on the Headquarters SoftSwitch

To run Voice Switch CLI diagnostics on the SoftSwitch, you must create a Telnet session. Voice Switch
CLI commands are listed in VxWorks® Command Line Interface on page 52.

Note:
All the information that is displayed in the session will also appear in the Sof t Swi t ch log file.
1. Create the following DWORD entry in
HKEY LOCAL MACHI NE\ Sof t war e\ Shor el i ne Tel ewor ks\ Soft Swi t ch
or, if you are using a 64-bit server, create the DWORD entry in

HKEY LOCAL_MACHI NE\ Sof t war e\ Wbw6432Node\ Shor el i ne Tel ewor ks\ Soft Swi t ch:
Tel net Enabl ed

2. Set the value to 1.

3. Open a Command Prompt (DOS) window and type telnet localhost 2323. To Telnet to the
SoftSwitch, the Telnet port must be set to 2323. The standard Telnet port is 23.

4. Press Enter. No User ID or Password is required. This immediately logs you into the SoftSwitch.

5. Press Enter a second time to get the SoftSwitch prompt, which looks like the following:

27?7
SHELL: ??7??

SHELL:

Enter CLI commands as described in VxWorks® Command Line Interface on page 52.

End the SoftSwitch Telnet session by typing x.

Press Enter.

Remove the Telnet Enabled DWORD from the registry editor by right-clicking on it and select Delete.

N

To start a Telnet session to the SoftSwitch from a different computer, you must specify the IP address of
the Mitel server and modify the Telnet port to 2323.

All switch commands are available in the SoftSwitch with the exception of the following:
* Any VxWorks-specific commands

* msps

Router Auto-Delete Properties for ICMP Redirects

When WAN links fail, ICMP redirect messages are received by the Voice Switches from routers on the
network. These ICMP redirect messages notify hosts on the network, such as Voice Switches, that an
alternate route is available, and the switch updates its routing table accordingly.

The default behavior for Voice Switches is to automatically delete any ICMP redirect messages three
minutes after time of receipt.

You can shorten or lengthen this period of time in one-minute increments, or you can disable the
automatic deletion of ICMP redirect messages altogether.
Modifying Time Period to Auto-Delete ICMP Redirect Messages
1. Create the following DWORD entry in
HKEY_LOCAL_MACHI NE\ SOFTWARE\ Shor el i neTel ewor ks\
TelephonyManagementServer\Settings:

Swi t chDebug - “debug_options timeout _icnp_redirect n.”

2. Set the value of n to the desired time period. Note that this must be an integral value and the number
represents minutes, not seconds. The value of n can be set to zero (0)to disable the auto deletion of
ICMP redirect messages.

When this key is defined in the main server, the switches automatically delete all of their routing table
entries after the specified period of time. Note that sampling occurs once per minute, so routes do not
disappear exactly 360 seconds later if n is set to 6.

3. Reboot the Voice Switch for these changes to take effect.
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VOICE SWITCHES

You have the option of setting IP address and boot parameters using the VxWorks ® boot Change
command. To access the boot Change command, you must establish a telnet session to the switch. For

information on other commands available from VxWorks ®, see VxWorks® Command Line Interface on

page 52.

1. Start the Telnet process with an i pbxct | command entered in this format:

C:\ Program Fi | es\ Shor el i neConmuni cat i ons\ Shor eWar eSer ver >i pbxct| -

t el net on

Switch | P Address>
2. After the Telnet process is running, open a Telnet session with the switch. You are prompted for a
User ID and Password.

o

For User ID, enter anonymous.
For Password, enter ShoreTel (case sensitive). The CLI opens and displays the menu of choices.

5. At the > prompt, enter bootChange.

The boot device parameter appears.
6. Modify parameters by typing values and pressing ENTER (do not backspace).

When you press ENTER, the next boot parameter appears.

Parameter Settings for Flash Boot and FTP Boot lists and describes the parameters required for flash
and FTP booting of Voice Switches.
7. Close the Telnet connection with the following i pbxct| command:

C:\ Progranti | es\ Shor el i neComuni cat i ons\ Shor eWar eSer ver >i pbxct| -tel netof f
Switch I P Address>
Table 9: Parameter Settings for Flash Boot and FTP Boot
Flash Boot FTP Boot
Parameter Description | 5324, 5G90/50/ SG24 SG30/50/90/220T]
220T1/220E1 1220TIA/220E1
boot device A network interface |flash =0 fei emac0
or a flash location

processor number | Always 0 0 0 0
host name Always bootHost bootHost bootHost bootHost

file name: SG

Path to
VxWorks.sys file for
SG switches

/flashQ/ vxworks

/tsal vxworks

/tsk/ vxworks

inet — ethernet

IP address>:Subnet
Mask (hex)>?

10.10.0.59:fff0000

10.10.0.59:ffff0Q

01D.10.0.102:ffff0000

inet — backplane Not used

host inet IP address of the 10.10.0.5 10.10.0.5 10.10.0.5
main Mitel server @

gateway inet IP address of router [ 10.10.0.254 10.10.0.254 10.10.0.254
a

user FTP site — User anonymous anonymous anonymous
name login (typically
set to anonymous)

ftp password (pw) FTP site — st1 st1 tsk

(blank — use rsh) Password (typically
set to st1)

flags See Boot Flags 0x40 0x40 0x40
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Flash Boot FTP Boot
Parameter Description | 5624, SG90/50/ SG24 SG30/50/90/220T!
220T1/220E1 1220TIA/220E1

target name Host name of switch | ShorelineSwitch ShorelineSwitch Shoretelbuild

that can be set to

other values
startup script Path to bootscrp.txt |/flashO/bootflsh.txt | /tsa/ /tsk/bootscrp.txt

file for SG24, SG8 bootscrp.txt
other Set to network fei fei emac

interface

Note:

#These IP addresses are examples. Use the IP address for your system.

Boot Flags

The boot flags allow you to alter how the switch boots up. The hexadecimal values of the flags and their
actions are listed in Table 10: Boot Flags on page 48. You can aggregate flags to perform multiple
functions by summing the hex values for the commands.

For example, the following command aggregates the flags 0x40 + 0x2000 + 0x40000 and instructs the
switch to use DHCP to get boot parameters, disable the shell, and set network speed and duplex mode
to 100 Mb HD:

0x42040

Table 10: Boot Flags

Command Description

0x0 Network speed and duplex mode auto-negotiate.

0x20 Disable login security.

0x40 Use DHCP to get boot parameters.

0x2000 Disable shell.

0x10000 Network speed and duplex mode 10 Mb full duplex
(fixed).

0x20000 Network speed and duplex mode 10 Mb half
duplex (fixed).

0x30000 Network speed and duplex mode 100 Mb full
duplex (fixed).

0x40000 Network speed and duplex mode 100 Mb half
duplex (fixed).

Setting IP and Boot Parameters from VxWorks® Boot Monitor

If you are unable to access the Voice Switch CLI, you can access the same configuration options
available with the bootChange command from the switch’s boot monitor.

Note:
Making incorrect settings in the boot monitor can cause the switch to malfunction.

1. Connect a serial cable between a personal computer and the Voice Switch.
2. Use a terminal emulation program such as HyperTerminal to open a connection to the switch.
3. Apply these values to the terminal settings:

e Speed: 19.2 kbps
» Data bit: 8 bits
e Stop bit: 1

48



VOICE SWITCHES

» Parity: No parity
e Flow Control: None

4. Type cat the prompt for SG24 switches, and press ENTER. You are guided through the options listed
in #unique_84/unique_84 Connect 42 id19BJG80F072 on page 47
Note: For SG50/90/220T1/220T1A/220E1 and voicemail-enabled switches, change options using the
set env command, and save using the saveenv command. For example:

¢ To change IP address:

setenv i paddr 10.10.0.59

* To change subnet mask:

set env net mask 255.255.0.0

* To save all changes:
saveenv

Voice Switch Configuration Reset

Each switch includes a hidden reset button on the front panel that restores the switch to factory default
boot settings and requests a new configuration from TMS. To enable the reset, press the button for

5;seconds. This button reboots the Voice Switch.

This completely clears all boot parameters and clears the switch’s configuration.

Voice Switch Utilities

Two utilities are available to help you diagnose and update Voice Switches.

¢ The ipbxctl utility allows you to perform diagnostics and Telnet to the switch.
* The burnflash utility updates the switch to the version of firmware compatible with the server software.

Both utilities are available in the Server folder:

C:\ Progr anti | es\ Shor el i neConmuni cat i ons\ Shor ewar eSer ver
* The UBOOT utility allows you to boot the switch in the field.
e The SSH utility allows you to access the switch and then run CLI commands.

Ipbxctl Utility

The following table lists and describes the commands available using the i pbxct | utility.

Table 11: i pbxct | Utility Commands

Command

Description

-telneton Switch | P Address>

Enables Telnet connection on the switch.

-reboot Switch | P Address>

Reboots the switch without using Connect Director.

-flash Switch I P Address>

Sets switch to boot from flash memory (allows you
to boot without logging in).

-ftp Switch | P Address>

Sets switch to boot from FTP (allows you to do this
without logging in).

-diag Switch I P Address >

Sends switch state information. By default, the
system puts this information in the same folder
where the ipbxctl utility is running.

Note:
This command may be disruptive to normal

switch function. Use this command only for
diagnostic functions, not for reporting.
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Command Description
-reset Clears all flash memory. Returns switch to factory
defaults.
Note:
This command is not available from the CLI.
-telnetoff Switch | P Address > Disables Telnet connection on the switch.

-traceroute target |P Address > Network troubleshooting tool.

For additional information about the parameters
that can be used with this command, see Table 14:
Traceroute Parameters on page 61.

Password Access

After entering the i pbxct| command, the user is prompted to enter a password. After the user enters
the correct password, the device permits access to executables that configure or diagnose the switch.

Performing a telnet session on a Voice Switch requires password access to ipbxctl before invoking the
t el net on command. After entering the correct password, a user can establish a telnet session during
the next minute. At the expiration of this period, existing telnet sessions are not affected, but users
cannot establish a new telnet session. Telnet access is permitted only from the IP address from where
the CLI was entered and access granted through password authorization.

Telnet continues to require User ID and Password entry that is distinct from i pbxct | password access.
However, unlike the cl i command and password, Telnet transmits the User ID and Password in the
clear. The Voice Switch continues using the user ID of anonymous and a password of ShoreTel for
initiating Telnet.

CLI passwords are configurable only through Director. The default password is ShoreTel.

Pressing the reset button on the switch resets the password to the default value of Mitel. The password
that was active on the switch prior to the hardware reset is restored when the switch is connected to the
network and receives an update from Mitel.

To set the Voice Switch passwords, select Administration > System Parameters > Other System
Parameters in Connect Director.

Burnflash Utility

Table 12: Burnflash Commands on page 50 lists and describes the commands available using the
bur nf | ash utility.

Table 12: Burnflash Commands

Command Description

burnflash - s Updates all bootrom areas.

Switch | P address>

burnflash - test - s Switch IP Checks to see if bur nf | ash command can be
addr ess> used.
UBOOT Utility

UBOOT is the boot loader for ST family switches and voicemail-enabled switches. The UBOOT
environment is accessed from a terminal emulator through the serial port when the switch is booted.
Before starting the boot, UBOOQOT lists the processor characteristics and displays results of the Power On
Self Test (POST). The switch then waits a specified period before starting the autoboot.
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SSH Access for Utilities

You can access ST family voice switches via SSH, and then run CLI commands on the switch.

Complete the following steps to access ST switches through SSH:

1.

Install PUTTYGEN on the HQ server.

2. Open PUTTYGEN and click Load an existing private key file.
3. Navigate to Shor el i ne Dat a\ keyst or e\ ssh\, and then complete the following steps:
a. Select All Files to view the key record.
b. Select the hq_rsa key.
c. Click Enter.
d. Click OK to dismiss the PUTTYGEN notice.
Note:
If you are not performing these steps on the HQ server, you must copy the hq_rsa file from the
HQ server to the system you are logging in from.
4. When the key is loaded, click Save private key. In the popup, click Yes to save without a password.
5. Name the key and save it. For example, you could use ST1 as the name of the key.
6. Use Putty in SSH mode and enter the IP address of the switch.
7. In the left column, expand the SSH item, and select the AUTH item. Click the Browse button in
Private key file for authentication.
8. In the list of private keys, right-click the key you created in step 5, and click Open. If a Putty security
alert dialog box appears, click Yes to confirm.
9. Enter admin in username.
Diagnostics

This section describes the tools available for diagnosing problems with switches.

Power LED

Voice Switches have one power LED with standard on and off displays. When flashing, the LED indicates

other information about the switch:

2 flashes

- The switch failed its internal self-test.

- The switch has a hardware failure; replace the unit and submit a Return Material Authorization
(RMA) to Mitel.

3 flashes

- Booting via FTP.

- Flash memory might be corrupted. Go to the Maintenance >;Status and Maintenance > Appliances
page in the Connect Director to ensure that the system is running properly.

4 flashes

- The IP address is unavailable.

- DHCP did not respond to the IP address request, and the IP address is not available in nonvolatile
memory to continue the boot process. The switch will automatically reboot in five seconds and try
again. Check the DHCP server and the network configuration to ensure that the Voice Switch is
receiving a valid IP address.

5 flashes

- The operating system is not available.

- The switch is booting from FTP but cannot find the boot files. It automatically reboots in five
seconds.

6 flashes

- The switch is using a previously stored IP address.

- A DHCP transaction was attempted, but the DHCP server did not respond. The switch continues
to use the IP address stored in nonvolatile memory until it receives a valid response. If the switch
receives a response that provides a different IP address, it reboots using the new IP address. If the
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switch receives a response that matches the IP address stored in nonvolatile memory, it continues
operation, and the power LED stops flashing. If the problem persists, check the DHCP server and

network configuration.

VxWorks® Command Line Interface

VxWorks ®provides a variety of useful tools and debuggers. This command line interface offers access to

both standard VxWorks ®commands and Mitel commands. You can access the VxWorks © interface by
opening a Telnet session to a switch without invoking CLI.

You may also enter the VxWorks ® command line interface from a serial interface by entering the
command gotoshell from the Shoreline> prompt. To return to CLI, enter the command cliStart.

Use caution when using the VxWorks ®interface; running commands can degrade performance on the

switch. Mitel does not support changing or setting IP or other parameters using the VxWorks Cinterface.
Changes made using this interface may not be persistent and using it may cause unpredictable behavior

in the system.
Note:

Mitel does not support changing or setting IP or other parameters using the VxWorks ®interface.
Changes made using this interface may not be persistent, and using it may cause unpredictable behavior

in the system.

Commands Available Through CLI

The following table describes the commands available through the CLI interface.

Table 13: CLI Commands

signal flow into IPBX log.

Command Description Available on Notes
Voicemail-
Enabled Switches
adm debug_I evel Logs admission control — 2 logs more
and bandwidth manager diagnostics.
signal flow onto serial
port.
adm di ag_I evel Logs admission control — 2 logs more
and bandwidth manager diagnostics.

interpreter (from a Telnet
session) from serial ports
only.

ar pShow and ar pt abShow Displays the ARP table. | X

aut oReboot - 0 Turns the switch Use only as directed
watchdog off to prevent by Mitel Technical
rebooting after a Support.
catastrophic failure.

bi gNvRantet up Erases switch's
configuration in NvRam.

boot Change Changes the boot ROM Use with caution.
parameters.

ci d_debug_I evel Logs caller ID related
information for
extensions.

cliStart Opens the command line | X Switch reboot

required for returning

switch to VxWorks®
interface.

config_status

Outputs the configuration
records for the switch.
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Command Description Available on Notes
Voicemail-
Enabled Switches
DEBUG LEVEL Sets the ShoreSIP Recommend using

debugging flags.

level 0xe00.

di agdCommands

Outputs full switch
diagnostic information.

di al _num dunp

Displays information
about switch's off-system
extension configuration.

dn_pl an_st at us

Displays information
about the switch's dial
plan.

dnp_debug_I evel

Displays detail
information (digit by digit)
about dial plan access.

Recommend using
level 1.

dt nf _debug

Displays RFC2833 for
G729 related events.
Settings are variable,

so contact TAC at (800)
742-2348 for assistance.

DunpSB

Displays maximum
PMCSW outputs.

dumpUsedBw

Displays information
about actual bandwidth
used on individual calls/
legs.

et her MonBr oadcast

Set command value to
1to include broadcast
network packets in
packet capturing.

Default value 0 does
not capture/broadcast
network packets.

et her MonDunp

Writes the ethernet

trace information
captured when using
EtherMonStart. Writes

to a .cap file in \inetpub
\ftproot directory of the
Mitel server controlling
the switch. The .cap file
name is ST-Ist 3 bytes of
MAC-time-date>.cap.

et herMonStart bytes>

Bytes is the number

of bytes of information
you want to capture (for
example, 10000000).
Recommended values
are between 1000000
and 3000000. Captures
ethernet packets for
trace purposes.

Requires excessive
switch memory.
Use nentShow to
determine memory
available for
command.

et her MonSt op

Stops capturing ethernet
packets.

eval _adm var

Displays information
about switch's own
bandwidth usage.

eval _bwm var

Displays information
about total and available
bandwidth.
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Command

Description

Available on
Voicemail-

Enabled Switches

Notes

ext _bca_status

Displays active BCA
calls along with call stack
usage information.

Run on switches
hosting BCA
extensions.

ext _cco_status

Displays information
the switch's extension
CCOs.

ext _conf_status

Displays MakeMe
conference port status.

ext _debug_level 1

Logs extension CCO
configuration.

ext _debug_I evel

Sets the extension
debugging level.

Recommend using
level 4.

ext _pg_status

Displays active pickup
group calls.

To be run on the
switches hosting PG
extensions.

ext _ecr_status

Displays all configured
Personalized Call
Handling rules on switch.

ext _ecr _debug

Displays real-time
behavior of Personalized
Call Handling rule.

Shows triggering of
rule during inbound
call.

f ax_debug_| evel

Displays fax-related
events and processing
such as tone detection,
fax determination,

and fax redirect. Valid
settings are 0 and 1.
Default value is 0.

fax_verbose

Displays fax/silence
detection, jitter buffer
freezing. and echo
canceller disabling
related events. Valid
settings are 0 and 1.
Default value is 0.

flsh_get Version

Displays switches
firmware and bootrom
versions.

flsh_printBootLine

Prints the boot
parameters of the switch.

f1 sh_set Boot Sour ceFl ash

Sets the switch to boot
from flash memory.

Requires a restart
for changes to take
effect.

fl sh_set Boot Sour ceFTP

Sets the switch to boot
from FTP.

Requires a restart
for changes to take
effect.

g729_verbose

Displays more
information for G729
calls.

Enable this for
G729 calls with
mscmd_verbose

host Show Displays the known X
hosts.
hunt | oad_debug Logs basic huntgroup Use when debugging
call flow. heavy call load issues
i cnpst at Show Displays ICMP statistics. | X
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Command

Description

Available on
Voicemail-

Enabled Switches

Notes

i pdt _debug filter

To print out IPDT log for
one extension (Ext A).

> ipdt_debug_level — -1

> ipdt_debug_filter— 1
(tell IPDT that filter is
enabled)

> ipdt_restrictTraceExts
"Ext A's #" (turn on Ext A

log)
>

ipdt_remRestrictTraceExt
"Ext A's #"(turn off Ext

log)
To print log for

all extensions:>
ipdt_debug_filter — 0

i pdt _debug_|I evel

Recommend setting to
-1to turn on all logging.

i pdt _dunpCCOCK

Dumps BB call key
state, since there is no
extension associated
with BB.

i pdt _dunpExtCal I s

Dumps call information
in the extension (for
example, calllD, legID,
call state and leg state,
and so on.)

i pdt _dunpExt Di spl ay

Dumps the current
display view from IPDT.

i pdt _dunpExt ensi ons

Dumps information for
all extensions controlled
by the switch and the
information for monitored
extensions and MAE
(BCA) extensions that
are in the same switch
and in the different
switches.

i pdt _dunpExt CK

Dumps information
for call keys on the
extension.

Useful for
troubleshooting LED
patterns and icon

issues.

i pdt _reset Ext Di spl ay

Redisplay on the
extension. If the phone
display and IPDT display
(ipdt_dumpExtDisplay)
are desynchronized, run
ipdt_reset_ExtDisplay to
synchronize them.

i pdt _restrictTraceExts

Set ipdt_debug_filter
to 1. Then, use
ipdt_restrictTraceExts
to turn on logging on a
particular extension.
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Command

Description

Available on
Voicemail-

Enabled Switches

Notes

i f Show

Displays the current
configured network
parameters.

X

| aa_debug_I evel

Logs backup auto
attendant signal flow.

| spConlLi st

Displays switch
connectivity to other
switches.

| sp_debug | evel

Displays Location
Service Protocol
messages that are
exchanged between
switches.

Recommend using

level 4.

| sp_ping

Tests the LSP UDP
communication to the far
end switch. Parameters
include IP address and
test iterations.

example:

->|sp_ping
"192.168.1.1", 100

Sends 100 packets
to the switch

at 192.168.1.1
(nominally 1 second).
If command lists only
the IP address, 1000
packets (10 seconds)
are sent.

| spTel Li st

Displays local and
remote contacts.

| spTel List 1

Displays detailed
information about local
contacts.

| spTel List 2

Displays detailed
information about remote
contacts.

mae_debug_| evel

Logs BCA call flow
information.

mai | box_debug_| evel

Logs mail box destination
for a particular call.

menShow

Shows current memory
usage of the switch.

ngcp_nsg_debug

Logs MGCP messages.

ngcp_t rans_debug

Logs MGCP
transactions.

nohc_debug_| evel

Prints diagnostic
information for music on
hold calls when set to 1.

Can be set to either 0
or 1. Default is 0.

npm debug_nmask — 0x40

Sets mpm debug flag
to output Caller ID
information received on
inbound calls.

npm debug_mask — 0x10

Displays detailed DTMF
information.
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Command

Description

Available on
Voicemail-

Enabled Switches

Notes

npm debug mask - -1

Displays detailed mpm
information. Full debug of
inbound calls (CallerID,
DTMF).

nscnd_ver bose

Prints diagnostic
information for the media
commands sent from
Switch board layer when
setto 1.

Main media command
verbose variable.

Default is 0.
nsps Displays media stream Use for all media-
statistics for all active related issues.
calls on the switch.
neps 7 Displays media stream
statistics for active calls.
nsps 8 Displays media stream Use only as directed
statistics. by Mitel Support.
msps 16 Displays media stream Use only as directed

statistics.

by Mitel Technical
Support.

mv _debug_| evel

Logs message waiting
indicator setting call flow.

ping "I P Address>"

Include double quotes (“)
around the IP address.

For voicemail-enabled
switch: valid on ssh
CLlI, not CLI

pri_log = 4

Begins output of D-
Channel information.

pri_trace = 4

Sets the PRI D-Channel
trace debug level.

pri _verbose

Traces a high level
description of the PRI
traffic sent and received
by trunks on the switch.

Recommend setting
pri_verbose=1

print_ether_stats

Prints Ethernet statistics
from the network
controller.

rdn_di ag_| evel

Used to determine

why calls are routing to
particular destinations,
similar to what gets put in
the DRSMain log when
DRS is enabled.

Useful values are
0 (none) or 5 (trace
resolve_dn).

r eboot

Reboots the switch.

Record2Fi | e2(port,tine,fi

I8 b3lUnd media
on the specified port for
the specified time (in
seconds) and writers it to
/i net pub/ftproot.

Writes to the TMS
server controlling

the switch. FTP write
access must be
enabled on the server.

rfc2833_for_g711 debug

Displays events related
to RFC2833 for G711.

Defaultis 0. Itis a
bitmasked integer.
Can be used as 1 and
2.
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Command

Description

Available on
Voicemail-

Enabled Switches

Notes

r out eShow

Displays current routing
table.

X

r out est at Show

Displays routing
statistics.

X

sb_debug | evel

Switch board debug
variable that prints
debug information for
the commands sent from
Call control.

Useful values range
from 1-5.

set _nmpm debug (char *)

Used to print information
regarding commands/
event interface between
host CPU and DSPs.

Uses string as the
parameter. Valid
parameters include
“pots”, “pstn”, “dtmfd”,
“dtmfg”, “cdis”, “class”,

cpm

Example:

To print POTS related
information, enter

set_mpm_debug(“pots’)

si p_debug_l evel -1

Logs ShoreSIP to SIP
translation.

si p_debug_| evel -4

Logs SIP messages also.

si puaCal | Li st

Displays active SIP stack
calls. sipuaCallList 2
dumps more call related
information.

Run on switches
hosting SIP trunks/
extensions.

si puali st

Displays list of SIP trunk/
extension user agents.

Run on switches
hosting SIP trunks/
extensions.

t 2t _debug | evel

Logs trunk interval
information such as
silence, trunk name,
trunk state, and so on.

t cpst at Show

Displays TCP statistics.

trans_debug

Logs ShoreSIP
transactions.

traceroute

"I P Addr ess>"

For troubleshooting
network by mapping
route packets use to
traverse an IP network.

Remember to include
double quotes (%)
around the target IP
address.

(For details, see
Running the
Traceroute Command
from the Voice Switch
CLL)

trunk_cco_status

Displays information
about switch's trunk
CCOs.

trunk_debug_I evel

Sets the trunk debugging
flag

Recommend using
level 4.
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Command Description Notes

Available on
Voicemail-

Enabled Switches

uaCal | Li st Displays information
about active calls and
legs.

ua_cal |l _status Shows a snapshot of the
active call status of the
switch.

uali st Displays list of ShoreSIP
extension/trunk user
agents.

unset _nmpm debug( char *) Disables
set_mpm_debugcommang

udpst at Show Displays UDP statistics. | XS

Creating an Ethernet Trace File Using a Voice Switch

You can capture the output of VxWorks ®;commands from the Voice Switches in an Ethernet Trace file
that is stored on the server that is managing that switch.

To create an Ethernet Trace file:
1. Open a Telnet session and type memShow.

Run this command to verify that the switch has at least 1 MB of memory to perform the procedure.
2. From the Start menu, navigate to the Control Panel > Administrative Tools and locate the 1I1S
Manager.
3. Right-click on the IIS Manager and select Properties. Then, enable the ability to write to the FTP
server by selecting the Write check box and clicking OK. This enables the ability to write to the
following directory:

C:\ I net pub\ ft proot

In Windows Server 2008, you must edit the permissions of the C:\Inetpub\ftproot directory and give
the users group write access.

* At the command prompt, run the following VxWorks ® commands:
(See Table 13: CLI Commands on page 52 for more information about the specific commands.)
et herMonStart 1000000
Note:
Do not exceed 6 zeroes.
et her MonSt at us
et her MonBr oadcast
et her MonBr oadcast =1 (enabl es capturing broadcast packets)
et her MonBr oadcast =0 (enabl es capturing broadcast packets - default)
et her MonDunp
et her MonSt op
The data generated by running these commands is stored in the _.cap;file in the following directory:

C:\ I net pub\ ft proot
5. When you are finished capturing data, the file can be processed using an Ethernet packet analyzer,
such as Ethereal or Wireshark.
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Recording Audio from a Physical Voice Switch Port

You can capture audio output from a Voice Switch physical port (for example, trunk port) using VxWorks

®;commands. Audio output is saved on the HQ or DVM server that controls the switch.

To capture audio output:

1. From the Start menu, navigate to the Control Panel > Administrative Tools and locate the IS
Manager.

2. Right-click on the 1IS Manager and select Properties. Then, enable the ability to write to the FTP
server by selecting the Write checkbox and clicking OK.

This enables the ability to write to the following directory:
C:\ I net pub\ ft proot

In Windows Server 2008, you must edit the permissions of the C:\Inetpub\ftproot directory and give
the users group write access.

* At the command prompt, run the following VxWorks ® commands.

(See Table 13: CLI Commands on page 52 for more information about specific VxWorks ®
commands.)

Record2File2 (1, 60, “test”)

Audio data from running this command is stored inthe t est _r x. pcmandt est _t x. pcmfiles in C.
\'I net pub\ f t proot .

When you are finished capturing data, a PCM Raw Data file is created with the following format profile:
8000 Hz, 16-bit, Mono.

Using the Traceroute Command from a Voice Switch

The t r acer out e command offers a useful troubleshooting tool that determines the route taken by
packets as they traverse an IP network from a Voice Switch to a specified destination. The command
sends IP packets across the network, and the successive batches of packets have increased TTL (time-
to-live) values.

TTL is a packet variable that defines the number of hops (stations) that a packet can pass through before
it expires. When a station receives an expired packet, it discards the packet and sends a time exceeded
message to the originating station. The t r acer out e command uses these expiration messages to build
the path map.

By determining the path to a known destination, network technicians can identify firewalls blocking
access to a site and gather information about the structure of a network and the IP address ranges
associated with a host.

The t r acer out e command can be executed from the switch’s command line or from the i pbxct | . exe
utility.

Running the Traceroute Command from the Voice Switch CLI
1. Open a Telnet session and enter:
traceroute “I P address>"

IP address is the address of the target destination and is a mandatory parameter. It must be in
double-quotation marks.
2. Press Enter.

Traceroute displays information about the number of hops, host IP addresses, and the amount of
time required for each hop.

Traceroute Parameters lists and describes the parameters that can be used with the t racer out e
command when executing the command from the Voice Switch command line.
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Table 14: Traceroute Parameters

Parameter

Description

target IP address

This parameter specifies the target IP address of the
traceroute. This parameter is mandatory. IP addresses
must be used and surrounded by quotes. DNS names are
not supported.

Probe on call control (ShoreSIP) port, using a ShoreSIP
Request message, to determine if the packets flow from
the switch through the network. This parameter uses
fixed ports and version compatibility among all switches
receiving packets.

This parameter specifies the use of a fixed destination
port and an incrementing source port.

By default, traceroute increments the destination port with
each probe. This port number is then used as a sequence
number for matching packet responses to the probes.
Incrementing the destination port number may complicate
troubleshooting when packets are being filtered or lost at
certain ports.

This parameter specifies the ICMP protocol. (UDP is the
default protocol used for traceroute.)

This parameter specifies that probes are sent with a SIP
message on the SIP destination port.

Set this parameter to determine if SIP is flowing from the
switch through the network. This parameter uses fixed
ports.

-m max_ttl>

max_ttl specifies the maximum time to live (TTL) value for
traceroute packets.

The default maximum TTL value is 30 bytes. Valid max_ttl
values range from 1 to 255.

-f first_ttl>

first_ttl specifies the TTL value of initial traceroute
packets.

The default initial TTL value is 1. Valid settings of first_ttl
range from 1 to 255 and must be less than max_ttl.

-I length>

length specifies the size of traceroute packet.

The default packet size is 40 bytes, but valid user-entered
length settings range from 100 to 1992.

-p port>

port specifies the port for the destination probe. Valid port
settings range from 1 to 65535.

-g nqueries>

nqueries specifies the number of queries execute with
each TTL value.

The default value is 3. All integers greater than 0 are
acceptable nqueries values.

-t tos>

tos specifies Type of Server (tos) bit settings in the IP
header of traceroute packets.

The default value is 0. Valid settings range from 0 to 255.
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Parameter Description
-w waittime> waittime specifies the period (seconds) a switch waits for
a reply to a traceroute packet.
The default value is 5 (seconds). Valid waittime settings
range from 2 to 86400.
-z pause>

pause specifies the period (milliseconds) between
successive probes sent by the command.

The default value is 0 (milliseconds). Valid pause settings
range from 0 to 3600000.

Entering t r acer out e without listing any parameters returns the list of available parameters.

USB Logging on ST Voice Switches

The ST family of Voice Switches supports USB logging, which you can use when troubleshooting issues
that require extra tracing on different features on the switch. Using the USB logging feature allows you
to perform extended logging while storing the log files in off-switch memory. This ensures you do not
encounter storage issues on the Voice Switch if the logging period is extensive and the log file is large.
Using USB logging also prevents the log file from being deleted by log maintenance applications before
the logging is complete or the data has been retrieved.

Note:

Because the USB logging procedure requires you to reboot the Voice Switch, Mitel recommends you
perform USB logging during off-peak hours.

Complete the following steps to use USB logging:

Plug a USB device into the USB port on the ST Voice Switch.

Open Connect Director and navigate to Maintenance > Status and Maintenance > Appliances.
Select the ST Voice Switch you want to start USB Logging for.

Select Start USB Logging in Command, and click Apply.

Select Reboot in Command, and click Apply.

Select Stop USB Logging in Command, and click Apply when you are finished gathering logs.
Select Reboot in Command, and click Apply.

Noakobh=2

Connecting to a Voice Switch

Voice Switch Half-Width and Full-Width Voice Switches provide a serial communications port accessible
through a straight-through 9-pin serial cable.

1. Connect a serial cable between a personal computer and the Voice Switch.
2. Use a terminal emulation program to open a connection to the switch.
3. Apply these values to the terminal settings:

e Speed: 19.2 Kbs for SG Voice Switches and 115.2 Kbs for ST Voice Switches
* Data bit: 8 bits

e Stop bit: 1

* Parity: No parity

¢ Flow Control: None

For information on port pinouts, refer to the Voice Switches appendix in the MiVoice Connect Planning
and Installation Guide.

Power over Ethernet Switches (PoE)

When considering the use of Power over Ethernet (PoE) data switches in your network, keep in mind that
not all PoE data switches provide power to all data ports, and not all PoE data switches provide adequate
power to support all devices.
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For example, when 24 IP560 phones are plugged into a switch, the maximum power requirement can
reach 153.6 W (24 phones x 6.4W/phone).

* The power usage on an IP phone typically spikes during bootup, and during normal operation, the
phone requires less power.

» Verify that power allocated to the PoE ports matches the switch wattage.

¢ Mitel recommends selecting a PoE data switch that includes four hardware queues for Quality of
Service (QoS) to ensure that rules can be set up to ensure adequate bandwidth for VolP and other
critical traffic.

Refer to the MiVoice Connect Planning and Installation Guide for information about power usage of IP
phones.
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Voicemail-Enabled Switches

This chapter describes maintenance operations for voicemail-enabled switches.

* Overview

 Ultilities

* Booting and Restarting Voicemail-Enabled Switches
* Switch Diagnostics and Repair
 stcli Commands

* SVCCLI Commands

e CLI Commands

 cfg Utility Commands

* UBOOT Commands and Flags
* Burnflash Commands

* ipbxctl Utility Commands

* regedit Commands

* Server File System

Overview

Voicemail-enabled switches provide voicemail services and access to auto-attendant menus for
extensions hosted by the switch. Voicemail-enabled switches provide local access to voicemail while
being controlled by a distributed voice server (DVS) at a different location.

Voicemail-enabled switches store voicemail in Compact Flash (CF) cards. Auto-attendant menus,
greetings, and prompts are stored in permanent flash memory. Voicemail backup and restore routines are
available through Connect Director, allowing you to safely store voicemail on a regular basis. If a switch is
disabled, information on the Compact Flash is retained and can be moved to another switch of the same
model.

Voicemail-enabled switches are deployed in the same manner as other Switch 1-U Half Width
switches,;and they are managed similarly to other switches and servers. You use Connect Director to
configure switch, voicemail, and server settings. Device status is also monitored in Connect Director.

Three voice switches operate as voicemail-enabled switches, which are voice switches;and voicemail
servers:

¢ Voice Switch 90V
¢ \oice Switch 90BRIV
¢ Voice Switch 50V

Utilities
This section describes the utilities available for voicemail-enabled switches.

Accessing Utilities for Voicemail-Enabled Switches

Utilities for voicemail-enabled switches are accessible through the maintenance port, an SSH client,
or a Microsoft Windows program executed from a command prompt on the Headquarters server or a
distributed voice server (DVS). The following sections describe utility access methods.

For security purposes, voicemail-enabled switches accept requests only from command-line interfaces
(CLlIs) running on the local host, the controlling DVS, or the Headquarters server.
Accessing Utilities from the Serial Port

Switch utilities and the UBOOT command interface are accessible through the maintenance port located
on the faceplate. The state of the switch at the time of Maintenance port access determines the available
utility.
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* During normal switch operation, the maintenance port accesses a specified Linux shell. The default
shell is the ST command-line interface (STCLI).
» During a switch boot, the maintenance port accesses UBOOT

To access voice switch utilities through the maintenance port:

1. Connect one end of a serial cable to a computer with a terminal emulator program installed.
2. Connect the male end of the serial cable to the maintenance port on the front panel of the switch.
3. Launch the terminal emulation using the following settings for the serial port:

e Speed: 19.2 kbps
» Data bit: 8 bits

e Stop bit: 1

* Parity: No parity

e Flow Control: None

Click OK. The ST command line interface appears.
5. Do one of the following:

B

* [f the interface shows that the switch has a Linux operating system:

a. Type the user ID and password as required. The default values are “admin” and “root”
respectively. (Root is available only through a serial connection.)
b. Atthe command line, enter STCLI. The STCLI interface opens.

¢ Do nothing if the interface shows that UBOOQOT is being used; a user ID and password are not
required.

For more information about these utilities, see stcli or UBOOT.

Accessing Utilities from SSH

Mitel provides access to several utilities for voicemail-enabled switches through a Linux BASH command
line, which you can access through an SSH client. Free SSH clients, such as PuTTY, are available
through the Internet.

To access the Linux utilities, including all command line interfaces for voicemail-enabled switches, use
the admin account. Logging into the admin account opens the STCLI interface.

1. Open an SSH client access panel.
If you use PuTTY, the PuTTY Configuration page appears, as shown in the figure below.

Figure 10 : PUTTY Configuration Page

2 PuTTY Configuration

Cateqgory:

=I- Session Basic options for your PuTTY seszion
Logging

X Specify the destination you want to connect to
= Teminal

Host Hame [or IP address) Fort
Keyboard
Bell 10.23.100.91 2
Features Connection type:
=I- Window O BRaw O Teet O Rlogn @ 5S5H O Serial
A
PpREAAncE Load, save or delete a stored session
Behaviour
Translation Saved Seszions
Selection
Colours :
Drefault Settings
= Connection
Ciata ol
D
FRilogin
+- 55H

Serial . .
Cloze window on exit:

O shways O Mever () Only on clean exit

(o= ) e
2. On the PuTTY Configuration page, do the following:

a. In the Host Name (or IP address) field, enter the IP address of the switch.
b. In the Port field, enter 22.
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c. Click Open. The command prompt window opens.
3. At the command prompt, enter admin and then press Enter. The STCLI command prompt opens.
Accessing Utilities from an MS Windows Server

Headquarters and distributed services contain executable files that access voicemail-enabled switches.
On a typically installed server, the executable files for the utilities are located in the following directory:

C:\ Program Fi | es\ Shorel i ne Communi cati ons\ ShoreTel Server.
Commands that you can perform from a server through Microsoft Windows include:

* svccli (See svccli.)
e burnfl ash (See Burnflash.)
e i pbxct!| (See ipbxctl.)

To run these utilities through MS Windows:

1. Open a command prompt by clicking Start > Program > Accessories > Command Prompt.
2. Enter the name of the utility on the command line, using the IP address of the voicemail-enabled
switch as the switch parameter, then press Enter.

Switch Utilities

A set of command-line interface (CLI) commands supports operations such as backing up and restoring
voicemail, stopping or starting services and groups, and formatting CF cards.

UBOOT

UBCQOT is the boot loader for voicemail-enabled switches. The UBOOT environment is accessed from a
terminal emulator through the serial port when the switch is booted. Before starting the boot, UBOOT lists
the processor characteristics and displays results of the Power On Self Test (POST). The switch then
waits a specified period before starting the autoboot. You can modify the duration of this period through
an svccl i command; the default period is three seconds.

To stop the autoboot during this delay, press any key.

The command pr i nt env displays all booting shell variable settings. The following is a typical response
to executing printenv:

boot del ay=3

seri al #=50VJ0724081DFA
et haddr =00: 10: 49: 08: 1d: fa
i paddr=10.1.4.0

net mask=255. 255. 0.0
gat ewayi p=10.1.0.1
serverip=10. 1. 1. 255
user =anonynous
pass=t sk

bootfil e=/tskl/ul mage
aut ol oad=FTP

boot cnd=dhcp; boot m

fl ags=0x40

These settings are edited through the set env command. The set env command has the format set env
variable> value>.The saveenv command saves environment variable settings to the non-volatile
memory on the switch. Execute saveenv after the variables are set to the required values. Boot flags
control switch operations after startup.

For a description of UBOOT commands and flag values, see UBOOT Commands and Flags.
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stcli

The ST Shell, st cl i, displays and modifies system configuration parameters. You can implement static
or dynamic IP addressing for the switch from st cl i . You can also reboot the switch from st cl i .

The main st cl i menu appears below the Mitel logo. The switch model number is displayed in
the command introduction line directly above the menu. st cli commands are described in stcli
Commands.

Toopenstcli:

* Access the Maintenance port, as described in Accessing Utilities from the Serial Port. If the window
displays the Linux prompt, enter st cl i on the command line.
¢ Access through SSH and log in as the administrator, as described in Accessing Utilities from SSH

Exiting st cl i returns the user to the login prompt.

CLI

The command-line interface (CLI) accesses diagnostic tools, manipulates debug setting levels, and
displays system information. CLI can be run from any remote SSH session or from Windows prompts
originating from the local host, the controlling Distributed server, or the main server.

To access CLI, do one of the following:

e Open a Linux BASH shell through the root account (see Accessing Utilities from SSH) and enter CLI.
e Openstcli and enter got oshel | atthe command prompt.

To display a list of executable commands, enter commandson the command line. For a description of
the CLI commands, see CLI Commands.

To perform actions on CLI variables, do one of the following:

¢ To view all of CLI variables and their current values, enter variables
¢ To view a variable current value, enter the variable name.
* To change a variable’s current value, enter the variable name and new value.

To specify the destination of switch trace information, type one of the following commands:

e trace_redirect O (Sends trace information to the Maintenance port)
e trace_redirect 1 (Sends trace information to the current device)

Note:
Trace information is sent to the STTS log on the voicemail-enabled switch.

Only trace streams that are sent to the maintenance port can be redirected to an SSH terminal session;
this prevents trace stealing from other SSH terminal sessions. All traces can be reverted to the
maintenance port, making them accessible to SSH terminals.

To exit the CLI, do the following:

* Type quit or enter the letter q at the CLI prompt.

¢ Type Ctrl-c if the CLI was opened from the Linux BASH shell.
ipbxctl

i pbxct| commands perform switch control and diagnostic tasks, including switch rebooting, clearing
flash memory, and running traceroute. For information about i pbxct | commands, see ipbxctl Utility
Commands.

The i pbxct| commands are run as a windows program from the Main Server or the controlling
Distributed Server, as described in Accessing Utilities from an MS Windows Server.
RegEdit

RegEdi t, a utility that modifies registry-type data structures on the switch, is accessible through the Root
account.
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Voicemail-enabled switches have a registry similar to Windows Servers. The registry is a Mitel construct,
not part of Linux. To edit the Registry, log in as root and run the RegEdi t command line tool from the
bash shell. RegEdi t may be used to set logging levels on applications and set other parameters that
change their behavior.

For more information about r egedi t commands, see regedit Commands.

Server Utilities

This section describes utilities available for servers: svccl i and cf g.

svccli

The svccel i commands control low-level switch parameter settings and application commands, including
Compact Flash storage, switch password, and service control operations. You can run svccl i from any
remote SSH session or from Windows prompts originating from the local host, the controlling distributed
voice server, or the Headquarters server.

To access svccl i, perform one of the following:

* Open a Linux BASH shell through the root account (Accessing Utilities from SSH) and enter svccl i
* Runsvccli fromthe Main Server or a Distributed Server ( Accessing Utilities from an MS Windows
Server).

To display the svccl i commands, enter help or ?. For more information about svccl i commands, see
SVCCLI Commands.

To exit svccl i, type Ctrl-c or enter the letter q.

cfg Utility

The cf g utility is a command-line tool that provides detailed information about the voicemail application.
The cf g. exe file resides in the following directory:

\'shoreline communi cati ons\ ShoreTel server
To start cf g:

1. Open a DOS window pointing to the \ shor el i ne conmuni cat i ons\ Shor eTel server
directory.
2. Enter cf g and press Enter. The system displays the / * Local *// - > prompt when cf g is ready.

All commands are entered at the above prompt. Results are displayed in the DOS window or in the
voicemail logs.

Note:
You can also initiate the cf g command from the voicemail-enabled switch directly by typing cf g

at the command prompt.
Note:

Some cf g utility commands may damage the system if used incorrectly. Ensure you understand
the commands before you use them.

For a list of the commands available through the cf g utility, see cfg Utility Commands.

Booting and Restarting Voicemail-Enabled Switches
Rebooting and restarting voicemail-enabled switches have different scopes:

* Rebooting a voicemail-enabled switch also reboots the Linux kernel. A reboot takes much longer than
a restart.

* Restarting a voicemail-enabled switch only restarts the switch application layer without restarting the
operating system and its services.

For voice switches running on VxWorks, rebooting and restarting are identical.

Under certain conditions, initiating a restart reboots the switch. One example is when a switch upgrade is
available.
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Voicemail-enabled switches boot, or load data and programs, from contents of their internal memory.
Network parameters, including IP addresses, are required to complete the boot process. Switches obtain
these parameters either from a DHCP server or through manual entry. New switches always attempt to
access a DHCP server.

Within installations where a DHCP server is not available, switches must be manually configured,
including the designation of the IP address and other configuration parameters. For switches not yet
placed on a network, this configuration must be performed through the maintenance port. For switches
that are on the network, switches can be configured through stcl i .

When using DHCP, Mitel recommends using DHCP reservations for each switch to ensure that DHCP
leases are not lost.

A voicemail-enabled switch can be brought up through a regular boot or by a software upgrade boot.
FTP booting is also available for troubleshooting. Switches booted through FTP have limited functionality
because internal memory contents are not loaded.

Manually Configuring Switches to Use Fixed IP Addresses

Voicemail-enabled switches normally use DHCP to dynamically set the device IP address and specify the
addresses of the servers to which it communicates. Switches are set into fixed address mode through
CLl instructions.

Voicemail-enabled switches require the following information:

* The IP address and subnet mask of the voicemail-enabled switch

e The IP address of the server that supervises the switch

¢ The gateway IP address of the supervising server if it resides on a different subnet from the voicemail-
enabled switch

e The IP address of the Network Time Protocol (NTP) server. Voicemail-enabled switches require valid
timestamps to operate; many services, including voicemail, cannot start without NTP access.

The following procedure places the voicemail-enabled switch into fixed-address mode:

1. Access the STCLI command line interface, as described in stcli.

2. Type 3 on the command line to select Change System Configuration. The CLI window displays the
Change System Configuration options.

3. Type 6 on the command line to select Enable/Disable DHCP. The CLI window displays the DHCP
options.

4. Type 0 on the command line to select Manual Configuration.

5. Change the network parameters as required to support the fixed address from the Change System
Configuration entry line.

¢« DHCP — To use a fixed address, this parameter must be disabled.

¢ IP address — This is the voicemail switch’s IP address. Set this parameter to an unused IP
address.

e |P subnet mask — Set this parameter to your network’s subnet mask.

¢ Server IP address — Set this to the IP address of the server that the voicemail switch gets
firmware and configuration files from.

¢ Controlling Server IP address — Typically, you set this to the same IP address for the same
server you specified in Server IP Address. When you configure the voicemail switch in Connect
Director, this field is set automatically.

* Gateway IP address — This is the Gateway of the IP address selected.

* Time server IP address — This is the IP address of your time server or of an NIST Internet
Time Service (ITS). When you configure the voicemail switch in Connect Director, this field is set
automatically.

6. After completing changes to the configuration, type Exit to close the CLI.
7. Reboot the switch.

Reboot Methods

A voicemail-enabled switch can be rebooted via a flash boot, a default button, FTP, or bur nf | ash, each
of which is described in this section.
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Flash Boot

The standard method for booting a voicemail-enabled switch is to boot from the switch’s flash memory.
When a switch is first powered on, it reads the boot parameters stored on the non-volatile memory,
which instructs the switch to load software from flash memory. When the software starts, it loads its
configuration, which is also stored in flash memory.

Default Button

The Default Button is the small paperclip button on the left side of the switch. Pressing this button
replaces the two configuration files with their default variants. The Compact Flash is not affected.

Pressing this button and holding for 10 seconds, in addition to replacing the configuration files, removes
all files from the Compact Flash.

FTP Boot

Booting from FTP is available when you cannot boot the switch from internal memory. When booting a
switch from FTP, the operating system and software are loaded from the FTP site identified in the boot
parameters. The loaded files define a default configuration.

Voicemail services on the switch are disabled after booting from FTP and are restarted only by booting
from Flash. After an FTP boot, the switch can perform telephony functions available via other voice
switches.

Note:

Voicemail-enabled switches started with an FTP boot can operate only as a voice switch that controls
phones, trunks, and call routing.

FTP boot is typically used for troubleshooting and also supports maintenance tasks and the backup and
restore facilities. FTP boot supports certain maintenance functions, such as an emergency boot, if the
flash becomes damaged.

Burnflash

Burnflash forces a reboot and installs new software.

The bur nf | ash command burns a Mitel image to the CF card. It unconditionally replaces the resident
image while rebooting the system, but it does not destroy any voicemail. The purpose of burning the
image to the CF is to enable the switch to boot from solid state memory instead of performing an FTP
boot from the server.

Note:

If a user created a static configuration for IP addresses and other system parameters through the STCLI
(option 3), those parameters must be reconfigured after bur nf | ash runs.

Switch Diagnostics and Repair

This section describes tools for diagnosing and repairing switch problems.

Remote Packet Capture

Remote packet capture is diagnostics tool in Connect Director that allows you to capture PRI/BRI ISDN
packets. This tool is available at Diagnostics > Remote Packet Capture. Refer to the MiVoice Connect
System Administration Guide for details about the parameters available to set for remote packet capture
and for details about starting and stopping this tool.

Switch Trunk Debug Tools

Trunk_debug_level is a switch setting that identifies trunk events from the switch’s perspective. Because
Mitel applications manipulate dialed digit strings for both incoming and outgoing calls, the trunk debugger
is typically used to validate the traffic between the Central office and the switch. The recommended trunk
debug level is 4.

1. Access the CLI shell, as described in CLI.
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2. Enter the following command: t r unk_debug_| evel =4
3. When finished, turn off debug by typing: t r unk_debug_I evel =0

Note:
Use D channel monitoring to view activity on the D;channel of a PRI span.

To monitor the D channel, complete the following steps using an SSH interface that is capable of
capturing the output of the commands:

1. At the prompt, enter the following:
-> pri_trace=4
-> pri_log=4

All D channel data is dumped to the screen.
2. When you are finished capturing data, turn the monitor off by entering the following:

-> pri_trace=0

-> pri_log=0

Creating a tcpdump File
Note:

Do not create t cpdunp files without consulting Mitel Technical Support.

At cpdunp is a packet sniffer that operates from a;command line. Mitel can use tcpdump output to
debug voicemail-enabled switch issues.

To create a t cpdunp file:

1. Access the CLI shell, as described in CLI.
2. Execute the following: t cpdunp -C 10 -W3 -w /var/| og/t cpdunp. pcap

This step captures ethernet traffic to the switch into ram.
3. After a brief period, press Ctri-C.

This step terminates the capture and saves the result to the following directory path: cp /var/ | og/
tcpdunp. * /ftproot

4. Submit the files to Mitel, as instructed by Mitel Technical Support.

Recording Audio from a Switch Port

You can capture audio output from a voice switch physical port,;such as a trunk port, using a CLI
command. Audio output is saved on the HQ or DVM server that controls the switch.

To record audio from a switch port:

1. On the Windows server, click Start > Control Panel > Administrative Tools and locate the IIS
Manager.

2. Right-click the IIS Manager and select Properties. This enables the ability to write to the FTP server
by selecting the Write checkbox and clicking OK.

This enables the ability to write to the following directory: C: \ | net pub\ f t pr oot

In Windows Server 2008, you must edit the permissions of the C. \ | net pub\ f t pr oot directory and
give the users group write access.
3. At the CLI prompt, run the following command: Recor d2Fi | e2 (1, 60, “test”)

Audio data from running this command is stored in the t est _r x. pcnfile and filet est _t x. pcmin
C:\I net pub\ ft proot

When you are finished capturing data, a PCM Raw Data file is created with the following format profile:
8000 Hz, 16-bit, Mono and can be listened to using a standard application, such as “Adobe Audition.”

stcli Commands

The following describes the st cl i commands. For a general description of st cl i , see stcli.
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e Option 0 — Exit
This command logs out of st cl i and returns control to the program from where st cl i was entered.

A user must exit st cl i before starting svccl i .
e Option 1 — Show Version

This command displays the system software version running on the voicemail-enabled switch.
¢ Option 2 — Show System Configuration

This command displays current values for system parameters that are viewable through st cl i , a user
enters a 2 atthe st cl i prompt.

¢ Option 3 — Change System Configuration

This command provides access to editable parameters for modifying the system configuration. When
option 3 is selected, the cursor displays ShoreTel Config to indicate that subsequent commands could
alter the system configuration.

The IP addressing mode is selected from this menu. To specify the addressing mode, select 6 from
the ShoreTel Config menu. If static IP addressing is selected, all other Option 3 parameters must be
configured. The static addressing configuration persists across upgrades.

The configuration file is cleared if the svccl i bur nf | ash command is executed.

If DHCP is enabled, the DHCP server must provide the IP address of the Network Time Protocol (NTP)
server.

Pressing 0 from the Config prompt returns the system to the main st cl i menu. When exiting the
st cl i main menu, the user is prompted to confirm all configuration changes made in the Option 3
menu.

¢ Option 4 — Reboot

Option 4 reboots the switch. The switch requests a confirmation of the command before rebooting.
e Option 5 — Shutdown

Option 5 performs a graceful shutdown of the switch. This command is accessible only through the
Maintenance port.

Perform this command before removing power from the switch.

¢ Option 6 — Archive logs
Option 6 archives all switch logs and uploads them to the Logs directory in the FTP root of the server
managing the switch.

e Option ? — Help

Entering a ? lists the main menu items.
* Gotoshell — Entry to CLI shell

Type got oshel | to enter the voicemail-enabled switch cl i interface. For more information, see CLI.

SVCCLI Commands

For a general description of SVCCLI , see svccli.

* The ? or hel p command displays a list of all commands and the syntax of each. The command takes
no parameters (such as an individual command name.) An example of the command output follows:

At the bottom of its display, SVCCLI states that a command can apply to all available arguments by
inclusion of “all” or “*”. For example, the following SVCCLI entry restarts all services:

>restartsvec *

e The backupvmcommand performs on-demand back up of voicemail, Auto-Attendant data, and the
logs that are written to the CF card. On-demand backup begins immediately upon backupvmentry.
During a backup, voicemail service continues, and an incoming voicemail message is backed up if it
was already being recorded when the backup began. When the backup finishes, the SVCCLI displays
a message indicating it is finished. Incontrast, during a restore operation, the voicemail server is
stopped. Also, the restore operation can by started from the SVCCLI only.
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If automatic backup is disabled in Connect Director, backupvmstill triggers the backup but only if
backup is configured in the Connect Director.

Whether for a scheduled or an on-demand backup, pre-configuration of the backup target is
necessary. For a description of how to configure an FTP server to be the target of the backup, see the
MiVoice Connect System Administration Guide.

On-demand backup can serve a variety of purposes. These purposes are usually in response to
anomalous situations. The main purpose of on-demand backup is to reduce the risk of losing voicemail
if a damaged or faulty CF is suspected. For example, if the installation of a new CF card is immediately
required, on-demand backup is the first step. After the new card is formatted, the r est or evm
command can bring the backed-up voicemail to the new card.

Run get svcstatus al | to see the state of the CF file system. At the bottom of the screen for this
command’s output, the state of each file system is shown. The following line is from the file system
lines of the get svest at us al | output and shows that the CF file system is mounted.

/dev/ kcfal 984871 268663 666163 29% / cf

If the®/cf” is missing, then the CF file system is not mounted, and remedial action is necessary. In this
case, not only does voicemail have nowhere to go, but the logs cannot be stored on CF, so the system
provides some space in RAM for holding the most important logs.

After backup, the suspect CF card can be removed and tested in another system, and a new card can
be installed after voicemail is backed up.

Note:

You cannot back up voicemail in Connect running on Windows Server 2008 using the vmbackup

command. You must manually add users with write permission to the FTP folder on the server in

order for users to use the vmbackup command.
bur nfl ash-Burn flash: The bur nf | ash command burns a Mitel image to the CF card. It
unconditionally replaces the resident image and then reboots the system, but it does not destroy any
voicemail. The purpose of burning the image to the CF is to enable the switch to boot from NAND
flash memory rather than to do an FTP boot from the server. FTP boot supports certain maintenance
functions, such as an emergency boot, if the flash becomes damaged. Do not use FTP boot to boot
the switch. It does not support certain services. For example, an FTP boot does not mount the CF file
system, so voicemail does not run after an FTP boot.

If a user created a static configuration for IP addresses and other system parameters through the
STCLI (option 3), those parameters must be reconfigured after bur nf | ash runs.

chgr oot passwor d - Change root password: The chgr oot passwor d command changes
the root password for accessing the voice switch CLI. Arguments for this command are old and
new passwords. This password was created in Connect Director on the Administration > System
Parameters > Other System Parameters

Syntax: chgr oot password passwor d>

chguser passwor d - Change user password: The chguser passwor d command changes an
administrator password for accessing the voice switch CLI. Arguments for this command are old and
new passwords. This password was created in Connect Director on the Administration> System
Parameters > Other System Parameters page.

di sabl egr oup- Di sabl e group: The di sabl egr oup command disables a group of services.
Disabling means that one group or all groups of services are suspended but not completely turned off.
To enable any disabled groups, use the enabl egr oup command.

This command is primarily for trouble shooting. During normal operation, if a group of services fails,
the system automatically tries to restart the stopped services. However, for troubleshooting purposes,
it can be important for the group to remain inactive.

Syntax: di sabl esvc service nane> * oral |

di sabl esvc - Di sabl e servi ce: The di sabl esvc command disables one or all services.
Disabling means that a service is suspended but not completely turned off. To enable disabled
services, use the enablesvc command.
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This command is primarily for troubleshooting. During normal operation, if a service fails, the system
automatically tries to restart any stopped services. However, for troubleshooting purposes, it can be
important for the service(s) to remain inactive.

This status of the service(s) is shown in the output of the get svcst at us command.

Syntax: di sabl esvc service nane> * oral |

dunp - Dunp: The dump command sends a dump command to certain services. This command is
used by engineering for debug only. Typically, the dump command dumps a service’s internal state to
a log file. The dump command does not work on all services.

Syntax: dunp servi ce name>

enabl egroup - Enabl e a group of services: The enabl egr oup command enables one or
more groups of services after they have been disabled by the di sabl egr oup command. These two
commands apply to troubleshooting.

Syntax: enabl egroup group nane> * oral |

enabl esvc - Enabl e servi ce: The enabl esvc command enables one or more services after they
have been disabled by the di sabl esvc command. These two commands apply to troubleshooting.

Syntax: enabl esvc servi ce nane> * oral |

erasecf - Erase CF: The er asecf command completely erases all the contents of a CF card. Back
up the CF before using this command. Examples of reasons to erase the CF are as follows:

- To correct suspected memory corruption.

- To erase a CF that is both formatted and mounted.
Note:

The f or mat cf command is not available for a CF card that is formatted and mounted.

After CF erasure, the system automatically reboots. The reason for rebooting is so that, when the
system detects that the CF is empty, the system recreates the file structure and replaces all other
voicemails and other needed elements on the CF card.

Syntax: er asecf

flushl ogs - Fl ush | ogs: The f| ushl ogs command is a utility that copies certain system logs
to the CF card. In normal operation, the system performs very little logging. Only severe problems
are logged to files on the voicemail-enabled switch. The logging system is implemented in a memory
circular buffer to record the logs (and perform certain tracing tasks.) Each log file includes its own
circular buffer. These circular buffers can be forced to a log file by the f | ushl ogs command.

Syntax: f | ushl ogs

formatcf - Format CF: The f or mat cf command formats a new CF with the Linux file system
format so that Linux recognizes it.

getsvestatus - Get service status: The get svcst at us command displays details about all
services on the switch. Regardless of the state of a service, this command displays it. (Therefore, it
also shows whether a service exists.) The command can display a particular service or all services. A
service name is case-sensitive, so it must be entered exactly. To see the spelling of a service name,
use the all or (*) argument get svcst at us.

Syntax: get svcstat us service name> * oral |

killsve -9-Kill service:Thekillsvc -9 command immediately kills all Linux services on a
voicemail-enabled switch.

Syntax: ki | | svc service nane> * oral |

Q (or CTRL+C) -Quit svccli: The g command or pressing the Ctrl-c keys terminates the
SVCCLI and returns the user to the Linux CLI.

Syntax: q or Ctrl-c

reboot [idle] -Reboot (if switch is idle):Thereboot command causes the voicemail-
enabled switch to reboot from NAND memory. With the optional idle argument, the reboot happens
only if the switch is idle.

Syntax: r eboot [idl e]

74



VOICEMAIL-ENABLED SWITCHES

Rebooting a voicemail-enabled switch and restarting a voicemail-enabled switch have different
scopes. On other voice switches, rebooting and restarting are essentially the same. Rebooting a
voicemail-enabled switch includes the Linux kernel and everything that a kernel reboot entails. In
contrast, restarting a voicemail-enabled switch affects only the application layer.

e restart [idle] -Restart services (if switch is idle):Therestart command stops
and then re-starts services. The idle option means that the operation waits until the process is idle.
For instance, restarting the stts process when idle means waiting for stts not to be handling any calls,
stopping stts, and then starting it again. Also, during the course of a restart or a reboot, the switch
upgrades, if necessary.

Syntax:restart [idl e]

e restorevm-Restore voice mail files:Therestorevmcommand causes the backed
up voicemail, Auto-Attendant, and logs to be restored from the server to the CF card. Voicemail
operation is unavailable during a restore. This process overwrites whatever is on the CF cards and
puts the voicemail-enabled switch in the same state it was in at the time of the backup. The restore
operation must be started from the SVCCLI . (Connect Director provides no option for starting a
restore operation.) When the restoration is complete, the SVCCLI posts a message, and the switch is
restarted.
Note:

The user must wait until the r est or evmcommand completes the operation and the mail server
comes up. This operation can be monitored from EventViewer of HQ server.

* sendcnd - Send conmand: The sendcnd command causes Linux to send a command to a particular
service. This command is used by engineers for debug only.

Syntax: sendcnd servi ce nanme>

e startgroup-Start group of services: Thestartgroup command starts a stopped group.
This command is the follow up to the st opgr oup debug command.

Syntax: start group group nanme> * oral |

e startsvc-Start service: The startsvc command starts one or all services that have been
stopped. This command might be able to restart one or more services that have stopped working. It
can also be the follow up to the st opsvc debug command

Syntax: startsvc service nanme> * oral |
e stopgroup-Stop group of services: The st opgr oup command stops one or all service
groups. It kills the targeted group’s process.

Syntax: st opgroup group nane> * oral |
e stopngr -Stop services manager: The st opngr command completely stops the operation of
the services manager.

Syntax: st opnygr
* stopsvc- Stop service: The st opsvc command completely stops one or all services. It kills the
targeted service’s process.

Syntax: st opsvc servi ce nane> * oral |

CLI Commands

The following table describes the CLI commands. For a general description of the CLI, see CLI.

Table 15: CLI Commands

Command Description Notes

adm debug_| evel Logs admission control and — 2 logs more diagnostics.
bandwidth manager signal flow
onto serial port.

adm di ag_| evel Logs admission control and — 2 logs more diagnostics.
bandwidth manager signal flow
into IPBX log.
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Command

Description

Notes

ar pShow and ar pt abShow

Displays the address resolution
protocol (ARP) table.

Not available on Voicemail-
enabled Switch.

aut oReboot — 0

Turns the switch watchdog off
to prevent rebooting after a
catastrophic failure.

Use this command only when
directed by Mitel Technical
Support.

bi gNvRantet up

Erases switch's configuration in
NvRam. Use config_nv_format.

boot Change

Changes the boot ROM
parameters.

Use with caution. Not available
on Voice Mail Switch.

ci d_debug_I evel

Logs caller ID related information
for extensions.

cliStart

Opens the command line
interpreter from a serial port.

Reboot the switch to return to the
Linux interface. Not available on
Voicemail-enabled Switch.

config_status

Outputs the configuration records
for the switch.

DEBUG_LEVEL

Sets the ShoreSIP debugging
flags.

Recommend using level 0xe00.

di agdConmmands

Outputs full switch diagnostic
information.

di al _num dunp

Displays information about
switch's off-system extension
configuration.

dn_pl an_st atus

Displays information about the
switch's dial plan.

dnp_debug_| evel

Displays detail information (digit
by digit) about dial plan access.

Recommend using level 1.

dt nf _debug Displays RFC2833 for G729 Values can be 0 or 1 (default is
related events. 0).

DunpSB Displays maximum PMCSW
outputs.

dunmpUsedBw Displays information about actual

bandwidth used on individual
calls/legs.

et her MonBr oadcast

Writes the ethernet broadcast
messages to a .cap file in
\inetpub\ftproot directory of the
server that are not intended for
that switch.

Recommend using level 1.

No et her MonBr oadcast
commands on Voicemail-enabled
switches.

et her MonDunp

Writes the ethernet trace
information captured when using
EtherMonStart. Writes to a .cap
file in \inetpub\ftproot directory of
the server controlling the switch.
The .cap file name is ST-<First 3
bytes of MAC-time-date>.cap.

etherMonStart <bytes>

Bytes is the number of bytes

of information you want to
capture (for example, 10000000).
Captures ethernet packets for
trace purposes

Command consumes switch
memory. Run menShowto
display available memory. Do
not specify more memory than is
available.

et her MonSt op

Stops capturing ethernet
packets.

eval _adm var

Displays information about
switch's own bandwidth usage.
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Command

Description

Notes

eval _bwm var

Displays information about total
and available bandwidth.

ext _bca_status

Displays active BCA calls along
with call stack usage information.

To be run on switches hosting
BCA extensions.

ext _cco_status

Displays information the switch's
extension CCOs.

ext _conf_status

Displays MakeMe conference
port status.

ext _debug_l evel 1

Logs extension CCO
configuration.

ext _debug_| evel

Sets the extension debugging
level.

Recommend using level 4.

ext _pg_status

Displays active pickup group
calls.

To be run on the switches
hosting PG extensions.

ext _ecr_status

Displays all configured
Personalized Call Handling rules
on switch.

ext _ecr _debug

Displays real-time behavior of
Personalized Call Handling rule.

Shows triggering of rule during
inbound call.

fax_debug | evel

Display fax-related events

and processes, including tone
detection, fax determination, and
fax redirect.

Values can be 0 or 1
Default is 0

fax_verbose

Used to display fax/silence
detection, jitter buffer freezing.
and echo canceller disabling
related events.

Values can be 0 or 1
Default is 0

fl sh_get Version

Displays switch’s firmware and
bootrom versions.

Not available on Voicemail-
enabled Switch.

flsh_printBootLine

Prints the boot parameters of the
switch.

Not available on Voicemail-
enabled Switch.

fl sh_set Boot Sour ceFl ash

Sets the switch to boot from flash
memory.

Restart to enable changes. Not
available on Voicemail-enabled
Switch.

f 1 sh_set Boot Sour ceFTP

Sets the switch to boot from FTP.

Restart to enable changes. Not
available on Voicemail-enabled
Switch.

g729_verbose

Displays more information for
G729 calls.

Enable this for G729 calls with
mscmd_verbose

host Show

Displays the known hosts.

Not available on Voicemail-
enabled Switch.

hunt | oad_debug

Logs basic huntgroup call flow.

For debugging heavy call load
issues.

i cnpst at Show

Displays ICMP statistics.

Not available on Voicemail-
enabled Switch.
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Command

Description

Notes

i pdt _debug_filter

Assume two extensions in the
system: Ext. A and Ext. B.

To print IPDT log for Ext. A:
i pdt _debug_level - -1

i pdt _debug_filter — 1 (tell
IPDT that filter is enabled)
i pdt _restrictTraceExts

"Ext A s#" (turn on log for Ext
A)

i pdt _renRestrict TraceExt
"Ext A's #"(turn off log for Ext
A).

To print log for all extensions:

i pdt _debug_filter — 0O

i pdt _debug_I evel

Recommend settingto— -1to
turn on all logging.

i pdt _dunpCCOCK

Dumps BB call key state, since
there is no extension associated
with BB.

Voicemail-enabled Switch does
not support CCOCK.

i pdt _dunpExtCal I s

Dumps call information in the

extension (for example, calllD,
leglD, call state and leg state,
and so on.)

Not available on Voicemail-
enabled Switch.

i pdt _dunpExt Di spl ay

Dumps the current display view
from IPDT.

Not available on Voicemail-
enabled Switch.

i pdt _dunpExt ensi ons

Dumps information for all
extensions controlled by the
switch and the information for
monitored extensions and MAE
(BCA) extensions that are in the
same switch and in the different
switches.

Not available on Voicemail-
enabled Switch.

i pdt _dunpExt CK

Dumps information for call keys
on the extension. Useful for
troubleshooting LED patterns
and icon issues.

Not available on Voicemail-
enabled Switch.

i pdt _reset Ext Di spl ay

Redisplay on the extension. If
the phone display and IPDT
display (ipdt_dumpExtDisplay)
are desynchronized, run
ipdt_reset_ExtDisplay to
synchronize them.

Not available on Voicemail-
enabled Switch.

i pdt_restrictTraceExts

Set ipdt_debug_filter to 1. Then,
use ipdt_restrictTraceExts to
turn on logging on a particular
extension.

Not available on Voicemail-
enabled Switch.

i f Show

Displays the current configured
network parameters.

Not available on Voicemail-
enabled Switch.

| aa_debug | evel

Logs backup auto attendant
signal flow.

| spConlLi st

Displays switch connectivity to
other switches.
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Command

Description

Notes

| sp_debug | evel

Displays Location Service
Protocol messages that are
exchanged between switches.

Recommend using level 4.

| sp_ping

Tests the LSP UDP
communication to the far end
switch for 100 iterations.

Tests LSP UDP communication
to the switch at 192.168.1.1,
for 100 iterations (nominally 1
second). If only the IP address
is supplied, 1000 iterations
(nominally 10 seconds) is used.

Example:

-> | sp_ping
"192.168.1. 1", 100

| spTel Li st

Displays local and remote
contacts.

| spTel List 1

Displays detailed information
about local contacts.

| spTel List 2

Displays detailed information
about remote contacts.

mae_debug_| evel

Logs BCA call flow information.

mai | box_debug_I evel

Logs mailbox destination for a
particular call.

nmensShow

Shows current memory usage of
the switch.

Not available on Voicemail-
enabled Switch.

ngcp_nsg_debug

Logs MGCP messages.

ngcp_trans_debug

Logs MGCP transactions.

nohc_debug_I evel

Prints diagnostic information for
music on hold calls when set to
1.

Valid settings are 0 and 1.
Default is 0.

npm debug_mask — 0x40

Sets mpm debug flag to output
Caller ID information received on
inbound calls.

npm debug_nmask — 0x10

Displays detailed DTMF
information.

npm debug nmask - -1

Displays detailed mpm
information. Full debug of
inbound calls (CallerID, DTMF).

nscnd_ver bose

Prints diagnostic information for
the media commands sent from
Switch board layer when set to 1.

Main media command verbose
variable. Default is 0.

neps Displays media stream statistics | This is a helpful command for all
for all active calls on the switch. | media-related issues.
nsps 7 Displays media stream statistics
for active calls.
nmsps 8 Displays media stream statistics. | Use only when directed by Mitel.
nsps 16 Displays media stream statistics. | Use only when directed by Mitel.

mv _debug | evel

Logs message waiting indicator
setting call flow.

ping " <IP Address>"

Include double quotes (“) around
the IP address.

pri _verbose

Traces a high-level description of
the PRI traffic sent and received
by trunks on the switch.

Recommended setting is
pri_verbose — 1
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Command

Description

Notes

print_ether_stats

Prints the Ethernet statistics from
the network controller.

Not available on Voicemail-
enabled Switch.

rdn_di ag_I evel

Used to determine why calls are
routing to particular destinations,
similar to what gets put in the
DRSMain log when DRS is
enabled.

Useful values are 0 (none) or 5
(trace resolve_dn).

r eboot

Reboots the switch.

Recor d2Fi | e2(port, tinme,

<fil e_name>; 0)

Records inbound media on the
specified port for the specified
time (in seconds) and writers it to

/i net pub/ftproot.

Writes to the TMS server
controlling the switch. FTP write
access must be enabled on the
server.

rfc2833 for_g711 debug

Displays events related to
RFC2833 for G711.

Bitmask integer. Valid settings
are 0, 1, and 2. Default is 0.

r out eShow

Displays current routing table.

Not available on Voicemail-
enabled Switch.

r out est at Show

Displays routing statistics.

Not available on Voicemail-
enabled Switch.

sb_debug_I evel

Switch board debug variable
that prints debug information for
the commands sent from Call
control.

Values range from 1-5.

set _npm debug (char *)

Used to print information
regarding commands/event
interface between host CPU and
DSPs.

Uses a string as a parameter (for
example, “pots”, “pstn”, “dtmfd”,

“‘dtmfg”, “cdis”, “class”, “cpm” are
valid parameters).

Example: To print POTS
related information, use
set _npm debug (“pots”)

si p_debug _level -1

Logs ShoreSIP to SIP
translation.

si p_debug_l evel - 2

Logs SIP messages also.

si puaCal | Li st

Displays active SIP stack calls.
sipuaCallList 2 dumps more call
related information.

For switches hosting SIP trunks/
extensions.

si puali st

Displays list of SIP trunk/
extension user agents.

For switches hosting SIP trunks/
extensions.

t 2t _debug_|I evel

Logs trunk interval information
like silence, trunk name, trunk
state, and so on..

t cpst at Show

Displays TCP statistics.

Not available on Voicemail-
enabled Switch.

trans_debug

Logs ShoreSIP transactions.

trunk_cco_status

Displays information about
switch's trunk CCOs.

trunk_debug_ | evel

Sets the trunk debugging flag

Recommend using level 4.

uaCal | Li st

Displays information about active
calls and legs.

ua_call _status

Shows a snapshot of the active
call status of the switch.
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Command Description Notes

ualLi st Displays list of ShoreSIP
extension/trunk user agents.

unset _npm debug(char*) To disable
set_mpm_debugcommand

udpst at Show Displays UDP statistics. Not available on Voicemail-
enabled Switch.

cfg Utility Commands

The following table describes the commands available through the cf g utility. Variables are italicized. For
a general description of the cf g utility, see cfg Utility on page 68.

Table 16: cfg Commands

Command Parameters Description Comments

call p p — phone number Make a call from the ;
voicemail application
and play a prompt.

cl osem ; Close the open ;
voicemail mailbox.
dmask 0x 0x — mask hex Set voicemail debug Enter without parameter
mask (hex) to display flag list.
exit ; Leave cfg. ;
| aam t t—(1-DID List Auto-Attendant Displays mapping of
’ menu map. trunks to Auto-Attendant
2 —DNIS, menus.
3 — Trunk)
lall f f— 1 for more details List all mail boxes in the [ Enter without “1” for a
system. summary of system mail
boxes and with “1” for
more detail.
[anp mf — mai Turns the message ;
m — mail box waiting light on/off for a
f—1-on;2-off specified mail box.
list pb b b - (0 - last name, 1 — Dump dial by names ;
first name) directory to the
voicemail log.
nmbox | f f= 1 for more details List mail box Enter without “1” for
information. a system mailbox
summary, including
message IDs.
| ms ; List mail box schedule. |;
[ msg m m — message ID List details of a specific [ Message IDs can be
message. found by using Inbox.
| oadc ; Load all voicemail ;
configuration from the
database.
| oadm ; Load all mailbox Requires that a mail box
configuration from the be open when you issue
database. the command.
| serv ; List information about all |;
servers.
| sys ; List voicemail system ;
parameters.
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Command Parameters Description Comments
I snmtp ; List status of distributed |;
voicemail.
| tapi ; List status of TAPI lines |;
opened by voicemail.
nsi nfo ; Dump voicemail internal |;
table to the voicemail
log.
openm # #- mail box Open specified mail ;
box.
psinfo ; Dump port server ;
information to the
voicemail log.
pur ge ; Remove message in the | Requires that a mail box
deleted queue. be open when you issue
the command.
sh str str — string Search help for a string. | Searches only from the
beginning.
starth ; Remove old deleted ;
messages.
Sy mm ; Run MWI Sends MWI status to all
synchronization. phones in system.
ver ; List cfg version. ;
? ; List help commands. ;

UBOOT Commands and Flags

The following table describes the UBOOT environment variables.

Table 17: Parameter Settings for Flash Boot and FTP Boot

Parameter

Description

Flash Boot

FTP Boot

autoload

Specifies booting
method for bringing up
operating system

FLASH

FTP

bootcmd

Specifies boot actions
that loads OS and
software onto switch.

bootfile

Path and filename of
operating system file

tskl/ulmage

tskl/ulmage

flags

Variable passed to
Linux that controls post
startup operations.

0x40

0x40

gatewayip

IP address of gateway
server

XXX XXX XXX XXX

XXX XXX XXX XXX

host

IP address of host
running Connect
Director

XXX XXX XXX XXX

XXX XXX XXX XXX

ipaddr

IP address of the switch

XXX XXX XXX XXX

XXX XXX XXX XXX

netmask

Subnet mask for subnet
location of the switch

XXX XXX XXX XXX

XXX XXX XXX XXX

pass

Password for FTP
account.

default setting is tsk

default setting is tsk

script

Path and filename of
bootscript file

tskl/bootflsh.txt

tskl/bootscrp.txt
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Parameter Description Flash Boot FTP Boot

serverip IP address of host from | XXX.XXX.XXX.XXX XXX XXX XXX XXX
which FTP transfer
retrieves the OS image.

user User name of FTP default:anonymous default: anonymous
account.

The following actions are triggered by flag values:

¢ 0x0: Auto-negotiate network speed and duplex mode
¢ 0x20: Disable login security

¢ 0x40: Use DHCP to receive boot parameters

* 0x2000: Disable shell

* 0x10000: 10 MB full duplex (fixed)

¢ 0x20000:10 MB half duplex (fixed)

* (0x30000:100 MB full duplex (fixed)

* 0x40000:100 MB halfduplex (fixed)

Multiple functions are specified by adding the hex values of the individual functions. For example, the
command 0x42040 instructs the switch to use DHCP to receive boot parameters (0x40), disable the Shell
(0x2000) and set the speed and duplex mode to 10 Mb, half duplex (0x40000).

Burnflash Commands

The following table describes the bur nf | ash commands.

Table 18: Burnflash Commands

Command Description

burnflash -s Switch | P Address> Updates all bootrom areas.

ipbxctl Utility Commands

The following table describes the i pbxct| commands.

Table 19: ipbxctl Utility Commands

Command Description
-reboot <Switch I P Address > Reboots the switch without using Connect Director.
-flash <Switch I P Address > Sets switch to boot from flash memory> (allows

you to boot without logging in).

-ftp <Switch | P Address > Sets switch to boot from FTP (allows you to do this
without logging in).

-diag <Switch I P Address > Sends switch state information. By default, the

system puts this information in the same folder
where ipbxctl utility is running.

Note:
This may be disruptive to normal switch function.

Use this command only for diagnostic functions,
not for reporting.

-reset Clears all flash memory. Returns switch to factory
defaults.

regedit Commands

The following table describes the r egedi t commands.
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Table 20: regedit Commands and Descriptions

Command Description
key keynane[\keynane]... Makes subkey keyname current key
keynane[ \ keynane] . . . Makes subkey keyname current key

Displays current key, values recursively depending
on display mode 'd'

key . Displays current key, values recursively depending
on display mode 'd'

* Display current values

key * Display current values

Go up one level

key .. Go up one level

addkey keynane Add subkey keyname to current key

del key keynane Delete subkey keyname from current key

addstr val name strval ue Add valname strvalue to current key

addnum val name nunval ue Add valname numvalue to current key. numvalue
is base10digit...

addhex val name hexval ue Add valname hexvalue to current key. hexvalue is
Oxhexdigit...

setstr val name strval ue Set valname strvalue in current key

set num val name nunval ue Set valname numvalue in current key. numvalue is
base10digit...

set hex val name hexval ue Set valname hexvalue in current key. hexvalue is
Oxhexdigit...

del val val nane Delete value valname from current key

d Toggle recursive display

q Quit the program

fil ename Read commands from a file

E.g RegEdit cmdfile

Where cndfile has the foll ow ng
contents

Voi ceMai
Loggi ng
set hex Level Oxff

Server File System
This section describes where the server files for a voicemail-enabled switch are installed.

The server installs files with default access permissions. System administrators may want to ensure a
more secure environment.

The Windows system user and the IPBX user created by the installer require full access to all the Mitel
directories. All other users can be granted access on an as-needed basis.

To ensure the security of sensitive and/or personal information, confine access to the vns and dat abase
directories strictly to administrator, system, and IPBX users.

The server contains the following directories:
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The shor el i nedat a directory contains all the dynamic information the server uses to run the system.
This directory and all sub-directories may be saved as part of a backup and used for full system
recovery.

drive>\shorelinedata
The pr onpt s directory contains copies of the auto attendant menu prompts.

drive>\shorelinedata\ pronpts

The vnsdirectory contains all the files and configuration information used by the voicemail system. The
files in this directory and its sub-directories are very dynamic. Never open these files. Opening any of
the configuration files may cause the voicemail system to become corrupted in part or completely, and
can cause loss of voicemail messages.

dri ve>\shorel i nedat a\ vns

The nmessagedirectory contains all voicemail messages as .wav files, along with an .enl pointer file for
each message.

dri ve>\shorel i nedat a\ ms\ nessage
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Configuring and Maintaining 400-Series
IP Phones

This chapter provides details about configuring and maintaining the 400-Series IP phones.

* Overview

* Updating IP Phone Firmware

* Boot Process

* Configuring 400-Series IP Phones

» Setting up an Alternate Configuration Server
* Migrating Phones Between Systems

* Viewing IP Phone and BB424 Diagnostic Information
* Displaying Settings for an IP Phone

* Resetting an IP Phone

* Resetting a BB424

* Clearing a Phone’s Configuration Settings

* Clearing a BB424’s Configuration Settings

Overview

400-Series IP phones differ from other IP phones in that they use the Session Initiation Protocol (SIP).
While this difference requires administrators to use slightly modified configuration and maintenance
procedures, the 400-Series IP phones provide telephony features similar to other IP phone models.
Users who are familiar with other phone models should have an easy transition to using the 400-Series
IP phones.

This chapter provides details about configuring and maintaining the 400-Series IP phones.

All IP phones are supported by voice switches, which must have sufficient capacity for all the phones
in the system. IP endpoints are configured in the system with Connect Director. For more information
about configuring 400-Series IP phones, see the MiVoice Connect Planning and Installation Guide and
the MiVoice Connect System Administration Guide.

IP Phone Failover

When IP phone failover is enabled on the IP Phone Options page in Connect Director, if an IP phone
cannot communicate with its switch, the phone automatically connects to another switch at the same site
that has available configured IP phone resources. For IP phone failover to be effective, the system must
be planned with sufficient excess capacity to handle phones from at least one switch during a failover
event. For example, if a switch with 20 IP phone ports fails, 20 IP phone ports need to be available
elsewhere in the system.

Date and Time

400-Series IP phones depend on a Network Time Protocol (NTP) server to authenticate a secure
connection and to provide the date and time to be displayed on for the phone’s screen. The time
displayed on the phone is the GMT value provided by the NTP server plus the offset from the time zone
setting of the phone. Users can set the time zone through the phone’s Options menu.

The IP address of the NTP server is delivered to the phone via DHCP or is manually configured in the
phone. In the absence of an accessible NTP server, the phone can obtain the time from its controlling
switch.
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IP Phones and Voice Switches

Voice switches provide configuration and call manager functionality for 400-Series IP phones. Every site
where IP phones are in use must have a voice switch configured to support the number of IP phones at
the site. SIP Proxy ports are not required for the 400-Series IP phones.

Voice switches provide configuration for the 400-Series phones in a different manner than for other
phone models. When a 400-Series IP phone downloads configuration files during the bootup process it
receives a list of all available switches. The phone then randomly selects a switch from this list (starting
with switches on the same subnet, if available) and attempts to register with the switch.

The contacted switch then redirects the phone to the appropriate call manager switch, which is the voice
switch assigned to the phone to set up and tear down calls. The call manager switch handles the Session
Initiation Protocol (SIP) information from the IP phones assigned to it and communicates call information
to other switches in the system using SIP. After two IP endpoints are connected in a call, media streams
are independent of the call manager switch.

After the phone registers with the call manager switch, any time the phone reboots it attempts to contact
that same switch. If that switch does not respond, the phone attempts to contact another switch on the
list until the phone successfully contacts a switch; the phone is then redirected to the appropriate call
manager switch.

IP Phone Communications
Communications for 400-Series phones are routed through the following protocols:

e Secure Session Initiation Protocol (SIPS)
e Real-time Transport Protocol (RTP) and Secure Real-time Transport Protocol (SRTP)
¢ Client Application Server (CAS)

Secure Session Initiation Protocol (SIPS)

SIP is a standard protocol that is based on a client-server model and works at the application layer.
Through SIP, networked users can initiate a call or receive a call. The protocol configures the parameters
for the session and handles the call setup and tear-down.

Mitel uses the secure version of SIP, SIPS, for signaling between voice switches and 400-Series IP
phones.

RTP and SRTP

Media flow for the 400-Series IP phones is either through Real-time Transport Protocol (RTP) or Secure
Real-time Transport Protocol (SRTP).

The use of SRTP, the encrypted version of RTP, depends on whether SRTP has been enabled through
the Media Encryption option in the Call Control > Options page in Connect Director. If the Media
Encryption option is set to SRTP - 128 bit AES, SRTP is used in the following scenarios:

e For calls between 400-Series IP phones configured as internal extensions, after the call is set up
media flows directly between the IP phones using SRTP.

¢ For calls between a 400-Series IP phone and an external number over a trunk, after the call is set up
media flows via the trunk using SRTP.

* For three-way mesh conference calls between 400-Series IP phones, after the call is set up media
flows between the phones using SRTP.

e For up to eight 400-Series IP phones involved in a Make Me conference, media flows through SRTP
when voice switches are used.

e or conference calls involving 400-Series IP phones that are initiated through a service appliance,
media flows through SRTP.

When SRTP is used to encode the audio, the secure nature of the call is indicated with a lock icon in the
call window.

If the Media Encryption option is not enabled, the connection negotiation between two 400-Series IP
phones is through SRTP, but the resulting media stream between the two phones is through RTP.
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Media flow for calls between 400-Series IP phones and other IP phones uses RTP. Make Me conference
calls that involve at least one non-400-Series IP phone and a 400-Series IP phone also use RTP. (RTP
is used in these scenarios even if SRTP is enabled through the Media Encryption option in Connect
Director.)

Client Application Server (CAS) Service

On the 400-Series IP phones, the Client Application Server (CAS) supplies information such as
call history, configuration details, directory, workgroup agent status, and visual voicemail. If CAS is
inaccessible, these services are not available, but a phone can still make and receive calls.

Updating IP Phone Firmware

While earlier phones automatically download available new firmware upon rebooting, updating firmware
on the 400-Series IP phones is a process you manage through the Diagnostics and Monitoring system
that you access through Connect Director.

For example, you can automatically maintain all 400-Series IP phones at the recommended firmware
level, or you can override the automatic updates if you want to select a different firmware version or
disable automatic update for certain phone models or for specific phones.

Control of phone firmware updates is accomplished through global-update and override settings that you
specify on the Phone Firmware Update page of Connect Director. For details, see the MiVoice Connect
System Administration Guide.

When you want to manage phone firmware on a more granular level, the Diagnostics and Monitoring
interface provides a flexible approach for updating phone firmware because you can manage the
firmware download and installation process in stages:

* If you want to download firmware to phones independently of installing it, use the Download command.
You can choose to run this command at a time when you can spare the network bandwidth needed
to accommodate the download. After firmware is loaded onto the phones, you can use the Update or
Update When Idle commands at a later time to install the firmware that you have already downloaded
without downloading it again.

* If you want to download firmware to phones and install it immediately, use the Update command. You
can also use this command to install phone firmware that you have previously downloaded.

¢ If you want to download firmware to phones and install it when phones are idle, use the Update When
Idle command. You can also use this command to install phone firmware that you have previously
downloaded.

When a group of phones at a site is selected for firmware download and the server is remote, to minimize
bandwidth utilization some of the phones at the site automatically download firmware from other phones
at the site.

When phones are running at least the latest recommended firmware version, the value in the Firmware
Status column is Up to Date. For more details about the possible values for Firmware Status, see the
MiVoice Connect System Administration Guide.

If you are not using the automatic phone firmware update mechanism, you should upgrade phone
firmware when the value in the Firmware Status column on the Status > IP Phones page is one of the
following:

¢ Firmware Version Mismatch indicates that the phone’s current firmware version is less than the
minimum firmware version required for the phone.

¢ Update Available indicates that the phone is running an acceptable firmware version, but a more
recent firmware version is available for download. In other words, the phone is running a firmware
version above or equal to the minimum version, but less than the recommended version.

The Advanced option, which is available with the Downl oad, Updat e, or Updat e When 1dl e
commands, allows you to select a different firmware build for each model of phone. Furthermore, if there
is more than one hardware version for each phone model, you can select a unique build to deploy to
those phones as appropriate. The system prevents you from accidentally downloading a firmware version
that is incompatible with a phone’s hardware version. If there is no firmware version appropriate for a
particular phone loaded on the server, you can select Skip from the Version dropdown list.
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Because the Diagnostics and Monitoring system selects any available server from which to download the
firmware update, you should ensure that all servers in the system, including servers that do not manage
voice switches, have the latest firmware installed. If the Diagnostics and Monitoring system directs the
phones to download from a server that does not have the specified firmware version, the download fails
and the phones do not attempt to obtain the firmware from another server.

To download and install a firmware upgrade:

1. Launch Connect Director.

Click Maintenance > Status and Maintenance > IP Phones. The IP Phones page is displayed.
Select the check box for each phone for which you want to upgrade firmware.

In the Command drop-down menu, select Update Firmware.

Click Apply.

In the Confirmation dialog box, do one of the following:

I

* To apply the recommended firmware version, click OK.
* To select a particular firmware version:

a. Click Advanced.

b. For each type of phone selected, in the Version drop-down list, designate the firmware
version.

c. Click OK.

The Firmware Status column shows the progress as the firmware is downloaded and applied. The
phones reboot.

Boot Process

The boot process varies depending on whether your network uses Dynamic Host Configuration Protocol
(DHCP) or static configuration:

* DHCP— IP phones are pre-configured to work with your network’s DHCP server. After the servers
and voice switches are configured, the phones are automatically added to your Mitel system when
they are connected to the network. Upon booting, IP phones use the configuration server address to
acquire their configuration specifications. The configuration server address is set in the DHCP site-
specific options (option tag 156). Alternatively, if DHCP is used without site-specific options, the server
returned by DHCP option tag 66 (Boot Server Host Name field) is used for configuration. If DHCP is
used without option tags 156 or 66, the phones are not automatically added to the system.

e Static configuration—If you are not using a DHCP server or it is not currently online, you can set a
static IP address and other startup parameters directly on the IP phone. For details, see Specifying
Configuration Parameters on a Phone.

Note:

If a phone is set to use DHCP but values are not provided for DHCP option 156 or 66, when you
plug a 400-Series IP phone into the network, by default the phone tries to connect to a MiCloud
Connect system and displays a window prompting you to enter MiCloud credentials. If this
happens, enter the phone setup process (MUTE + 73887#) and specify your configuration server.
For details, see Entering SETUP from the Key Pad.

After the IP phone obtains the configuration server IP address or addresses, it downloads configuration
files from the configuration server using HTTP (unless otherwise specified). If the configuration server
cannot be reached because of some kind of error (such as a timeout) but the phone was configured with
multiple configuration server IP addresses, then the phone tries to download the configuration files from
the other servers. If no configuration server can be reached, or if a configuration file cannot be located,
the phone uses the last successfully loaded configuration parameters. After a phone is finished reading
configuration files, the current parameters are saved in flash memory.

Configuring 400-Series IP Phones

This section describes how you can specify custom configuration parameters for the phones.

When a 400-Series IP phone boots, it contacts the configured server and reads an initial configuration
file from the server. You can override the default configuration parameters for a phone through DHCP
site-specific options, through the phone interface, or through custom configuration files. As phone
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firmware is upgraded, some configuration information is overwritten, but parameters specified in custom
configuration files are preserved across upgrades.

Parameter Precedence

While there are some exceptions, in general configuration parameters are processed by the phone in the
following order. The last parameter source takes precedence:

* Defaults

* Values specified on the phone through the MUTE 73887# SETUP# command.
e LLDP-MED

e DHCP option tags 156 or 66 (if DHCP is enabled)

» Configuration files that reside on the server. The precedence order for these files is described in
Processing Order for Configuration Files.

* Configuration settings from the voice switch

Specifying Configuration Parameters on a Phone

If you are not using a DHCP server to provide IP address and configuration parameters to the phones,
you must manually configure the phones. You can enter the phone configuration menu at bootup or by
entering a key sequence from the phone’s keypad after the phone has finished booting up.

For descriptions of the parameters you can set on a phone, see Table 21: Phone Information for 400-
Series IP Phones on page 90.

If you are using DHCP, be aware that the order of precedence for certain parameters varies:

* Setting the Config server parameter on the phone (through the Admin options > Services menu)
overrides the configServers parameter specified through DHCP.

¢ Setting the SNTP server parameter on the phone (through the Admin options > Internet protocol
menu) does not override the SNTP value provided by a DHCP server because when the phone
is rebooted the DHCP value overwrites the value entered on the phone. However, if you set this
parameter on the phone, unplug the phone from the network that uses DHCP, and then plug it into a
network that does not supply the SNTP server value through DHCP, the parameter value entered on
the phone is retained.

Table 21: Phone Information for 400-Series IP Phones

Admin Options Option Name Description
Menu ltem
Network policy Use LLDP-MED

Network policy Use LLDP-MED If On, the phone captures
link policy from a Link Layer Discovery Protocol-Media
Endpoint Discovery (LLDP-MED) broadcasting neighbor
(presumably the upstream ethernet switch). If Off, you can
manually set the policy values (such as using 802.1.Q
tagging, VLAN ID, PCP, DSCP-audio). If On, these policy
values are not editable.

If present, the following MED data fields are used by the
phone:

« VLANID
. PCP
- DSCP

If a new neighbor is found (that is, the phone has been
moved to a new network), the network policy cache is
updated with the new values. If no LLDP messages are
found within the 5-second time-out period, the phone uses
the cached network policy. If network policy caching is
disabled, the default policy is used.
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Admin Options
Menu ltem

Option Name

Description

LLDP neighbor

If Active, an LLDP-MED broadcasting neighbor has been
found and the phone is actively using the received policy.

Cache LLDP-
MED

If On, then in the event of failure to receive an LLDP-MED
messages, the previously received values are applied.

If Off, the default values are used.

Use 802.1Q

IEEE 802.1Q specifies the use of VLANs (Virtual LANs) on
Ethernet. If enabled, you must also specify values for the
following fields:

* VLAN
e IDPCP
e DSCP audio

If the value for the Use LLDP-MED option is On, this field is
not editable.

VLAN ID

The Virtual LAN identifier

The default value is 0, which means that VLAN tagging is
disabled.

PCP

The IEEE P802.1p Priority Code Point (PCP) value

The default value is 5.

DSCP audio

The Differentiated Services Code Point (DSCP) value to
be used for audio packets. (For details on DSCP, see RFC
2475.)

The default value is 46.

DSCP SIP

The Differentiated Services Code Point (DSCP) value to be
used for signaling (SIP) packets. (For details on DSCP, see
RFC 2475.)

The default value is 26.

Ethernet

Network port

Choose automatic configuration (Auto) or choose speed
and duplex modes. The recommended value is Auto.

PC port

Choose to disable the PC port, or choose automatic
configuration (Auto) or speed and duplex modes. The
recommended value is Auto.

802.1Q

On or off, as dictated by the Use 802.1Q option in the
Network policy menu

VLAN ID

The Virtual LAN identifier

The default is 0, which means that VLAN tagging is
disabled.

PCP

The IEEE P802.1p Priority Code Point (PCP) value

The default value is 5.
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Admin Options
Menu ltem

Option Name

Description

Use 802.1X

Choose to enable or disable IEEE 802.1X link layer
authentication. If enabled, enter the username and
password.

Note the following points about 802.1X usage:

 |f the phone has 802.1X turned on but the network
does not have 802.1x authentication, the phone
functions normally (and does not need a username and
password).

« |f the network has 802.1X and the phone's user name
and password credentials are missing or invalid, the
phone prompts for a username and password on startup.

Username

The user name to enable 802.1X link layer authentication

Password

The password to enable 802.1X link layer authentication

Authenticated

The current status of 802.1X authentication

Internet protocol

Use DHCP

If On, DHCP is used to collect the IP address layer
information. If Off, you must manually enter the IP address
layer information.

If On, DHCP provides values for the following fields. If Off,
specify static values for these fields:

e |Pv4 address

e Subnet mask

* Gateway

e DNS

SNTP (Simple Network Time Protocol) server

It is optional but recommended that DHCP option tag 156
be used to specify the designated configuration server for
400-Series IP phones.

For more information about this DHCP option tag, see
Specifying Config Parameters through DHCP Options on
page 95

DHCP lease

If Active, indicates a DHCP lease has been received by the
phone.

Cache DHCP

If On, the last received DHCP lease is cached and used if
a DHCP lease is not received on the next renew. If Off and
static values are not provided, the phone will fail to get an

IP address if the DHCP server does not respond.

IPv4 address

The IP address of the phone. If Use DHCP is On, this field
displays the value from the DHCP server.

Subnet mask

If Use DHCP is Off, specify the static subnet mask for the
phone. If Use DHCP is On, this field displays the value
from the DHCP server.

Gateway

If Use DHCP is Off, specify up to three static IP gateways.
(If you do not want to specify a gateway, set the value of
the Subnet mask field to 0.0.0.0 to confirm that no address
needs a gateway.) If Use DHCP is On, this field displays
the value from the DHCP server.

DNS

The default list of static DNS servers. DHCP can override
these servers. If Use DHCP is on, this field displays the
current value.
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Admin Options Option Name Description
Menu Item

SNTP server The IP address for the SNTP server, which is required for

phone operation. The SNTP server should be synchronized
with the time used by the Mitel Headquarters server. DHCP
option tag 42 should be used to pass the time server IP
address.

If Use DHCP is On, this field displays the value from the
DHCP server.

DSCP audio The Differentiated Services Code Point (DSCP) value to
be used for audio packets. (For details on DSCP, see RFC
2475.)

The default value is 46.

DSCP sIP The Differentiated Services Code Point (DSCP) value to be
used for signaling (SIP) packets. (For details on DSCP, see
RFC 2475.)

The default value is 26.

VPN Use VPN If On, the phone can be used securely on a public Internet
connection. If Off, the phone cannot be used off the
network.

VPN gateway If connected, shows the connected VPN gateway and
configures the list of VPN gateways to connect to

VPN gateway The port used for the VPN connection
port

Tunnel IP When the tunnel is connected, the phone reports the
current tunnel IP address obtained from the VPN gateway

VPN protocol Shows the active VPN protocol: rast-dtls

VPN debug
mode

If On, VPN log information is included when you upload
logs to the destination specified in the Diagnostic server
field (in the Diagnostics menu). If you change the value of
this field from Off to On, the phone reboots.

If Off, VPN log information is not included in the logs.

Services Config server This is the IP address of the Headquarters server. It can be
entered manually here or obtained from DHCP. If entered
manually, this server overrides the server specified in
DHCP option tags 156 or 66. If you specify a list of servers,
the phone attempts to connect to subsequent servers in the
list if a server fails.

SIP This is the IP address of the voice switch that the phone
has successfully registered with or is attempting to register
with.

Directory This is the IP address of the Client Application Server
(CAS), which provides Directory and History services.

MiCloud domain | gor |P phones used with MiCloud Connect, this field
specifies the domain for MiCloud connections.
Note:

This is not applicable for MiVoice Connect

Phone information MAC address The MAC address of the phone. This is a unique number
forcthe device.
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Admin Options
Menu ltem

Option Name

Description

Software version

The version of the phone software that the phone is
running.

Model number

The model number of the phone.

HW version The hardware version of the phone.
Language The language the phone is configured to use
Country The country for which the phone is configured

Kernel version

The kernel version installed on the phone.

Boot1 loader
version

The boot1 loader version installed on the phone.

Boot2 loader
version

The boot2 loader version installed on the phone.

Signature

Mitel internal use only

Diagnostics

System

Ping

Traceroute

Capture

Clear
configuration

Reset phone

Log upload

Diagnostic
server

For details on these menu options, see Viewing Diagnostic
Information on a Phone

Entering SETUP at Bootup

1.

3.

Connect the Ethernet cable to the data jack on the back of the IP phone.
2. As the phone is booting, when prompted press any key to enter setup.
At the Admin Password prompt, enter the default password 1234 or the password provided by your

system administrator.

Note:

This password is configured through Connect Director on the Administration >;IP Phones >

Options page. The parameter name is IP Phone Password. If the phone uses factory defaults, the

phone has never been connected to a server, and you have not modified the IP Phone Password,

use the default password, 1234.
Do one of the following:

* On the IP420, press #.
¢ On the IP480, IP480g, and IP485g, press the OK soft key. The Admin Options menu opens.

Use the navigation key pad and the selector button to open the submenus necessary to configure
parameters as follows:

If you are not using a DHCP server to provide an IP address, enter the following information:

Internet protocol > Use DHCP (Toggle to Off.)

Internet protocol > IPv4 address (Enter the static IP address of the phone.)
Internet protocol > Subnet mask (Enter the static IP subnet mask of the phone.)
Internet protocol > Gateway (Enter the static IP gateway.)

- Internet protocol > SNTP server (Enter the IP address of the time server.)

If you are not using DHCP to provide configuration parameters, in the Services > Config server
field enter the IP address of the configuration server.

. With the appropriate submenu highlighted, do one of the following:

¢ On the IP420, press the selector button on the navigation key pad.
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* On the IP480, IP480g, and IP485g, press the Edit soft key.
7. To return to the previous menu, do one of the following:

* On the IP420, scroll down to the Back option and press the selector button on the navigation key
pad until you return to the top-level menu.

* On the IP480, IP480g, and IP485g, press the Back soft key until you return to the top-level menu.
8. To apply the changes, do one of the following:

* On the IP420, with Exit highlighted press the selector button on the navigation key pad.
¢ On the IP480, IP480g, and IP485g, press the Apply soft key.

Note:

On 1P480, IP480g, and IP485g phones, to exit the menu and apply changes, press and hold the
Back soft key for 2 seconds.

The phone reboots and applies settings.

Entering SETUP from the Key Pad

1. With the phone on hook, press the MUTE key followed by 73887# (SETUP#).
2. Go to step 3 in the Entering SETUP at Bootup on page 94, and proceed with the steps there.

Specifying Config Parameters through DHCP Options

By default, DHCP option tag 156 is used. The following parameters are specified in the site-specific
options for option tag 156:

¢ configServers: Specify a comma-separated list of IP addresses or DNS names for the configuration
server. If a server is not available, the phone cycles through the list of servers until it finds a working
server.

o ftpServers: Specify a comma-separated list of IP addresses or DNS names for the configuration
server. If a server is not available, the phone cycles through the list of servers until it finds a working
server.

Note:

The ftpServers parameter is provided for compatibility with sites running MGCP phones. 400-
Series IP phones use HTTP to download configuration files from servers specified in the ftpServers
parameters. For new installations, the configServers parameters is recommended over the
ftpServers parameter.

e vlan

While DHCP Option 156 can be used to enable VLAN tagging and set the VLAN ID, it is not
recommended because VLAN hopping after the DHCP address is acquired forces the phone to re-start
the network stack on the new VLAN a second time. LLDP-MED is the preferred method to enable VLAN

tagging.
The complete Option 156 syntax including VLAN tagging is:

vl an=<nunber >, | ayer 2t aggi ng=<0| 1>, confi gserver s=<I P address>, ft pservers=<IP
address>

Specify the parameters in any order, separating multiple parameters with a comma. Not all parameters
are required. When providing multiple values for one parameter, use quotation marks around the comma-
separated values. For example:

configServers="192.168. 0. 13, joe.test.coni, vl an=2

If DHCP option tag 156 is not used, DHCP option tag 66 is used. The following parameters are specified
in the site-specific options for option tag 66:

o tftpServers
e ftpServers

Note:

400-Series IP phones use HTTP to download their configuration files from the servers specified in DHCP
option tag 156.
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Specifying Config Parameters through Custom Config Files

The following table lists the configuration file names for the 400-Series IP phones. These files are stored
in the phone configuration directory created on the server when your Mitel system is installed. The default
directory for these configuration files is as follows:

<Drive>:\inet pub\ftproot\phoneconfig

Table 22: 400-Series IP Phone Model Configuration Files

IP Phone Model Custom Configuration Model-Specific Custom
File Name for All 400- Configuration File Name
Series IP Phones for 400-Series IP Phones
IP420 custom.txt custom_|P420.txt
IP480 custom.txt custom_|P480.txt
IP480g custom.txt custom_|P480g.txt
IP485¢g custom.txt custom_[|P485g.txt

Processing Order for Configuration Files
Configuration files are processed in the following order:

e country_| SO>. t xt, where ISO> is a two-character ISO country code (For example, the file for the
United States is country_US.txt.)

Do not edit these files. These files specify country-specific settings such as date/time formats.
° generated.txt

Do not edit this file, because it is generated by the server and any changes would be overridden the
next time the server generates the file. This file contains a list of voice switches for the phone and the
default httpResources parameter setting, which specifies the default server path for wallpaper and
ringtones. The server regenerates this file whenever the list of switches is updated.

e customtxt

This is the base custom configuration file for all 400-Series IP phones. Any configuration parameters
that you add to this file are applied to all 400-Series IP phones in your system.

e custom phone_nodel >. t xt (where phone_model> is IP420, IP480, IP480g, or IP4859)

This is the custom configuration file for a particular model of 400-Series IP phone. Any configuration
parameters that you add to this file are applied to all phones of that model at your site.

e custom MAC address>.t xt (where MAC address> is the MAC address of a phone)

This is the custom configuration file for a particular phone as identified by its MAC address (the 12-digit
number on the white sticker on the back of the phone). Any configuration parameters that you add to
this file will be applied to the phone identified by the MAC address.

Note:

- File names for MAC configuration files must be in lower case and not contain punctuation.
- The following is an example of a custom configuration file name for a particular phone identified
by its MAC address: cust om 00104928630b. t xt

The phone-specific custom configuration file is the last file read. Any parameters in a custom
configuration file override configuration parameters specified at a lower level of precedence, including the
parameters entered on the phone, because they are processed first, before any configuration files are
read. Any duplicate parameters specified in the configuration files are overridden according to their own
precedence order.

Parameters are organized by group, and each parameter must begin on a new line within the proper
group, as follows:

[group>]
parameter>=value>

parameter>=value>
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[group>]
parameter>=value>
parameter>=value>
where

[group>] is the configuration parameter group as shown in Table 24: Configuration Parameters on page
98.

value> is the name of the configuration parameter as shown in Table 24: Configuration Parameters on
page 98.

In specifying parameters, the following rules apply:

¢ |P addresses must be provided in dotted-decimal format.

e Parameters and values in configuration files are case sensitive.

e Cases are preserved in character strings unless otherwise indicated.

e Comments may be embedded in a configuration file by starting the comment line with a #.

* If a parameter value is formatted incorrectly or is outside the range of valid entries, the phone skips the
value and moves to the next parameter. Errors are not logged in these cases.

Example of a Custom Configuration File

Assume that you want to configure the following custom settings on all of the 400-Series IP phones at
your site:

» Specify a dedicated server other than the Headquarters server for ringtones and wallpaper (through
the httpResources parameter)

* Specify a path where diagnostic log and capture files from the phones should be uploaded

¢ Use custom power settings as follows:

- The phone screens return to partial brightness at 07:00 rather than the default of 06:00.

- The phone screens enter sleep state (completely blank or dark) at 20:00 rather than the default of
19:00.

- This schedule applies to the phone displays on weekdays and Saturdays, rather than the default of
just weekdays.

To implement these custom configuration settings, you would add the following lines to cust om t xt ,
which is the custom configuration file that applies to all models of 400-Series phones:

[systen
ht t pResour ces=http://10.53.53.53/fil eserver
di agnosti cServers=ftp://10.11. 12. 500/ phonedi agfil es

[ power]

sl eepl nhi bi t Start Ti ne=07: 00

sl eepl nhi bi t St opTi me=20: 00

sl eepl nhi bi t Days=Mon, Tue, Wd, Thu, Fri, Sat

Receiving Configuration Settings from a Switch

After the configuration files are processed and the phones register with the system, they are
automatically provided with the configuration information related to the system, their site, and the user
assigned to the phone. This configuration information, which is specified in Connect Director and the
Connect client,;overrides settings specified in configuration files. As changes are made in Connect
Director or the Connect client,;these parameters are automatically kept up to date on the phones,
whereas the configuration file values are provided only when the phone boots.
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Configuration Parameters

Configuration Parameterslists the configuration parameters. The abbreviations listed in Source File
Abbreviationsidentify the source of each parameter in the Source column in Configuration Parameters.

When adjusting values for any of the parameters in the [audiohaldm] group, keep in mind that analog
gain and digital gain are cumulative values. To determine the total gain, add the analog gain and digital
gain values. Be aware that increasing the gain level can cause echo in the network or distortion for users
at either end. This distortion might be apparent only when one of the talkers is speaking loudly or close to
the microphone.

Note:

This section contains detailed information that can be used to modify the behavior and functionality of
your Mitel system. Make sure that you understand what you are doing before attempting to use this
information to modify your system. Mitel is not responsible for any damage or expenses incurred through
misuse of this information. If you have questions, contact Mitel Technical Support before attempting to
modify your system.

Table 23: Source File Abbreviations

Source Abbreviation in Table
DHCP Site Specific Option DHCP
Configuration File CFG
Manual Entry Using SETUP Phone
Configuration Setting from the Voice Switch SIP

Table 24: Configuration Parameters

Group Parameter Value Format Description Source
and Default
[audio] enableHacMode on or off Enable or disable hearing aid CFG

compatibility (HAC)
Default: off

[audiohaldm] The handset microphone analog |CFG

gains.p2.handsetMicApalagfaincal gain level for the IP420

value between
12 (louder) and 0
(quieter). Values
must be divisible
by 3.

Default: 6

. ; - The handset microphone analog |CFG
gains.p8.handsetMicAnalogeirical gain level for the IP480 and

value between iP480g
12 (louder) and 0
(quieter). Values
must be divisible
by 3.

Default: 6

[audiohaldm]

[audiohaldm] The handset microphone analog |CFG

gains.p8cg.handsetMi¢A numerical gain level for the IP485g

AnalogGain value between
12 (louder) and 0
(quieter). Values
must be divisible
by 3.

Default: 6
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Group Parameter Value Format Description Source
and Default

[audiohaldm] The handset microphone digital CFG

gains.p2.handsetMicDjditalimerical value gain level for the IP420

Gain between 9 (loud)
and -3 (soft).
Values must be
divisible by 3.

Default: 3

[audiohaldm] The handset microphone digital CFG

gains.p8.handsetMicDjditalmerical value gain level for the IP480 and
Gain between 9 (louder) IP480g

and -3 (quieter).
Values must be
divisible by 3.

Default: 3

[audiohaldm] CFG

gains.p8cg.handsetMicA numerical value | The handset microphone digital
DigitalGain between 9 (louder) | gain level for the IP485¢g

and -3 (quieter).
Values must be
divisible by 3.

Default: 3

[audiohaldm] The handset speaker analog gain | CFG

gains.p2.handsetSpegk&mumerical level for the IP420

AnalogGain value between -6
(louder) and -18

(quieter). Values
must be divisible
by 3.

Default: -12

[audiohaldm] The handset speaker analog gain | CFG

gains.p8.handsetSpegk&mumerical level for the IP480 and IP480g

AnalogGain value between -6
(louder) and -18

(quieter). Values
must be divisible
by 3.

Default: -12

[audiohaldm] A kenAeaicg Gain The handset speaker analog gain | CFG

gains.p8cg.handsetSp level for the IP485¢g

value between -6
(louder) and -18

(quieter). Values
must be divisible
by 3.

Default: -12

[audiohaldm] The handset speaker digital gain | CFG

gains.p2.handsetSpegktmumerical value level for the IP420

DitgitalGain between 6 (louder)
and -6 (quieter).
Values must be
divisible by 3.

Default: 0
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Group

Parameter

Value Format
and Default

Description

Source

[audiohaldm]

gains.p8.handsetSpeq

DigitalGain

k&mumerical value
between 6 (louder)
and -6 (quieter).
Values must be
divisible by 3.

Default: 0

The handset speaker digital gain
level for the IP480 and IP480g

CFG

[audiohaldm]

gains.p8cg.handsetSp

s kenD gicdGedtue
between 6 (louder)
and -6 (quieter).
Values must be
divisible by 3.

Default: 0

The handset speaker digital gain
level for the IP485g

CFG

[audiohaldm]

gains.p2.headsetMicAl

nalog@aincal
value between
18 (louder) and 6
(quieter). Values
must be divisible
by 3.

Default: 12

The headset microphone analog
gain level for the IP420

CFG

[audiohaldm]

gains.p8.headsetMicAl

nalog@aincal
value between
18 (louder) and 6
(quieter). Values
must be divisible
by 3.

Default: 12

The headset microphone analog
gain level for the IP480 and
IP480g

CFG

[audiohaldm]

gains.p8cg.headsetMi

AnalogGain

CA numerical
value between
18 (louder) and 6
(quieter). Values
must be divisible
by 3.

Default: 12

The headset microphone analog
gain level for the IP485g

CFG

[audiohaldm]

gains.p2.headsetMicD

Gain

igitalmerical value
between 9 (louder)
and -3 (quieter).
Values must be
divisible by 3.

Default: 3

The headset microphone digital
gain level for the IP420

CFG

[audiohaldm]

gains.p8.headsetMicD

Gain

igitalimerical value
between 9 (louder)
and -3 (quieter).
Values must be
divisible by 3.

Default: 3

The headset microphone digital
gain level for the IP480 and
IP480g

CFG
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Group

Parameter

Value Format
and Default

Description

Source

[audiohaldm]

gains.p8cg.headsetMi

DigitalGain

CA numerical value
between 9 (louder)
and -3 (quieter).
Values must be
divisible by 3.

Default: 3

The headset microphone digital
gain level for the 1P485¢g

CFG

[audiohaldm]

gains.p2.headsetSped

AnalogGain

k&mumerical
value between -6
(louder) and -18
(quieter). Values
must be divisible
by 3.

Default: -12

The headset speaker analog gain
level for the IP420

CFG

[audiohaldm]

gains.p8.headsetSpes

AnalogGain

k&mumerical
value between -6
(louder) and -18
(quieter). Values
must be divisible
by 3.

Default: -12

The headset speaker analog gain
level for the IP480 and IP480g

CFG

[audiohaldm]

gains.p8cg.headsetSp

oA kenfesicg Gain
value between -6
(louder) and -18

(quieter). Values

must be divisible
by 3.

Default: -12

The headset speaker analog gain
level for the 1P485¢g

CFG

[audiohaldm]

gains.p2.headsetSpes

DigitalGain

k&smumerical value
between 6 (louder)
and -6 (quieter).
Values must be
divisible by 3.

Default: 0

The headset speaker digital gain
level for the IP420

CFG

[audiohaldm]

gains.p8.headsetSped

DigitalGain

k&emumerical value
between 6 (louder)
and -6 (quieter).
Values must be
divisible by 3.

Default: 0

The headset speaker digital gain
level for the IP480 and IP480g

CFG

[audiohaldm]

gains.p8cg.headsetSp

oA kenD gicdOatue
between 6 (louder)
and -6 (quieter).
Values must be
divisible by 3.

Default: 0

The headset speaker digital gain
level for the 1P485¢g

CFG
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Group Parameter Value Format Description Source
and Default
[audiohaldm] 4 4ins p2 side ToneGaidenhumerical value | The handset/headsetsidetone CFG
between -9 (very level for the 1P420
IouQ) and -33 Sidetone refers to the level at
(quiet). Values . : .
L which you hear your voice while
must be divisible AU
speaking into a handset.
by 3.
Default: -24
[audiohaldm] 4ains p8.sideToneGaimdehumerical value | The handset/headset sidetone CFG
between -9 (very level for the IP480 and 1P480g
Ioud) and -33 Sidetone refers to the level at
(quiet). Values . . :
L which you hear your voice while
must be divisible AU
speaking into a handset.
by 3.
Default: -24
[audiohaldm] 4ains p8cg.sideToneGatndBmerical value | The handset/headsetsidetone CFG
between -9 (very level for the 1IP485¢g
Ioud) and -33 Sidetone refers to the level at
(quiet). Values . . ;
L which you hear your voice while
must be divisible AU
speaking into a handset.
by 3.
Default: -24
[headsetct]] | headsetcti On or Off This setting enables a user to use | CFG
Default: Off thle elect-ronlc hook switch feature Phone
with a wireless headset that uses
the Plantronics APD-80 adapter
cable.
If you want to enable this feature
for a user of the IP420 or IP420g
phone models, in Connect
Director you must also set the
Users > Users > Telephony >
Automatic off-hook option to
Wireless headset.
Note:
On the IP420 and IP420g
models, this feature can
be enabled only through a
configuration file. On the 1P480,
IP480g, and IP485g models,
administrators can enable the
feature through a configuration
file or end users can set the
APDB80 option through the
phone interface (Options >
Headset type> APD80), as
described in the phone user
guides.
[net] dot1XEnable On or Off Enable or disable 802.1x network | oG
Default: On Phone
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Group Parameter Value Format Description Source
and Default
[net] dnsAddress Comma-separated | The default list of static DNS DHCP
list of IP addresses | servers
CFG
Phone
[net] ntpServerAddress Comma-separated | The default list of Network Time DHCP
list of IP addresses | Protocol servers
CFG
Phone
[net] policyCache On or Off Enable or disable caching of CFG
LLDP-MED network policy on the
Default: On phone
[power] idleBrightness A number between | 1he intensity of the phone CFG
1 and 100. which backlight when the phone is in the
Tan » WHIC idle state
indicates a
percentage
Default: 5
[power] idleTimeout A number that The number of minutes without | ¢FG
indicates minutes | phone activity (key presses or
Default: 5 calls) that elapse before the
) phone transitions to the idle state,
which dims the backlight.
A value of 0 means that the
phone never goes into the idle
state.
[power] sleepTimeout A number that The number of minutes without | ©FG
indicates minutes | phone activity (calls or key
. presses) that elapse before
Default: 60 the phone transitions to the
sleep state, which dims the
backlight and lowers power usage
depending on the settings for
the sleepEthernetLowPower and
sleepUsbSuspend parameters. A
value of 0 means that the phone
never goes into the sleep state.
The value specified for the
sleepTimeout parameter is in
effect outside the hours specified
by the sleeplnhibitStartTime and
sleeplnhibitStopTime parameters.
[power] sleepEthernetLowPowedn or off Whether or not the phone CFG
reduces Ethernet power when the
Default: on phone is in a sleep state. If off,

Ethernet power is not reduced.
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Group Parameter Value Format Description Source
and Default
[power] sleepUsbSuspend On or off Whether or not the phone CFG
supplies power to USB devices
Default: on plugged into the USB port on
the phone (on IP485g) when
the phone is in a sleep state. If
off, power to USB devices is not
suspended when the phone is in
a sleep state
[power] sleeplnhibitStartTime | A four-digit time on | The time of day when the phone | CFG
24-h lock display goes from the sleep state
a z4-hour cloc to an idle state. This typically
Default: 06:00 corresponds to the start of normal
B business hours at your site.
During the hours when the sleep
state is inhibited, the phone can
go into an idle state, but it cannot
go into a sleep state.
[power] sleeplnhibitStopTime | A four-digit time on | /e time of day when the phone | CFG
24-hour clock transitions to the sleep state, in
a which the display turns blank or
Default: 19:00 dark and other configured power-
o saving measures take effect. This
typically corresponds to the end
of normal business hours at your
site.
[power] s _ The days of the week when CFG
sleeplnhibitDays Fc:m;nat)sepgr?ted the sleeplnhibitStartTime and
ISt o abbrevialions | gleep|nhibitStopTime parameters
for days of the are in effect
week. Other valid
values are “none”
and “all”.
Default: Mon, Tue,
Wed, Thu, Fri
[syscontrol] | 4; ; The maximum intensity of the CFG
displayBrightnessMax ?\ nugw?g(; beLv_vehen phone backlight when the phone
Tan » Whic is not in an idle or sleep state
indicates a
percentage
Default: 100
[system] diagnosticServers A comma- Specifies where log and capture | CFC
separated list of IP | files generated by the phones are
addresses or full uploaded through FTP
URL paths The phone cycles through the list
No default. of specified servers until it finds a
server it can connect to.
[system] enableSpeakerPhone | On or off Specifies whether the CFG
speakerphone is enabled. If off,
Default: on only the handset or a headset

may be used.
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Group Parameter Value Format Description Source
and Default
[system] httpResources An IP address or | The IP address or full URL CFG
full URL path path for a dedicated server that
Def aul t : contains cu_stom ringtone and
<Headquart er s wallpaper files.
server/ Typically, / fi | eser ver . points
fileserver to the installation directory for
the phone configuration files.
By default, this is <Dr i ve>:
\'i net pub\ ftproot\
system ; : A comma- The configuration server with
oy ] overrideConfigServers separated list of IP | the highegt precedence. This CFG
addresses or full configuration server overrides the | Phone
URL paths configuration server specified in
DHCP option tag 156.
[system] remoteSyslogger A server address | The address of the computer CFG
. . running the syslog server
in the following application.
format:
<| P_address or
DNS_name>: port _|nunber ; pr ot ocol
The protocol is
either tcp or udp.
The protocol and
port number are
optional. If not
specified, the
default port is 514
and the default
protocol is udp.
[user] apd80Selected apd80Selected=true| This setting configures the CFG
or false. Headset Type on the 400-Series SIP
Default is IP phone to be APD80. This is for
| users who have the Plantronics Phone

apd80Selected=fals

"APD-80 adapter cable and need
the APD80 option enabled.

In Connect Director, using the
following path, you must set the
Automatic off-hook preference
option to Wireless headset:

Administration > Users >
Users > Class of Service >
Telephony tab > Automatic off-
hook preference
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Group Parameter Value Format Description Source
and Default
[user] headsetType One of the The default headset type CFG
following values: Note: sIP
* wired SIP overrides the headset Phone
* wireless

setting specified in a

Default: wired configuration file with the user's
headset preference configured
in Connect Director. Users

can change the headset type
on the 1P480, 1P480g, IP485¢g
phones. For information about
automatic off-hook and headset
type settings, see the MiVoice
Connect System Administration

Guide.
[user] timezone The time zone, The time zone for the time CFG
tsepxetmﬂed in plain displayed on the phone Phone
The time zone specified overrides
Default: Pacific the time zone value provided by
Standard Time the switch.

Setting up an Alternate Configuration Server

If any of the default network configuration settings on the phone are not appropriate for your production
network, to save time you might want to stage phones by using a custom configuration file on an
alternate configuration server and network rather than manually changing the setting on each phone. To
do this, you need to configure the phones using this method before connecting the phones to the Mitel
system on the production network.

1. Set up a Web server that is appropriate for your operating system (such as IIS on a Windows server
or Apache on a Linux server).
Note:

For details on setting up a Web server, consult the documentation for your operating system.
When setting up a Web server for this purpose, it is generally appropriate to accept the default
settings (such as using port 80 for an HTTP server) and permissions. For details about port
usage, see Port Usage Tables on page 242.
2. On the Web server, create the following virtual directory where the custom configuration file will
reside:

<ht t pr oot >/ phoneconfi g/

3. Create the custom configuration file (for example, cust om t xt ) with the parameter setting
appropriate for your purpose, and store it in the directory created in the previous step. (For details
about creating custom configuration files, see Configuring 400-Series IP Phones on page 89.)

4. On the staging network, use DHCP option tag 156 or 66 to configure the ftpServers or configServers
parameter to specify the Web server where the custom configuration file resides.

Note:

If you do not use DHCP to provide the configuration server value, you must enter the value
manually on each phone.
5. Connect the phones to the staging network.

Phones boot up and download the custom configuration file from the Web server. Because the
phones have downloaded only configuration information and not switch information, the phones
display a No Service message.

6. Connect the phones to the production network. (The configuration server value can be provided
through DHCP option tag 156 or 66 or specified manually on each phone.)

Phones boot up normally.
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Migrating Phones Between Systems

The 400-Series phones were designed to be extremely secure and immune from compromise through
the network. The first time a 400-Series phone is powered on and configured, it downloads the “UC
Certificate Authority” certificate from the Headquarters Server and remembers it. After that, the phone
connects only to services (SIPS, HTTPS) that provide certificates signed by that certificate authority or
certificates signed by public certificate authorities.

If you need to move some or all 400-Series IP phones from one system to another and using MUTE
CLEAR# on each phone would be burdensome, you can use the procedure described in this section.

While it is possible to move phones from one system to another, it is not possible to maintain the user
binding for those phones. After moving the phones, an administrator can assign the phones to users
through Connect Director, or users can assign themselves using the phone interface.

In the following procedure, the phones are being migrated from System A to System B.
Note:

Any 400-Series phones that are not operational during this process will not be able to reconnect to the
system. For this reason, do not attempt this process during an upgrade or other down time.

1. Verify that System B has sufficient IP phone capacity for the phones that will be moved from System
A
2. Replace the UC Certificate Authority certificate/key on System A with the certificate/key from System

B as follows:

a. Ensure that System A is fully operational before attempting to replace the UC Certificate
Authority.

b. On System A, make a backup copy of the <dri ve>: \ Shor el i ne Dat a\ keyst or e directory.
Note:

You can accomplish this by doing a simple copy and paste using Windows Explorer.
c. Copy the following private key and certificate files from System B and replace them in the same
path on System A:

<drive>:\Shoreline Data\keystore\private\hg_ca. key

<drive>:\Shoreline Data\keystore\certs\hqg_ca.crt
3. On System A, using either Windows Task Manager or Connect Director (Maintenance > Status and
Maintenance > Servers) stop and restart the WebFrameworkSvc service.

This service detects the certificate change and performs the necessary steps to regenerate and
install the appropriate certificates throughout the system. This might take a few minutes.

4. Phones get their “Config Server” value through DHCP or by being entered directly on the phone,
which is referred to as static configuration. Depending on your existing configuration for System A
and System B, follow the instructions in the appropriate section below:

* If the phones that you want to move are isolated to a subnet such that DHCP parameters pointing
to the configuration server for System A can be modified, then follow the steps in If Both Systems
Get Config Server Value from DHCP.

 [f the phones on System A are already using a static configuration or if you wish to move a subset
of phones from System A to System B, but do not want to modify DHCP, then follow the steps in If
Config Server Is from DHCP or Static for System A and Static for System B.

Note:

After a Phone has a static configuration, it is difficult to remove that configuration.

If Both Systems Get Config Server Value from DHCP

1. Modify your DHCP server to point to the IP address for System B by using the procedure in MiVoice
Connect Planning and Installation Guide > Network Requirements and Preparation > Configuring
DHCRP for IP Phones.

2. Use the following procedure to reboot the phones you want to move:

a. Launch Connect Director on System A, and in the navigation pane and click Maintenance >
Status and Maintenance > IP Phones. The IP Phones page is displayed.
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b. Select the phones you want to move, and then select the Reboot command from the Command
drop-down list and click Apply.
c. In the Confirmation dialog, click OK.

The selected phones reboot and get the new Config Server value for System B from DHCP and
bind to System B.
3. Verify that the phones are in service on System B by checking the Maintenance > Status and
Maintenance > IP Phones page in Connect Director.
4. On System A, delete the moved phones as follows:

a. Launch Connect Director on System A, and in the navigation pane click Administration >
Telephones > Telephones. The Telephones page is displayed.
b. Select the phones you want to delete, and then click Delete.
c. In the Confirmation dialog, click OK.The system deletes the selected phones.
5. Do one of the following:

* If you plan to continue using System A and want it to have a certificate different from System B,
restore System A’s original certificate and private key:

a. From the backup copy you made of System A’'s <dri ve>: \ Shor el i ne Dat a\ keystore
directory, replace the private key and certificate files in the same path on Server A:

<drive>:\Shoreline Data\keystore\private\hqg_ca. key

<drive>:\Shoreline Data\keystore\certs\hqg_ca.crt
b. On System A, using either Windows Task Manager or Connect Director (Maintenance >
Status and Maintenance > Servers), stop and restart the WebFrameworkSvc service.

This service detects the certificate change and performs the necessary steps to regenerate
and install the appropriate certificates throughout the system. This might take a few minutes.
* [f you plan to leave the changed certificate on System A and you have a Mobility Router in your
system, reboot the Mobility Router.

If Config Server Is from DHCP or Static for System A and B

1. On System A, edit the <dri ve>: \i net pub\ f t proot\ phoneconfi g\ customtxt fil e toadd
the following lines, and then save and close the file:

[systen
overri deConfi gServers=<|P address of System B Headquarters server>
Note:

When specifying the configuration server, be sure to use the IP address of your System B
Headquarters server.
2. Use the following procedure to reboot the phones you want to move:

a. Launch Connect Director on System A, and in the navigation pane click Maintenance > Status
and Maintenance > IP Phones. The IP Phones page is displayed.

b. Select the phones you want to move, and then select the Reboot command from the Command
drop-down list and click Apply.

c. In the Confirmation dialog, click OK.

The selected phones download the new configuration setting. (However, the new configuration
server is not applied until the phone is rebooted again.)
3. When the rebooted phones are back in service, reboot the phones again.

The phones now honor their static configuration and bind to System B.

4. Verify that the phones are in service on System B by checking the Maintenance > Status and
Maintenance > P Phonesl page in Connect Director.

5. On System A, delete the moved phones as follows:

a. Launch Connect Director on System A, and in the navigation pane click Administration >
Telephones > Telephones. The Telephones page is displayed.
b. Select the phones you want to delete, and then click Delete.
c. In the Confirmation dialog, click OK. The system deletes the selected phones.
6. On System A, remove the lines added in Step 1 from your cust om t xt file.

108



CONFIGURING AND MAINTAINING 400-SERIES IP PHONES

7. Do one of the following:

* If you plan to continue using System A and want it to have a certificate different from System B,
restore System A’s original certificate and private key:

a. From the backup copy you made of System A’'s <dri ve>: \ Shor el i ne Dat a\ keystore
directory, replace the private key and certificate files in the same path on Server A:

<drive>:\Shoreline Data\keystore\private\hqg_ca. key

<drive>:\Shoreline Data\keystore\certs\hqg_ca.crt
b. On System A, using either Windows Task Manager or Connect Director (Maintenance >
Status and Maintenance > Servers), stop and restart the WebFrameworkSvc service.

This service detects the certificate change and performs the necessary steps to regenerate
and install the appropriate certificates throughout the system. This might take a few minutes.

* [f you plan to leave the changed certificate on System A and you have a Mobility Router in your
system, reboot the Mobility Router.

Viewing IP Phone and BB424 Diagnostic Information

You can view diagnostic information about the 400-Series IP phones and BB424s in your system by
using Connect Director.

You can view diagnostic information for a specific phone through that phone’s user interface.

Viewing IP Phones and BB424s in the Mitel System
You can view information about the IP phones and BB424s in your Mitel system in the following ways:
* To check the status of IP phones and button boxes in your system, use one of the following methods:

- To use the Diagnostics and Monitoring system in Connect Director to view the IP Phones status
page, click Maintenance > Status and Maintenance > IP Phones.

- To use Connect Director to view the IP Phones page, click Administration > Telephones >
Telephones.

* To view the number of IP phones connected through a switch and the switch’s phone configuration
capacity, check the switch configuration information in Connect Director. Click Administration >
Appliances/Servers > Platform Equipment and select the particular switch.

For details about viewing IP phone information, see the MiVoice Connect System Administration Guide.

Viewing Diagnostic Information on a Phone

By pressing a key combination on a phone’s key pad, you can access various types of diagnostic
information for a phone.

Viewing Real-Time System Status on a Phone
You can see the following real-time system status information for a phone:

e CPU load
* Memory usage
* Percentage of storage space used

1. With the phone on hook, press the MUTE key followed by 3424# (DIAG#). The Diagnostics menu
opens.
2. With the System submenu highlighted, do one of the following:

* On the IP420, press the selector button on the navigation key pad.

¢ On the IP480, IP480g, and IP485g, press the Open soft key or press the selector button on the
navigation key pad.

Details for CPU load, memory usage, and storage space are displayed.
3. To return to the Diagnostics menu, do one of the following:

¢ On the IP420, press the selector button on the navigation key pad.
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* On the IP480, IP480g, and IP485g, press the Back soft key or press the selector button on the
navigation key pad.
4. To exit, do one of the following:

* On the IP420, scroll to the bottom of the Diagnostics menu to select the Exit option and then press
the selector button on the navigation key pad.

* On the IP480, IP480g, and IP485g, press the Exit soft key or press the selector button on the
navigation key pad.

Using Ping to Check the Status of an IP Address

1. With the phone on hook, press the MUTE key followed by 3424# (DIAG#). The Diagnostics menu
opens.

2. Use the navigation key pad to scroll to the Ping submenu.

3. With the Ping submenu highlighted, do one of the following:

* On the IP420, press the selector button on the navigation key pad.

¢ On the IP480, IP480g, and IP485g, press the Open soft key or press the selector button on the
navigation key pad.

The Ping screen is displayed.
Note:

To proceed directly to the Ping screen, press the MUTE key followed by 7464# (PING#).
4. Use the numbers or letters on the key pad to enter an IP address. On an 1P480, IP480g, or IP485¢,
you also have the option of entering a DNS name.
Note:

¢ Press the * key to insert a period in an IP address or DNS name.
¢ On the IP420, press the speakerphone button to backspace. To proceed with the value you have
entered, press #.
5. Do one of the following:

¢ On the IP420, press #.

* On the IP480, IP480g, and IP485g, press the Start soft key or press the selector button on the
navigation key pad.

The phone pings the IP address or DNS server five times, and then reports the ping statistics.
6. To return to the Diagnostics menu, do one of the following:

* On the IP420, press #.
¢ On the IP480, IP480g, and IP485g, press the Back soft key or press the selector button on the
navigation key pad.
7. To exit, do one of the following:

¢ On the IP420, scroll to the bottom of the Diagnostics menu to select the Exit option and then press
the selector button on the navigation key pad.

¢ On the IP480, IP480g, and IP485g, press the Exit soft key or press the selector button on the
navigation key pad.

Using Traceroute to Determine the Network Route to a Host

1. With the phone on hook, press the MUTE key followed by 3424# (DIAG#). The Diagnostics menu
opens.

2. Use the navigation key pad to scroll to the Traceroute submenu.

3. With the Traceroute submenu highlighted, do one of the following:

¢ On the IP420, press the selector button on the navigation key pad.

¢ On the IP480, IP480g, and IP485g, press the Open soft key or press the selector button on the
navigation key pad.

The Traceroute screen is displayed.
4. Use the key pad to enter an IP address. On an IP480, IP480g, or IP485g, you can also enter a DNS
name.
Note:
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* Press the * key to insert a period in an IP address or DNS name. In non-numeric mode (which is
set through the left soft key), press the * key repeatedly to insert other symbols such as /: @.
* On the IP420, press the speakerphone button to backspace. To proceed with the value you have
entered, press #.
5. Do one of the following:

* On the IP420, press #.

¢ On the IP480, IP480g, and IP485g, press the Start soft key or press the selector button on the
navigation key pad.

The phone displays the network route for the IP address or DNS server.
6. To return to the Diagnostics menu, do one of the following:

¢ On the IP420, press #.
¢ On the IP480, IP480g, and IP485g, press the Back soft key or press the selector button on the
navigation key pad.
7. To exit, do one of the following:

¢ On the IP420, scroll to the bottom of the Diagnostics menu to select the Exit option and then press
the selector button on the navigation key pad.

* On the IP480, IP480g, and IP485q, press the Exit soft key or press the selector button on the
navigation key pad.

Capturing Packets for Phone Network Traffic

To diagnose problems on a phone, you might need to capture packets to see details about network traffic
to and from the phone. You can capture packets by using the phone interface, which is described here,
or you can initiate packet capture and view the results (using Wireshark or a similar network protocol
analysis tool) through the Diagnostics Monitoring system. For details, see the MiVoice Connect System
Administration Guide.

On the 400-Series IP phones signaling packets are encrypted, and packet capture tools available on the
network cannot decrypt these packets. However, using the packet capture tool built into the phone, both
the encrypted and decrypted versions of the packets are displayed.

The packet capture can run for up to two hours or until the resulting .pcap file reaches 70 MB.

If you specify a location through the diagnosticServers configuration parameter, packet capture (.pcap)
files are uploaded to that location. (For details, see Table 24: Configuration Parameters on page 98.) If
your installation does not have a di agnosti cSer ver s path configured, by default the . pcap files from
the capture operation are uploaded to the following directory on the Headquarters server:

<Drive>:\inetpub\ftproot (orthe default FTP location on the server)

However, unless this directory allows anonymous write access (which is not recommended), uploading
the capture file to this directory will fail.

Uploaded packet capture files are named as follows:
<Phone MAC address>_YYYYMVDD HHWESS. pcap
Where:

YYYYMVDD is the date (four-digit year, two-digit month, and two-digit day) when the . pcap file was
created on the phone.

HHWVEBS is the time (two-digit hour, two-digit minute, and two-digit second) when the . pcap file was
created on the phone.

The results of a packet capture operation are also accessible through the phone interface until you start a
new packet capture operation.

1. With the phone on hook, press the MUTE key followed by 73887# ( SETUP#). The Password prompt
opens.

Enter the admin password, and press the OK soft key.

Use the navigation key pad to scroll to the Diagnostics submenu, and press the Open soft key.

Use the navigation key pad to scroll to the Capture submenu.

With the Capture submenu highlighted, do one of the following:

abrobn
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* On the IP420, press the selector button on the navigation key pad.

* On the IP480, IP480g, and IP485g, press the Open soft key or press the selector button on the
navigation key pad.

The Capture screen is displayed.
6. Do one of the following:

¢ On the IP420, with Start highlighted, press the selector button on the navigation key pad.
¢ On the IP480, IP480g, and IP485g, press the Start soft key.

The phone starts capturing packets. On the IP480, IP480g, and IP485g, you can see captured
packet information on the phone display. You can drill down to get details about a packet by
pressing the Details soft key.

Note:

While the packet capture operation is running, you can exit the Admin options menu and
perform the problematic phone operation so that packets for that particular operation can be
captured and used to diagnose the problem. After running the problematic scenario, return
to the Capture page using steps 1-5 in this procedure and then proceed with step 7 to stop
the packet capture operation.

7. To stop the capture process, do one of the following:

¢ On the IP420, with Stop highlighted, press the selector button on the navigation key pad.
¢ On the IP480, IP480g, and IP485g, press the Stop soft key.

8. Optionally, on the 1P480, IP480g, and 1P485g, before or after you stop the capture process you can
filter the results by protocol or IP address:

* To filter by protocol, enter the protocol in the filter box. (For example, enter SIP.)
» To filter by IP address, in the filter box enter i p. addr ==<I P_addr ess>.

Note:

* To enter a period in an IP address, press the * key.
* To enter the = symbol, while in either uppercase or lowercase alphanumeric entry mode, press
the * key several times to move through various symbols until the = symbol is displayed.
* You can change the entry mode by pressing the soft key on the left.
9. Optionally, to see the contents of a packet on the IP480, IP480g, or IP485g, press the Details soft
key.
10. Toyupload the captured packet information, do one of the following:

¢ On the IP420, with Upload highlighted, press the selector button on the navigation key pad. After
receiving a message about the upload process, press # to continue.
¢ On the IP480, IP480g, and IP485g, press the Upload soft key. The phone returns a message to let
you know whether the upload operation succeeded.
11. To return to the Diagnostics menu, do one of the following:

¢ On the IP420, with Back highlighted press the selector button on the navigation key pad.
* On the IP480, IP480g, and IP485g, press the Back soft key or press the selector button on the
navigation key pad.
12. To exit, do one of the following:

* On the IP420, scroll to the bottom of the Diagnostics menu to select the Exit option and then press
the selector button on the navigation key pad.

* On the IP480, IP480g, and IP485g, press the Exit soft key or press the selector button on the
navigation key pad.

Clearing a Phone’s Configuration

To return a phone to the factory settings, you can clear the phone’s configuration through the Diagnostics
menu. If you move phones from one Mitel system to another, you need to clear each phone’s
configuration.

You can also clear a phone’s configuration by using MUTE 25327# (CLEAR#), which is described in
Clearing a Phone’s Configuration Settings on page 119.
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1. With the phone on hook, press the MUTE key followed by 3424# (DIAG#). The Diagnostics menu
opens.

2. Use the navigation key pad to scroll to the Clear configuration submenu.

3. With the Clear configuration submenu highlighted, do one of the following:

* On the IP420, press the selector button on the navigation key pad.

* On the IP480, IP480g, and IP485g, press the Open soft key or press the selector button on the
navigation key pad.

The Clear configuration screen is displayed.
4. Do one of the following:

¢ On the IP420, with Clear & reboot highlighted, press the selector button on the navigation key
pad.
¢ On the IP480, IP480g, and IP485g, press the Clear soft key.

The phone reboots.

Resetting a Phone
You can reset (reboot) a phone through the Diagnostics menu.
You can also reset a phone by using MUTE ( 73738# RESET#), which is described in .

You can also clear a phone’s configuration by using MUTE 73738# (RESET#), which is described in
Resetting an IP Phone.

1. With the phone on hook, press the MUTE key followed by 3424# (DIAG#). The Diagnostics menu
opens.

2. Use the navigation key pad to scroll to the Reset phone submenu.

3. With the Reset phone submenu highlighted, do one of the following:

¢ On the IP420, press the selector button on the navigation key pad.

¢ On the IP480, IP480g, and IP485g, press the Open soft key or press the selector button on the
navigation key pad.

The Reset phone screen is displayed.
4. Do one of the following:

¢ On the IP420, with Reset highlighted, press the selector button on the navigation key pad.
* On the IP480, IP480g, and IP485g, press the Reset soft key.

The phone reboots.

Uploading a Phone’s Log
If a phone user experiences problems, you or the user might want to upload logs to debug the problem.

If you specify a location through the diagnosticServers configuration parameter, or through the
Diagnostics server item on the phone’s Diagnostics menu, log files are uploaded to that location. (see
Table 24: Configuration Parameters on page 98.) For information about how to specify a diagnostic
server from a phone, see Configuring a Diagnostic Server from the Phone Interface on page 114.)

If your installation does not have a di agnost i cSer ver s path configured, by default the . t gz files from
the capture operation are uploaded to the following directory on the Headquarters server:

If your installation does not have a diagnosticServers path configured,;by default the log files are
uploaded to the following directory on the Headquarters server:

<Drive>:\inetpub\ftproot (orthe default FTP location on the server)

However, unless this directory allows anonymous write access (which is not recommended), uploading
the log files to this directory will fail.

Uploaded log files are named as follows:
<Phone MAC address>_YYYYMVDD_ HHWVSS. t gz
Where:
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YYYYMVDD is the date (four-digit year, two-digit month, and two-digit day) when the . t gz file was created
on the phone.

HHWVEBS is the time (two-digit hour, two-digit minute, and two-digit second) when the . t gz file was
created on the phone.

1. With the phone on hook, press the MUTE key followed by 73887# (SETUP#). The Diagnostics
menu opens.

2. Use the navigation key pad to scroll to the Log upload submenu.

3. With the Log upload submenu highlighted, do one of the following:

* On the IP420, press the selector button on the navigation key pad.

* On the IP480, IP480g, and IP485g, press the Open soft key or press the selector button on the
navigation key pad.

The Log upload screen is displayed.
4. To start the log upload, do one of the following:

* On the IP420, with Start highlighted, press the selector button on the navigation key pad.

¢ On the IP480, IP480g, and IP485g, press the Start soft key.
5. As the log upload is running, do one of the following:

¢ To cancel the log upload after it has started:

- On the IP420, with Stop highlighted, press the selector button on the navigation key pad.
- On the IP480, IP480g, and IP485¢, press the Cancel soft key and then the OK soft key.
* To continue the log upload in the background:

- On the IP420, with Back highlighted press the selector button on the navigation key pad or wait
for the log upload to complete.

- On the IP480, IP480g, and IP485g, press the Back soft key or wait for the log upload to
complete.

The phone displays a message indicating whether the log upload was successful.
6. When the log upload is finished, do one of the following:

* On the IP420, press #.

¢ On the IP480, IP480g, and IP485g, press the OK soft key.
7. To return to the Diagnostics menu, do one of the following:

¢ On the IP420, with Back highlighted press the selector button on the navigation key pad .
¢ On the IP480, IP480g, and IP485g, press the Back soft key or press the selector button on the
navigation key pad.
8. To exit, do one of the following:

¢ On the IP420, scroll to the bottom of the Diagnostics menu to select the Exit option and then press
the selector button on the navigation key pad.

* On the IP480, IP480g, and IP485q, press the Exit soft key or press the selector button on the
navigation key pad.

Configuring a Diagnostic Server from the Phone Interface

1. With the phone on hook, press the MUTE key followed by 3424# (DIAG#). The Diagnostics menu
opens.

2. Use the navigation key pad to scroll to the Diagnostic server submenu.

Press the Edit soft key. The Diagnostic servers screen is displayed.

4. Enter the IP address of a server where phone diagnostic server information will be uploaded, and
then press the Back soft key. (For information about the path, see Uploading a Phone’s Log on page
113.)

d

The Diagnostics menu is displayed.
5. Do one of the following:

* To configure another diagnostic server, repeat steps 3-4.
* To exit, press the Exit soft key.
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Viewing Diagnostic Information for a BB424 Button Box

You can view information about a BB424 device, such as its IP address, its position in a sequence of
BB424 devices, and its MAC address.

1. Press and hold the first and fourth page indicator buttons on the BB424 for three seconds.

The BB424 displays the Info menu with details about the BB424.
2. To advance to the next page of information, press the programmable button to the right of Next.

The second page of the Info menu is displayed.
3. To return the BB424 to normal operation, press the programmable button to the right of Next.

The BB424 exits the Info menu and returns to displaying labels for the programmed buttons.

Diagnostic and Failure Messages for 400-Series IP Phones

Diagnostic failure and error messages for the 400-Series |IP phones are displayed on the phone, in
remote and local syslog output, or both.

You can get more information about the status of a phone by using MUTE 4636# (INFO#) to enter the
Admin options menu. Error conditions are indicated as follows:

On the IP480, IP480g, or IP485g models, scroll to the submenu marked by an & icon, open that
submenu, and with the error highlighted press the Details soft key. In addition, when an error message
(such as “No service”) is displayed on a phone, you can see details about the error by pressing the
Details soft key.

¢ On the IP420,;scroll to the submenu marked by !, press the selector button on the navigation key pad,
and scroll to the menu item marked by 1. The > character indicates that details are available. Press the
selector button to see details about the error condition. Press the selector button again to leave the
error details page.

Note:

Though the Admin options menu displayed when you use MUTE 4636# (INFO#) is similar to the

menu displayed when you use MUTE 73887# (SETUP#), the error indicators (& or ! are not
displayed when you access the Admin options menu through 73887# MUTE (SETUP#).

In addition to messages displayed on the phone, syslog messages of CRITICAL, ALERT, and
EMERGENCY priority levels are sent to a remote syslog server if configured. To configure a remote
syslog server, you must specify a value for the remoteSyslogger configuration parameter. For more
information about configuring the remoteSyslogger parameter, see Table 24: Configuration Parameters
on page 98.

The below describes some of the important diagnostic and failure messages that may be displayed on
400-Series IP phones or in remote syslog output. (Other messages are self-explanatory.) The messages
in the following table are listed in alphabetical order.

Table 25: Error Messages

Message on Phone Message in Message Interpretation and Action
or BB424 Display Remote Syslog

and/or in Details
View of Phone

802.1X user, 802.1X 802.1X 802.1X authentication has failed. Reboot the

password authentication failed | phone. If that does not address the problem,
check the VLAN configuration.

Button box HW Revision There is a hardware version mismatch between

mismatch the phone and the BB424 button box, which

means that the button box and the phone are not
compatible and will not work together.
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Message on Phone Message in Message Interpretation and Action
or BB424 Display Remote Syslog

and/or in Details
View of Phone

Download failed If you have a dedicated server configured for the
httpResources configuration parameter, check the
status of that server. Otherwise, check the status
of the Headquarters server.

Download file missing If you have a dedicated server configured for the
httpResources configuration parameter, check the
status of that server. Otherwise, check the status
of the Headquarters server.

Download server busy If you have a dedicated server configured for the
httpResources configuration parameter, check the
status of that server. Otherwise, check the status
of the Headquarters server.

Error applying hotfixes Confirm that the hotfix is applicable to the current
phone release. If the hotifx is not applicable,
remove it.

Error downloading hotfixes The hotfix could not be obtained from the server.

Ensure that the hotfix specified in the phone
configuration files on the server matches the
hotfix files installed on the server.

Failed to connect to server Check the status of the Headquarters server.

Invalid SNTP time zone In Connect Director, on the Sites page check the
value of the Time Zone parameter.

Log generation failed Reboot the phone and try the log upload again.

Log upload failed Reboot the phone and try the log upload again.

If the diagnosticServers configuration parameter
was used to specify a destination for log and
capture uploads, check thestatus of that server.
Otherwise, check the status of the Headquarters

server.
Maximum allowed number of The phone has detected that there are more
button boxes exceeded than four BB424 button box devices connected

through USB cables.

No compatible host

discovered This message is displayed on the BB424 button

box in the following cases:

e The button box was not able to connect to the
phone.

e There is a hardware version mismatch
between the phone and the BB424.

No config server specified If using DHCP, ensure that a configuration server
is specified in the settings for DHCP option tag
156 and/or option tag 66. If not using DHCP,

use MUTE 73887# (SETUP#) to specify a
configuration server. For details, see Entering
SETUP from the Key Pad on page 95

No download server If you have a server configured for the

configured httpResources configuration parameter, check the
status of that server. Otherwise, check the status
of the Headquarters server.

No download server could be If you have a dedicated server configured for the
reached httpResources configuration parameter, check the
status of that server. Otherwise, check the status
of the Headquarters server.

116



CONFIGURING AND MAINTAINING 400-SERIES IP PHONES

Message on Phone Message in Message Interpretation and Action
or BB424 Display Remote Syslog

and/or in Details
View of Phone

No Service No SIP server found | The phone cannot connect with a SIP switch

in config because no switch is configured. The phone did
not obtain the IP address of a SIP switch from the
configuration files. The most likely cause of this
error is that the configuration server is down.

SIP authorization

. You can obtain details about the error condition
failed

as follows:

* On the IP480, IP480g, or IP485g models,
press the Details soft key.

e On the IP420, the > character indicates that
details are available. Press the selector button
on the navigation key pad, and scroll to the
menu item marked by !. Press the selector
button to see details about the error condition.

No Service SIP bad request If you need more information to resolve the

SIP connection problem, you can perform the following actions in
keep-alive timeout | the following order until the problem is resolved:

SIP connection « Use the Ping or Traceroute tools in the phone’s
timeout Diagnostic menu to check network connectivity
SIP invalid to the voice switch and configuration server.
username » Check the status of the phone’s call control
SIP permission switch. If the switch is down, the phone cannot
denied register with the switch. The problem should

SIP registration resolve when the switch returns to normal

failed operation.

* Check the date and time on the phone’s
display while the phone is idle. If the date

SIP registration

stopped and time are not current, there might be a

SIP server internal problem with certificate verification. Ensure that
error the SNTP server settings are valid, and then
SIP server timeout reboot the phone.

SIP service * Press the Details soft key (on the 1P480,
unavailable IP480g, and 1P4859) or the selector button

- - on the navigation key pad (on the IP420) and
SIP switch failure, select the Services menu. Select the SIP
stale calls will be .
dropped submenu, and monitor the IP address. If the
SIP IP address changes every few seconds,
the phone is actively trying tofind a voice
switch with which to register, which could
indicate a problem. Check the status of the
Headquarters server and the switches.

No Service SIP switch failure, |, |t the switch is operating normally, these
stale calls will be
dropped messages could indicate a problem with the

phone’s configuration. To address the issue, try
rebooting the phone. If that does not address
the problem, use MUTE 25327# (CLEAR#) to
clear the phone’s configuration. For details,
see Clearing a Phone’s Configuration on page
112
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Message on Phone
or BB424 Display

Message in
Remote Syslog
and/or in Details
View of Phone

Message Interpretation and Action

No Ethernet

No Ethernet link
detected

If “No Ethernet” is displayed on the phone while
the phone reboots, you can ignore the message
because it is a normal part of the phone boot-up
process.

If “No Ethernet link detected” is displayed in the
remote syslog output, then there might be an
issue with the Ethernet connection. Check the
network connection and/or reboot the phone.

No upload server configured

If the diagnosticServers configuration parameter
was used to specify a destination for log and
capture uploads, check the status of that server.
Otherwise, check the status of the Headquarters
server.

No upload server could be
reached

If the diagnosticServers configuration parameter
was used to specify a destination for log and
capture uploads, check the status of that server.
Otherwise, check the status of the Headquarters
server.

No valid config server present

The phone has attempted to contact all
configuration servers specified through DHCP
option tags 156 or 66 or set manually through
MUTE 73887# (SETUP#), but no configuration
server is reachable. Check the status of the
configuration server or servers.

Phone application
initialization:
Remotesyslog
diagnostic message

This message is captured in the remote and local
syslog when the phone reboots, regardless of the
reason for the reboot.

for <MAC Address>

Phone crash for An error has occurred, causing the phone to
<MAC Address> automatically reboot.

Phone deadlock An error has occurred, causing the phone to
detected for <MAC | automatically reboot.

Address>

SIP server The phone’s connection to the switch was lost

<|P Address>
connection failure

due to a switch or network issue. For example,
the switch could be down because of a switch

for <MAC Address> | reboot or a switch error condition. Check the
status of the switch and the network.
Unassign user: Operation There was an error during the user unassignment
failed operation.
User assignment: Anyphone The user assignment failed because the server
not allowed sent an “Anyphone not allowed” response. Check
the user’s settings on the Headquarters server.
User assignment: CAS CAS failed to The phone failed to establish a connection to
Connection failure connect

CAS. As a result, no CAS-driven features (such
as History and Directory) are available on the
phone. Check the status of the Headquarters
server.

If you see this message in remote syslog output
during initial bootup, wait several seconds for the
error to clear and try again.
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Message on Phone Message in Message Interpretation and Action
or BB424 Display Remote Syslog

and/or in Details
View of Phone

User assignment: CAS invalid | CAS login failed During an attempt to assign a phone to a user,

login the user extension and/or password provided
were invalid.

User assignment: Permission The user assignment failed because the phone

required received a response from the Headquarters

server indicating that the user does not have
adequate permissions for the operation being
attempted on the phone. Usually, this means that
in Connect Director the user is not configured with
the permissions necessary to execute a particular
operation, such as using VPN and remotely
authenticating with the server.

Displaying Settings for an IP Phone

1. With the phone on hook, press the MUTE key followed by 4636# (INFO#). The Admin Options menu
opens.

2. Use the navigation key pad and the selector button to scroll through and open the submenus as
necessary to see the phone’s settings.

For descriptions of the parameters, see Table 21: Phone Information for 400-Series IP Phones on
page 90.

To close the Admin options menu, do one of the following:

* On the IP420, with Exit highlighted press the selector button on the navigation key pad.
¢ On the IP480, IP480g, and IP485g, press the Exit soft key.

Resetting an IP Phone

1. With the phone on hook, press the MUTE key followed by 73738# (RESET#). The phone displays the
Reset phone screen.
2. Do one of the following:

¢ On the IP420, with Reset highlighted press the selector button on the navigation key pad.
¢ On the IP480, IP480g, and IP485g, press the Reset soft key.

The phone reboots and applies settings.

Resetting a BB424

The following procedure resets all BB424 devices in a configuration. Performing the action on one BB424
device performs the reboot on all connected BB424 devices.

1. Press and hold the first and fourth page indicator buttons on the BB424 for three seconds.

The BB424 displays the Info menu with details about the BB424.
2. To reset the BB424, press the programmable button to the left of Reset.

The BB424 displays a confirmation message.
3. Press the programmable button to the left of Reset.

The BB424 reboots.

Clearing a Phone’s Configuration Settings

You can clear a phone’s configuration settings and return it to factory settings by entering a key sequence
on the phone’s key pad. If you move phones from one Mitel system to another, you need to clear each
phone’s configuration.

1. With the phone on hook, press the MUTE key followed by 25327# (CLEAR#). The phone displays
the Clear Configuration screen.
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2. Do one of the following:

* On the IP420, with Clear & reboot highlighted, press the selector button on the navigation key
pad.

¢ On the IP480, IP480g, and IP485g, press the Clear soft key.

The phone reboots and applies settings.

Clearing a BB424’s Configuration Settings

You can clear a BB424'’s configuration settings and return it to factory settings by pressing a combination
of buttons on the BB424.;This should be necessary very rarely and only if recommended by Mitel
Technical Support.

The following procedure clears the configurations for all BB424 devices that are connected to a phone.
Performing the action on one BB424 device affects all of the connected BB424 devices.

1. Press and hold the first and fourth page indicator buttons on the BB424 for three seconds.

The BB424 displays the Info menu with details about the BB424.
2. To reset the BB424, press the programmable button to the left of Clear.

The BB424 displays a confirmation message.
3. Press the programmable button to the left of Clear.

The BB424 reboots.
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Configuring and Maintaining 6900-
Series IP Phones

This chapter provides details about configuring and maintaining the 6900-Series (6910, 6920, 6930, and
6940) IP phones.

* Overview

* Updating IP Phone Firmware

* Boot Process

* Configuring 6900-Series IP Phones

* Configuring the Time Zone on 6900-Series Phones
* Migrating Phones Between Systems

* Viewing Diagnostic Information about a Phone

* Displaying Settings for an IP Phone

* Clearing a Phone’s Configuration

Overview

6900-Series (6910, 6920, 6930, and 6940) IP phones are similar to 400-Series IP phones. Both use
Session Initiation Protocol (SIP). In general, both provide telephony features similar to those provided by
the other IP phone models. However, the configuration and maintenance procedures for the 6900-Series
(6910, 6920, 6930, and 6940) phones are slightly different from those for the 400-Series IP phones.
Users familiar with using the 400-Series IP phones should have an easy transition to using the 6900-
Series (6910, 6920, 6930, and 6940) IP phones.

IP Phone Failover

When IP phone failover is enabled on the IP Phone Options page in Connect Director, if an IP phone
cannot communicate with its switch, the phone automatically connects to another switch at the same site
that has available configured IP phone resources. For IP phone failover to be effective, the system must
be planned with sufficient excess capacity to handle phones from at least one switch during a failover
event. For example, if a switch with 20 IP phone ports fails, 20 IP phone ports need to be available
elsewhere in the system.

Date and Time

6900-Series (6910, 6920, 6930, and 6940) IP phones depend on a Network Time Protocol (NTP) server
to authenticate a secure connection and to provide the date and time to be displayed on for the phone’s
screen. The time displayed on the phone is the GMT value provided by the NTP server plus the offset
from the time zone setting of the phone. Users can set the time zone through the phone’s Options menu.

The IP address of the NTP server is delivered to the phone through DHCP or is manually configured in
the phone. In the absence of an accessible NTP server, the phone can obtain the time from its controlling
switch.

IP Phones and Voice Switches

Voice switches provide configuration and call manager functionality for 6900-Series (6910, 6920, 6930,
and 6940) IP phones. Every site where IP phones are in use must have a voice switch configured to
support the number of IP phones at the site. SIP Proxy ports are not required for the 6900-Series IP
phones.

Similar to 400-Series phones, the voice switches provide configuration for the 6900-Series (6910, 6920,
6930, and 6940) phones in a different manner than for other phone models. When a 6900-Series (6910,
6920, 6930, and 6940) IP phone downloads configuration files during the bootup process it receives a list
of all available switches. The phone then randomly selects a switch from this list (starting with switches
on the same subnet, if available) and attempts to register with the switch.
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The contacted switch then redirects the phone to the appropriate call manager switch, which is the voice
switch assigned to the phone to set up and tear down calls. The call manager switch handles the Session
Initiation Protocol (SIP) information from the IP phones assigned to it and communicates call information
to other switches in the system using SIP. After two IP endpoints are connected in a call, media streams
are independent of the call manager switch.

After the phone registers with the call manager switch, any time the phone reboots it attempts to contact
that same switch. If that switch does not respond, the phone attempts to contact another switch on the
list until the phone successfully contacts a switch; the phone is then redirected to the appropriate call
manager switch.

IP Phone Communications

Communications for 6900-Series (6910, 6920, 6930, and 6940) phones are routed through the following
protocols:

e Secure Session Initiation Protocol (SIPS)
* Real-time Transport Protocol (RTP) and Secure Real-time Transport Protocol (SRTP)
¢ Client Application Server (CAS)

Secure Session Initiation Protocol (SSIP)

Secure Session Initiation Protocol (SIP) is a standard protocol that is based on a client-server model
and works at the application layer. Through SIP, networked users can initiate a call or receive a call. The
protocol configures the parameters for the session and handles the call setup and tear-down.

Mitel uses the secure version of SIP, SIPS, for signaling between voice switches and 6900-Series (6910,
6920, 6930, and 6940) IP phones.

RTP and SRTP

Media flow for the 6900-Series (6910, 6920, 6930, and 6940) IP phones is either through Real-time
Transport Protocol (RTP) or through Secure Real-time Transport Protocol (SRTP).

The use of SRTP, the encrypted version of RTP, depends on whether SRTP has been enabled through
the Media Encryption option in the Call Control > Options page in Connect Director. If the Media
Encryption option is set to SRTP - 128 bit AES, SRTP is used in the following scenarios:

¢ For calls between 6900-Series (6910, 6920, 6930, and 6940) IP phones configured as internal
extensions, after the call is set up, media flows directly between the IP phones using SRTP.

e For calls between a 6900-Series (6910, 6920, 6930, and 6940) IP phone and an external number over
a trunk, after the call is set up, media flows via the trunk using SRTP.

* For three-way mesh conference calls between 6900-Series (6910, 6920, 6930, and 6940) IP phones,
after the call is set up, media flows between the phones using SRTP.

¢ In Make Me conference involving up to eight 6900-Series (6910, 6920, 6930, and 6940) IP phones,
media flows through SRTP when voice switches are used.

¢ For Conference calls involving 6900-Series (6910, 6920, 6930, and 6940) IP phones that are initiated
through a service appliance, media flows through SRTP.

When SRTP is used to encode the audio, the secure nature of the call is indicated with a lock icon in the
call window.

If the Media Encryption option is not enabled, the connection negotiation between two 6900-Series IP
phones is through SRTP, but the resulting media stream between the two phones is through RTP.

Media flow for calls between 6900-Series (6910, 6920, 6930, and 6940) IP phones and other IP phones
uses RTP. Make Me conference calls that involve at least one non-6900-Series (6910, 6920, 6930, and
6940) IP phone and a 6900-Series (6910, 6920, 6930, and 6940) IP phone also use RTP.

Note:

RTP is used in these scenarios even if SRTP is enabled through the Media Encryption option in Connect
Director.
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Client Application Server (CAS) Service

On the 6900-Series (6910, 6920, 6930, and 6940) phones, the Client Application Server (CAS) supplies
information such as call history, configuration details, directory, workgroup agent status, and visual
voicemail. If CAS is inaccessible, these services are not available, but a phone can still make and receive
calls.

Updating IP Phone Firmware

While earlier phones automatically download available new firmware upon rebooting, updating firmware
on the 6900-Series IP phones is a process you manage through the Diagnostics and Monitoring system
that you access through Connect Director. For example, you can automatically maintain all 6900-Series
IP phones at the recommended firmware level, or you can override the automatic updates if you want to
select a different firmware version or disable automatic update for certain phone models or for specific
phones.

Control of phone firmware updates is accomplished through global-update and override settings that you
specify on the Phone Firmware Update page of Connect Director. For details, see the MiVoice Connect
System Administration Guide.

To manage phone firmware on a more granular level, the Diagnostics & Monitoring interface provides
a flexible approach for updating phone firmware because you can manage the firmware download and
installation process in stages:

* If you want to download firmware to phones independently of installing it, use the Downl oad
command. You can choose to run this command at a time when you can spare the network bandwidth
needed to accommodate the download. After firmware is loaded on the phones, you can, later on,
use the Updat e or Updat e When | dl e commands to install the firmware that you have already
downloaded without downloading it again.

¢ If you want to download firmware to phones and install it immediately, use the Update command. You
can also use this command to install phone firmware that you have downloaded.

When a group of phones at a site are selected for firmware download and the server is remote, some
of the phones at the site automatically download firmware from other phones at the site for minimizing
bandwidth utilization.

When phones are running at least the latest recommended firmware version, the value in the Firmware
Status column is Up to Date. For more details about the possible values for Firmware Status, see the
MiVoice Connect System Administration Guide.

If you are not using the automatic phone firmware update mechanism, you should upgrade phone
firmware when the value in the Firmware Status column on the Status > IP Phones page is one of the
following:

¢ Firmware Version Mismatch indicates that the phone’s current firmware version is earlier than the
minimum firmware version required for the phone.

¢ Update Available indicates that the phone is running an acceptable firmware version, but a more
recent firmware version is available for download. In other words, the phone is running a firmware
version later than or at the minimum version required, but earlier than the recommended version.

The Advanced option, which is available with the Downl oad, Updat e, or Updat e When Idl e
commands, allows you to select a different firmware build for each model of phone. Furthermore, if there
is more than one hardware version for each phone model, you can select a unique build to deploy to
each phone as appropriate. The system prevents you from accidentally downloading a firmware version
that is incompatible with a phone’s hardware version. If there is no firmware version appropriate for a
particular phone loaded on the server, you can select Skip from the Version drop-down list.

Because the Diagnostics and Monitoring system selects any available server from which to download the
firmware update, you should ensure that all servers in the system, including servers that do not manage
voice switches, have the latest firmware installed. This is because the Diagnostics and Monitoring system
directs the phones to download from a server that does not have the specified firmware version, the
download fails and the phones do not attempt to obtain the firmware from another server.

To download and install a firmware upgrade:

1. Launch Connect Director.
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Click Maintenance > Status and Maintenance > IP Phones. The IP Phones page opens.
Select the check box for each phone for which you want to upgrade firmware.

In the Command drop-down menu, select Update Firmware.

Click Apply.

In the Confirmation dialog box, do one of the following:

I

* To apply the recommended firmware version, click OK.
* To select a particular firmware version:

a. Click Advanced.

b. For each type of phone selected, in the Version drop-down list, designate the firmware
version.

c. Click OK.

The Firmware Status column shows the progress as the firmware is downloaded and applied. The
phones reboot after firmware is updated.

Boot Process

The boot process varies depending on whether your network uses Dynamic Host Configuration Protocol
(DHCP) or static configuration:

* DHCP— IP phones are pre-configured to work with your network’s DHCP server. After the servers and
voice switches are configured, the phones are automatically added to your Mitel system when they are
connected to the network. Upon booting, IP phones use the configuration server address to acquire
their configuration specifications. The configuration server address is set in the DHCP site-specific
options (option tag 156).

e Static configuration—If you are not using a DHCP server or the server is not currently online, you
can set a static IP address and other startup parameters directly on the IP phone. For details, see
Specifying Configuration Parameters on a Phone on page 125.

After the IP phone obtains the configuration server IP address or addresses, it downloads configuration
files from the configuration server using HTTP (unless otherwise specified). If the configuration server
cannot be reached because of some kind of error (such as a timeout) but the phone was configured with
multiple configuration server IP addresses, then the phone tries to download the configuration files from
the other servers. If no configuration server can be reached, or if a configuration file cannot be located,
the phone uses the last successfully loaded configuration parameters. After the phone completes
downloading the configuration files, the current parameters are saved in flash memory.

Configuring 6900-Series IP Phones

This section describes how you can specify custom configuration parameters for the 6900-Series (6910,
6920, 6930, and 6940) IP phones.

When a 6900-Series (6910, 6920, 6930, and 6940) IP phone boots, it contacts the configured server and
reads an initial configuration file from the server. You can override the default configuration parameters
for a phone through DHCP site-specific options, through the phone interface, or through custom
configuration files. As phone firmware is upgraded, some configuration information is overwritten, but
parameters specified in custom configuration files are preserved across upgrades.

Parameter Precedence

While there are some exceptions, in general configuration parameters are processed by the phone in the
following order. The last parameter source takes precedence:

e Defaults

e LLDP

* DHCP option tag 156

* Configuration files that reside on the server. The precedence order for these files is described in
Processing Order for Configuration Files.

¢ Configuration settings from the voice switch
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Specifying Configuration Parameters on a Phone

If you are not using a DHCP server to provide IP address and configuration parameters to the phones,
you must manually configure the phones. You can enter the phone configuration menu at bootup or enter
a key sequence from the phone’s keypad after the phone has finished booting up.

For descriptions of the parameters you can set on a phone, see the following table
If you are using DHCP, be aware that the order of precedence for certain parameters varies:

* Setting the Config server parameter on the phone (through the Settings > Advanced > Voice
Services > MiVoice Connect > Config Server N (where N is value 1 through 6) menu) overrides the
configServers parameter specified through DHCP.

Table 26: Phone Information for 6900-Series IP Phones

Advanced Option Name Description
Options
Menu Item

Time and Date | Settings This field allows you to set the date and time format.

The following fields are populated by default:

e Time Format: 24-Hour
* Daylight Savings: Automatic
¢ Date Format: WWW DD MMM

Time Zone This field allows you to set the time-zone of your region. The
timezone is Custom by default.

Set Date and This field allows you to set the date and time

Time
Note:
The Use Network Time field is selected by default
Status Firmware Info This field displays firmware information.
Network

Depending on the network that is connected, the following fields are
populated by default:

* IP Address

e MAC Address
e LAN Port
 PC Port

* Cloud Domain
* Language

* Time Zone

e Country

Error Messages | This field displays error messages related to the IP phone.

Bluetooth This field allows you to switch the audio from your Bluetooth-

paired mobile phone to your Mitel desktop IP phone. This function
is available if your mobile phone is synchronized with your desk
phone through the Mitel Mobilelink feature.

It provides the list of Paired and Available devices.

Voice Service | MiVoice Connect | This field displays the Headquarters (HQ) server IP address.
> Config. Server

MiCloud Connect | This field displays the current cloud domain used for routing of
> Cloud Domain | MiCloud Connect authentication requests.

Diagnostics Troubleshooting | For details on these menu options, see Viewing Diagnostic
Information about a Phone on page 132.

Ping
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Advanced Option Name Description
Options
Menu Item

Traceroute

Capture

Log upload

Diagnostic

server

Audio

Diagnostics

Display Home Screen This field has a default timer of 1800 seconds for screen lock.

Brightness This field enables you to adjust the brightness level. it has the
following options:
* Brightness Level
* Brightness Timer
Note:
The values in these fields are populated by default.

Push ‘o i ; e

Notifications This field has the following options:
e Sound
* Bluetooth
e External

Network LLDP This option is enabled by default.
Settings

The following fields are enabled by default:

* Use DHCP

e DHCP User Class

e DHCP Download Option
e |P Address

* Subnet Mask

* Gateway

e Primary DNS

» Secondary DNS

* Hostname

Ethernet Ports

The following options are available:

* LAN Port: Auto (default)
e PC Port: Auto (default)
e Pass Thru Port: Enable (default)

Use 802.1Q

IEEE 802.1Q specifies the use of VLANs (Virtual LANs) on
Ethernet.

If EAP Type is EAP-MD5 or EAP-TLS, you must also specify values
for the following fields:

e EAP-TLS Settings

* |dentity

* MDS5 Password
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Advanced Option Name Description
Options
Menu Item
Network VLAN ID This option is the Virtual LAN identifier.
(Continued)

This field is disabled by default and the following fields are
populated by default:

* LAN Port VLAN

* LAN Port VLAN ID
e SIP Priority

* RTP Priority

* RTCP Priority

e Other Priority

* PC Port VLAN

* PC Port VLAN ID
e PC Port Priority

DSCP This option is the Differentiated Services Code Point (DSCP) value

to be used for audio packets.

The default value is 46.

Configuration | Download

Server Protocol If you select FTP, complete the following fields:

* FTP Server

e FTP Path

e FTP Username
e FTP Password

If you select, TFTP, complete the following fields:

e Primary Server
e Pri TFTP Path

If you select, HTTP, complete the following fields:

e HTTP Server
e HTTP Path

Note:
The HTTP Port is 80 by default.
If you select, HTTPS, complete the following fields:

e HTTPS Server
e HTTPS Path

Note:
The HTTPS Port is 443 by default.
The Client Method is TLS Preferred by default

Restart This option allows you to restart the phone.

Reset This option allows you to set Factory Default settings.

Specifying Config Parameters through DHCP Options

By default, DHCP option tag 156 is used. The following parameters are specified in the site-specific
options for option tag 156:

¢ configServers: Specify a comma-separated list of IP addresses or FQDN for the configuration server. If
a server is not available, the phone cycles through the list of servers until it finds a working server.
Note:

127



CONFIGURING AND MAINTAINING 6900-SERIES IP PHONES

The factory MiINET firmware only supports reading the first IP/FQDN value from the list of
configServers as provided in DHCP option 156. Once the phone upgrades to appropriate SIP
firmware, it will support the list of IP/FQDN from DHCP 156.

» ftpServers: Specify a comma-separated list of IP addresses or FQDN for the configuration server. If a
server is not available, the phone cycles through the list of servers until it finds a working server.
Note:

The ftpServers parameter is provided for compatibility with sites running MGCP phones. 6900-
Series IP phones use HTTP to download configuration files from servers specified in the ftpServers
parameters. For new installations, the configServers parameters is recommended over the
ftpServers parameter.

¢ vlanid

While DHCP Option 156 can be used to enable VLAN tagging and set the VLAN ID, it is not
recommended because VLAN hopping after the DHCP address is acquired forces the phone to re-start
the network stack on the new VLAN a second time. LLDP-MED is the preferred method to enable VLAN

tagging.
The complete Option 156 syntax including VLAN tagging is:

vl ani d=<nunber >, | ayer 2t aggi ng=<0| 1>, confi gservers=<| P address>, ftpservers=<| P
address>

Specify the parameters in any order, separating multiple parameters with a comma. Not all parameters
are required. When providing multiple values for one parameter, use quotation marks around the comma-
separated values. For example:

configServers="192.168.0. 13, joe.test.coni, vlani d=2

Note:

6900-Series (6910, 6920, 6930, and 6940) IP phones use HTTP to download their configuration files
from the servers specified in DHCP option tag 156.

Specifying Config Parameters through Custom Config Files

The following table lists the configuration file names for the 6900-Series (6910, 6920, 6930, and 6940) IP
phones. These files are stored in the phone configuration directory created on the server when your Mitel
system is installed. The default directory for these configuration files is as follows:

<Drive>:\inet pub\ftproot\phoneconfig

Table 27: 6900-Series (6910, 6920, 6930, and 6940) IP Phone Model Configuration Files

IP Phone Model | Custom Configuration File Name Model-Specific Custom Configuration
for All 6900-Series IP Phones File Name for 6900-Series IP Phones
6910 startup.cfg 6910.cfg
6920 startup.cfg 6920.cfg
6930 startup.cfg 6930.cfg
6940 startup.cfg 6940.cfg

Processing Order for Configuration Files
Configuration files are processed in the following order:

e country_| SO>. t xt, where ISO> is a two-character ISO country code (For example, the file for the
United States is country_US.txt.)

Do not edit these files. These files specify country-specific settings such as date/time formats.
° generated.txt

Do not edit this file, because it is generated by the server and any changes would be overridden the
next time the server generates the file. This file contains a list of voice switches for the phone and the
default httpResources parameter setting, which specifies the default server path for wallpaper and
ringtones. The server regenerates this file whenever the list of switches is updated.
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e startup.cfg

This is the base custom configuration file for all 6900-Series IP phones. Any configuration parameters
that you add to this file are applied to all 6900-Series IP phones in your system.

e <nodel >. cf g (where <model> is 6910, 6920, 6930, and 6940)

This is the custom configuration file for a particular model of 6900-Series IP phone. Any configuration
parameters that you add to this file are applied to all phones of that model at your site.

e <pac>. cf g (where <mac> is the MAC address of a phone)

This is the custom configuration file for a particular phone as identified by its MAC address (the 12-digit
number on the white sticker on the back of the phone). Any configuration parameters that you add to
this file will be applied to the phone identified by the MAC address.

Note:

File names for MAC configuration files must be in lower case and not contain punctuation. The
following is an example of a custom configuration file name for a particular phone identified by its
MAC address: <mac>. cf g.

The phone-specific custom configuration file is the last file read. Any parameters in a custom
configuration file override configuration parameters specified at a lower level of precedence, including the
parameters entered on the phone, because they are processed first, before any configuration files are
read. Any duplicate parameters specified in the configuration files are overridden according to their own
precedence order.

Parameters are organized by group, and each parameter must begin on a new line within the proper
group, as follows:

[group>]

parameter>=value>

parameter>=value>
[group>]
parameter>=value>
parameter>=value>
where

[group>] is the configuration parameter group as shown in Table 24: Configuration Parameters on page
98.

value> is the name of the configuration parameter as shown in Table 24: Configuration Parameters on
page 98.

In specifying parameters, the following rules apply:

¢ |P addresses must be provided in dotted-decimal format.

e Parameters and values in configuration files are case sensitive.

* Cases are preserved in character strings unless otherwise indicated.

* Comments may be embedded in a configuration file by starting the comment line with a # symbol.

¢ |If a parameter value is formatted incorrectly or is outside the range of valid entries, the phone skips the
value and moves to the next parameter. Errors are not logged in these cases.

Receiving Configuration Settings from a Switch

After the configuration files are processed and the phones register with the system, they are
automatically provided with the configuration information related to the system, their site, and the user
assigned to the phone. This configuration information, which is specified in Connect Director and the
Connect client,;overrides settings specified in configuration files. As changes are made in Connect
Director or the Connect client,;these parameters are automatically kept up to date on the phones,
whereas the configuration file values are provided only when the phone boots.
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Configuring the Time Zone on 6900-Series Phones

To configure the time zone on 6900-Series (6910, 6920, 6930, and 6940) phones, do the following:

1. Go to Settings O3

2. Select Advanced.
3. Enter the password in the Enter Administrator Password field.
Note:

If phone is in factory-default settings, enter 22222 as the password. If the phone is registered with
the MiVC system, use the default password 1234 or the password set by the administrator.

4. Select Time and Date > Time Zone.

Select the desired option from the list of options displayed on the Time Zone screen.

6. Click Save.

o

Migrating Phones Between Systems

The 6900-Series (6910, 6920, 6930, and 6940) phones are designed to be extremely secure and
immune from compromise through the network. The first time a 6900-Series (6910, 6920, 6930, and
6940) phone is powered on and configured, it downloads the “UC Certificate Authority” certificate from
the Headquarters Server and remembers it. After that, the phone connects only to services (SIPS,
HTTPS) that provide certificates signed by that certificate authority or certificates signed by public
certificate authorities.

While it is possible to move phones from one system to another, it is not possible to maintain the user
binding for those phones. After moving the phones, an administrator can assign the phones to users
through Connect Director, or users can assign themselves using the phone interface.

To move a 6900-Series (6910, 6920, 6930, and 6940) phones, got to Settings > Advanced Settings >
Reset.

In the following procedure, the phones are being migrated from System A to System B.
Note:

Any 6900-Series (6910, 6920, 6930, and 6940) phones that are not operational during this process will
not be able to reconnect to the system. For this reason, do not attempt this process during an upgrade or
other down time.

1. Verify that System B has sufficient IP phone capacity for the phones that will be moved from System
A

2. Replace the UC Certificate Authority certificate/key on System A with the certificate/key from System
B as follows:

a. Ensure that System A is fully operational before attempting to replace the UC Certificate
Authority.

b. On System A, make a backup copy of the <dri ve>: \ Shor el i ne Dat a\ keyst or e directory.
Note:

You can accomplish this by doing a simple copy and paste using Windows Explorer.
c. Copy the following private key and certificate files from System B and replace them in the same
path on System A:

<drive>:\Shoreline Data\keystore\private\hg ca. key

<drive>:\Shoreline Data\keystore\certs\hqg_ca.crt
3. On System A, using either Windows Task Manager or Connect Director (Maintenance > Status and
Maintenance > Servers) stop and restart the WebFrameworkSvc service.

This service detects the certificate change and performs the necessary steps to regenerate and
install the appropriate certificates throughout the system. This might take a few minutes.

4. Phones get their “Config Server” value through DHCP or by being entered directly on the phone,
which is referred to as static configuration. Depending on your existing configuration for System A
and System B, follow the instructions in the appropriate section below:
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* If the phones that you want to move are isolated to a subnet such that DHCP parameters pointing
to the configuration server for System A can be modified, then follow the steps in If Both Systems
Get Config Server Value from DHCP on page 131.

 [f the phones on System A are already using a static configuration or if you wish to move a subset
of phones from System A to System B, but do not want to modify DHCP, then follow the steps in If
Config Server Is from DHCP or Static for System A and Static for System B.

Note:

After a phone acquires a static configuration, it is difficult to remove that configuration.

If Both Systems Get Config Server Value from DHCP

1.

Modify your DHCP server to point to the IP address for System B by using the procedure in MiVoice
Connect Planning and Installation Guide > Network Requirements and Preparation > Configuring
DHCRP for IP Phones.

. Use the following procedure to reboot the phones you want to move:

a. Launch Connect Director on System A, and in the navigation pane, and click Maintenance >
Status and Maintenance > IP Phones. The IP Phones page is displayed.

b. Select the phones you want to move, and then select the Reboot command from the Command
drop-down list and click Apply.

c. In the Confirmation dialog, click OK.

The selected phones reboot and get the new Config Server value for System B from DHCP and
bind to System B.

. Verify that the phones are in service on System B by checking the Maintenance > Status and

Maintenance > IP Phones page in Connect Director.

. On System A, delete the moved phones as follows:

a. Launch Connect Director on System A, and in the navigation pane click Administration >
Telephones > Telephones. The Telephones page is displayed.

b. Select the phones you want to delete, and then click Delete.

c. In the Confirmation dialog, click OK. The system deletes the selected phones.

Do one of the following:

* If you plan to continue using System A and want it to have a certificate different from System B,
restore System A’s original certificate and private key:

a. From the backup copy you made of System A’'s <dri ve>: \ Shor el i ne Dat a\ keystore
directory, replace the private key and certificate files in the same path on Server A:

<drive>:\Shoreline Data\keystore\private\hqg_ca. key

<drive>:\Shoreline Data\keystore\certs\hqg_ca.crt
b. On System A, using either Windows Task Manager or Connect Director (Maintenance >
Status and Maintenance > Servers), stop and restart the WebFrameworkSvc service.

This service detects the certificate change and performs the necessary steps to regenerate
and install the appropriate certificates throughout the system. This might take a few minutes.
* [f you plan to leave the changed certificate on System A and you have a Mobility Router in your
system, reboot the Mobility Router.

If Config Server Is from DHCP or Static for System A and B

1.

On System A, manually set the config server value through phone Settings Ul (Settings > Advanced
> Voice Services > Config Server N parameters). They will not be able to use custom config file and
reboot phones to pick up the value.

Note:

When specifying the configuration server, be sure to use the IP address of your System B
Headquarters server.

. Verify that the phones are in service on System B by checking the Maintenance > Status and

Maintenance > P Phonesl page in Connect Director.

. On System A, delete the moved phones as follows:
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a. Launch Connect Director on System A, and in the navigation pane click Administration >
Telephones > Telephones. The Telephones page is displayed.
b. Select the phones you want to delete, and then click Delete.
c. In the Confirmation dialog, click OK. The system deletes the selected phones.
4. On System A, remove the lines added in Step 1 from your cust om t xt file.
5. Do one of the following:

* If you plan to continue using System A and want it to have a certificate different from System B,
restore System A’s original certificate and private key:

a. From the backup copy you made of System A’'s <dri ve>: \ Shor el i ne Dat a\ keystore
directory, replace the private key and certificate files in the same path on Server A:

<drive>:\Shoreline Data\keystore\private\hqg_ca. key

<drive>:\Shoreline Data\keystore\certs\hqg_ca.crt
b. On System A, using either Windows Task Manager or Connect Director (Maintenance >
Status and Maintenance > Servers), stop and restart the WebFrameworkSvc service.

This service detects the certificate change and performs the necessary steps to regenerate
and install the appropriate certificates throughout the system. This might take a few minutes.
* [f you plan to leave the changed certificate on System A and you have a Mobility Router in your
system, reboot the Mobility Router.

Viewing Diagnostic Information about a Phone

To access various types of diagnostic information for a phone, do the following:

1. Go to Settings ‘@'

2. Select Advanced.
3. Enter the password in the Enter Administrator Password field.
Note:

If phone is in factory-default settings, enter 22222 as the password. If the phone is registered with
the MiVC system, use the default password 1234 or the password set by the administrator.

. Select Enter.

. Select Diagnostics.

(S,

Viewing Troubleshooting Information about the Phone

1. Go to Settings ‘@'

2. Select Advanced.

3. Enter the password the Enter Administrator Password field.
Note:

If phone is in factory state, the password will be 22222 (generic SIP admin password). After the
phone is registered to the MiVC system, the password will be set to the one that the admin has
defined in the MiVC server setup. The default value is 1234. However, it may be changed.
4. Select Enter.
Select Diagnostics.
6. Select Troubleshooting. The troubleshooting information is displayed.
Note:

o

The fields in the Troubleshooting information page is populated by default.

Using Ping to Check the Status of an IP Address

Go to Settings 03

Select Advanced.

Enter the password in the Enter Administrator Password field.
Select Enter.

Select Diagnostics.

Select Ping. The Host Name or IP Address field appears.

oakrkobd =
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7. Enter the IP address in the Host Name or IP Address field. It displays the Ping status.

Using Traceroute to Determine the Network Route to a Host
1. Go to Settings O3

Select Advanced.

Enter the password in the Enter Administrator Password field.

Select Enter.

Select Diagnostics.

Select Traceroute. The Traceroute Command field appears.

Enter the traceroute command in the Traceroute Command field. It displays the Ping status.

Noahkoh

Capturing Packets for Phone Network Traffic

To diagnose problems on a phone, you might need to capture packets to see details about network traffic
to and from the phone. You can capture packets by using the phone interface, which is described in this
section, or you can initiate packet capture and view the results (using Wireshark or a similar network
protocol analysis tool) through the Diagnostics Monitoring system. For details, see the MiVoice Connect
System Administration Guide.

On the 6900-Series (6910, 6920, 6930, and 6940) phones, signaling packets are encrypted, Packet
capture tools available on the network cannot decrypt these packets. However, using the packet capture
tool built into the phone, both the encrypted and decrypted versions of the packets are displayed.

The packet capture can run for up to two hours or until the resulting .pcap file reaches 70 MB.

If you specify a location through the Diagnostic Server field, the packet capture files (.pcap) are
uploaded to that location. If your installation does not have a di agnost i cSer ver s path configured,
by default the .pcap files from the capture operation are uploaded to the following directory on the
Headquarters server:

<Drive>:\inetpub\ftproot (orthe default FTP location on the server)
Note:

For 6900-Series IP phones, you must manually configure the diagnostic server using Advanced >
Diagnostics > Diagnostic Server option.

However, unless this directory allows anonymous write access (which is not recommended), uploading
the capture file to this directory will fail.

Uploaded packet capture files are named as follows:
<Phone MAC address>_ YYYYMVDD HHWMVES. pcap
Where:

YYYYMVDD is the date (four-digit year, two-digit month, and two-digit day) when the . pcap file was
created on the phone.

HHWVEBS is the time (two-digit hour, two-digit minute, and two-digit second) when the . pcap file was
created on the phone.

The results of a packet capture operation are also accessible through the phone interface until you start a
new packet capture operation.

1. Go to Settings‘@'.

Select Advanced.

Enter the password in the Enter Administrator Password field.
Select Enter.

Select Diagnostics.

Select Capture. The Timeout (1 - 1440 Minutes) field appears.
Enter the timeout in the Timeout (1 - 1440 Minutes) field.
Select Start to capture the packets for phone network traffic.

@NoghA~wN
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Uploading a Phone’s Log

If a phone user experiences problems, you as an administrator or the user might want to upload logs to
debug the problem.

If you specify a location manually through the Diagnostics server item on the phone’s Diagnostics menu,
log files are uploaded to that location. For information about how to specify a diagnostic server from a
phone, see Configuring a Diagnostic Server from the Phone Interface on page 134.)

Uploaded log files are named as follows:
<Phone MAC address>_YYYYMVDD_ HHWVSS. t gz
Where:

YYYYMVDD is the date (four-digit year, two-digit month, and two-digit day) when the . t gz file was created
on the phone.

HHWVEBS is the time (two-digit hour, two-digit minute, and two-digit second) when the . t gz file was
created on the phone.

Note:

* You must create \ upl oads\ phone folders under C: \ i net pub\ f t pr oot in all FTP Servers.

* When you upload logs from the Connect Director User Interface (Ul), the logs will be uploaded to the
following location: C: \ i net pub\ f t pr oot \ upl oads\ phone.

¢ When you upload logs from the phone, the logs will be uploaded to the following location: C.
\'i net pub\ ft proot\

Follow these steps to upload a phone’s log:

Go to Settings #

Select Advanced.

Enter the password in the Enter Administrator Password field.
Select Enter.

Select Diagnostics.

Select Log upload.

Select Upload. The phone will collect all the logs.

Select Upload again and select Close.

Note:

ONoaklkebd =

* You must create \ upl oads\ phone folders under C: \ i net pub\ ft pr oot in all FTP Servers.

¢ When you upload logs from the Connect Director User Interface (Ul), the logs will be uploaded to the
following location: C: \'i net pub\ f t pr oot \ upl oads\ phone.

¢ When you upload logs from the phone, the logs will be uploaded to the following location: C:
\'i net pub\ftproot\

Configuring a Diagnostic Server from the Phone Interface

Go to Settings 03

Select Advanced.

Enter the password in the Enter Administrator Password field.

Select Enter.

Select Diagnostics.

Select Diagnostic Server.

Enter the IP address of the desired FTP upload server in the Diagnostic Server field to view the
server information.

Noaprwbh =

Viewing Audio Diagnostics Information

" Go to Settings #

. Select Advanced.

. Enter the password in the Enter Administrator Password field.
. Select Enter.

A OON =
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5. Select Diagnostics.
6. Select Audio Diagnostics.
7. Enter the timeout in the Timeout (1 - 5 Minutes) field to capture the RTP information.

Displaying Settings for an IP Phone
Follow these steps to display the settings for 6900-Series IP (6910, 6920, 6930, and 6940) phones:

1.

2.
3.

4,

Go to Settings ‘@'

Select Advanced.

Enter the password in the Enter Administrator Password field.
Note:

If phone is in factory-default settings, enter 22222 as the password. If the phone is registered with
the MiVC system, use the default password 1234 or the password set by the administrator.
Select Enter. The settings for the phone is displayed

Clearing a Phone’s Configuration

To return a phone to the factory settings, you can clear the phone’s configuration through the Reset
menu. If you move phones from one Mitel system to another, you need to clear each phone’s
configuration.

1.

2.
3.

Go to Settings #
Select Advanced.

Enter the password in the Enter Administrator Password field.
Note:

If phone is in factory-default settings, enter 22222 as the password. If the phone is registered with
the MiVC system, use the default password 1234 or the password set by the administrator.
Select Enter.

Select Reset > Factory Default > Select to clear a phone’s configuration.
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Configuring 6970 as a Generic SIP
Phone with MiVoice Connect

Overview

When set up as a Generic SIP device with MiVoice, the 6970 IP phone supports additional features as
listed in the Supported Features on 6970 as Generic / Third-Party SIP Device on page 136 section.
This chapter provides details of setting up a 6970 IP phone as a Generic SIP device with MiVoice
Connect.It also provides information about converting a 6970 device from MiNet to Generic SIP and
configuring and registering the device as a third-party or a Generic SIP device with MiVoice Connect.

Note:
MiVoice Connect does not support TLS and TCP connections for third-party phones.

* Important Considerations

» Supported Features on 6970 as Generic / Third-Party SIP Device

* Converting 6970 from MiNet to Generic SIP and Registering with MiVC
* Configuring MiVoice Connect to Register 6970 Device

* Registering 6970 Device with MiVoice Connect as a Generic SIP Device

Important Considerations
The following are important considerations for configuring and registering a 6970 device:

¢ Do not disable the web interface for 6970. This is because the web interface must provide logs
and audio diagnostics that are useful for handling any issues that might occur during the setting up
process.

* All options on the web interface with default values work fine for a third-party device. Therefore, it is
recommended not to change any of the default options on the web interface.

Supported Features on 6970 as Generic / Third-Party SIP Device
As a generic or third-party SIP device, 6970 supports the following features:

* Registrations

* Basic Calls (Incoming and Outgoing)

* Hold/Retrieve

¢ Mute/UnMute

e Attended Transfer

¢ Blind Transfer

¢ Conference (third party only)

¢ Dial-In Conference

e Call Forward

* Dial by name (Local directory Only)

e Music on Hold

e Localization

e NTP

e Call History (through Programmable key)
e Speed Dial

¢ Inbound and Outbound trunk (PRI) calls
e Inbound and Outound trunk (SIP) calls
¢ Voice mail

* Intersite Calls

¢ Codec Negotiation

* Find Me
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* Paging groups

* Feature Access Codes (Star Codes)
¢ DTMF (In-Band and Out-of-Ban)

e Transport protocol (UDP)

e Calls with SMR

* Meet Me Conference

e Phone Lock

Converting 6970 from MiNet to Generic SIP and Registering with MiVC

To configure a 6970 device with MiVoice Connect, you can convert the device from MiNet to Generic
SIP by using DHCP Option 159 or by using the local TFTP server for the conversion and the registration
process.

The following sections describe both these procedures.

Using DHCP Option 159

Note:

This method is recommended for users who have access to modify DHCP option.

To convert a 6970 device from MiNet to Generic SIP by using DHCP Option159 follow these steps:

1. Place the 6970 device SIP build files 6970. st , mac. cf g and st art up. cf g at the following
location of your HQ server:

C.\inetpub\ftproot\6970files

2. Log in to your local DHCP server.

Go to Scope Options, right-click, and select Configure Options.

4. In the Scope Options window that opens, go to Option 159 and enable it.
Note:

Red

You must predefine Option 159 in the DHCP Scope options.
5. Go to Data Entry > String Value and enter http://<<ip-address>>/fileserver/6970files.

Figure 11 : DHCP Scope Options

CHCP
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6. Click Apply > OK.
7. Connect the 6970 device to a LAN network.
Note:

After the device connects to the LAN, the following sequence of events occurs:

¢ The 6970 device fetches its IP address from the DHCP server and gathers information about
the HTTP server from the DHCP offer.
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¢ The device contacts the HTTP server and downloads the SIP build.
* The device is updated with the SIP build and boots-up with the Generic SIP build.

Using the Local TFTP Server
Note:

This procedure is recommended if you do not have the privileges to modify the DHCP option.
To convert the 6970 device from MiNet to Generic SIP by using the local TFTP server, follow these steps:

1. Run a TFTP server on your local test machine.

2. Place the 6970-specific Generic SIP build file 6970. st on the TFTP server.

3. Connect the 6970 device to a PoE-enabled LAN network or switch port.
Note:

* The 6970 device takes two minutes to boots up.
¢ The device fetches its IP address from the DHCP server.
* While booting up, the device might display Contacting Server 0.0.0.0 and might remain at
95% completion. This is because it is a new device and no servers are configured.
After the 6970 device boots up, select the Dialpad icon and select Settings.
Select Advanced.
Enter 73738 in the Enter Administrator Password field.
Press Enter.
Go to Network > Static Settings.
Enter the TFTP server address in the TFTP Server field.
Select Save.
Note:

COX®ND AR

¢ The device contacts the TFTP server and fetches the available SIP build files.
¢ The device is converted from MiNet to SIP and restarts with the Generic SIP build.

Configuring MiVoice Connect to Register 6970 Device

This section describes the procedure for configuring 6970 devices as SIP extensions on the MiVoice
Connect platform.

Creating a User in Connect Director

To configure the MiVoice Connect platform to register the 6970 device as SIP extensions, you must
create a user in Connect Director. To create a user, complete the following fields in Connect Director:

¢ First name

* Last name

¢ Extension*

* Email address

¢ Client username*

¢ SIP phone password

Note: * indicates mandatory fields for successfully registering 6970 phones on MiVoice Connect platform.

Figure 12 : Creating a User in Connect Director
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. Username
First name: Last name:

) 9876
Extension™:

Email address:

Client_name

i1

Client username™:

Primary phone port: IP phone: Any IP Phone

W

SIP phone password™:

Allocating Ports for the SIP Extensions - SIP Proxy Settings

Following is a description of the switch configuration required on the Mitel system to work with the 6970
Phones. Depending on the switch type, Voice Switches and Virtual Phone Switches support variable
numbers of SIP Proxies and IP Phones, which can be verified on the Switch Edit page of Mitel Connect
Director.

Port Allocation Designated on Switches shows an example of the port allocation designated on switches
for IP phones and SIP proxy resources.

Figure 13 : Port Allocation Designated on Switches

[6 IP Phones v

[100 SIP Proxy

P01

LY

Built-in capacity:
IP phone + SIP trunks = Total

25 0| |25 of 30 (100 SIP proxy ports)

Configuring Site Settings

The Administrator can designate up to two Proxy switches per site for redundancy and reliability. The first
switch is assigned as the primary proxy server, and the second switch acts as the backup proxy server,
which takes over when the primary proxy server fails.

To configure the Site settings, follow these steps:

-

- Launch Connect Director.

. In the navigation pane, click Administration > System > Sites. The Sites page appears.

. In the list pane, select the name of the site in which SIP proxies will be assigned.

- In the General tab > Proxy switch 1 field, select the switch configured with SIP proxies for the site.
. Click Save.

Figure 14 : Proxy switch 1 Field

a b ODdN

Virtual IP address:

Proxy switch 1 |vPhone v I

Proxy switch 2 [<None> v

Configuring a SIP Profile

Following are the steps required to configure the SIP profiles for 6970 Phones. By default, 6970 phones
use the “System” profile. To optimize the functionality, you must add a custom SIP profile. Follow these
steps to configure SIP profiles:
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1. Launch Connect Director.

2. In the navigation pane, click Administration > Telephones > SIP Profiles. The SIP Profiles page
opens.

3. To create a new SIP profile, click New.

In the General tab, enter a name in the Name field.

Note: It is recommended that you enter a name that describes the SIP endpoint.

In the User agent field, enter Mitel 6970*.

To enable the SIP profile, select Enable.

In the Custom parameters field, enter Accept302=exe.

Click Save.

Figure 15 : Configure a SIP Profile

P

@ No»

GENERAL

Name 86970

User agent: Mitel 6970*

Priority: 100

System parameters: OptionsPing=©

- |SendEarlyMedia=0

MWI=none
1CodecAnswer=1
StripVideoCodec=0

Custom parameters: Accept302=exe

Registering 6970 Device with MiVoice Connect as a Generic SIP
Device

To register 6970 with Mivoice Connect, you must create a user in the Connect Director before
registration. See the User Details in Connect Director figure for more details.

Figure 16 : User Details in Connect Director

. Username '
First name: ! Last name:

9876

il

Extension™:

Email address:
Client_name

I

Client username™:

W

SIP phone password™:

Note:

¢ *indicates mandatory parameters to successfully register the 6970 device with MiVoice Connect.
* You must specify the site proxy switch that performs the site’s SIP server functions.

You can register the 6970 phone with MiVoice Connect by using one of the following methods:

* From 6970 Web Ul
e From 6970 phone TUI
e Using DHCP option 159
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e Using Local TFTP Server

The following sections describe the registration procedures using these methods.

Registering From 6970 Phone Web Ul

After you convert 6970 from MiNet to SIP, follow these steps to register the 6970 device with MiVoice
Connect as a Generic SIP device from 6970 Web UI:

1. Open the Web interface of the 6970 phone using the IP address of the phone.
2. In the Web interface, complete the following fields:

¢ Username: admin
e Password: 22222

3. In the 6970 Web interface window, go to Advanced Setting > Global SIP and complete the fields as

indicated in the following table:

Table 28: Global SIP Parameter Description

Parameter Description

Basic SIP Authentication Settings

Screen Name You can enter either a user name or an extension number as the
value for this field.

Screen Name 2 You can enter either a user name or an extension number as the
value for this field.

Phone Number* Enter the user extension created on Connect Director.

Caller ID You can enter either a user name or an extension number as the

value for this field.

Authentication Name*

Enter the user’s extension or client user name.

Note:

It is recommended that you enter the user’s extension in this
field.

Password* Enter the SIP phone password provided in Connect Director.

Basic SIP Network Settings

Proxy Server

Enter the IP address of a switch that has SIP proxy capacity.

Note: You can provide the IP address of the switch that has SIP
proxy capacity and that switch must be configured as the site

proxy.
Registrar Server Enter the switch IP address provided in the Proxy Server field.
4. Click Save.
Note:

¢ The device registers with MiVoice Connect server using the server IP address and user details.
¢ The device shows the assigned user name at the top left corner of the display after it enters
the Idle state and enabling To and From calls for the device.

* The Status window on the 6970 Web Ul shows that 6970 phone is successfully registered with
MiVoice Connect. See Successful Registration of 6970 Device for details.

Figure 17 : Successful Registration of 6970 Device
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Status
System Information
Operation
User Password
Phone Lock
Softkeys and XML
Keypad Speed Dial
Directory
Reset
Login/Logout
Basic Settings
Preferences
Account Configuration
) Cusiom Ringlones

System Information

Network Status
Attribute
Link State

Negotiation

Speec

Dupiex

Hardware Information
Attribute
MAC Address:

BT MAC Address

Platform

Value

_ 0B000F-0C358

:%_E__C{ 0F-CC:03:5C

Firmware Information
Attribute

Firmware Version

Firmware Release Code

Date/Time

Boot Version

SIP Status

Tine

2

Regisiered
Registered

4001@ 192 168.152.235:5060

Registering From 6970 Phone TUI

After you convert Generic 6970 device from MiNet to SIP, follow these steps to register the 6970 device
with MiVoice Connect as a Generic SIP device from the 6970 phone TUI:

1. On the 6970 device, go to Settings > Advanced Settings.
2. Enter 22222 in the Enter Administrator Password field.

3. On the device interface, press SIP > Call Server and enter the following details:

* Proxy Server: 10.30.105.81
* Registrar Server: 10.30.105.81

Note:

Backup Registrar Used?
No
No

In these fields, you must enter the IP address of a switch that has SIP proxy capacity.

4. Click Save.

5. On the device interface, press SIP > User and enter the following details:

* SIP Auth Name: 9876 (User extension or client Username created on MiVoice Connect)
¢ SIP Password: 123456 (SIP Phone password on MiVoice Connect)

SIP User Name: Username

* SIP Display Name: Display Name
¢ SIP Screen Name: Screen Name
6. Click Save. The device restarts.

Note:

* The device registers with MiVoice Connect server using the server IP address and user details.

¢ The device shows the assigned user name at the top left corner of the display after it enters
the Idle state and enabling To and From calls for the device.

Registering 6970 Using DHCP Option 159
To register a 6970 device as a Generic SIP from MiNet by using DHCP Option159, follow these steps:
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1. Place the 6970 device SIP build files 6970. st , 0800Fxxx. cf g and st ar t up. cf g at the following
location of your HQ server:

C:\inetpub\ftproot\6970files

2. Log in to your local DHCP server.

3. Go to Scope Options, right-click, and select Configure Options.

4. In the Scope Options window that opens, go to Option 159 and enable it.
Note:

You must predefine Option 159 in the DHCP Scope options.
5. Configure the HTTP server IP address. Go to Data Entry > String Value and enter http://<<ip-
address>>/fileserver/6970files.

Figure 18 : DHCP Scope Options

CHCP

cccccc

i= 015 ONS Domain Name
3 M2 NP Servers Stander;

bechla bgletloct
weckdebyllab.bocal
00ferchiballsh. ocel

0K Cancel Aoy

6. Click Apply > OK.
7. Connect the 6970 device to a LAN network.
Note:

After the device connects to the LAN, the following sequence of events occurs:

¢ The 6970 device fetches its IP address from the DHCP server and gathers information about
the HTTP server from the DHCP offer.

e The 6970 device contacts the HTTP server. Using the 0800Fxxx. cf g and st art up. cfg
files, the 6970 device is registered with MiVoice Connect and enabling To and From calls for
the device.

Example of 0800010fxxx.cfg File
Following is a sample 0800010f xxx. cf g file:

Figure 19 : 0800010fxxx.cfg file

sip auth name:9876 #User Extension created on MiVoice Connect
s5ip password: 123456 # sip phone password on MiVoice Connect
sip user name: Username

sip display name: Displayname

sip screen name: Screenname

Example of startup.cfg File
Following is a sample st ar t up. cf g file:

Figure 20 : startup.cfg File
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sip proxy ip: 10.30.105.81 # switch IP or FQDN
sip registrar ip: 10.30.105.81 # switch IP or FQDN
log issue: 1

audio diagnostic: 1

Registering 6970 Using the Local TFTP Server
To register the 6970 as a Generic SIP from MiNet by using the local TFTP server, follow these steps:

1. Run a TFTP server on your local test machine.

2. Place the 0800Fxxx. cf g and st ar t up. cf g files in TFTP server running on your local test
machine.

On the 6970 device, go to Settings > Advanced Settings.

Enter 22222 in the Enter Administrator Password field.

Select Enter.

Go to Configuration Server, select Download Protocol as TFTP (if not set already).

Enter the TFTP server address in the TFTP Server field.

Select Save. The device restarts and the following sequence of events occurs:

ONo gk

* The device fetches the 0800Fxxx. cf g and st art up. cf g files from the TFTP server.
* The device registers with MiVoice Connect server using the server IP address and user details
fetched from the 0800Fxxx. cf g and st art up. cf g files.

¢ The device shows the assigned user name at the top left corner of the display after it enters the
Idle state, enabling To and From calls for the device.

Note:

e The st art up. cf g file is mandatory because without this file, the device will not request a
0800Fxxx. cf g file.

¢ Using this Configuration file, you can add the Log Issue and Audio Diagnostics soft key on to 6970
phone TUI. This action is not available when you register the 6970 phone through Web Ul or Phone
TUI.
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Other IP Endpoints

This chapter provides information about phone IP endpoints other than the 400-Series and 6900-Series
(6910, 6920, 6930, and 6940) IP phones, which are described in Configuring 400-Series IP Phones on
page 89 and Configuring 6900-Series IP Phones on page 124.

Overview

The Mitel system manages calls and applications for three types of IP endpoints: IP phones, SoftPhones,
and conference bridges. IP endpoints are identified by IP address and can exist anywhere on the
network. All IP endpoints are supported by voice switches, which must have sufficient capacity for all

the IP endpoints in the system. IP endpoints are configured in the system with Connect Director. For
more information about IP endpoints, see the MiVoice Connect Planning and Installation Guide and the
MiVoice Connect System Administration Guide

This chapter provides information about 100-, 200-, 500-, and 600-Series (6910, 6920, 6930, and 6940)
IP phones and the BB24 button box. For details about 400-Series and 6900-Series (6910, 6920, 6930,
and 6940) IP phones, see Configuring 400-Series IP Phones on page 89 and Configuring 6900-Series IP
Phones on page 124.

* |P Phones

* Diagnostics

* Configuration for IP Phones

* PhoneCTL Command Line Tool

» Configuring Syslog Functionality for the IP Phones
* Retrieving Information about the IP Phone

* Softphone

* Dial Tone Behavior

* Connect Client

IP Phones

IP phones allow you to deploy your telephony system as an end-to-end IP network without dedicated
station wiring. Connecting anywhere on the network, IP phones work with the Connect client applications
or can be used independently.

The IP phone controls basic display operations, such as volume level, date and time, and icons.

IP Phone Keep Alive

The Voice Switches that manage IP phones send a heartbeat to their associated IP phones once every
minute. If the heartbeat is not acknowledged within approximately four seconds, the switch considers the
IP phone to be offline or unavailable. The switch continues to broadcast the heartbeat every minute. Any
currently offline IP phone that returns an acknowledgment is considered online and available.

IP Phone Failover

IP phones can be optionally configured to send a heartbeat to their Voice Switch every four minutes. If
an IP phone cannot communicate with its switch, the phone automatically connects to another switch
located at the same site with available configured IP phone resources.

For IP phone failover to be effective, the system must be planned with sufficient excess capacity to
handle phones from at least one switch during a failover event. For example, if a switch with 20 IP phone
ports fails, 20 IP phone ports need to be available elsewhere in the system.

Services

There are two services running on the HQ and DVS servers that interact with the system’s IP phones:

e |P Phone Configuration Service (IPCS)
* Client Application Server (CAS)
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IPCS

IPCS manages the IP phone configuration process, including configuration files and the database
updates. Problems with IPCS connectivity can prevent IP phones from booting and prevent phone
configuration data from being updated.

Client Application Server (CAS)

Client Application Server handles the remaining functions, such as event handling and feature button
functions. It also controls any actions by the IP phone display not controlled by the device’s firmware or
switches. Problems with CAS or TMS connectivity can result in incorrect phone displays and errors in
both the hard and soft key functions.

Embedded IP Phone Display Driver

The embedded IP phone display is provided by the server. Control of IP phone features (such as phone
display, redial, and call transfers) are handled on the server. Features that require writing to the database
(such as directory and speed dial) rely on the server.

Date and Time

IP phones depend on an SNTP server to maintain the correct time and date. Without an SNTP server,
you can set the phone date and time via a GMT offset.

IP Phones and Voice Switches

IP phones in a Mitel system interact with two voice switches: the configuration switch and the call
manager switch. The configuration switches help the IP phones obtain their configuration from the server,
which functions as a FTP server for the IP phones. You must have at least one configuration switch and
must be able to designate a second configuration switch for reliability.

The call manager switch is responsible for hold, transfer, conference, and park actions.

As part of the configuration information, each IP phone is assigned a Voice Switch that acts as the
phone’s call manager to help the IP phone set up and tear down calls.

Configuration Switches

In a DHCP environment, when an IP phone is enabled, it receives the IP address of the configuration
switch from DHCP and the server. Each system includes at least one configuration switch for this
purpose.

If you have configured the IP phones to start without a DHCP server, you must set the IP address of the
configuration switch manually.

The switches, communicating with the HQ server, determine which switch manages calls for a particular
IP phone. You have the option of assigning two switches to this function, in case one fails.
Call Manager Switch

The call manager module of the Voice Switches handles the Media Gateway Control Protocol (MGCP)
information from the IP phones assigned to it. After a call is connected to an endpoint, media streams are
independent of the call manager switch.

The Voice Switch communicates call information to other switches in the system using Mitel’'s enhanced
SIP protocol. Every site where IP phones are in use must have a Voice Switch configured to support the
number of IP phones at the site.

To configure IP phone support on a Voice Switch, you must reserve ports for IP phone support on the
Voice Switch edit page in Connect Director.
IP Phone Communications

IP phone communications are routed through two protocols: MGCP and RTP (Real-time Protocol).
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MGCP

IP phones (except 400-Series and 6900-Series (6910, 6920, 6930, and 6940) IP phones) communicate
with voice switches via MGCP, a device control protocol. The relationship between the switch (call
manager) and the phone (gateway) follows a master—slave model.

MGCP is used to:

* Deliver information to the IP phone display
e Set up and tear down media streams
¢ Report phone events such as key presses, on hook, and off hook

Real-time Protocol

Media travels through the Mitel system using Real-time Protocol (RTP). After call setup, media flows
directly between IP phones through RTP. The Voice Switch is involved only when setting up or tearing
down a call.

Boot Process

IP phones are pre configured to work in conjunction with your network’s Dynamic Host Configuration
Protocol (DHCP) server. After the servers are configured, when the phones deployed, they are
automatically added to your Mitel system.

After the IP phone obtains the DHCP and FTP server IP addresses, it downloads the application and
configuration files from the FTP server. The IP phone configuration file is modified by Connect Director
during IP phone configuration.

If you are not using a DHCP server or if the server is not currently online, you can set a static IP address
and other startup parameters directly at the IP phone. Static IP addresses for IP phones can also be
assigned using the IP phone setup menus.

IP Phone Firmware Upgrades

The IP phone application software can be upgraded by replacing the application file on the FTP server.
When 100-, 200-, 500-, and 600-Series IP phones and the BB24 button box boot up or reboot, they
automatically download the available new firmware.

You can also initiate firmware updates by triggering a reboot through the Diagnostics & Monitoring
system available through Connect Director.

Note:

Modifying the IP phone configuration files can cause unpredictable behaviour. If you have special needs,
contact Mitel Technical Support for instructions.

Diagnostics

Viewing System IP Phones

IP phone connectivity is displayed in Connect Director in the IP Phone List on the Telephones page
(Administration > Telphones > Telephones).

The number of IP phones connected through a switch and the number of IP phones that can
be connected to a switch are displayed in Connect Director on the Platform Equipment page
(Administration > Appliances/Server > Platform Equipment).

You can also use the Diagnostics & Monitoring system to view status of IP phones. For details, see the
MiVoice Connect System Administration Guide.

On-Screen Error Messages

Any time a user action results in an error being returned by TAPI, the error is displayed on the IP phone
display for six seconds (one North American ring cycle). The error message can be dismissed more
quickly by pressing the OK soft key.
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Diagnostic and Failure Messages

The following table lists and describes the diagnostic and failure messages that may be displayed on IP
phones.

Table 29: Diagnostic and Failure Messages

Display Message Interpretation
File System Failure An internal, unspecified, problem detected while performing a
file system operation.
Boot File Too Big The boot file is too big and will not fit in RAM.
Boot Save Failed Writing the boot image to flash memory failed.

Reconfiguring Network The phone is switching VLANS.

Note:
This might be displayed after DHCP and/or after configuration

file processing.

Duplicate IP Address A duplicate IP address is typically caused by DHCP or a manual
entry of the IP address onto multiple devices.

FTP Unreachable The FTP server is unable to be pinged (for IP110 or IP115).

FTP Server Unreachable The FTP server is unable to be pinged (for others).

Unresponsive task/Resetting A task failed to respond to a keep alive request so the phone is
restarted.

DSP Error/Repair Required DSP testing failed on startup. Bad DSP.

NO MGC IP CONFIGURED An IP address is not set for the MGC.

DSP Asserted/Resetting The DSP crashed, and a reboot is started.

DHCP lease/invalid! ;I'he DHCP lease expired and the phone failed to acquire a new
ease.

APP download failed!/filename Application image download failed.

Invalid App Name The application name does not follow the required format.

Format Failed While trying to store a new image in flash, a failure occurred
when erasing the flash device.

File System Error An error was returned by the file system API.

Invalid Signature The boot or application image file is the wrong type for this
phone.

Invalid Image Version The .bmp image was not of a known acceptable format.

Download CFG file failed/filename Failed to download the main configuration file specified.

Couldn’t Get INCL file/filename Failed to read the specified Include file from the FTP server.

; If a complete conf i g file and all includes cannot be
ILIJas;?g)Cached CFG (for IP110 or downloaded, a cached conf i g file is being used.

Using Cached CFG Files! (for others)

Enter Factory mode In Response to Mute + RRAMOS.

*—No

#— Yes

Factory Test KPD Mode You are in factory test mode ready to test the keypad (via Mute +
RRAMOS).

Boot Application If only a boot application is in flash and an application image

cannot be downloaded, this information is displayed after the
boot process is completed.
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Display Message

Interpretation

No/Ethernet

Ethernet is not detected.

100 Mbps/Ethernet

100 Mbps Ethernet speed in use.

10 Mbps/Ethernet

10 Mbps Ethernet speed in use.

Request Service (for IP110 or IP115)

Requesting Service (for others)

Being requesting service from MGC.

No Service

MGC service is unavailable.

Troubleshooting the IP Phone Display

This section presents some techniques for troubleshooting the IP Phone Display Server. When you
suspect an IPDS (CAS) problem, verify that you can call into voicemail successfully. If you can call
voicemail successfully, then you have an IPDS (CAS) issue. If voicemail does not answer or you hear a
message stating the voicemail system is unavailable, you have an issue with the communications to the
server.

Phone Display Is Incorrect

If a phone display is incorrect, the following may occur:
IPDS/CAS Sent a Bad Display Update

This can be detected by searching through the IPDS log file for the display line in question. If it is found
at the appropriate time and on the appropriate extension, IPDS/CAS is the cause of the problem.
Provide the relevant IPDS log to your engineering resources.

Switch Did Not Update the IP Phone Correctly

It is possible for the switch to mishandle phone updates.

Enabling IPDT Debugging

By default, | PDT logging is turned off. However, you can enable | PDT logging to assist in troubleshooting
efforts.

Enabling IPDT Debugging

To enable logging on the switch:

1. Telnet into the switch.

2. Enterthe i pdt _debug | evel

3. Logging output appears on the screen.

Note:

— -1 command.

¢ Mitel recommends that you enable IPDT logging only for short periods. This feature generates
large amounts of data that consumes CPU cycles on the switch and slows it down.

* You can disable the logging feature by replacing -1 with a -0 in the command above.

* The -1 variable enables tracing for all IPDT-related components. You can selectively enable
individual IPDT components by using the commands and variables listed in the following table:

Table 30: IPDT Debugging Flags

Debug flag

Decimal value

Hexadecimal value

Purpose

DEBUG_HOTDIAL 2

0x2

timeouts and logic
associated with hot dial /
fast transfer feature

DEBUG_NCC_RAW_EVERHS 0x100 raw device status, call
control, and IPDS helper
events from switch core

DEBUG_NCC_DEVICE_|NYENTORY 0x200 ncc acquisitions and

releases
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Debug flag Decimal value Hexadecimal value Purpose
DEBUG_NCC_FLOW1 (4096 0x1000 ncc event handling
DEBUG_NCC_FLOW2 (8192 0x2000 verbose ncc event
handling

DEBUG_CONFIG_NOTIFE55BE®ONS 0x10000 configuration data and
changes

DEBUG_NCC_DISPLAY |BBBIC216 0x01000000 logic associated with
determining which
“screen” is shown

DEBUG_NCC_DISPLAY | BEI#4U32 0x02000000 the actual display
commands sent to the
phones

The functions listed in the following table can be executed from a terminal session. String arguments
must be passed in quotes. Integer arguments may be passed in decimal form, or in hex form by prefixing

with Ox.

Table 31: IPDT Functions

Function

Argument name

Argument Type

Purpose

i pdt _dunpExt ensi ons

none

none

lists all phones and
extensions configured
on switch, along with
CCOID, and phone type
where appropriate.

i pdt _dunpExt Di spl ay

extension number

string

shows current value of
all display elements:
announcement area,
soft keys, custom key
labels, custom key
icons/leds, message
waiting indicator,
location and format of
date and time, location
of borders.

i pdt _dunpCCQODi spl ayf

CCOID

integer

same as above, using
CCOID as key. Use

i pdt _dunpExt ensi ong
to find CCOIDs of non-
extension devices such
as anonymous phones.

i pdt _dunpExt Cal | s

extension number

string

lists all calls on the
given extension. Works
for “foreign extensions”
too (that is, extensions
whose call info is
supplied by IPDS)

i pdt _dunpCCQCal | s

CCOID

integer

same as above, using
CCOID as key; native
extensions only.

i pdt _dunpExt Cf g

extension number

string

lists configuration and
extension status for
extension. For foreign
extensions, lists those
details supplied by
IPDS.

i pdt _dunpCCOCf g

CCOID

integer

same as above, using
CCOID as key; native
extensions only.

i pdt _dunpActi veTi e

mone

none

lists currently active
timed objects in IPDT
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Function Argument name Argument Type Purpose

i pdt _r eset Ext Di spl gyextension number string redraws the entire
display of the phone, by
the given extension.

i pdt _reset CCODi spl gCCOID integer redraws the entire
display of the phone, by
the given CCOID.

i pdt _adm nMsgExt extension number string displays an
administrative message
in announcement area
of given phone for

i pdt _adm n_ti meout
seconds. " or “all”’
indicates all phones on
switch.

i pdt _adm nMsgCCO CCOID integer displays an
administrative message
in announcement area
of given phone for

i pdt _adm n_ti meout
seconds. 0 indicates all
phones on switch

Manual Phone Configuration

Phones must be manually configured if you are not using a DHCP server to provide IP address and
configuration parameters.

You can enter the phone configuration menu at bootup or enter a key sequence from the phone’s keypad.

Manually Configure the IP Phones at Bootup

1. Connect the Ethernet cable into the data jack on the back of the IP phone.

2. At the Password prompt, enter the default password 1234 or the password provided by your system
administrator, followed by the # key.
Note:

You have four seconds to enter the password, after which the phone enters normal operation with
its current settings.

The default Password can be changed in Connect Director. For more information, see the MiVoice
Connect System Administration Guide.

3. Enter the values listed in the table below when prompted. Press # to advance to the next settings or *
to exit.

Table 32: Boot up Configuration Prompts

Prompt Value
Clear all values? Press #. (No.)
DHCP - ON Press * and #.
IP - Enter the IP address for the phone. Press #.
Subnet — Enter the Subnet mask. Press #.
Gateway — Enter the gateway IP address. Press #.
FTP — Enter the IP address of your server. Press #.
MGC — Press #.
Note:
The phone obtains the address from
configuration files on the server.
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Prompt Value
SNTP — Enter the IP address of your time server. Press #.
802.1Q Tagging — OFF Press #.
Note:

Consult your network administrator before

changing this value.
VLAN ID — Press #.

Save all changes Press #. ( Yes.)

The phone downloads the latest bootROM and firmware from the server and in the process, reboots
several times. When the phone displays the date and time, the boot and upgrade process is complete.

Manually Configuring a Phone from the Keypad

1. With the phone on hook, press the MUTE key followed by 73887# (SETUP#).

2. At the Password prompt, enter the default password 1234 or the password provided by your system
administrator, followed by the # key.
Note:

The default IP Phone Password can be changed in Connect Director. For more information, see
the MiVoice Connect System Administration Guide.
3. Enter the values when prompted. Press # to advance to the next settings or * to exit.

The phone downloads the latest bootROM and firmware from the server and in the process, reboots
several times. When the phone displays the date and time, the boot and upgrade process is complete.

Displaying IP Phone Settings

You can display the phone’s current IP parameters setting by entering a key sequence from the phone’s
keypad.

1. With the phone on hook, press the MUTE key followed by 4636# (INFO#). The phone displays the
first two parameters.
2. Press * to advance the display or# to exit.

The phone resumes normal operation after the last parameter is displayed.

Resetting the IP Phone
1. With the phone on hook, press the MUTE key followed by 73738# (RESET#)

The phone reboots.

Configuration for IP Phones

Boot Configuration Operation

Upon booting, IP phones use the FTP server address to acquire their configuration specifications. The
FTP server address is determined from DHCP site-specific options (default option 156). If DHCP is
disabled, the FTP server address can be manually entered on the phone, and the information is stored in
the flash memory of the phone. Alternatively, if DHCP is used (but no site-specific option is returned), the
FTP server returned by option 66 is used.

If the FTP server cannot be reached, or if a configuration file cannot be located, the phone uses the last
successfully-loaded configuration parameters. After a phone is finished reading configuration files, the
current parameters are saved into flash memory.

IP Phone Configuration

When an IP phone boots, it contacts the configured FTP server and reads an initial configuration
file from FTP root. This file corresponds to its coded model name. Each of these initial configuration
files, references a custom configuration file that can be manually edited by a system administrator. As
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phone software is upgraded, the contents of configuration files are overwritten at the time of update by
Kadot aut i | , but custom configuration files are preserved across upgrades.

Configuration parameters are prioritized by the phone in the order that they are processed. Custom
configuration files are the last file read. Any parameters in a custom configuration file override previous

configuration parameters. This applies to local parameters also, as they are processed first, before any

configuration files are read.

Parameters and values are case sensitive. A parameter and its value are separated by one or more
spaces or tabs. Each parameter must begin on a new line of the text file.

The following table lists the phone configuration file names.

Table 33: Phone Models

IP Phone Name Name on Top Model Name Base Custom
of Phone on Barcode Configuration File Name
Label Underside Name
of Phone
IP 110 110 S0 shore_s0.ixt sOcustom.ixt
IP 115 115 S01 shore_s01.xt sO1custom.txt
IP 212k 212k S12 shore_s12.ixt s12custom.txt
IP 230 230 SEV shore_sev.txt sevcustom.txt
IP 230g 230g SEG shore_sevg.txt sevgcustom.txt
IP 265 265 S36 shore_s36.txt s36custom.txt
IP 530 530 S2 shore_s2.ixt s2custom.ixt
IP 560 560 S6 shore_s6.ixt s6custom.ixt
IP 5609 5609 S6G shore_s6g.txt s6gcustom.txt
IP 5659 5659 S6C shore_s6c.txt s6cecustom.txt
IP 655 655 SWE shore_swe.txt swecustom.txt
BB24 24 SBB shore_sbb.txt sbbcustom.txt

While booting, IP phones look in FTP root for the unique configuration file, shor e_<MACaddr ess>. t xt

(the MAC address of the phone).

Note:

MAC configuration files must be named in lower case. While Windows is usually not case-sensitive, the

LI ST command within the Windows FTP server is case-sensitive.

If shor e_<MACaddr ess>. t xt is found, it is used to provide configuration files and configuration
parameters for the phone. If shor e_<MACaddr ess>. t xt is not found, the phone uses the<coded-

nodel - nane>. t xt file for configuration.

The format of a configuration file is:

Parameter1

Value

Parameter2

Value

where the parameter and value are separated by one or more spaces or tabs, and each parameter is on

a new line of the text file (CR/LF is the nominal new line indicator).

Comments may be embedded in a configuration file by starting the line for- the comment with a # symbol.

The maximum permitted size of any configuration file is 5000 bytes.

Additional configuration files may be included in the file by using the Include parameter where its value
is the name of the file (and optionally a path) to include. All Include parameters should be located

in the original file downloaded from the FTP server. Includes must be located at the end of the main
configuration file. The maximum number of included files is 5.
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The most commonly customized configuration parameters are audio levels, described in Configuring
Audio Levels. All other customizable phone configuration parameters are described in Other
Customizable Parameters.

Configuring Audio Levels

Four sets of audio levels can be custom configured for each phone:

* handset
* headset
* ringer

* speaker

The following table lists the default audio levels for all IP phones except the IP655 and the IP400-Series
phones. Default audio levels for the IP655 are provided in the table below. Information about audio
parameters for the IP400-Series phones is provided in Configuring 400-Series IP Phones on page 89.

For more information about the parameters, see Parameter Definitions.

Table 34: Default Audio Levels for IP Phones (except IP655, IP400-Series, and 6900-Series)

Parameter Handset Headset Bluetooth Ringer Levels Speaker
Levels Levels Headset Levels
Levels (for
IP565g)
TxGain 5157 6144 6143 — 8192
RxGain1 183 183 182 130 258
RxGain2 258 258 258 258 410
RxGain3 365 365 364 410 649
RxGain4 516 516 515 649 1029
RxGain5 728 728 727 1029 1631
RxGain6 1029 1029 1028 1630 2584
RxGain7 1631 1631 1631 2584 4096
RxGain8 2303 2303 2303 4096 6492
RxGain9 3254 3254 3253 6491 10289
RxGain10 4596 4596 4595 10288 16305
SideTone 517 649 0 — —
Handset DTMF |13 13 13 — 17
Attenuation
Call Progress |13 13 13 — 17
Tone
Attenuation
Note:

If the value of the RxGain1 parameter for the ringer level is set to 0, the audio is turned off. (The phone
does not ring.)

The following table lists the default audio levels for IP655 phones:

Table 35: Default Audio Levels for IP655 Phones

Parameter Handset Levels Headset Levels Ringer Levels Speaker Levels
TxGain 0 3 — -2
RxGain1 -27 -27 -30 -24
RxGain2 -24 -24 -24 -20
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Parameter Handset Levels Headset Levels Ringer Levels Speaker Levels
RxGain3 -21 -21 -20 -16
RxGain4 -18 -18 -16 -12
RxGain5 -15 -15 -12 -8
RxGain6 -12 -12 -8 -4
RxGain7 -8 -8 -4
RxGain8 -5 -5 0
RxGain9 -2 -2 4
RxGain10 1 1 8 12
SideTone -14 -10 — —
Handset DTMF -19 -13 — -17
Attenuation
Call Progress Tone |-25 -7 — -1
Attenuation

Parameter Definitions

* The TxGain (transmit gain) parameter sets the level of the audio transmitted from the phone onto the
network.

¢ The RxGain (receive gain) values correspond to each of the 10 volume setting levels shown when
the volume on the phone is adjusted. Sometimes, the RxGains are not high enough and need to be
customized for an individual system.

* SideTone is the audio picked up from the microphone and transmitted to the speaker (speakerphone,
handset or headset speaker) that provides feedback to the user that the phone is working. SideTone
gain is very subjective, and is sometimes lowered and sometimes raised.

* DTMF (dual-tone multi-frequency) Attenuation sets the receive DTMF level that the phone user hears.

e Call Progress Tone Attenuation sets the level for the various tones played after a call is placed and
before audio is connected.

¢ The Plantronics CS50 wireless headset provides its own side tone, plus “+” inserts 20 ms delay
between the headset and the phone, which causes some people to say they hear echo when using
the Plantronics headset; in this case, headset side tone may need to be reduced. When you speak,
Plantronics reduces the gain on the speaker by -24dB; but when you stop speaking, the gain is turned
up, and you can hear the last little bit echoed in your ear.

For example, inserting the following line in s2custom.txt or s6custom.txt and rebooting the phone
increases the headset volume settings 11 dB at the highest setting, which may be required in noisy
environments:

Headset levels: 6144,183,258,409,649,1028,1630,2899,6491,10288,14333,917,13,13
Inserting the following line reduces the headset side tone by 6 dB, which some CS50 users prefer:
Headset levels: 6144,183,258,365,516,728,1029,1631,2303,3254,4596,643,13,13

Minimum gain values are 0 and maximum are 32536. Setting values very high may saturate the speaker
and create poor sound quality.

You can change gains on an individual phone by changing the configuration files and then rebooting the
phone. Eventually, all phones on the system obtain these values when they reboot.

Displaying Gain Levels

The prt audCf gVal ues command can be used from a telnet session to display the RxGain (receive
gain) levels for a device.

Other Customizable Parameters

In addition to changing the audio parameters, the custom configuration text files allow you to customize
other parameters, such as phone brightness or day of week abbreviations used in time displays.
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Note:

The tables in this section contain detailed information that can be used to modify the behavior and
functionality of your Mitel system. Make sure that you understand what you are doing before attempting
to use this information to modify your system. Mitel is not responsible for any damage or expenses
incurred through misuse of this information. If you have questions, contact Mitel Technical Support before
attempting to modify your system.

The phones support the parameters described in the table below.
In specifying parameters, the following rules apply:

* |P addresses from the keypad must be provided in dotted-decimal format.

* Cases are preserved in character strings unless otherwise indicated.

e Parameter checking is performed on all parameters to look for illegal values, and illegal values are
ignored.

e White space within a parameter is ignored.

The file names used for AppName, BootName, and FontPixmap, IlconPixmap, WallpaperPixmap and
in include parameters may also include a path to the file. Upper and lower case characters are ignored
except when specified in the path or file name for these parameters to preserve operation with case-
sensitive FTP servers.

For the purpose of comparing the file in flash and the value on the server, only the file name and date are
used.

The abbreviations listed in the following table are used to identify the source of each parameter in the
“Source” column in the table.

Table 36: Source File Abbreviations

Source Abbreviation in Table
DHCP ACK DHCP
DHCP Site Specific Option SSON
Configuration File CFG
Manual Entry Using SETUP MAN
MGCP Message MGCP
DHCP Site Specific Options

Parameters may be set from within a DHCP ACK message in the site specific option field (default is 156,
but it may be modified with the SiteOption parameter). These parameters may be specified in the site-
specific option field:

e FtpServers

e Country

e Language

e Layer2Tagging
* Vlanid

Enclose each parameter in quotes, and separate multiple parameters with a comma. For example:

FtpServers —”192.168.0.13, 192.168.0.23”, Country — 1, Language — 1, SetupPassword —
"12345abcde12345abcde12345abcde12”
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Parameter

Value Type

Value

Source

Default

AppName

Up to 32
alphanumeric
characters

This is the name of the
application image that is in

the telephone. The application
file name can be at most 24
characters long. The combination
of filename and path can be up
to 32 characters long. A new
application name is specified

in a configuration file and is
checked against the NV value to
decide if a new version needs to
be downloaded. The NV value

is updated after a successful
download and flash programming
sequence.

CFG

Value from
factory in NV
Storage

BackLight

Up to 4 ASCII
characters

Number of minutes the backlight
remains on at full brightness
when the phone is idle.

Format:

Backlight NN, where NN is a
number 0-60.

0 - n/a.

1-60 — number of minutes after
which display is shut off

CFG

BackLightDim

Up to 4 ASCII
characters

Note:

Only applicable to the S6C and
S36.

Number of additional minutes the
backlight remains on at a DIM
level after the BackLight interval
passed since an idle state was
entered. A value of 0 causes the
backlight to remain at the dim
level indefinitely.

CFG

120

BootName

Up to 32
alphanumeric
characters

The name of the boot image is in
the telephone. The boot file name
can be 24 characters long. The
combination of filename and path
can be up to 32 characters long.
A new boot name is specified

in a configuration file and is
checked against the NV value to
decide if a new version needs to
be downloaded. The NV value

is updated after a successful
download and flash programming
sequence.

CFG

Value from
factory in NV
Storage

Country

Up to 3 ASCII
Characters

This parameter specifies the
Country that is used by the
Include parameter to identify a
particular file to include. May be
between 1 and 255.

SSON,
CFG, MAN
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Parameter Value Type Value Source Default
DHCP 1 ASCII DHCP enable/disable MAN 1
Characters
0 — Disabled
1 — Enabled
DscpAudio Up to 2 ASCII | Differentiated services code point | CDG 0
characters for audio packets. Allowed values
of 0 to 63.
DscpSignaling Up to 2 ASCII | Differentiated services code point | CFG 0
characters for audio packets. Allowed values
of 0 to 63.
DtmfLevels Up to 3 ASCII | This specifies the DTMF level in | CFG -10
Characters dB of in-band tones sent from
the phone to the network. The
allowed values are -1 to -20.
These are attenuation levels in
dB, so -1 is louder than -20.
Ethernet1 Up to 10 ASCII Status of the 1st Ethernet CFG, MAN | 1,Auto
Character

Interface.
Ethernet2 Status, Speed/Duplex
Where:

Status is 0 or 1 (disabled or
enabled)

Speed/Duplex is one of the
following:

Auto
10/FD
10/HD
100/FD
100/HD
1000/HD
1000/FD
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Parameter Value Type Value Source Default
Ethernet2 Up to 10 ASCII CFG, MAN |1,Auto
Cﬁaracter Status of the 2"'Ethernet 8
Interface.
Ethernet2 Status, Speed/Duplex
Where:
Status is 0 or 1 (disabled or
enabled)
Speed/Duplex is one of the
following:
Auto
10/FD
10/HD
100/FD
100/HD
1000/HD
1000/FD
FontPixmap Up to 32 ASCII | Name of the .bmp format file that | CFG "fontpixmap.bmp
Character contains the font pixmap. Format
is windows .bmp 16 color except
on the S6¢c where it is 256 colors.
Font2Pixmap Up to 32 ASCII | Name of the .bmp format file that | CFG "font2pixmap.bm
Character contains the large font pixmap
used by the U/dIt2 signal. Format
is windows .bmp 16 color except
on the S6¢ where it is 256 colors.
FtpServers Up to 255 A comma-separated list of up DHCP, 0.0.0.0
ASCII to 2 FTP servers. If a server MAN
Characters is unavailable the phone goes
through the list until a working
server is found.
GatewayAddress | Dotted Gateway address for the DHCP, 0.0.0.0
Decimal ASCII |telephone. MAN
GreyLevels Up to 3 ASCIl | Grey level setting for the middle | CFC 1.1
Characters

grey levels on the IP530 and
IP560 only.

Low middle grey level may have
the values:

0-1/4
1-1/3
2-1/2

High middle grey level may have
the values:

0-1/2
1-2/3
2-3/4
Example: 1,2
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Parameter

Value Type

Value

Source

Default

IcmpArpTimeout

Up to 5 ASCII
Characters

Number of seconds before routing
table entries that are created by
ICMP redirects are timed out of
the routing table.

If 0, then they never time out.

CFG

IconPixmap

Up to 32 ASCII
characters

Name of the .bmp format file that
contains the icon pixmap. Format
is windows .bmp 16 color.

CFG

"iconpixmap.bmp

Include

Up to 64 ASCII
Characters

The file name that is specified is
read and its contents included
into the master configuration

file. Files may be specified
completely, or may include

the variables $Hardware,
$Country or $Language. The
value of the Hardware Version
(programmed into flash at the
factory e.g. KO1MO1PO1L01),
Country or Language Parameter
is substituted for $Hardware,
$Country or $Language when the
file name is created. For example:

Include Country_$Country.txt with
the Country parameter set to 3
loads in the file Country_3.txt

This permits parameters to be
specified based on the Country
and Language parameter values.

CFG

IPAddress

Dotted
Decimal ASCII

IP address to be used by the
telephone.

DHCP,
MAN

0.0.0.0

KeepAlive

Up to 3 ASCII
Characters

Number of seconds to wait for an
audit endpoint command before
initiating the IP phone failover.

Note:

If set to zero, recovery
procedures are never started.

The valid range is 0 to 999
seconds.

CFG

120

Language

Up to 3 ASCII
Characters

This parameter specifies the
Language that is used by the
Include parameter to identify a
particular file to include. The valid
range is 1 to 255.

SSON,
CFG, MAN

Layer2Audio

1 ASCII
character

Layer 2 audio priority values from
Oto7.

CFG

Layer2Tagging

1 ASCII
character

802.1Q tagging enable on Port 1
0 — Disable
1 — Enable

SSON,
CFG, MAN

Layer2Signaling

1 ASCII
character

Layer 2 signaling priority values
fromQOto 7.

CFG
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Parameter Value Type Value Source Default
Maxditter Up to 4 ASCIlI | The maximum value that the jitter | CFG 50
characters buffer may be allowed to grow.
Valid values are 10 to 300 mS in
1 mS steps.
MgcAuthenticate gﬁat(r)altérscu If enablt_ad, then only CFG 0
authenticated MGC messages
are accepted by the phone.
0 — disable
1 —enable
MgcServers gﬁ;f_’ag?egsc” Comma separated list of up to 2 glsngMAN 0.0.0.0
MGC Servers. Must be in dotted ’
decimal format.
Example: 192.168.0.1,
192.168.0.2
MonthsOfYear Up to 64 ASCII | Comma separated list of the CFG Jan,Feb,Mar,Apr,
Characters months of the year abbreviations May,Jun,Jul,Aug
used by the phone to display the Sep,Oct,Nov,Ded
time. The first month is January.
NoSvc Up to 64ASCII | String displayed when phone CFG “No Service”
Characters service is lost. Characters in this
string must be specified using
UTF-8.
PersistantEvents Up to 255 Comma separated list of CFG
éﬁe?rlelacters persistent events. Example:
L/hu,L/hd, U/kd,U/ku
ReqSvc Up to 64 ASCII | String that is displayed as the CFG “‘Requesting
Characters phone is waiting for service from Service”
the switch. Characters in this
string must be specified using
UTF-8.
RingDefine Up to 64 ASCII | See the MiVoice Connect System | CFG
Characters Administration Guide for a
definition of permissible values.
RingMap Up to 64 ASCII | See the MiVoice Connect System | CFG
Characters Administration Guide for a

definition of permissible values.
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Parameter

Value Type

Value

Source

Default

RtpBase

Up to 5 ASCII
characters

This is the base port from which
the phone transmits and receives
media.

The valid range is an

even number from 3000 to
65408.65408 is the highest even
16-bit number that allows enough
headroom for the 64 RTP and

64 RTCP ports that are reserved
when you establish an RTP base
value.

Given an RTP base, the

phone should use the next 64
consecutive even numbers for
RTP ports. If within that range an
existing (reserved) odd or even
UDP port number is used, the
phone should skip over an even/
odd pair to the next even number.

For example, if the user set
rtpBase to 5550, then 5550,
5552, 5556, 5558, etc., is usedIn
this example, 5554 is skipped
because 5555 is a reserved

port used by the phonectl server
(actually, 5554 is also used

and also provides a reason for
skipping over 5554).

If an odd number is specified, the
phone should use the next lowest
even number if it fits the above
limitations.

CFG

3000

SetupPassword

32 ASCII
Characters

This is the MD5 hash of the
password that must be entered
after the mute button is pushed to
enter a manual key command.

Note:
This password must be saved

in flash after a value is received
from the MGC so it can be
enforced on subsequent
reboots. It is not cleared by the
CLEAR command nor the clear
step in the SETUP command.

MGCP

1234

SiteOption

Up to 3 ASCII
Characters

Site-specific option number used
by DHCP between 128 and 254.

CFG

156

SntpServer

Dotted
Decimal ASCII

SNTP server address in dotted
decimal format.

DHCP,
CFG, MAN

0.0.0.0
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Parameter Value Type Value Source Default
SpeakerLevels Up to 255 Set the audio levels of the CFG Defaults vary by
ASCII ; phone model.
Characters speakerphone using a comma- For details, see
separated list of values for the Default Audio
following settings: Levels for IP
, Phones (except
TxGain IP655, IP400-
. Series, and
RxGain1 600-Series)and
RxGain2 Default Audio
Levels for
RxGain3 IP655 Phones.
RxGain4
RxGain5
RxGain6
RxGain7
RxGain8
RxGain9
RxGain10
Speaker DTMF Attenuation
Call Progress Tone Attenuation
SubNetMask Dotted Network Mask for the telephone. | DHCP, 0.0.0.0
Decimal ASCII | On boot, the phone checks fora | MAN
non-zero NV value, and if one is
present it is used.
SysLogInfo 8ﬁ;?a2tzeg80” IP Address, module, verbose CFG 0000,0,0,0,0

level, facility code, and output
device of the SysLog function.
The port number may be
optionally identified and
appended to the IP address.

Note:

The default of 514 is used if no
port is specified.

The module is a 32-bit integer
where each bit refers to the
debug enable/disable status
from a specific software module.
Bit assignments are defined in
Configuring Syslog Functionality
for the IP Phones on page 167.

The verbose level indicates the
level of information that is printed.
Levelsare 0 to 7.

Facility code is the syslog facility
code.

The output devices are 0 — serial
port, 1 — syslog server.

Example:
192.168.0.3:514, 279,33,1

163




OTHER IP ENDPOINTS

b.bmp"

to any of the ring signals. The
first value is the signal, and the
second value is the location of the
file on the FTP server.

Example:
L/rg 192.168.0.20/audio/dave.wav

Parameter Value Type Value Source Default
ToneDefine Up to 64 ASCII | See the M Voi ce Connect CFG
Characters System Admi ni stration

Gui de for a definition of
permissible values.
ToneMap Up to 64 ASCII | See the MiVoice Connect System | CFG
Characters Administration Guide for a
definition of permissible values.
TouchBeep Oor1 If enabled, the phone plays a CFG 0
beep when the touch screen is
touched for user feedback.
Version Up to 16 ASCII | This parameter specifies CFG
Characters the version identifier of the
configuration file. It is then
reported via the Mgc/gi signal
request.
Vlanld Up to 9 ASCII SSON, 0
Characters VLAN ID to be used on tagged CFG, MAN
packets from the phone.
Example: 1234
WallpaperPixmap |Up to 32 ASCII [ Name of the .bmp format file that | CFG "wallpaperpixmay
Characters contains the wallpaper pixmap.
Format is windows .bmp 16 color.
WallPaper2Pixmap | Up to 32 ASCII [ Name of the .bmp format file that | CFG "wallpaper2pixmap.bmp"
Characters contains the user pixmap.
WaveRinger1 Up to 64 ASCII | jsed to assign one wave file CFG
Characters . ;
to any of the ring signals. The
first value is the signal, and the
second value is the location of the
file on the FTP server.
Example:
L/rg 192.168.0.20/audio/dave.wav
WaveRinger2 Up to 64 ASCII | sed to assign one wave file CFG
Characters

Local Keypad Procedures

If DHCP is turned off and manual settings are being used, the set should display the text Password
— ? and Speaker — #— OK * — . for at least 1 second. The string assigned to SetupPassword (by the
MGC server or the default) must be provided to access the SETUP command. All other commands are
accessible without a password.

While the Password? prompt is displayed during the boot sequence the user might enter the muteINFO#
(mute4636#) sequence to enter the local | NFOcommand. When the | NFO command is exited, the

phone again displays the Password prompt and continues boot operations.

The SetupPassword is sent by the MGC in hashed MD5 format. The telephone compares the MD5 hash
of the password the user entered with this value to determine if the correct password is entered.

On the IP phones, “Line 1” and “Line 2” refer to the top and bottom lines of the display. On newer
models that support the programmable buttons feature, adapt the display of these positions to suit the
capabilities of the LCD in use. The IP110 and 115 models are slightly different from the other models
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in that they have one line for displaying information. Thus, the “Line 1” information is scrolled across
the LCD display and is followed by the more detailed “Line 2” information. (See the following table for
clarification.)

The IP212k model includes a narrow LCD display. Thus, the “Line 1” and “Line 2” information cannot fit
on one line (as is possible with the other phones). Instead, the text must be wrapped around to appear on
as many as 4 lines, for long strings.

If at any time during normal operation these sequences are entered, the operational display state is
maintained while these commands are displayed, and the display is returned to the current state after
the commands are finished (unless they require a restart). While the phone is in any of these local key
procedures, it returns an error code “501” indicating it is not ready, in response to any MGCP command
received. Because there is not a mute key on the IP110 phone, use the transfer key instead of the mute
key in the following access sequences.

Table 38: Local Command Interface

Access Sequence Mnemonic Procedure Description
Mute 25327# CLEAR

A shortcut for enabling DHCP does not do anything else and
is not password protected (only SETUP is).

This command is present in the event someone hijacks the
phone using the SETUP command. CLEAR allows it to be
brought under DHCP control without knowing the password.

Mute 4636# INFO Display the following information sequentially on the top

and bottom lines of the display. All data is retrieved from the
currently active configuration. Use *to exit and #to go to the
next item. The phone returns to normal operation after the
last screen.

* |P address static/dynamic
e Subnet mask

* Gateway

* Link speed
 FTP server
 MGC server

e SNTP server

» Tagging on/off

* Application file

* Boot file

* Config file date

* App version

* Boot version

e Country

e Language

* Model number

* MAC address

e Serial number

e Hardware version

Mute 7464# PING The phone prompts for an IP address and then pings that IP
address 5 times and report the result after 10 seconds.

Mute 73738# RESET After displaying a warning, resets the phone. On the top line
Reset Phone? and on the bottom line *=No #=Yes.
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Access Sequence Mnemonic Procedure Description

Mute 73887# SETUP After the mute sequence is provided, if Set upPasswor d
is not null, then prompt for the proper password ending

in #. Do not display password digits as they are entered
but use *. If a match, then prompt to Clear All Values?. If
no, then prompt for DHCP On/Off. If DHCP is on skip over
the prompts for IP Address, Subnet Mask, and gateway.
Then prompt for FTP Server, MGC Server, SNTP Server,
Tagging On/Off, VLAN ID, Ethernet1, Ethernet 2, Country,
and Language. Save to NV storage if values are modified.
If Clear all Values? is answered with yes, in addition to
returning settings to the <Not Set> state, any cached DHCP
values including the IP address are cleared.

If a value was never configured using SETUP, it is displayed
<Not Set> when its prompt is displayed. Otherwise, the
value stored in flash is displayed. The only exception is the
DHCP value, which defaults and clears to the ON state.

Setup value may be returned to the <Not Set> state by:

* Answering yes to the “Clear All Values?” query

» Executing the factory CLEAR command ( executable only
from the serial port)

e All values are <Not Set> when the phone is new.

Perform this error checking on IP address entries during
setup:

* Only 0-9, * and # are accepted.
* Leading zeroes are ignored

* Values outside 0-255 are ignored. If 2 digits are input, a
third digit that makes the value >255 is ignored. So, upon
entering 654, the 4 is ignored.

“

e Multiple “.” inputs are ignored.

* If no entry is provided before “.” is entered, a 0 is
automatically inserted.

Parameter Precedence
The IP phones use the following order of precedence sources for all parameters:

1. Config file

2. DHCP (if active)
3. Set up Command
4. Defaults

In other words, configuration parameters have precedence over DHCP over Setup over Defaults.

Not all parameter sources may be supported for every parameter. Phone Configuration Parameters
indicates which sources are allowed for each parameter.

To fully manually configure a phone simply turn off DHCP, then use the Setup command but be sure not
to specify an FTP server that might download a configuration file and overwrite your manual settings.

PhoneCTL Command Line Tool

PhoneCTL is a command-line tool used to configure and diagnose IP phones. PhoneCTL commands can
be run from the Windows command prompt.

Syntax for PhoneCTL commands can be obtained by typing pi ng at the prompt and pressing Enter.
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Commands
The supported commands are the following:

e aut hentic8
e tel netOn
e telnetOF f

Note:
All commands are case-insensitive.
After the phonect| command, the user is prompted to enter a password.

After the user enters the correct password, the device permits access to executables that configure or
diagnose the respective device.

CLI passwords are configurable only through Connect Director. The default password is ShoreTel.

Configuring Syslog Functionality for the IP Phones

Several commands are used to set up syslog functionality. These must be run before any logging
messages can be received.

SetLoglevel

The set LogLevel command (the table below) sets the logging severity level.

A log level remains in effect until a new set LogLevel command is issued.
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Table 39: setLogLevel Command

Syntax Example Parameters
Pronpt : \ phonect| - Pr onpt : \ phonect | modulelDis the ID number of
set LogLevel [nodul el D] -setLoglLevel 3 7 the specific IP phone software
[level] [destlP] 192.168. 0. 170 modules the logging level is

being set for. It is a 32-bit integer.
Values must be 0-655335. Each
bit in the integer enables or
disables a specific module. Any
module bit that is not set is not
logged. Hexadecimal values for
phone software modules include:

0x1 Call Processing (MGCC)

0x2 Config File Processing
(MCFGP)

0x4 User Storage (MUSTG)

0x8 Network Configuration
(MNETC)

0x10 User Interface (MELUI)
0x20 Display Driver (MDIS)
0x40 Provisioning (MPROV)
0x80 Task Maintenance (MAINT)

The number used in the
parameter is the decimal
equivalent of the sum of the hex
values for all modules that are to
be logged.

For example, to turn on only the
user interface module, enter

16 in the [modulelD] parameter
(which is the decimal value of
0x10). To turn on call processing
and config file process, enter 3 in
the [modulelD] parameter (which
is 0x1 + 0x2 in decimal).

This is the value shown in the
example command shown
above. To turn on all modules,
enter 255 (which is 0x1 + -x2 +
0x4 + 0x8 + 0x10 + 0x20 + 0x40
= 0x80).

SetServerlP

The set Ser ver | Pcommand (the table below) sets the server’s IP address and points to the location
where messages are to be logged.
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Table 40: setServerlP Command

Syntax

Example

Parameters

Pr onpt : \ phonect |
-set Serverl P

[ newServer| P] [dest!|P]

Pr onpt : \ phonect |

set Server| P 192.168.0. 3

192. 168. 0. 170

newServerlP is the address of
the computer running the syslog
server application.

destlIP is the IP address of the
destination IP phone to which the
command is sent.

SetOutputDev

The set Qut put Dev command (the table below) sets the output device to which the syslog messages

are sent. The device may be either a serial port or the syslog server.

Table 41: setOutputDev Commands

Syntax

Example

Parameters

Prompt : \ phonect | -
set Qut put Dev [devl D]
[dest | P]

Pronpt : \ phonect |
-set Qut put Dev O
192.168. 0. 170

deviD is set to zero if the device
is a serial port or one for the
syslog server.

destlP is the |IP address of the
destination IP phone to which the
command is sent.

Retrieving Information about the IP Phone

Dump2pc

The dunp2pc command (the table below) is used to retrieve the syslog messages from the IP phone’s
buffer. The results are printed to the command line.

Table 42: dump2pc Command

Syntax

Example

Parameters

Pronpt : \ phonect| -
dunmp2pc [dest!| P]

Pronpt : \ phonect |

dunmp2pc 192. 168.0. 170

destIP is the IP address of the
destination IP phone to which the
command is sent.

ShowLogLevel

The showLogLevel command (the table below) prints the log level of each module for which logging is
active. Information is printed to the command line.

Table 43: showLogLevel Command

Syntax

Example

Parameters

Pronpt : \ phonect| -
showiLoglLevel [ nodul eNuni
[dest | P]

Pr onpt : \ phonect |
-showLoglLevel 4
192.168. 0. 170

destlP is the IP address of

the destination IP phone the
command is sent to. You retrieve
the log level settings for this
phone.

ShowConninfo

The showConnl nf o command (the table below) shows information about connections created by

MGCP_create messages.

169



OTHER IP ENDPOINTS

Table 44: showConninfo Command

Syntax Example Parameters

destlP is the IP address of the
destination IP phone to which the
command is sent.

Pronpt : \ phonect| - Pr onpt : \ phonect |
showConnl nfo [dest!| P] - showConnl nf o
192.168. 0. 170

ShowStats

The showSt at s command (the table below) shows information about connections created by
MGCP_create messages.

Table 45: showStats Command

Syntax Example Parameter
Prompt : \ phonect | - Pronpt : \ phonect | cxid is the ID number of a
showSt at s [ cxi d] -showStats 5 specific connection. The value
[dest | P] 192.168. 0. 170 can be discovered by reading

the value returned by the
showConnInfo command.

destlP is the |IP address of the
destination IP phone to which the
command is sent.

ShowTime

The showTi me command (the table below) prints the time of day on the command line for the destination
IP phone.

Table 46: showTime Command

Syntax Example Parameters

destlIP is the IP address of the

Pronpt : \ phonect| - Pronpt : \ phonect| - LS .
showTi me [ dest | P] showTi me 192. 168. 0. 170 2§rsrf'rﬂgtr']%”is”jsggt‘_’”e to which the
Version

The ver si on command (the table below) prints the version of the PhoneCTL software.

Table 47: Version Command

Syntax Example

Prompt : \ phonect| -version Prompt : \ phonect| -version

Softphone

The Softphone can be launched through Connect client. Softphone does not support NAT or firewall
transversal. Problems with the Headquarters server or network connectivity can prevent the softphone
from being loaded.

From a configuration and management standpoint, the softphone appears to be an IP phone with some
limitations. User have access to the DTMF keys (0-9, #, *), on hook, off hook, and flash.

The softphone user interface does not have a display, so it does not interact with IPDS. Just like an IP
phone, the softphone uses MGCP for call setup and teardown, and RTP for media.
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IP phones are uniquely identified by their MAC address. In most cases the softphone is identified by the
NIC of the user PC. If a softphone is installed on a PC without a NIC, the softphone generates a fake
MAC address that is still unique.

The softphone page contains an ActiveX control that implements the VolP media support. Because

it requires an ActiveX control, the softphone only works on PCs with Internet Explorer and Microsoft
Windows. The ActiveX object attempts to reach the switch call manager configured in Connect Director. If
the switch call manager is successfully contacted, the softphone buttons are enabled.

When the switch call manager is contacted, Connect Director detects that a new IP phone is being
registered. Depending on licensing and IP phone port availability, a new port is automatically created
in the configuration database. The softphone then appears in the Individual IP Phones list in Connect
Director.

In some situations, Connect client waits for several seconds for a corresponding IP phone port to appear
in the configuration database. If this times out, a warning message is displayed in the softphone status
bar.

When Connect client is closed, the operation is reversed to return the user to his or her home port.

Dial Tone Behavior

The following section discusses the dial tone behavior for various call operations.

Transfer

When a user is on a call and hits the transfer button, the phone remains off-hook and plays a dial tone.
When the user completes the blind or consultative transfer while on the speakerphone or headset, the
phone automatically goes on-hook. Only if a user is on the handset does the phone stay off-hook and
play a dial tone. A user using hands-free mode with speaker or headset goes on-hook without a dial tone.

Park

When a user is on a call and hits the park button, the phone remains off-hook and plays a dial tone.
When a user parks a call while on the speakerphone or headset, the phone automatically goes on-

hook. The phone plays dial tone only if the user is on the handset. When using hands-free mode with the
speaker or headset, the phone goes on-hook without a dial tone.

Hold (Multi-line IP Phones)

When a user on a multi-line IP phone places a call on hold while on the speakerphone or headset, the
phone goes on-hook. If the user is on the handset, the phone plays a dial tone. A user using hands-free
mode with speaker or headset goes on-hook without a dial tone.

* To retrieve the call, go off-hook by lifting the handset, pushing the speaker button, pushing the headset
button, or pushing the call appearance

¢ To answer a second incoming call, press the second call appearance.

* To retrieve a second held call, press the second call appearance.

Hold (Single-line IP Phones: IP110/IP115)

When a user on a single-line IP phone places a call on hold while on the speakerphone or handset, the
phone remains off-hook and plays a dial tone. A user using hands-free mode with speaker or headset
goes on-hook without a dial tone.To retrieve a call, the user can go off-hook by lifting the handset and
pushing the speaker button.

New Voice Mail Indicators
Your voice mailbox contains unplayed messages if:

¢ There is an interrupted dial tone for two seconds after a new line is opened.
¢ The phone’s Message Waiting Indicator (MWI) light flashes.

Connect Client
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Connect Client Logs

The Connect client creates a log file each time the user logs in. The logs are used to help the Mitel
Technical Support with debugging problems that may arise during the client operation. Users can send
the log files to the Mitel Technical Support while opening a troubleshooting ticket.

To send the client logs:

1. Press Ctrl+F12.
2. In the Log Level tab, select the following:

* Type of logs to be captured in the log report (Information or Debug)

* Specify the number of log files. The default value is 20 and you can set the maximum number up
to 1000 files.
Note:

Upon reaching the maximum limit, the newly generated log file replaces the oldest file in the
logs folder.
¢ Specify the size limit for each log file. The default value is 20 megabytes and you can set the
maximum size up to 1000 megabytes
3. In the Logs tab, do one of the following:

¢ Click Send Client Logs to send the logs through email to the Mitel Technical Support.

¢ Click Open Log Folder to open the log folder on your system. You can select the required log file
and send through email to the Mitel Technical Support.

* The log files are stored in the Connect-<date>.<time>.log format.
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Service Appliances

This chapter contains information about Service Appliances.
Overview

The Service Appliance is a sealed appliance, optimized for resiliency and security, capable of running
Mitel services. The Service Appliance can host Audio Conferencing, Web Conferencing and Instant
Messaging services.

Service appliances are deployed in the same manner as other voice switches and managed similarly to
the voicemail-enabled switches. Director windows configure conference settings and provide status for
the Service Appliance. Network setting are configured using a serial cable or the Service Appliance's
switch command line interface (st cl i ). The management of the services running on the Service
Appliance switch is done via the Service Manager command line interface (svccli ). Thestcli and
svccl i are accessible via a serial cable or remotely via SSH.

This chapter describes the processes and procedures necessary to back up and restore your Service
Appliance, locate key log files, produce logs, and various switch commands and utilities useful for
monitoring and troubleshooting the Service Appliance.

* Using the Service Appliance
* Log Files and Processes

* Log Files

» Service Appliance Utilities

» Diagnostics and Repair

Using the Service Appliance

Service Appliance Maintenance

A few key tasks are required to maintain the Service Appliance (the table below).

Table 48: Service Appliance Maintenance Tasks

Task Description

Backup Performs regular automatic backups of your Service Appliance to protect
conference data, generated recordings, and uploaded user content

Restore Restore your Service Appliance based on a saved backup of both the
Service Appliance and the HQ database. Coordinates the restore of the
Service Appliance with the restore of the HQ database.

Disk Management Watches disk utilization to avoid running out of disk space.

Service Appliance Backup

The Service Appliance uses the same backup and restore methods as the voicemail-enabled switches.
Backup scheduling and configuration is performed in Connect Director. The manual backup and restore
commands are executed on the Service Appliance using the Service Manager command line interface
(sveeli).

Back up your system to protect the conference data, generated recordings, and user files uploaded to
the Service Appliance. This feature is NOT meant as a method of archiving or as a method for retrieving
accidentally deleted files.

Note:

Install the Service Appliance on the same network as the FTP backup server to avoid bandwidth issues.
The Service Appliance can generate more than 1GB of data per day and have more than 100GB stored
internally.

There are two methods for backing up the Service Appliance:
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¢ Automatic scheduled backup
e Manual backup.

Automatic Backup

Automatic backups are performed after the system administrator configures the backup parameters in

Connect Director.

The following table lists and describes the parameters.

Table 49: FTP Server Parameter

Field Description

Enable Daily Backup Turn on/off automatic backupsr

IP Address The IP address of the FTP Server.

FTP Port The FTP port used to access the FTP server.
Note:
The FTP port must be set to 21. The Service Appliance can only
perform backup and restore against a FTP server running on port
21.

Directory The directory on the FTP server where the backup files are stored.
Note:
If you are backing up multiple Service Appliances, use a separate
directory for each Service Appliance.

User ID The User ID for accessing the FTP server.

Password The Password for accessing the FTPserver.

Manual Backup

To perform a manual backup, you must have configured the FTP parameters in Connect Director per the

automatic backup set.

1. Access the Service Appliance using either the serial Port or via SSH.
2. Start the Service Manager command line interface (svccl i ).

3. Run the backupweb command.

Accessing the Service Appliance Using the DB9 Serial Port

1. Connect a serial cable from a desktop/laptop PC to the DB9 serial connector on the rear of the

Service Appliance.
Note:

Establishing the serial console connection requires a DB9 female to DB9 female cable, instead of
a DB9 male to DB9 female as in the voice switches. A Null-Modem connection (crossover cable)
is required, instead of the straight-through cable (extension cable) used on voice switches.

2. Open a terminal emulation program such as Hyper-terminal or Putty and set it for a serial connection

using the following parameters:

e Serial Port: COM X (where 'X' is the port number used on your PC)

e Speed: 19200 baud
e Data Bits: 8

* Stop bits: 1

e Parity: None

¢ Flow control: None

3. After establishing a serial connection, login to the Service Appliance environment using Admin as the

User ID and ShoreTel as the Password.
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Accessing the Service Appliance Using a SSH Connection

Open an SSH client and connect to your Service Appliance using SSH.

Note:

Telnet to the Service Appliance is not supported.

You can create a SSH connection on the command line by issuing the following command:

SSH -1 adnmin <ip address or donmain name of the Service Appliance>

Manually Backing Up the Service Appliance

1. At the Li nux prompt ($ for admin access; # for root access), run the svccl i command to start the
services cli.

2. Start the backup using the backupweb command.

When the backupweb command returns you to the svccl i prompt (">'), exit the svccl i .

4. Verify that the backup is complete by checking the / cf/ shor el i nedat a/ Logs/ Ft pSync-
<dat e>. <t i me> log file where:

d

* <date> is the current date
e <time> is the time when the log file was created

Restoring the Service Appliance Backup

You may restore a previous backup of the Service Appliance by executing the r est or eweb command
using the svccli. See Automatic Backup for more information about the location of the backup files.

Restoring Best Practices

Restore the Service Appliance with a restoration of the HQ database from the same day.

Note:

Since the file pointers are stored in the database in HQ application server, users MUST back up/restore

BOTH the HQ database and Service Appliance(s) altogether to ensure consistency between HQ
database and Service Appliance file system.
Note:

Restoring a Service Appliance backup without restoring HQ database taken from the same time as the
Service Appliance backup may cause the following issues:

* Ghost files - These are the files that exist during the time when the Service Appliance backup was
made, but have since been removed.

¢ Wrong metadata files - Service Appliance restore overwrites existing files on the Service Appliance
even if the existing files might be more up to date than the ones in backup.

To ensure the file system on the Service Appliance is consistent with HQ database:

e Enable daily backup for Service Appliance in Director

¢ Schedule a windows task to back up the HQ database at the same time as the daily backup

* Restore HQ database from a backup that was created at the same time as the Service Appliance
backup that is going to be restored

* Restore Service Appliance from a backup created at the same time as the HQ database backup

Manual Restore

A manual restore is the only method for restoring the Service Appliance. The system administrator
accesses the Service Appliance (through the serial port or via SSH) and executes the r est or eweb
command from the Service Manager command line interface (svccli).

Manually Restoring the Service Appliance

1. At the Li nux prompt ($ for admin access; # for root access), run the svccl i command to start the
services cli.
2. Start the backup using the r est or eweb command.
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The restore is complete when the r est or eweb command returns you to the svccl i prompt ('>').
3. Verify that the backup is complete by checking the / cf/ shor el i nedat a/ Logs/ Ft pSync-
<dat e>. <ti me>. Log Fil e where:

* <date> is the current date
e <time> is the time when the log file was created

Disk Management

The system administrator must monitor the disk space usage on the Service Appliance to ensure that
users can continue uploading presentation data for web meetings. The system administrator can monitor
disk usage via the system administrator's Conferencing User Interface.

Note:

The system administrator cannot delete media uploaded to the Service Appliance without deleting the
user. Users must delete their own uploaded media files. If the system administrator deletes the user, all of
the media files and recordings uploaded by the user are deleted.

Disk Usage from the Command Line

The following table lists and describes disk usage from the command line.

Table 50: Disk Usage From The Command Line

Name Description

df -h Li nuxfree disk command. This command displays statistics
about the amount of free disk space on all mounted files
systems (that is, disks) on the Service Appliance

du -bc --excludes —".*"*|grep -i total Li nux disc usage command. This command returns the total
apparent size (in bytes) for all the files and sub-directories of
the current directory

getstatus all svccl i command that shows high CPU usage processes,
memory usage and disk usage

Log Files and Processes

The Service Appliance provides log files for various processes running on the appliance. Most logs are
located in the / cf/ shor el i nedat a/ Logs directory.

Service Appliance Logging Process

Collaboration Manager/Collaboration Attendant (CMCA)

The CMCA provides session control for new and existing conferences. Monitoring conference extensions
via TMS and manages participant and Reservation-less or Scheduled conference calls arriving at

the Conference Extension. It uses the media module for playing prompts, playing files, playing tones,
recording media sessions.

STTS (SoftSwitch)

The STTS process hosts local Conference Extensions (CEs). To create conference calls between users
and CMCA, join and end conference calls, and provide call signaling during the conference session.
Media Module

The media module provides media resources (prompts and user audio mixing) for audio conference
sessions. The CMCA uses the media module to setup media resources during conference calls.
Telephony Management Server (TMS)

The TMS provides call control for conference sessions. It also manages Participant Lists and provides
the Call Detailed Record (CDR) interface for the CMCA.
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Web Bridge

The Web Bridge provides Internet conference viewing screen and data sharing, and provides a server
side interfaces for user conference and Service Appliance web conference administration.

Other Services

The list of services running on the Service Appliance can be viewed using the svccl i interface.
Service Appliance Processes and Protocols

The following table shows the processes and protocols are used by the Service Appliance:

Table 51: Service Appliance Protocols

Name Description

TAPI Telephony API - provides call control information between CMCA
and TMS. STCTSP is the client side of the TAPI connection.
STSTSP is the server side of the TAPI connection.

Media Control Messages between CMCA and Media to provide media
resources to conference participants

Call Control Messages between Media and STTS to provide media resources
to conference participants

CDs Call Data Service - provides CDR records to the HQ database

NCC Network Call Control provides call setup/teardown between TMS

and network switches

SIP Session Initiation Protocol - setup and teardown phone calls
between switches. It is also used for 3rd party SIP phones

MCGP Media Gateway Control Protocol - setup and teardown phone
calls between IP phones and voice switches

Log Files
The following table lists and describes the key log files in the Service Appliance:

Table 52: Service Appliance Log Files

Name Description
WC2Access and WC2Error logs Access and error log files for web bridge
apache_access and apache_error logs ﬁpgche access and error logs when accessing the web
ridge

STMEDIA log New media log file for audio mixing. Media are the audio
prompts played to audio bridge users.

STTS log SoftSwitch Logs

CMCA log Access and error log files for the Service Appliance CMCA
process

STCTSP and STSTSP logs TAPI client and server logs for communication between

CMCA and TMS
TmsCDS, TmsMain, and TmsNCC logs | Telephony Management Server logs

Service Appliance Utilities

 UBOOT on page 178
e Stcli on page 178

e Clion page 178

* Regedit on page 178
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Accessing Utilities from SSH

Mitel provides access to several voicemail utilities through a Linux BASH command line. Voicemail-
enabled switches define two accounts: Admin and Root.

* Admin: The Admin account provides access to selected Mitel and Linux utilities, including all
voicemail-enabled switch command line interfaces.
Note:

Mitel recommends that user log into the Admin account when accessing Linux utilities.

Unlike the voicemail-enabled switches, logging into the Admin account does not open the st cl i
interface. Logging into the Root account immediately opens a Linux BASH shel | . The administrator
must run the st cl i command to use the stcli .

* Root: The root account provides access to all Mitel and Linux utilities. Restrict access to this account
to help prevent potential switch problems.

Logging into the Root account immediately opens a Linux BASH shel | .

Access to the Linux BASH command line through an SSH client.

Appliance Utilities

The Service Appliance uses the same switch architecture as the voicemail-enabled switches. The switch
utilities are nearly identical to the voicemail-enabled switches. As such, only general descriptions are
provided in the following sections.

See Overview on page 64 for detailed descriptions and processes. Relevant differences between the
voicemail-enabled switches and the Service Appliance are described in the following sections.
UBOOT

UBQOT is the boot loader for the Service Appliance. The UBOOT;environment is accessed from a
terminal emulator through the serial port when the switch is booted.

See UBOOT Commands and Flags;for a detailed description of the UBOOT boot loader.

Stcli

Shell (st cl i ) displays and modifies system configuration parameters. You can implement static or
dynamic IP addressing for the switch from st ¢l i . You can also reboot the switch from st cl i .

See stcli Commands for a description of the st cl i commands.

Option 7 is unique to the Service Appliance; it restores the Service Appliance back to factory defaults.
See Restore Factory Default for details.

The administrator can execute this command only by using the root account for the SSH session.

Cli

The cl i interface accesses diagnostic tools, manipulates debug setting levels, and displays system
information. cl i can be run from any remote SSH session or from Windows prompts originating from the
local host, the controlling Distributed server, or the Main server.

Regedit

Regedi t, a utility that modifies registry-type data structures in the switch, is accessible through the root
account. voicemail-enabled switches have a registry similar to Windows Servers. To edit the Registry, log
in as root and run the RegEdi t command line tool from the bash shell. RegEdi t might be used to set
logging levels on applications and set other parameters that change their behavior.

Note:

The Registry is a construct, not part of Linux.
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Diagnostics and Repair

The Service Appliance uses the same switch architecture as the voicemail-enabled switches. See
Booting and Restarting Voicemail-Enabled Switches for a detailed description of the booting and
restarting process. The Service Appliance does not use compact flash. As such, compact flash
commands and boot methods do not apply to the Service Appliance. Also, the Service Appliance does
not capture audio output from a switch port.

Restore Factory Default

If the Service Appliance becomes non-operational due to corruption of the OS or application, it may be
possible to restore the appliance to an operational state.

Procedural steps to follow depend upon whether a backup exists for the appliance to be restored,
whether HTTPS is being used and whether the Service Appliance is in a single appliance installation or
one of multiple Service Appliances in a distributed system.

Depending on configuration, various recovery steps may be required:

* Turn offflon HTTPS and uploading of SSL certificates. See the MiVoice Connect Conferencing and
Instant Messaging Planning and Installation Guide for details.

* Configuring a Service Appliance with original IP address settings. See the MiVoice Connect
Conferencing and Instant Messaging Planning and Installation Guide for details.

¢ Installing a Service Appliance in Director. See the MiVoice Connect Conferencing and Instant
Messaging Planning and Installation Guide for details.

¢ Restoring a backup to an Service Appliance. See Restoring the Service Appliance Backup.

» Perform Restore to Factory Default. See Restoring Service Appliance to Factory Default.

Restoring Service Appliance to Factory Default

1. Using the serial port, login to the Service Appliance as root.
2. Enter stcli to open STCLI menu.

3. Select 7 -- Restore factory default.

4. The Service Appliance reboots and start up login prompt.

Note:

Following the restoration to factory default condition, the Service Appliance requires configuration
with IP addressing before any backups can be restored into the appliance. See the MiVoice Connect
Conferencing and Instant Messaging Planning and Installation Guide for detailed instructions.
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Appendix A - Event Codes

This appendix includes information about Event codes.

Overview

Event Types

Using the Event Code Tables
Switches

Telephony Management Service (TMS)
Voice Mail Port Manager

Media Driver

Event Watch

System Management Interface
Port Mapper

Trigger Server

Distributed Routing Service (DRS)
Kadota Utility

Call Accounting

Workgroup Server

CSIS

IP Phone Configuration Service (IPCS)
ABC

Edge Gateway

Offline Migration

IP Phone Display Server (IPDS)
CMCA

Overview

This appendix provides a comprehensive list of event codes. Organized by error type and sorted by event
ID numbers, the tables in this appendix are a helpful resource for troubleshooting events reported by the
Mitel system.

Connect Director provides the following methods for viewing events:

Clicking Maintenance > HQ Event Log > System or Application allows you to see all events the
system or application generates. For more information, see the Maintenance section in the MiVoice

Connect System Administration Guide.

Clicking Maintenance > Diagnostics and Monitoring > Alerts allows you to view the events
associated with a particular alert. For more information, see the Monitoring and Diagnosing section in

the MiVoice Connect System Administration Guide.

Event Types

The tables in this appendix lists the event types according to the following categories associated with
components in the Mitel system:

Switch

TMS

Voice Mail Port Manager
Media Driver

Event Watch

System Management Interface
Port mapper

Trigger Server
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» Distributed Routing Service (DRS)

* Kadota Utility

e Call Accounting

e Workgroup Server

* CSIS

¢ |P Phone Configuration Service (IPCS)

 ABC

¢ Edge Gateway

» Offline Migration

* |P Phone Display Server (IPDS) (also known as CAS)

Using the Event Code Tables

The event tables in this appendix provide a structured view of events you may encounter in messages
and log files. Each event table entry includes a unique event ID number, a severity level, the event

message text, possible causes, and suggested courses of action (if any).

In some cases, event codes result from other error conditions that cause related problems. For this
reason, always review event codes in the context in which they appear. For example, if event code 171
(internal operating temperature of switch is exceeding acceptable range) appears with code 166 (internal
fan failure), you should replace the fan—not the entire switch—to solve the problem.

Each event is assigned one of three levels of severity. The following table lists and describes the severity

levels used in the tables:

Table 53: Severity Level Descriptions

Severity Level

Explanation

Information Reports status

states.

Typically, no action is required.

Indicates normal operation, or a transition between normal operating

Error

Reports an exception to normal operations

Depending on the event and its context with other events, it requires no
action, monitoring, troubleshooting, or referral.

Warning

Alerts you to a failure or an impending failure (for example, when a
service or hardware component is disabled)

In most cases, a warning requires immediate response and resolution.

Switches

The following table lists and describes event codes for switches.

Table 54: Event Codes: Switches

ID Severity Level Message Cause

Action

100 Error The Voice Switch
is receiving too
many events from
the NT Server.
Possibly caused
by an application
problem on the
server.

Switch < Voice
Switch Host
Name>: Event
message lost,
queue overflow.

Check the server for events
that might indicate an
application problem.

Troubleshoot the problem and
reboot the server, if you cannot
identify a cause.
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ID Severity Level Message Cause Action

101 Warning Switch < Voice Flash memory area | If problem persists, return for
Switch Host is corrupt. repair.
Name>: The
<area> in flash
memory is corrupt
and is being reset.

102 Error Switch < Voice Application is If problem persists, return for
Switch Host unable to erase repair.
Name>: Unable area of Flash
to reset <area> memory.
in flash memory,
erase failure.

103 Error Switch < Voice Application is If problem persists, return for
Switch Host unable to write repair.
Name>: Unable to |area of flash
update <area> in memory.
flash memory, write
failure.

105 Error Switch < Voice A software Contact Mitel Technical
Switch Host exception Support and be prepared to
Name>: Task occurred. provide the log files for further
exception analysis.
occurred. System
needs to be
restarted.

106 Error Switch < Voice A task exception Contact Mitel Technical
Switch Host occurred. The Support and be prepared to
Name>: Task Voice Switch provide the i pbx andt msncc
exception experienced an log files for further analysis.
occurred. System | internal error and is
automatically rebooting.
restarting.

107 Information Switch < Voice ;Voice Switch No action.
Switch Host restarted via the
Name>: Restart Maintenance >
request received Appliances >
—system is being | Servers page in
shutdown and Connect Director.
restarted.

108 Error Switch < Voice No longer reported | This event code reports
Switch Host in NT event log. internal software debug
Name>: Internal statements for use by
error: developers.

109 Error Switch < Voice The switch cannot

Switch Host
Name>: Unable
to seize trunk

on port <port
number>. Taking
trunk temporarily
out of service.

seize a trunk.

Verify that the trunk line is
connected to the Voice Switch.

Check wiring between Voice
Switch and the telephone
company De-marc.

Connect a phone or telephone
test set to the line, then go off-
hook and listen for a dial tone.
If no dial tone is present, report
the problem to your service
provider.

182




APPENDIX A - EVENT CODES

ID Severity Level Message Cause Action
110 Information Switch < Voice The system No action.
Switch Host administrator took
Name>: Trunk the port out of
on port <port service.
number> taken out
of service by the
administrator.
111 Information Switch < Voice The trunk line is No action.
Switch Host again functional
Name>: Trunk on |andis back in
port <port number> | service.
is back in service.
112 Information Switch < Voice Trunk is back in No action.
Switch Host service.
Name>: Trunk
on port <port
number> put back
in service by the
administrator.
113 Warning Switch < Voice Specified extension | Put the port back in service
Switch Host port removed from | when the system administrator
Name>: Extension | service. indicates that it is appropriate.
on port <port
number> taken out
of service by the
administrator.
114 Information Switch < Voice Specified extension | No action.
Switch Host port is back in
Name>: Extension | service.
on port <port
number> put back
in service by the
administrator.
115 Information Switch < Voice The switch No action.
Switch Host
Name>: System was reset and
restarted. Product: |subsequently
Firmware Version: |restarted.

< Voice Switch
firmware version
number> BootROM
Version: < Voice
Switch bootrom
version number>
Telephone Board:
< Voice Switch
telephone board
revision number>
CPU Board: <
Voice Switch CPU
revision number>

(The event also
provides current
version information
for the switch.)
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ID Severity Level Message Cause Action
116 Error ;c\)/sq(icl:\leaavéilcrost The switch The specified switch may be
connection to is unable to off or disconnected from the
switch < Voice communicate with | network.
Switch Host the other Voice . . .
Name>. . . | Check the switch in question
Switch specified in . o
the event to confirm that it is powered on
’ and connected to the network.
The swilches are If the switch is connected
not able to place . .
to the network, verify with
calls to each other. . o
Director that it is properly
configured.
For event 205 and 206, update
the configuration and power
cycle the switch.
After restart, confirm network
visibility and the switch’s
configuration.
117 Information Switch < Voice The switches No action.
Switch Host Name | established a
>: Established connection and
connection to are communicating
switch < Voice with each other.
Switch Host
Name>.
119 Warning Switch < Voice The switch is losing | Verify that your network
Switch Host Name | an excessive configuration meets the
>: Excessive number of packets. | requirements.
number of packets
lost from < Voice
Switch Host
Name>.
127 Error Switch < Voice The call cannot - P
Switch Host be forwarded Conﬂrm tl"1at the spec!fled
Name>: Failed to the specified extension's call handling mode
to forward call extension. configuration is valid.
on <CHM Type> Thi h
from <extension is error can appear when
number> to the destination extension
<extension is connected to a Voice
number>. Switch that is either offline or
unavailable to the network.
130 Error Switch < Voice An incoming fax Confirm that the extension
Switch Host transmission . .
Name>: Failed call was not is p_rope_rly configured for fax
to redirect redirected to the redirection.
:‘?c?r%nllg)%t;%xsion fax extension. _Confirm t.hat the fax extension
number> to is operating properly.
<extension
number>.
131 Error Switch < Voice The Voice Switch Reboot the switch.
Switch Host was unable to
Name>: Extension conﬂ_gure the If this error persists, contact
<extension specified extension

number> failed to
acquire port <port
number>.

on the desired port.

Mitel Technical Support.
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ID Severity Level Message Cause Action

132 Information Switch < Voice The specified Inform user about dial-out
Switch Host extension dialed a | restrictions.

Name>: Call restricted number.
restriction violation,
call placed from
<extension
number> to <dialed
number>.

138 Error Switch < Voice Memory block Reboot the switch
Switch Host corruption '

Name?: M(cajmton{ g detected. If the event persists, replace
corruption detecte ;

~bad block the switch.

<parameter

pinpointing failing

block> in partition

<parameter

pinpointing failing

partition>.

140 Error Switch < Voice The flash memory | Replace the switch.
Switch Host in the Voice Switch
Name>: Cannot re- |is bad.
initialize NvRam -

Cannot Continue.

141 Warning Media module is Media response Restart the switch in case of
taking too long to | timed out. non-linux switches or restart
respond. stts in case of virtual switch/

VMB or restart stmedia and
stts in case of UCB.

143 Warning Switch < Voice The specified Use Connect Director to reset
Switch Host .

Name>: Echo train | Port did not the port.
grade F port <port | recelve proper If the error was reported on
number>. echo cancellation . .
! a phone port, lift the phone’s
properties. . .
receiver to view the event log.
The trunk or phone | (You may need to cover the
connected to the mouthpiece to prevent ambient
port may exhibit noise pickup.)
poor sound quality If the error persists on a phone
or echo.
port, you may need to replace
the phone.

144 Information Switch < Voice The specified trunk | confirm that an active call is in
Switch Host connected to the
Name>: Trunk on | port for two or progress.
port <port number> | more hours. If no call is present, reset the
connected for more it f C t Direct
than two hours. port from Connect Director.

145 Warning Switch < Voice The echo No action for an isolated
Switch Host suppression
Name>: Echo software was occurrence.
coeffs stuck unable to adapt to | ¢ the error persists, follow the
possibly needs to |a call in progress. f acti ’ ted
be retrained port Eourste1z3ac ion suggested for
<port number>. ven .

146 Information Switch < Voice The echo No action.

Switch Host
Name>: Echo train
grade A port <port
number>.

suppression
software is properly
configured.
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ID Severity Level Message Cause Action
147 Information Switch < Voice The echo No action.
Switch Host suppression
Name>: Echo train | software is properly
grade C port <port | configured.
number>.
148 Warning gm:gn ;Xg{ice The echo No action for an isolated
Name>: Low Erl suppression occurrence.
p?ggligﬁ hg'[tdyaé?t zolgxaer(e:httected If the error persists, follow the
ﬁumberf P return loss on the | €2Urse of action suggested for
specified port. Event 143.
This error can
occur when
modem or fax calls
connect to a port.
Event is infrequent
and random.
149 Warning ga:ign ag/scz[ice -srl:];)apergs]gion No action for an isolated
Name>: Low software detected | Occurrence.
Eﬂlr?]é’gg@ort ?eltzﬁw?gg‘s}on ihe | f the error persists, follow the
' specified port. course of action suggested for
Event 143.
151 Information Switch < Reboot due to No action.
Voice Switch configuration
Host Name>: change.
Reboot due to
configuration
synchronization.
152 Warning Switch < Voice The DSP on this No action for an isolated
Switch Host switch is nearing
Name>: DSP< capacity. occurrence.
DSP number> -
80% utilization.
153 Error Switch < Voice

Switch Host
Name>: DSP
<DSP number> -
100% utilization.

The DSP on this
switch reached
maximum capacity.

In most instances,
this event does not
affect operations.

No action for an isolated
occurrence.

If the error persists, reboot the
switch.
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ID Severity Level Message Cause Action

157 Error gmign ;c\)/sotice The DHCP In Connect Director, display
Name>: Received |Server responded |the Switches page and open
DHCP NAK for negatively to the switch’s record.

C o] g y
fdgggggf's <IP ?eESVS:aIT rlgajzst Change the switch’s IP
q ’ address to the address
The IP address assigned to it by the DHCP
previously server.
assigned to the ;
switch is no longer (Yo.u can use th_e Find .
. Switches page if the switch
available for that .
device is on the same LAN as the
' server.)
The DHCP server
assigns the switch
a new |P address.

158 Warning Switch < Voice The DHCP lease | In Connect Director, display
Switch Host . .

Name>: DHCP for the switch the Switches page and open
lease expired for expired and the the switch’s record.
Llf’dgddrefs <IP swnghl is currently Change the switch's IP
ress=>. obtaining a new IP
address Address to the address
) assigned it by the DHCP

While the switch is | server.

obtaining an.other (You can use the Find

IP address, it . . .

is unable to Switches page if the switch

communicate with is on the same LAN as the

the server. server.)

159 Error gm:gﬂ ;(\)/Sciice The IP address | In Connect Director, display
Name>: DHCP [P | currently stored in | the Switches page and open
address mismatch: | the switch’s flash the switch’s record.
<IP Address> memory is not o
Existing address: the same as the Change the switch’s IP
<|P Address> address that DHCP address to the address
Offered address: is trving t . assigned to it by the DHCP
<IP Address> Fatal | 'S 'YINGt0@assign 1 4o
Error... Rebooting < [ tO it.

Voice Switch Host The switch (You can use the Find
Name>. automaticall Switches page if the switch
reboots andy is on the same LAN as the
obtains a new server.)
address.
160 Error Switch < Voice The Voice Switch | Contact Mitel Technical

Switch Host
Name>: HAPI
command
failed. System
automatically
restarting.

experienced a fatal
internal software
error.

Support for updated
information about fatal errors.
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ID Severity Level Message Cause Action
161 Error Switch < The Voice Check the server for
Voice Switch Switch st d licati that laci
Host Name>: witch stoppe applications that are placing
Connection communicating inordinate demands on the
to Telephony with the TMS processor.
Management Server. o
Service terminated Correct any application errors
- too many This error can causing CPU overload.
unacknowledged | result from a CPU
events. overload on the
server.
162 Error Switch < Voice A device with the Remove the offending device
Switch Host same |IP address from the network, or ask the
Name>: Another as the switch network administrator to assign
device using the appeared on the the switch an alternate IP
same |IP address network. address.
detected.
163 Information Switch < Voice The switch is No action.
Switch Host connected to the
Name>: Ethernet Ethernet network.
link established:
using <Ethernet
speed> <Duplex
mode>.
164 Error Switch < Voice The switch is no Confirm that network cables
Switch Host longer connected | and ports are connected
Name>: Ethernet | to the Ethernet properly and are in working
link lost. network. order.
165 Warning Switch < Voice The twisted pairing | Although the switch continues
Switch Host wiring for an to function, replace the suspect
Name>: Receive ethernet cable is cable.
pair polarity reversed.
reversed.
166 Error Switch < Voice The fan in the Replace the Voice Switch.
Switch Host Voice Switch failed.
Name>: Fan failed.
167 Warning Switch < Voice The fan in the If this event is accompanied
Switch Host Voice Switch i by Event 168 tion i
Name>: Fan oice Switch is y Even , No action is
running slow. running slow. required.
If the condition If the error persists, replace the
persists, the switch | switch.
may overheat.
168 Information Switch < Voice The fan in the No action.
Switch Host switch is running
Name>: Fan normally.
running normally.
169 Information Switch < Voice The internal No action.
Switch Host operating
Name>: Operating |temperature of the
temperature: switch is within
normal. normal operating

parameters.
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ID Severity Level Message Cause Action
170 Warning Switch < Voice The internal Check if the event is
Switch Host operating ied bv Event 166. If
Name>: Operating |temperature of the |2cCompanied by Even :
temperature: above | switch is above the [S0, replace the switch.
normal. acceptable range. . ;
If the fan is working properly,
check the environment in
which the switch is operating
to confirm that it is capable
of supporting a temperature
range within the switch’s
operating parameters.
17 Error Switch < Voice The internal Check if the event is
Switch Host . .
Name>: Operating operating accompanied by Event 166. If
temperature: too temperature of the | so, replace the switch.
hot. switch exceeded . ;
If the fan is working properly,
the acceptable . .
operating range check the physical location of
' the switch for environmental
The switch may causes.
soon fail.
172 Error Switch < Voice The Voice Switch | Reboot the switch. If the
Switch Host was unable to error persists, contact Mitel
Name>: NvRam write to the flash Technical Support.
failure. memory.
173 Error Switch < Voice The 48-Volt DC Replace the switch.
Switch Host power supply
Name>: VTALK failed.
failure.
174 Error Switch < Voice The 70-Volt DC Replace the switch.
Switch Host power supply
Name>: -70 Volt failed.
failure.
175 Information Switch < Voice The power supply | No action.
Switch Host that reported a
Name>: Voltage failure is once
OK. again operating
correctly.
176 Error Switch < Voice The firmware

Switch Host
Name>: Firmware
Upgrade Failed:

< Voice Switch
Host Name>
<specific diagnostic
message>.

upgrade for the
switch failed.

Check the switch event logs
for subsequent appearances of
Events 177 and 178.

The presence of these
events means that the switch
automatically recovered and
you can ignore the alert of
upgrade failure.

If Events 177 and 178 are not
also present, perform a manual
upgrade of the firmware by
rebooting the switch.

If a reboot does not complete
the upgrade, enter the

bur nf | ash command at
the command prompt. This
may indicate an installation
problem.
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Severity Level

Message

Cause

Action

177

Information

Switch < Voice
Switch Host
Name>: Firmware
Upgrade Started.

A firmware

upgrade started.

No action.

178

Information

Switch < Voice
Switch Host
Name>: Firmware
Upgrade Finished

The firmware
upgrade was
successful.

No action.

179

Error

1.5V too high:
value — d.dV

1.5V too low: value
—d.dv

Board failure

Return for repair.

180

Error

1.6V too high:
value — d.dV

1.6V too low: value
—d.dv

Board failure

Return for repair.

181

Error

2.0V too high:
value — d.dV

2.0V too low: value
—d.dv

Board failure

Return for repair.

182

Error

2.5V too high:
value — d.dV

2.5V too low: value
—d.dv

Board failure

Return for repair.

183

Error

3.3V too high:
value — d.dV

3.3V too low: value
—d.dVv

Board failure

Return for repair.

184

Error

12V too high: value
—d.dv

12V too low: value
—d.dv

Board failure

Return for repair.

185

Error

25V too high: value
—d.dv

25V too low: value
—d.dv

Board failure

Return for repair.

186

Error

48V too high: value
—d.dv

48V too low: value
—d.dv

Board failure

Return for repair.

187

Error

75V too high: value
—d.dv

75V too low: value
—d.dv

Board failure

Return for repair.
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ID Severity Level Message Cause Action

188 Warning Operating Temperature in Fix the environment.
temperature: below | room too cool.
normal

189 Error Operating Temperature in Fix the environment.
temperature: too room too cold.
cold

284 Warning Message This event is No action.

Processin generated by

9 TMS if it does

Duration Exceeded not receive a

response within
the processing
duration after a
request is sent to
the switch.

1300 Information gm:gn ;Xs‘?['ce The trunk on the | Check the trunk and verify that
Name>: Trunk on specified port was | an active call is in progress.
port <port number> | continuously active | .,/ present, reset the
connected for for the number of f C D
<number of minutes specified. port from Connect Director.
minutes> minutes.

This message is
generated after
every two hours of
continuous trunk
activity.

1301 Error Switch < Voice Another Server
Switch Host attempted to take Onlylong server can control
Name>: Second | control of the a switch; multiple servers
TMS connection switch. cannot manage a switch
attempt from <IP simultaneously.

Address of second ) )

TMS server>. Decide which server you want
to manage the switch, then
delete the switch from the
other server.

1303 Error Switch < Voice The IP address From Director, change the
Switch Host configured for the | switch’s IP address to match
Name>: Configured | switch in Director is | the address the switch uses.
IP <IP Address> not the IP address
does not match the switch is using.
actual IP <IP
Address>.

1305 Information Switch < Voice Reports the No action.

Switch Host switch’s memory

Name>: Free usage.

memory reduction

trend. Min

<minimum memory

used>. Avg

<Average memory
used>.

191




APPENDIX A - EVENT CODES

ID Severity Level Message Cause Action
1306 Warning Switch < Voice An attempted call | From Connect Director, open
Switch Host L .
Name>: Call exceeded the limit | the Site Parameters page
was unable to be on the number of | and check the number of
completed due to media streams media streams specified
insufficient network | allowed for multiple | for the “Other Number of
ts)ﬁggmdth between | gjteg. Media Streams for Multi_Site”
May indicate the parameter.
number of media Use the Site-Link Configuration
streams configured | Guide to determine the
for multiple-site number of media streams the
calls cannot handle | connection's bandwidth can
the inter-site call support.
traffic. If the bandwidth can support
more media streams, raise the
value specified for the site.
Increasing the number of
media streams may reduce
sound quality for multiple-site
calls.
1307 Information Switch < Voice Not reported in NT |;
Switch Host event log.
Name>: Trunk
on port <port
number> forced out
of service.
1308 Warning Switch < Voice The SGT1 switch | Your service provider is
Switch Host is in a local or performing diagnostic tests.
Name>: SGT1 is payload loopback.
in %2 loopback
mode.
1309 Information Switch < Voice Loopback on this No action.
Switch Host switch removed.
Name>: SGT1 is
out of %2 loopback
mode.
1310 Error Switch < Voice The SGT1 switch | Check the cabling. Contact
Switch Host is experiencing your service provider.
Name>: SGT1 framing errors.
framing error
<specific error>.
1311 Information Switch < Voice Framing restored. [ No action.
Switch Host Name
>: SGT1 framing
ok.
1312 Error Switch < Voice SGT1 switch lost Check the cabling. Contact
Switch Host the SGT1 carrier your service provider.
Name>: SGT1 signal.
signal error
<specific error>.
1313 Information Switch < Voice SGTA1 carrier signal | No action.

Switch Host
Name>: SGT1
signal ok.

restored.
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ID Severity Level Message Cause Action
1314 Switch < Voice Notable event ;
Error Switch Host while reading non- No action.
(Severity Name>: Config volatile switch The configuration received
level varies Store: <specific configuration. from the server supplies any
: error>. .
depending on missing data.
error)
1316 Information Switch < Voice The system No action.
Switch Host disconnected
Name>: Trunk to trunks on the
trunk transfer from | reported ports as
port <port number> | a result of option
killed after <time settings in Director.
interval> of
connection.
1317 Information Switch < Voice SoftSwitch started. | No action.
Switch Host
Name>: Software
Telephony Switch
< Voice Switch>
Starting.
1319 Warning Switch < User called No action -- someone already
Voice Switch emergency called for help.
Host Name>: number.
Emergency
Services Call on
port <port> from
user <user> at <ext
or ani>.
1320 Error Switch < Voice The SoftSwitch This message appears only
Switch Host failed to start after SoftSwitch successfully
Name>: SoftSwitch | because it was contacts the NT Event Log
Cannot Start: unable to contact Manager—meaning that the
Logger Failed. the NT event log. | error condition is cleared
(possibly by the clearing of a
full NT event log).
1324 Information Switch < Certain No action.
Voice Switch configuration
Host Name>: changes, for
Reboot due to example, changing
configuration signalling protocols
change. for a SGT1,
requires a switch
reboot.
1325 Warning Switch < Voice Can only be This message confirms
Switch Host caused by that SoftSwitch stopped on
Name>: Received [executing command from the NT Service
request to reset the |a i pbxct | Manager. No action is needed.
configuration and command. The
restart the system. | command is only
for use by Mitel
Technical Support
personnel.
1326 Information Switch < Voice SoftSwitch service | If the SoftSwitch service does
Switch Host stopped. not restart within two minutes,
Name>: SoftSwitch perform a manual restart
Stopping %2. and contact Mitel Technical
Support.
1330 Error Switch < Voice SoftSwitch service | If the SoftSwitch service does

Switch Host
Name>: Soft
Switch Stopping
<reason>.

stopped.

not restart within two minutes,
perform a manual restart

and contact Mitel Technical
Support.
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Severity Level

Message

Cause

Action

1331

Error

Switch < Voice
Switch Host
Name>: Assertion
failure <failure>

A software
assertion failed.

If the problem persists, contact
Mitel Technical Support and
be prepared to provide the log
files for further analysis.

1332

Information

Switch < Voice
Switch Host
Name>: Trunk
<trunk> received
digits <digits> (no
match), redirected
to <destination>.

Incoming call on
trunk failed to
route.

Check trunk configuration.

1333

Information

Switch < Voice
Switch Host
Name>: Trunk
<trunk> received
digits <digits>
(too many),
used <number>,
redirected to
<destination>.

Incoming call on
trunk failed to
route.

Check trunk configuration

1334

Information

Switch < Voice
Switch Host
Name>: Trunks
unavailable to
route <extension>
to <dialed
number>.

Outgoing call failed
due to no available
trunks.

Verify that trunks are in-use.

1338

Information

Switch < Voice
Switch Host
Name>: Using
PSTN failover to
reach extension
<extension>
from extension
<extension>,
reason <reason>.

PSTN failover
feature invoked.

Verify network connectivity
between sites.

1339

Error

Switch <

Voice Switch
Host Name>:
<message>.

Request to record
a call failed.

If the problem persists, contact
Mitel Technical Support and
be prepared to provide the log
files for further analysis.

1340

Warning

Switch <

Voice Switch
Host Name>:
<message>.

Attempt to
conference using
switch conference
resources failed.

Check switch configuration.

1341

Warning

Switch < Voice
Switch Host
Name>: Call

was unable to be
completed due to
insufficient network
bandwidth at site
<site name>.

Bandwidth limits
have been
exceeded.

Check site configuration.

1342

Error

Switch < Voice
Switch Host
Name>: SGT1/
E1 PRI D channel
down.

PRI D channel
down.

If the problem persists, contact
PRI service provider.

1343

Information

Switch < Voice
Switch Host
Name>: SGT1/E1
PRI D channel up.

PRI D channel up.

No action.
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ID Severity Level Message Cause Action
1344 Information Switch < Voice Information No action.
Switch Host about SIP trunk
Name>: SIP registrations.
Dynamic
Trunk Event:
<description>.
1355 Information Switch < Voice The Monitoring No action.
. Agent was started
Switch Host or stopped.
Name>: Monitoring
Agent was started.
or
Switch < Voice
Switch Host
Name>: Monitoring
Agent was
stopped.
1356 Warning Switch < Voice A recoverable error | Be aware that metrics
Switch Host occurred for the collected for a specific call
Name>: Monitoring | Monitoring Agent. | might be inaccurate.
Agent Warning:
<message>
1357 Error Switch < Voice The Monitoring Restart the switch. If the
Switch Host Agent experienced | problem persists, contact Mitel
Name>: Monitoring | a fatal error and Technical Support.
Agent Warning: is no longer
<message> running.;As a
result, call metrics
are not collected
for calls to that
switch.

Telephony Management Service (TMS)

The following table lists and describes event codes for TMS.

Table 55: Event codes: TMS

ID Severity Levels Message Cause Action
200 Error TMS Assertion | TMS Restart the TMS service
Failure: encountered a ’
<parameters>. [non-fatal error. | Contact Mitel Technical Support and
submit a support incident.
201 Information TMS service TMS service No action.
started. started.
Version:
<version
number>.
202 Information TMS service TMS service No action
stopped. stopped. ’
If the stoppage was unintentional, check
the event logs for a cause.
203 Information Updated switch | Switch No action.
< Voice Switch |upgraded to
Host Name> the version
switch firmware | of firmware
to revision identified in the
<version event.
number>.
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ID Severity Levels Message Cause Action
204 Error Failed to An upgrade Review the event log and correct any
update switch o .
< Voice Switch to the switch’s errors related to the upgrade failure.
sch\ii?E;r':lﬁprqnev:are firmware failed. | o <ot the switch from Connect Director.
to revision ghls SW';[Ch If the event persists, contact Mitel
<version 0es no Technical Support.
number>. operate
properly until
the firmware
upgrade is
complete.
205 Warnin Switch Ethernet Ensure that the Switch <MAC Address>
J Address to ™S qetected is set up with a correct IP address. If the
IP Address a configured DHCP lease for the switch expires and
mapping switch with the switch receives a new IP address.
change. Old a changed If this happens frequently, contact Mitel
I\A/Iggping; <<|Y|LAC IP address Technical Support.
ress
Address> New changed.
kﬂggggg; <MAC | The event
<IP Address> | "ePOrts
Detected previously
telephony assigned
switch that and current
changed its MAC and IP
IP address or | 5q4resses for
2 using an the switch.
IP address
previously
in use by a
different switch.
206 | Error Emtch ) TMS detected | If address information was entered
Adderrenses_lP- a switch with a [ incorrectly for the switch, use Connect
Address MAC address Director to edit the record to include the
conflict. and/or an IP correct address(es).
EE@?S;;MAC addrgss thg t (The switch reboots automatically when
conflicts with
<IP Address> the address(es) you save the record.)
Found: <MAC § )
Address> configured If the DHCP server assigned an
<IP Address> for the device incorrect IP address to the switch,
Detected in Connect correct the DHCP record and reboot the
L‘?ﬁ%ﬂo\%h Director. switch force reassignment of a new IP
IP address The conflicting address.
or Ethernet address or
address in
conflict with the | @ddresses
configuration result from a
database. misconfigured

DHCP server
or an incorrect
switch record.
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ID Severity Levels Message Cause Action
21 Warning Switch < The switch is no | Reburn flash memory.
Voice Switch longer able to
Host Name> 9 On the server, open a command prompt
booted via boot from flash . .
! . window and change the directory
FTP. Possible memory and is to th direct tvpical path
switch firmware | now booting via to the server directory ( ypical pa
corruption. Ifa | F1p is Program Fi | es\ Shoreline
failure occurs ' Tel ewor ks\ Shor eTel Server)
during firmware
upgragde, a ;Zeecr?oursii c;f Enter the bur nf I ash command in this
switch must . ) format:
boot via FTP failed firmware
instead of from |upgrade, bad burnflash -s <IP address>
its firmware. firmware, or a (Use the IP address of the switch you
reset caused are upgrading.)
by pressing the P9 9
reset button. When the bur nf | ash process is
complete, check the event logs to
confirm that the switch is no longer
booting from FTP.
If the event persists, replace the switch.

212 | Warning Switch < TMS detects New switches ship with base firmware
Voice Switch a switch with that is “d > th t .
Host Name> outdated atis "down” from the current version.
software firmware. An automatic upgrade is confirmed
version when the device is put into service.
mismatch: TMS i o
Version: <TMS (This event also appears during field
version> Switch upgrades.)

Version:< Voice i

Switch version> From Connect Director, open

The switch the Maintenance > Status and
firmware is Maintenance > Appliances page and
upgraded the reboot the switch.

next time the

switch boots.

213 Error Unexpected The MAC From Connect Director, open the switch
Ethernet address in configuration record and correct the
address for the switch’s MAC address.
switch < configuration
Voice Switch record is
Host Name> incorrect.

Expect:<MAC
Address>
Found:<MAC
Address>.
The switch

is reporting
an Ethernet
address
different

from the one
specified in the
configuration
database.
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ID Severity Levels Message Cause Action

214 | Warning Switch < The Re-install the server software.
Voice Switch firmware file
F'OS’E Name>” filessys. di | If the event persists, contact Mitel
irmware . ;
file version does not match Technical Support.
?'\I/?rsnstch; the TMS file

ersion: :

<TMS Version> version.
File Version: The switch’s
<File version> | firy\yare cannot
Cannot upgrade b ded
switch firmware. | P€ Upgraded.
The firmware
file used to
upgrade the
switch firmware
does not have
the correct
version.

221 Error Failed to A switch This error appears when the
load firmware firmware \ Sh I Co ! .
image file upgrade may oreline nmuni cat i ons
<FileSys.dlI>. not be possible. |\ ShoreTel Server does not have
Telephony the Fi | eSys. dl | file, and TMS cannot
Management find or access this file.
Service was
unable to load If this error appears frequently, contact
the switch Mitel Technical Support.
firmware image
file.

223 Warning Detected an TMS corrected No action
unexpected a configuration ’
configuration mismatch that | f this error appears frequently, contact
change. This it detected on @ | pitel Technical Support
may indicate switch. '
that TMS was
not notified
of a change.
Configuration
inconsistency
corrected.

227 Information TMS service TMS service No action.
starting. started.
Version: <TMS
version>

230 Warning TMS was TMS failed Reboot the server
unable to to detect '
find an TCP/ a network Troubleshoot the server’s network
IP network interface on the

interface. This
computer may
not have a
network adapter
or may not

be connected
to a network.
Operation
continues in
stand-alone
mode until

the next TMS
restart.

server.

configuration and make necessary
repairs or modifications.
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ID Severity Levels Message Cause Action

231 | Error -cl:-gr?fi uration for | 1€ To synchronize the configuration data,
switc% “< \/oice |configuration on [reboot the switch.
ﬁ‘g’r'%%hjlr?gt Lho(?[ ;\Ag:g:: ,:jhc;es After the switch restarts, check the
longer matches | one stored on event log for messages that indicate
the system ™S network problems between the switch
configuration ' and the server to correct any network
_?_?]tabaseél._t. The mismatch | errors.

is condition
may exist on ﬁ?: i?:rse If the event persists, check for events
additional b hg : that indicate corrupted flash memory
switches, and ehavior and follow the instructions for correcting
may result in on devices th bl
unexpected connected to © probiem.
behavior. this switch.
To resolve
the problem, The error
restart any
switch having appears
a configuration | when there
mismatch (as are network
shown on the problems
Maintenance between the
> Status and server and
Maintenance h itch
> Appliances t e switch, or
page in is generated
Connect as a result of
Director). corrupted flash

memory.

233 | Warning gil\s/lcsonnected -rI;eMgrtlisn The disconnect is typically caused by a
from switch “< thgt it ca?nnot network-related problem such as outage
Voice Switch communicate | or degraded performance.

Host Name>" (< | with the switch.

Voice Switch Correct the network problem.
#F;]erg;esgz). (The event also appears when the

as a restljlt ofa switch is taken offline for maintenance.)
network outage,

administrative

action, or

unexpected

switch behavior.

234 Information TMS connected | TMS detected No action.
to switch “< a switch
Voice Switch and opened
Host Name>” (< | communications
Voice Switch IP | with the device.

Address>).

235 Information <Connection New TAPI No action.
type user connection
or App accepted from
Server> TAPI auserata
connection for | specific IP
login <user address.

ID> from <IP
address or
name of system
initiating the
connection>
initiated.
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ID Severity Levels Message Cause Action

237 Information TAPI The TAPI No action.
connection for | connection to
login <user the specified
ID> from user was
<IP address closed.
or name of
system that is
connected>
closed.

238 Warning TAPI A user’s Contact the user and help him or her
connection remote TSP correct the client configuration.
with login configuration
<user ID> from | tried to get
<IP address> ownership
denied access |access to an
to extension extension the
<Extension user does not
DN>. own.

239 Error Qttgg:]pr)]tg;% ;E?Psvavgg?easts Edit the switch configuration information
to switch at does not to reflect the correct data.

IP address correspond t0 | corpect the IP address, or delete
<IP address> the switch type . ’ .
with incorrect | identified in the | the Switch, and create a new switch
product type: configuration configured with the correct switch type.
Expected database.

product type:

<Product Type

ID> Actual

product type:

<Product

Type ID>.

Configuration

database

includes

incorrect

product type for

the switch at

this IP address.

241 Error I\Ego%?lltlin ;rvesr:grcggl;ed Contact Mitel Technical Support and be
Service 9 from the call prepared to provide server logs from the
returned the accounting day of the occurrence.

Ecilllzor\;\gpgc;oedrgir feest\p/)gr?slg to Note: This error is sometimes the result
Source =< logged data. of a “false positive” and may not indicate
component serious problems.

that returned

error>):

<Message

description>.

243 | Warning TAPIrequest | TMS is not This event can precede a significant
thread timed responding fail in TMS
out after to internal aflure in :

;ggcr)r:]téiiof {inn?glsa%iiilgna Contact Mitel Technical Support and be
seconds y " | prepared to provide server logs from the

for context
<context handle
ID> performing
request type
<request type
ID>.

day of the occurrence.
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ID Severity Levels Message Cause Action

244 Warning <Connection A TAPI Contact the user and assist him or her
type user connection with login information.
or App request was
Server> TAPI denied due to
connection an invalid login
attempt for login | or password.
<user ID> from
<IP address>
failed. Invalid
<LoginID>.

246 Information ﬁ;?wgh%rr]rz/ent 'ab\sls?grit?on within | N action, unless the event is
Servicge logged | TMS failed. accompanied by system failures.
32grdformational If system failures are occurring, contact
messgage. The Mitel Technical Support.
debug message
contents
are:<Message>

247 | Information Ilrg)e Iﬁ% friwlgme> Igr?nl(o)?vyrlﬁe This event typically results from a
cur?ent size new events configuration that creates an event loop.
isjzfalggbgltgs it rt')ee:c?#:c? |Itts Review all configured call handling
exceeded its maximum size. |Modes for loops.
Irinrr?i)t(lcr:;linr:wgge Example: UserA forwards calls to userB,
log size> bytes. who in turn is forwarding all calls to
Further logging userA.
Is suspended. If no logic fault is found, contact Mitel

Technical Support.

248 Information Failed to W_rite TMS failed to No action. :
to the log file write to a lo
<log file name> | 9 Log files are not essential for telephony
(Error Code — | files. operations. -
<error code>). (The embedded P i
Further |Oggéj“9 error code If the problem persists, contact Mitel
is suspende i
until midnight | identifies the | ToCMical Support.
or service cause of the
restart. The write failure.)
log files collect
diagnostics
and are not
required for
correct system
behavior.

249 | Information E)a{lﬁedltoogwrite Qg\;NHItee ft:"teh de This event can occur during normal
file <log file because the backups of system log files.

name> because
another process
locked a portion
of the file.

file was locked
by another
process.

Local administrators can choose
to suspend logging activity during
scheduled backups.
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251 Information <Connection When TMS No action
type user notified a ’
or App remote TSP of | |f the event is accompanied by unusual
Server> TAPI | anew call, the | ;jiant hehavior, report the error to Mitel
connection remote TSP Technical S it
did not give failed to accept | '€chnical support.

NEWCALL or acknowledge
event (CalllD that notification.
— <Call ID>,

Login: <user

ID>, From: <IP

address>).

This may

indicate a TAPI

connectivity

outage between

the server and

Telephony

Management

Service on

the machine

specified.

252 Information A time change |The system No action
of %1 was clock was ’
detected in the | changed. Changing the system clock can result
system clock. in inaccurate call timers for applications

and skew call detail reporting records.
A system clock adjustment affects
only calls in progress at the time of the
change.

253 | Error ﬁ:,elgeﬁéﬁg rggh’e This error Reconfigure the IP phone from the
Agent that can occur rogue Call Agent or take the rogue
established when a Call agent off-line.

a control Agent switch is Tvoically thi t hen t I
connection with | replaced and ypically this event occurs when two ca
an IP Phone. IP : agents attempt to control the same IP
- ' | the previous
Phone Details: S phone.
IP Address:<|p | switch is still
address> MAC | on-line, or if
Address:<MAC |an IP phone
édﬁr§55>t is moved from
all Agen

Details:<Call ‘S’”et'P Pthone
Agent Details> | ©YStem to
Config'd another.
ﬁggﬂ}:gggﬂgumq’his error can
Agent:<Rogue | cause the IP
Agent>. phone to exhibit

unexpected

behavior.

202




APPENDIX A - EVENT CODES

ID Severity Levels Message Cause Action

255 Warning The This server is The administrator must configure this
configuration not configured | server correctly in Connect Director
database does |in Connect and ensure that a correct |IP address is
not list this Director as one | given.
server as a of the servers;
configured or IP addresses
server. on this server
The TMS do not match
(Telephony any of the
Management configured
Services) on IP addresses
this system for servers
remains in in Connect
standby and Director.
is not fully
available while
this condition is
present. Check
the Connect
Director
configuration
of servers for
correctness.

256 Warning This server is Servers cannot | The administrator must configure this

configured with
Loopback IP
address. This
may prevent
other servers
from reaching
this server.
Configure

with proper IP
address for this
server.

be configured
with | oopback
IP addresses.

server correctly in Connect Director and
ensure that the correct IP address is
given.
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257

Error

Telephony
Management
Service (TMS)
was unable

to connect to
or access the
configuration
database on
the computer.
Ensure that
network
connectivity
exists between
this computer
and the
configuration
database,

and that the
database
services are
operational on
the main server.
TMS on this
system remains
in standby

and is not fully
available while
this condition is
present. Check
the Connect
Director
configuration
of servers for
correctness.
(Error code —
<Error code>).

This server

is unable to
connect to the
database on the
Headquarters
server.

The administrator must ensure there
is network connectivity between this
server and headquarters server. If the
network connection is present and
this condition persists, contact Mitel
Technical Support.

258

Error

The main
server is
configured

in the
configuration
database with

| oopback

IP address
127.0.0.1.
Ensure that
proper IP
address is
configured for
the main server.
The TMS
(Telephony
Management
Service)
remains in
standby and

is not fully
available while
this condition is
present. Check
the Connect
Director
configuration
of servers for
correctness.

The main
Headquarters
server is
configured with
al oopback IP
address.

The administrator must provide the
correct IP address of the Headquarters
server.
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259 Information The Telephony |When an No action needed.
Management administrator
Service is changes the IP
reinitializing address of a
because new remote server,
configuration the Telephony
changes have |Management
occurred. Service on that
<Version of remote server
Server> is reinitialized

with the new IP
address. This
event indicates
the start of the
initialization
process.

260 Information The Telephony | When the No action needed.
Management administrator
Service is changes the IP
reinitialized address of a
with the new remote server,
configuration The Telephony
changes. Management
<Version of Service on that
Server> remote server

is reinitialized
with the new IP
address. This
event indicates
end of the
reinitialization
process.

261 Warning This Server The Telephony | If administrator made the configuration
is deleted Management changes that caused server to be
from the Service is deleted and added again, check the
configuration reinitialized if Maintenance > Status and Maintenance
database. configuration > Servers page in Connect Director
The server changes to see if all the services are running
was deleted caused this correctly. If not, contact Mitel Technical
permanently or |server to be Support.
configuration deleted and
changes were | added again,
made to this or the service
server that remains in
caused it to standby if
be deleted this server is
and added deleted.
again. TMS
(Telephony
Management
Service) on
this server is
reinitialized
and remains in
standby until
the server is
added again.
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262 Error Configured The IP address | Check whether all the services are
IP address configured reinitialized correctly after the IP
for this server | for this server address is changed. Check the
changed in the [changed in Maintenance > Status and Maintenance
configuration configuration > Servers page in Connect Director
database. TMS | database and to see if all the services are running
(Telephony Telephony correctly. If not, contact Mitel Technical
Management Management Support.
Service) needs | service is
to bind to new | reinitialized
IP address and | with the new IP
needs to be address.
reinitialized
with the new IP
address.

275 Information The Telephony | An internal TMS | N5 action. unless the event is
Management configuration . .
Server received | error occurred. | @ccompanied by system failures.
an invalid If system failures are occurring, contact
configuration .
type: Mitel Support.
<number>.

Voice Mail Port Manager

The following table lists and describes event codes for voice mail:

Table 56: Event Codes: Voice Mail Port Manager

ID Severity Level Message Cause Action
401 Information Voice Mail Voice Mail Port No action.
Port Manager Manager service
starting.Version: started.
<version number>.
402 Information Voice Mail Port Voice Mail Port No action if the service was
Manager stopping. . . .
Manager service intentionally stopped by a user.
stopped. Otherwise, check the event log
This error usually for related errors and correct
results from them.
an |qtent|onal If necessary, restart the
service stoppage, .
service.
stoppage by a
dependant service,
or application
failure.
410 Information Recording stopped. | o message was Free up space on the drive. ;
The disk got full t letel
during recording. | MOt coOmpletely
recorded. ;
The hard
drive on which
\'shoreline
dat a\ vns resides
is full.
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Message

Cause

Action

411

Information

Recording stopped.
The caller went
silent during
recording.

The person leaving
a voice message
was silent for

more than 30
seconds, triggering
automatic
termination of the
recording.

The message is
still sent so no
action is required.

No action.

The recipient is still able to
retrieve the partial message.

412

Information

Recording stopped.
No response from
the switch.

The recording

of a message
halted when the
connection to the
switch dropped.

Check the event log and
correct any errors related to
the dropped connection.

414

Error

The outbound
AMIS phone
number %1 for
System ID %2 was
a wrong number.
No more attempts
are made to this
system/number
until it is corrected.
Verify that the
number is correct.

Verify that the phone number is
correct.

415

Error

The outbound
AMIS phone
number for System
ID %1 was not
found. Verify that
the System ID
includes a phone
number associated
with it.

Verify that the System ID
includes a phone number
associated with it.

416

Error

An internal error
occurred. The
system was unable
to delete an AMIS
message from the
outbound message
queue. System ID
%1 mail box ID %2
Message ID %3

417

Error

The undeliverable
AMIS message
from %2 was

not able to be
delivered to %3 for
AMIS System ID
%1. The message
is being deleted.
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Message
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418

Error

An error occurred
during the delivery
of an AMIS
message from %2
to %3 for AMIS
System ID %1,
which prevents
retrying delivery
at a later time.
The message is
missing.

419

Error

An error occurred
during the delivery
of an AMIS
message from

%2 to %3 (AMIS
System ID:mail
box), and the
system tried %1
times to deliver
this message.
The message is
returned to the
sender and deleted
from the outbound
queue.

420

Error

An internal

error occurred
communicating
between the Port
Manager and
another server. The
error code was %1.

421

Error

Number of delivery
attempts (%2) to
AMIS System ID
%1 exceeded.
Verify that the
number is correct.

1001

Information

Voice Mail
Message Server
starting. ;Version:
<version number>

Voice Mail
Message Server
service started.

No action.

1002

Information

Voice Mail
Message Server

stopping.

Voice Mail
message service
stopped.

This error usually
results from

an intentional
service stoppage,
stoppage by a
dependant service,
or application
failure.

No action if the service was
intentionally stopped by a user.

Otherwise, check the event log
for related errors and correct
them.

If necessary, restart the
service.
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1003

Information

Voice Mail disk
usage reached
maximum capacity.

A message was
not completely
recorded. ;

The hard

drive on which
\'shoreline

dat a\ vns resides
is full.

Take necessary action to free
up space on the hard disk.

1004

Information

No available
message stores in
Voice Mail.

The voice mail
system cannot
locate message
storage directory
\'shoreline
dat a\ viis on the
server.

Verify that the hard drive or
drive partition where \shoreline
data\vms resides is operating
properly.

Correct any disk problems and
restart the server.

If event persists, call Mitel
Technical Support.

1005

Information

Voice Mail disk
usage is greater
than 90 percent.

The hard drive on
which the message
storage directory
\'shoreline

dat a\ vns resides
is nearly full.

When no disk
space remains,
Voice Mail is
unable to store
new messages.

This error appears
once each day
when the system
disk is more than
90% full.

Free up disk space on the
hard drive where \ shor el i ne
dat a\ virs resides.

1006

Information

Error writing mail
box file to disk.

The Voice Mail
system failed to a
mailbox.dat file on
the disk where the
message storage
directory \shoreline
data\vms resides.

The write failure can result
from corrupted data or a
Windows NT error.

Verify that the hard drive or
drive partition where \shoreline
data\vms resides is operating
properly.

Correct any disk problems and
restart the server.

209




APPENDIX A - EVENT CODES

ID Severity Level Message Cause Action
1007 Information Eﬂ'or, d's.tk got fu_III The hard drive on | Free up disk space on the
\évo)?zr;/]vglillrg%)r(nal which the message | hard drive where \ shor el i ne
number>. storage directory dat a\ vns resides.
\'shoreline
dat a\ vns resides |’
is full.
The mail box a
user attempted
to create was not
added.
1009 Information Failed to get Unable to open This may indicate an
<registry string> required entry in . .
from registry the registry. installation problem.
Contact Mitel Technical
Support and be prepared to
provide the voice mail log files
for further analysis.
1011 Information Voice Malil The Voice Mail Verify that the hard drive
Message Server server was unable ; o
was unable to to retrieve a or drive partition where
open message message because |[\shoreline datalvms
<file name> Error < | it was unable to resides is operating properly.
specific error>. read the disk. i
Correct any disk problems and
restart the server.
If the error persists, contact
Mitel Technical Support and
be prepared to provide the
voice mail log files for further
analysis.
1014 Information Failed to attach Error resulted from | This event results from a
message <file a failure with a full mail box included i
name> to mail box | specific mail box. | Yl Mmall box included in a
<mail box ID> Error distribution list (or any other
< specific error>. general failure related to a mail
box).
Verify that the mail box is full.
If not, contact Mitel Technical
Support and be prepared to
provide the voice mail log files
for further analysis.
1015 Error All Voice Mail The mail server

Message Server
threads in use.

cannot access
resources.

This event corresponds to a
logged NT event indicating
serious problems that can
prevent clients from retrieving
voice mail.

Contact Mitel Technical
Support and be prepared to
provide the voice mail log files
for further analysis.
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ID Severity Level Message Cause Action
1016 Error The system failed | The Voice Mail The probable cause is
to send voice server failed to add .
message <file a message to a corrupted mail box data.
name>. user mail box. Verify that the mail box is
functioning properly.
If not, contact Mitel Technical
Support and be prepared to
provide the voice mail log files
for further analysis.
1018 Error The SMTP server | The SMTP server | Verify that the SMTP server is
used by voice mail |is not forwarding down or that its address is set
is not sending stored messages up incorrectly
messages. on to recipients.
1019 Error Voice message Message sent to Contact Mitel Technical
sent to voice mail | a remote server Support and be prepared to
server <file name> | returned. provide the voice mail log files
returned. for further analysis.
1020 Error Failed to find entry | A viice Mail server | The probable cause is
in database for . . : .
voice mail server. looks up its own incorrect server information
address in the or incorrect IP address in the
database. database.
The event indicates | Edit the database record to
that the server was | include the correct data.
unable to locate a
database record
that matched its
server name and/or
IP address.
1101 Information Voice Malil Voice Malil No action.

Application Application service

starting. Version: started.

<version number>.

1102 Information Voice Mail Voice Mail No action if the service was
Application Aoplicati . intentionally st db
stopping. pplication service |intentionally stopped by a user.

stopped. Otherwise, check the event
This error usually | log for event watch errors and
results from correct them.
an |r?tent|onal If necessary, restart the
service stoppage, .

service.
stoppage by a
dependant service,
or application
failure.

1109 Information Unable to The system A write failure is usually the
create message
<message was unable result of corrupted data or a

number> Error
<error number>.

to write to the
mailbox.dat file on
the disk where the
message directory
\'shoreline

dat a\ vis resides.

Windows NT error.

Verify that the hard drive

or drive partition where
\'shoreline data\vns
resides is operating properly.

Correct any disk problems and
restart the server.
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ID Severity Level Message Cause Action
1110 Information Voice Mail (rj]'ss The hard disk Free up disk space on the
umS:)g%L?%a%acity. driV(_a.or disk drive where \ s_hor el i ne
partition where the |dat a\ vis resides.
message directory
\'shoreline
dat a\ vns resides
is full.
Voice mail is
unable to accept
any new messages
until disk space is
made available.
1111 Information Removed <lfile The message was ;
name> millisecond too short to retain
message. :
Messages from Error is no longer
callers must be at
least <configured | 1099ed-
limit> milliseconds
to send.
M2 Information Message The voice mail Verify that the hard drive
notification . o
was unable to system was unable | or drive p_artltlon where
open phrase to locate system \'shoreline data\vns
libraries.<file prompts. resides is operating properly.
name> Error <error
number>. The hard disk Correct any disk problems and
drive or disk restart the server.
partition where the
message directory
\'shoreline
dat a\ vns resides
is unavailable,
was intentionally
removed from
the system, oris
corrupted.
1113 Information There have been

too many invalid
logon attempts for
mail box <mail box
number>.

An attempt to log
into this mail box
failed.

While this event
can indicate an
unauthorized user,
it most often results
from a forgotten

(or mistyped)
password.

No action.
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Severity Level

Message

Cause

Action

1114

Information

Listen unheard
was unable to
open message
<message
number>.

The server was
unable to locate
the indicated
message number.

The hard disk
drive or disk
partition where the
message directory
\'shoreline

dat a\ vns resides
is unavailable

or someone
intentionally
removed the
message file from
the system.

Verify that the hard drive

or drive partition where
\'shoreline data\vns
resides is operating properly.

Correct any disk problems and
restart the server.

1115

Information

Listen saved
was unable to
open message
<message
number>.

The server was
unable to locate
the indicated
message number.

The hard disk
drive or disk
partition where the
message directory
\'shoreline

dat a\ virs

resides is
unavailable

or someone
intentionally
removed the
message file from
the system.

Verify that the hard drive

or drive partition where
\'shoreline data\vns
resides is operating properly.

Correct any disk problems and
restart the server.

1116

Information

Listen deleted
was unable to
open message
<message
number>.

The server was
unable to locate
the indicated
message number.

The hard disk
drive or disk
partition where the
message directory
\'shoreline

dat a\ vns resides
is unavailable

or someone
intentionally
removed the
message file from
the system.

Verify that the hard drive

or drive partition where
\'shoreline data\vns
resides is operating properly.

Correct any disk problems and
restart the server.
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ID Severity Level Message Cause Action
1119 Error Voice Malil Sending of voice Restart mail server.
Application messages failed.
determined that
the Voice Mail
Message Server is
down.
1121 Error The SMTP Details can only be

The corrective action depends

message delivery | found by checking on the error found in qmail logs

was not a success. |the gmail logs in

More details on the specified folder. | g, example

the error can be ’

found in the QMAIL 1. User wasn't able to

l:tg? sa%/glrlaef;'z y establish an SMTP

qﬁai | /1 0gs/ f:onnection begause there
gmail.lo is a problem with the SMT/

Network configuration.

2. 550 5.7.1 Unable to relay
for User@10.57.1.218
because there is a problem
with the user configuration
and current network
statistics of the user.

Media Driver

The following table lists and describes event codes for the Media Driver.

Table 57: Event Codes: Media Driver

ID Severity Level Message Cause Action

2100 Information Media Driver Media Driver No action.
started.Version: started.
<Version Number>.

2101 Information Media Driver Media Driver No action.
stopped. stopped.

2102 Error Media Driver The Media Driver | Contact Mitel Technical Support
failed to start. failed to start. and be prepared to provide the
<Message>. NT system, and NT application

log files for further analysis.

2103 Error Failed to allocate | The Media driver | parform a system restart.
non-paged was unable to
pool memory. allocate non- Contact Mitel Technical Support
<Message> paged pool and be prepared to provide the

memory. This L )
failurergan result | NT system application log files

in an inability to | for further analysis.
deliver media to
IVR applications,
and/or force a
system restart

with a crash
dump.
2104 Information Poor audio The Media No action
timer resolution. cjriver’s internal ’
<Message> timer detected | The event can indicate the
fhna![nvegguracy occurrence of a voice-quality
corrected. event that caused the driver to

reset its internal timer.
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ID Severity Level Message Cause Action
2105 Error Unable to map The Media driver | If this error is appearing
application buffer |was unable to frequently, perform a system
into kernal memory | translate a user |restart, In addition, contact
space. <Message> | buffer to system | Mitel Technical Support and
memory. This be prepared to provide the NT
failure can result | system, and NT application log
in an inability to | files for further analysis.
deliver media to
IVR applications,
and/or force a
system restart
with a crash
dump.
2106 Information Recording of call The Media driver | If this error is appearing
was terminated detected silence [frequently, perform a system
due to silence. when recording | restart, In addition, contact
<Message> a message. Mitel Technical Support and
This may be be prepared to provide the NT
due to incorrect | system, and NT application log
behavior from files for further analysis.
one of the
switches.
2107 Error Media Driver The UDP ports | The administrator must ensure
is unable to to be used by the [ that the UDP port range
bind all media Media Driver can | configured in the registry
channels within the | be configured includes at least 255 empty
configured UDP using the registry | UDP ports, and reboot the
port range. Either | by giving the server. Or this configuration
the UDP port range of UDP option may be completely
range given is not | ports. Driver is eliminated by removing the
sufficient, or some | unable to bind registry setting. This option
of the UDP ports to the UDP ports | enables the driver to choose
are being used by | given in the any empty UDP port.
other components |range.
in this system.
<Configured
UDP Range from
registry for the
Driver>
2108 Error Media Driver is The UDP ports | The administrator must ensure
configured with to be used by the | that the UDP port range
invalid UDP port Media Driver can | configured in the registry is
range. <Configured | be configured between 1024 and 65535. After
UDP Range from | using the registry | providing the correct UDP port
registry for the by giving the range, the system must be
Driver> range of UDP rebooted.
ports. The driver
is configured
with an invalid
UDP port range.
2109 Warning Media Driver A logic assertion | If this error is appearing
encountered in Media Driver | frequently, perform a system
an assertion failed. restart. In addition, contact

statement that
failed. In some
cases an assertion
failure may
precede a more
significant problem.
The assertion
statement details
follow. <Message
description>

Mitel Technical Support and
be prepared to provide the NT
system, and NT application log
files for further analysis.
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Event Watch

The following table lists and describes event codes for event watch.

Table 58: Event Codes: Event Watch

ID Severity Level Message Cause Action
1200 Information Event Watch service | ; No action.
successfully started.
1201 Information Event Watch ; No action.
service successfully
stopped.
System Management Interface
The following table lists and describes event codes for the system management interface.
Table 59: Event codes: System Management Interface
ID Severity Level Message Cause Action
5102 Information User <user name> Specified user No action.
successfully | dint
logged in. ogged Into
Connect Director.
A user history is
maintained for
auditing purposes.
5103 Information User <user name> | the gpecified user | No action. (Monitor if the
failed to log in. :
unsuccessfully event persists.)
gttempted tolog While this event might
into Connect A .
. indicate an unauthorized user
Director. . .
is trying to access Connect
A user history is Director, it most often results
maintained for from a forgotten (or mistyped)
auditing purposes. | password.
Port Mapper

The following table lists and describes event codes for port mapper.

Table 60: Event Codes: Port Mapper

PortMap> service
stopping.

service stopped.

ID Severity Level Message Cause Action
700 Information <ShoreTel- Port Mapper No action.
PortMap> service | service started.
starting. Version:
<version number>
701 Information <ShoreTel- Port Mapper No action.
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Severity Level

Message

Cause

Action

702

Error

Can’t bind
<protocol type>
socket; port <port
number> in use.

The preferred
port for the RPC
Portmapper (111)
is already in use.

Another network
application or
service is probably
running on that
system.

While the

port remains
unavailable, no
communication is
possible between
TMS and the
switches.

Notify Mitel Technical
Support, and be prepared to
provide server log files.

Trigger Server

The following table lists and describes event codes for trigger server.

Table 61: Event Code: Trigger Server

ID Severity Level Message Cause Action

800 Information <Service name> Trigger Server No action.
service starting. started.
Version: <Software
version number>.

801 Information <Service name> Trigger Server No action.
service stopping. stopped.

805 Error The notification Usually indicates No action, when related to a
server lost that one of ice fall
connectivity with a | the services service tailure.
notification client. crashed without In other instances, check for
This may indicate a | properly closing its twork out
network outage or | connection. network outages.
unexpected client
behavior. Client:
<name of affected
service> Status:
<error code>.

806 Error The notification The connection No action, when related to
server lost between a twork out th
connectivity Distributed Voice |2 Network outage or other
with the master Mail Server and the | @dministrative action.
notification server. | HQ Server failed. .

This may indicate In the problem persists, collect
a network outage log files from affected servers
or unexpected and contact Mitel Technical
behavior from the Support.

master notification

server.

Distributed Routing Service (DRS)

The following table lists and describes event codes for DRS.
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Table 62: Event Codes: Distributed Routing Service (DRS)

ID Severity level Message Cause Action

3100 Information The Distributed The specified No action.
Routing Service version of DRS
(Version started.

%1) started
successfully.

3101 Information The Distributed DRS stopped. No action.
Routing Service
stopped.

3108 Information The Distributed DRS re-established | No action.
Routing Service communications
failed to connect to | with the specified
this switch: %n%1 | switch.

3109 Information The Distributed Network Fix network connectivity
Routing Service connectivity may issues, and confirm that
reconnected to this | be lost to the the switch is up.
switch: %n%1 specified switch, or

the switch may be
down.

Kadota Utility

The following table lists and describes event codes for Kadota utility.

Table 63: Event Codes: Kadota Utility

ID Severity level Message Cause Action

1400 Information <ShoreTel- Specified version | No action.
KadotaUtil> of Kadota Utility
service starting. started.
Version: <version
number>

1401 Information <ShoreTel- Kadota Utility No action.
KadotaUtil> stopped.
service stopping.

Call Accounting

The following table lists and describes event codes for call accounting.
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Table 64: Event Codes: Call Accounting

ID Severity level Message Cause Action
2000 Warning TmsCdr records an ; i Remove or replace
attempt to archive aunng”archlvm?, the CDR archive
an entry from table | € Callaccounting | 4stahase files.
<table name> service
of <database encountered a
name> to that of | duplicate key value
<archive name> in a table.
with a duplicate v
<duplicate D> A duplicate value
primary key. It usually means the
might be caused .
by a manual |tem_was already
manipulation archived.
between CDR.mdb Results f
and its backup esults from
version. renaming or
moving the CDR
database file
without also
renaming or
moving the CDR
archive database
files.
2008 Information CDR service Used to record No action.
<starting or service start/stop
stopping> events.
Workgroup Server
The following table lists and describes event codes for workgroup server.
Table 65: Event Codes: Workgroup Server
ID Severity level Message Cause Action
1600 Information WorkgroupServer | Workgroup server | No action.
Started. started.
1604 Information WorkgroupServer | The workgroup No action if server was
Stopping. server is stopping. stopped intentionally.
Otherwise, review the WG*.log
and SC*.log to identify reason
for stoppage.
CSIS

The following table lists and describes event codes for CSIS.

Table 66: Event Codes: CSIS

ID

Severity Level

Message

Cause

Action

1898

Information

CSIS Web
Services starting.

No action.
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ID Severity Level Message Cause Action

1899 Error CSIS Web CSIS Web Contact Mitel Technical Support
Services failed : . and be prepared to provide the
to start (<error services failed to | cg|5 |og for review.
code>). start. ;

(The embedded
error code is a
Microsoft error
code.)

2400 Information CSIS Web CSIS Web No action.

Services stopping. | services are
stopping.
(Occurs when
web services are
stopped.)

2401 Error CSIS\Web CSIS Web Contact Mitel Technical Support
Services contained . )
an error (<error services and be preparec! to provide the
code>). experienced a CSIS log for review.

non-fatal error. .
(The embedded
error code

isa CSIS or
Microsoft error
code.)

2402 Information User <username> | The specified No action.
at Workstation user is
<workstation authenticated
name> for CSIS server
authenticated. access.

2403 Information User <username> [1pq specified No action.
at Workstation .
<workstation user is no longer
name> authorized for
authentication CSIS server
revoked <reason>. | access. ;

Causes include
client logout,

or an inactive
connection as
the result of

a client going
offline without
logging out.

2405 Information CSIS_ Web ' CSIS Service No action.
Services execution
enabled. started.

Client access to
CSIS Services is
enabled.
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(Web services
continue to run.)

ID Severity Level Message Cause Action
2406 Warning CSIS Web .| CSIS Service No action.
Services execution stooped. Client
disabled. P toCsls | The event is assigned a severity
g(;i\?iscsesois level of “warning”, because
disabled. a service (CSIS) is disabled

and no longer accept logins or
requests. But the result is “non-
destructive”; the service can be
enabled at any time.

IP Phone Configuration Service (IPCS)

The following table lists and describes event codes for IPCS.

Table 67: Event Codes: IP Phone Configuration Service (IPCS)

ID Severity Level Message Cause Action

2700 Information IPCS Server IPCS Server No action.
started. started.

2701 Error Handler not The service was Re-install the service.
installed. not installed

properly.

2702 Information The IPCS Server IPCS Server No action.
Stopped. stopped.

2703 Warning Spare fail-over to | Switch outage. For information about
site Headquarters outages, review Director.
in zero second(s).

2704 Warning Spare HQ220 from | Switch outage. For information on
site Headquarters outages, review Director.
fail-over to site
Headquarters.

2705 Warning Spare HQ220 fail- | Switch outage, fail- | For information on
back from site back. outages, review Director.
Headquarters
to home
Headquarters.

2706 Information IP-Phone was No switches are To support more IP
unable to be configured to phones, configure a new
configured. No IP | support IP phones | switch, or add additional
Phone switches at the destination IP ports to existing
are configured on | site. switches.

Site: <site name>.

2707 Information IP Address'for' IP- | The IP address No action.
Phone Device: p »
<MAC address fora d.owned IP
of phone> is set phone is set to
to NULL in the NULL.
configuration .
database. This usually

indicates that a
new IP phone
appeared on the
system using the
same IP address
as the phone that
is “down”.

221



APPENDIX A - EVENT CODES

Severity Level

Message

Cause

Action

2708

Error

IP-Phone could
not be configured.
No switches

are available on
Site: <variable>
_Headquarters.
The existing
switch(es) have
reached maximum
capacity or may
temporarily be
down.

Check switch status and
address any issues.

2709

Error

IP-Phone could not
be configured. No
IP Phone switches
are configured on
Site: <variable>
_Headquarters.

2710

Error

The IP Address for
IP-Phone Device:
<MAC address of
phone> has been
set to NULL in

the configuration
database because
another IP Phone
has contacted the
system with the IP
address that had
been assigned to
the device. The IP
Phone with the IP
Address now set to
NULL is currently
not communicating
with the server. If
communication

is reestablished
the configuration
database will be
updated with the
device's current IP
Address.

2711

Error

The IP-Phone
Device: <MAC
address of phone>
could not be
configured since
another IP Phone
device is using the
same |IP Address.

The IP address
assigned to an IP
phone is already in
use by another IP
phone.

The new phone
cannot be
configured.

Troubleshoot the DHCP
server to determine why it
is assigning the same IP
address to two different

phones.

2712

Error

The IP-Phone
Device: <MAC
address of phone>
could not be
configured since
the IP Phone

is using an IP
Address that is not
allowed.
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ID Severity Level Message Cause Action

2713 Information The IP-Phone No action.

Device: <MAC
address of phone>
has been updated
to be managed by
Switch: <variable>.
2714 Warning Too many Restart the SysMgrSvc
pending IP phone service.
registration
requests. Restart
SysMgrSvc to
clean up the
queue.

2715 Warning LDVS failover No action.

from Failed
<variable> to
Spare <variable>
initiated.

2716 Warning LDVS failover No action.

from Failed
<variable> to
Spare <variable>
completed.
2717 Warning LDVS failover ;

from Failed
<variable> to
Spare <variable>
failed.

ABC

The following table lists and describes event codes for ABC.

Table 68: Event Codes: ABC

ID Severity Level Message Cause Action

5100 Information Authenticator The specified No action.
<version number> | version of
has started Authenticator
successfully. started.

5101 Information ;Authenticator has | ;Authenticator No action.
been stopped. stopped.

5103 Warning An authentication [ A user attempted | Contact and assist
attempt by user to authenticate the user with login
<user ID>, using using an invalid information.
Mitel credentials, user ID, password
failed with status or expired
code <status password.
code>.

5104 Information The user <user User ID and No action.
ID> authenticated |password
successfully authentication is
using network successful.
credentials.

5105 Warning An authentication | A user attempted | Contact and assist
attempt by to authenticate the user with login
user <user |D>, using an invalid information.
using network user ID, password,
credentials, failed | or expired
with status code password.
<status code>.
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ID Severity Level Message Cause Action

5106 Information An entity Phone No action.
authenticated authentication is
successfully using | successful.

a client certificate
issued to <phone
MAC address>.

5107 Warning An authentication [ Unsuccessful If a phone fails to
attempt by an authentication by | register with the
entity using a client | a phone, or an system or cannot
certificate issued intrusion attempt. | be assigned to a
to <phone MAC user after power-
address> failed cycling the phone,
with status code contact Mitel
<status code>. Technical Support.

5108 Information A ticket issued An application No action.
to <user ID> is successful in
was successfully getting a new ticket
renewed. when the old one

expires.

5109 Warning An attempt to A user attempted | Contact and assist
renew a ticket to renew a ticket the user with login
issued to <user using an invalid information.

ID> failed with user ID, password,
status code or an expired
<status code>. password.

5110 Warning An attempt A user attempted | Contact and assist
to renew an to renew a ticket the user with login
unrecognized ticket | using an invalid information.
failed with status user ID, password,
code <status or an expired
code>. password.

5111 Warning A malformed This may be due If the client
authentication to an intrusion application
request <HTTP attempt. continues to fail,
request> was contact Mitel
received. Technical Support.

Otherwise, block
the source IP
address of the
HTTP request.

5112 Warning A request <HTTP | The client If the client
request> was application does application
received through not use HTTPS continues to fail,
HTTP and is when the system contact Mitel
allowed only is configured Technical Support.
through HTTPS. for secure client

access.

5113 Information An entity An application, No action.
authenticated such as
successfully as Conferencing,
the trusted server [received an
application with authentication
ID <trusted server | ticket.

ID>.
5114 Warning An authentication | An application, Contact Mitel

attempt by an
entity claiming

to be a trusted
server application
<trusted server ID>
failed with status
code <status
code>.

such as
Conferencing,
failed to receive
an authentication
ticket.

Technical Support.
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ID Severity Level Message Cause Action
5200 Information Bootstrapper The specified No action.
<version number> | version of
has started Bootstrapper
successfully. started.
5201 Information Bootstrapper has | Bootstrapper No action.
been stopped. stopped.
Edge Gateway
The following table lists and describes event codes for Edge Gateway.
Table 69: Event Codes: Edge Gateway
ID Severity Message Cause Action
Level
5600 Information EdgeGW <EGW <service name> No Action.
host name>: is started and
<service name> is | running.
running.
5601 Information EdgeGW <EGW <service name> is | No Action.
host name>: stopped.
<service name> is
stopped.
5602 Information EdgeGW <EGW Admin applied EGW service will restart.
host name>: restart command
Restart command | through Connect
is received. Director.
5603 Information EdgeGW <EGW Admin applied 1. EGW check version again
host name>: reboot command HQ/Li DVS. If X
Reboot command | through Connect YLINUX DVS. 1T version
is received. Director. mismatch, it will download
new image and install
automatically.
2. Reboot EGW machine.
5604 Information EdgeGW <EGW Admin applied EGW download image for HQ/
host name>: upgrade Linux DVS, install the image
Upgrade command | command through | and reboot. Note: It does not
is received. Director. check version in this command.
It's supposed to be used for
diagnostic purpose.
5605 Information EdgeGW <EGW EGW starts to Download image from HQ/Linux
host name>: download image |DVS server.
Download image when it receives
from <FTP server |the reboot or
IP address>. the upgrade
command under
version mismatch.
5606 Information EdgeGW <EGW EGW starts Start to installs new image.
host name>: Install | the new image
new image. installation after
download.
5607 Information EdgeGW EGW completed | Complete installing new image.
<EGW host upgrading to new
name>: Upgrade image.
completed.
5608 Error EdgeGW <EGW EGW failed to Write error message to log file and
host name>: upgrade to new quit current upgrading task.
Upgrade abort. image.
Please check
more details in
egwds.log.
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ID Severity Message Cause Action
Level

5609 Warning EdgeGW <EGW EGW is already Reject the new connect request.
host name>: connected with
Second TMS HQ/Linux DVS
connection attempt | server, but
from <IP address>. | another HQ/Linux

DVS server tries
to connect with it.

5610 Error EdgeGW <EGW Non-fatal internal | This is a diagnostic message to
host name>: error happened. be used by TS and engineers.
Internal diag:
<internal diagnostic
messages >.

5611 Error EdgeGW <EGW Admin input Reject the incorrect IP address
host name>: incorrect RAST IP | and send event to administrator.
<service name> address, TURN IP
IP address <IP address, Reverse
address> is invalid. | Proxy IP address,

or Gateway in
Connect Director-
>Administration-
>Appliances/
Servers->Platform
Equipment-
>General

page of EGW
configuration.

5612 Error EdgeGW <EGW Admin input Reject the incorrect subnet mask
host name>: incorrect and send event to administrator.
Network mask Subnet mask in
length <number> is | Connect Director-
invalid. >Administration-

>Appliances/
Servers->Platform
Equipment-
>General

page of EGW
configuration.

5613 Warning EdgeGW <EGW Admin input Reject the incorrect FQDN and
host name>: incorrect Connect | send event to administrator.
Connect client client FQDN in
FQDN is invalid. Connect Director-

Disable RP service | >Administration-

for it. >Appliances/
Servers->Platform
Equipment-
>REVERSE
PROXY
page of EGW
configuration.

5614 Warning EdgeGW <EGW Admin input Reject the incorrect FQDN and
host name>: incorrect send event to administrator.
Collaboration Collaboration
FQDN is invalid. FQDN in Director-

Disable RP service
for it.

>Administration-
>Appliances/
Servers->Platform
Equipment-
>REVERSE
PROXY

page of EGW
configuration.
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ID Severity Message Cause Action
Level
5615 Warning EdgeGW <EGW Admin input Reject the incorrect FQDN and
host name>: ECC |incorrect Contact [send event to administrator.
FQDN is invalid. Center FQDN
Disable RP service |[in Director-

>Administration-
>Appliances/
Servers->Platform

for it.

Equipment-
>REVERSE
PROXY

page of EGW
configuration.

Offline Migration

The following table lists and describes event codes for Offline Migration.

Table 70: Event Codes: Offline Migration

ID Severity Level Message Cause Action

5400 Information Message CDR The CDR Offline No Action.
Migration has data migration
started. service has

started.

5401 Information CDR Migration has | The CDR Offline No Action.
stopped. data migration

service has
stopped.

5402 Error CDR Migration An error has Contact Mitel
halted due to error. | occurred while technical support
<Error Message>. | migrating CDR with the error

data. message and log
files.

5403 Information CDR Migration has | The CDR Offline No Action.
completed. data migration

completed.

5404 Information DM Migration has | The DM Offline No Action.
started. data migration

service has
started.

5405 Information DM Migration has | The DM Offline No Action.
stopped. data migration

service has
stopped.

5406 Error DM Migration An error has Contact Mitel
halted due to error. | occurred while technical support
<Error Message>. | migrating DM data. | with the error

message and log
files.

5407 Information DM Migration has | The DM Offline No Action.
completed. data migration

completed.

IP Phone Display Server (IPDS)

The following table lists and describes event codes for IPDS.
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Table 71: IP Phone Display Server (IPDS)

ID Severity Level Message Cause Action

2800 Information The IP Phone IPDS service No action.

Display Service started.
(Version
X.X.XXxX.X) started
successfully.
2801 Information The IP Phone ;IPDS service No action.
Display Service stopped.
stopped.

2802 Error The IP Phone The IPDS service | Contact Mitel Technical Support
Display Service crashed upon and be prepared to provide server
(Version x.x.xxxx.x) | startup. (Thisisa [logs.
encountered a fatal condition.)
fatal error during
startup; the service
is terminated.

2803 Warning An unexpected The Win32 Contact Mitel Technical Support
service control Service Control and be prepared to provide server
message Manager reports logs.
<Message ID an unexpected
as hexadecimal message. The
integer> was IPDS installation
encountered. was probably

modified manually
by the user.

2804 Warning An unexpected An exception Contact Mitel Technical Support
exception was )
encountered and | occurred and was | and be prepared to provide server
handled. Exception | handled by the logs.
description logging of the error. It Lo
<Description _ users are experiencing
here>. Typically, one or problems, perform an

more of the phones | administrative restart on the
are displaying phones.

anomalies; a

display update may

not have been sent

or a phone display

is out of sync.

2805 Error An unhandled An exception Immediately notify all IP phone
exception was occurred, but was
encountered. :Excegtian handied. users and restart IPDS to restore
description: normal service. (Use the Send
<Description Diagnostic Message to dispatch a
here>. message to all phone displays.)

Contact Mitel Technical Support
and be prepared to provide server
logs.

2806 Warning The following A general error Contact Mitel Technical Support
warning condition [ message that can |and be prepared to provide server
was encountered [ indicate minor user | logs.
in the IP Phone problems. Usually
Display Service: the result of a non-
<Warning fatal TAPI error.
description>.
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ID Severity Level Message Cause Action

2807 Error The following error | A general error Contact Mitel Technical Support
condition was message that .
encountered in the | can accompany and be prepared to provide server
IP Phone Display | extensive user logs.
Service: <Error problems. Usually . .
Description>. the result of a fatal | Perform other diagnostics at your

TAPI error. discretion.

2808 Information The phone display | An administrator No action.
was reinitialized reset the display
because of an on the phone
administrative at the specified
request: Extension: | extension.
<Extension
number>.

2809 Information The phone display | An administrator No action.
was reinitialized reset the display
because of an on the phone
administrative configured for the
request: Port ID: specified port.
<Port ID>.

2810 Information All phone displays | An administrator No action.
were reinitialized reset the display
because of an on all IP phones.
administrative
request.

2811 Information The phone display | An administrator No action.
was reinitialized reset the display
because of an on the phone
administrative having the
request: IP specified IP
Address <IP address.
address>.

2812 Warning The IP Phone Fault in Microsoft | \watch for anomalous behavior.
Display service Telephony
encountered an Service; there is Restart the following if problems
apparent crash potential to recover persist:
in the Microsoft automatically. '
Teleghony Service. e TMS
IPDS attempts to
recover from this * IPDS
problem. If users * Workgroup
report anomalous  All Voice Mail Services
behavior, stop
and restart
the Microsoft
Telephony Service
and all services
that depend on it.

2813 Error The IP Phone Fault in Microsoft

Display service
was unable to

recover from an
apparent crash
in the Microsoft

Telephony Service.

Stop and restart
the Microsoft
Telephony Service
and all services
that depend on it.

Telephony Service;
there is no
potential to recover
automatically.

Restart the following if problems

persist:

* TMS
* IPDS
* Workgroup
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ID Severity Level Message Cause Action

2814 Warning The following An administrator Unset the option listed in the
config option was | set a debug flag event message.
set to a value that |in the registry
is only intended for | that was only
engineering use: intended for use by
<option name>. engineers.

2815 Warning The IP Phone IPDS was unable [ Also see 2816 and 2817.
display service is | to access the
unable to connect |database upon
to the database. startup. It tries
It retries in 30 again in 30
seconds. <error seconds. No action
code that was needs to be taken
encountered> at this time.

2816 Error The IP Phone ; If recovery is not possible
display service is ':I;g|s onlydhap]E)ens (see error 2817), contact Mitel
unable to connect seconds after a | Tochnical Support.
to the database. 2815 error, in the
It continues to event that the retry
retry once every for 2815 failed.
minute.<error
code that was At this point, the
encountered> most common

cause is that

the most recent
installation or
upgrade on the
server where

the evenrtis
generated did not
properly register
the database
access libraries.

2817 Information The IP Phone A database retry No action.
display service’s after 2815/1816
connection to errors was
the database successful and
recovered from the | the situation was
previous error. recovered from.

2818 Error The database is Database file Call Mitel Technical Support.
missing a table or | corrupted, or a
stored procedure query removed
needed to run the |or otherwise
following stored inaccessible at this
procedure: (name |time.
if query). This
causes degraded
functionality in
IPDS. Ensure that
the HQ server and
all Remote servers
are running the
same version of
software.

CMCA

The following table lists and describes event codes for CMCA.
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Table 72: Event Codes: CMCA

ID Severity Message Cause Action
Level

4400 |Warning Conferencing | Occurs when | Go to licenses tab in Director and add extra
audio license [ 80% or more | licenses that are required and configure.
near max of the audio
capacity. licenses are in

use.

4401 |Warning Conferencing | Occurs when | Go to licenses tab in Director and add extra
audio license |audio license |licenses that are required and configure.
max capacity. |have already

reached the
maximum
capacity.

4402 |Informational | Conferencing |Occurs when | No action.

CMCA started. | CMCA service
is started or
restarted on
UCB.

4403 |Informational | Conferencing |Occurs when | No action.
CMCA has CMCA service
stopped. is stopped on

UCB.

4404 | Warning Conferencing | Occurs when | To free up the disk space on UCB by deleting
CMCA the CMCA some recordings or free up logs from / cf /
approaching was unable shor el i nedat a/ | ogs.
full disk to finish the
capacity. recording or
Certain able to upload
operations like |the library
recording and | because the
library upload |disk capacity is
failed. full.

4405 |Warning Conferencing | Occurs when | Go to licenses tab in Director and add extra
web license 80% or more | web conferencing licenses that are required
near max of the web and configure.
capacity. licenses are in

use.

4406 |Warning Conferencing | Occurs if Go to licenses tab in Director and add extra
web license web license licenses that are required and configure.
reached max |have already
capacity. reached the

maximum
capacity.

4407 |Warning Conferencing |HTTPS is Go to appliances in Director and check if
HTTPS disabled for HTTPS is enabled for the respective UCB, if
disabled. the UCB in not enable it.

Director.

4408 | Error Conferencing | Occurs if the Go to system parameters in Director and make
exchange credentials sure the credentials entered is correct and
connector entered for connection is successful.
failed because |exchange
the Exchange | connector in
UserID and/or | the Director
Password set | are wrong.
in Director is
incorrect.

4410 |Informational | Conferencing |Occurs when | No action.

Exchange exchange
Connector connector is
started started.
successfully.
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ID Severity Message Cause Action
Level
4411 | Informational | Conferencing | Occurs when | No action.
exchange exchange
connector connector is
stopped. stopped.
4414 | Error Conferencing Oc(tj:_urs V‘;,?e” Verify the usage of the ports by performing the
audio port 323506%()” following tasks in Director:
ums:)gremrjerra]ched tmhgxlﬂrgl?rrlls » Navigate to Maintenance > Status and
capacity Maintenance > Audio/Web Conferencing
' and check the peak and current usage of
the audio and web ports.
* Navigate to Maintenance > Status and
Maintenance > Appliances and check the
ports that are free and the ports that are in
use.
If all the ports are in use for web or audio, the
system might not have enough conferencing
resources for the current load levels.
Therefore, you may need to add additional
conferencing devices to the system.
When there are no ongoing meetings and if
the Maintenance page still shows the devices
are in use, contact Mitel Technical Support for
assistance before you restart the device.
4415 | Error Conferencing | Occurs when

web port
usage reached
maximum
capacity.

web port
usage on
the UCB is
maximum.

Verify the usage of the ports by performing the
following tasks in Director:

* Navigate to Maintenance > Status and
Maintenance > Audio/Web Conferencing
and check the peak and current usage of
the audio and web ports.

* Navigate to Maintenance > Status and
Maintenance > Appliances and check the
ports that are free and the ports that are in
use.

If all the ports are in use for web or audio, the
system might not have enough conferencing
resources for the current load levels.
Therefore, you may need to add additional
conferencing devices to the system.

When there are no ongoing meetings and if
the Maintenance page still shows the devices
are in use, contact Mitel Technical Support for
assistance before you restart the device.
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Appendix B - Alerts

This chapter includes information about Connect alerts.

* Overview of Alerts
* Bandwidth Alerts

e Connection Alerts

* Server Alerts

» Switch Alerts

* Trunk Group Alerts
* Voice Quality Alerts

Overview of Alerts

This appendix provides a comprehensive list of alerts organized by category. These alerts are a valuable
resource for understanding events reported by the Mitel system.

Alerts identify system issues by correlating events that occur in the Mitel system. The data for these
correlations comes from the Windows event log, the Monitoring Database and an internal database that
keeps track of status information on sites and switches.

Alerts are available for the following aspects of the Mitel system:

¢ Bandwidth

¢ Connections
e Servers

e Switches

e Trunk Groups
* Voice Quality

The tables in this appendix provide a structured view of alerts displayed in the Diagnostics and
Monitoring web application. Each alert includes a severity level, ID number, description text, possible
causes, suggested courses of action (if any), and whether the alert clears automatically or must be
cleared manually.

For information about monitoring alerts using the Diagnostics & Monitoring system in Connect Director,
see the MiVoice Connect System Administration Guide.

Each alert is assigned a level of severity. The following table describes the three severity levels.

Table 73: Severity Levels of Alerts

Severity Level Explanation

Information Indicates normal operation, or a transition between normal

operating states

Typically, no action is required.

Warning Reports an exception to normal operations that might need to be
monitored
Critical Reports a failure or an impending failure (for example, when

a service or hardware component is disabled) that requires
immediate response and resolution

Bandwidth Alerts

The following table describes the alerts related to bandwidth. Messages are listed alphabetically within
each severity level.
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Table 74: Bandwidth Alerts

Severity Level Description Cause Action and Clearing Status

Critical Bandwidth A site has reported @ | \jonitor the (outbound) call volume
utilization critical bandwidth utilization A g .
threshold has been | percentage above the |@nd trunk utilization within the site to
exceeded. accepted threshold. determine if there could be a correlation

High bandwidth between the number of calls and the

utilization could ) bandwidth usage.

result from excessive

network activity This alert clears automatically when the

because of high call [ bandwidth utilization percentage for the

X?#é?faﬁrszorﬁ]@ h site sustains a level below the critical

bandwidth utilization | threshold for 3 minutes.

could also mean Collect all necessary logs and screen

that there is simply . .

not enough network shots _before contacting the M|tel_ _

bandwidth for the site. | Technical Support for further assistance if
the problem persists.

Warning Bandwidth A site has reported a | \ionitor the (outbound) call volume
utilization warning | bandwidth utilization A S .
threshold has been | percentage above the and trupk qtlllzatlon within the site to _
exceeded. accepted threshold. determine if there could be a correlation

High bandwidth between the number of calls and the

utilization could ) bandwidth usage.

result from excessive

network activity This alert clears automatically when the

because of high call | bandwidth utilization percentage for the

X?A:Tfaﬂgzom% h site sustains a level below the threshold

bandwidth utilization | for 3 minutes.

fr?:tktjhzlfeoi?si?nnply Collect all necessary logs and screen

not enough network shots before contacting the Mitel

bandwidth for the site. | Technical Support for further assistance if
the problem persists.

Warning Switch is The switch has Increase the amount of intersite
experiencing low reported that it does .
bandwidth. not have sufficient bandwidth or decrease the amount of

bandwidth to initiate call traffic between the two sites that are

an intersite call. experiencing the issue.
This alert clears automatically when the
bandwidth utilization percentage for the
target site increases or decreases. A
decrease in the percentage of bandwidth
utilization represents a decrease in
call traffic or an increase in configured
intersite bandwidth. An increase in the
percentage of bandwidth utilization
indicates that an intersite call was
successfully established since the alert
was generated.

Connection Alerts

The following table lists and describes the alerts related to connections. Messages are listed
alphabetically within each severity level.
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Table 75: Connection Alerts

Severity Level Description Cause Action and Clearing Status
Critical Switch has lost | The switch’s Ensure that the switch is running and is
connection to the | managing
network. server cannot connected to the network. If you manually
communicate restarted the switch, you can ignore this alert,
with the switch. [ as it was generated while the switch was
restarting.
This alert clears automatically after the switch
is running and connected to the network.
Collect all necessary logs and screen shots
before contacting the Mitel Technical Support
for further assistance if the problem persists.
Information IP phones are The phone is Review the events associated with the alert,
having DHCP having issues . : .
issues with IP related to its IP and take corrective action as appropriate.
addresses. address. After correcting the switch configuration, you
must clear this alert manually. Otherwise,
the system deletes the alert according to the
parameters set for purging and reclaiming
space used for alerts in the shoreware
monitoring database. (The default is three
days.)
Collect all necessary logs and screen shots
before contacting the Mitel Technical Support
for further assistance if the problem persists.
Server Alerts

The following table describes the alert related to servers.

Table 76: Server Alerts

to a configuration
issue.

Severity Level Description Cause Action and Clearing Status
Warning gg/’I(Sc?:ds Es‘ﬁ esserv://i?r: ii?Shaving Review the associated events and
invalid Director |current IP address, | d&termine appropriate configuration
configurations. | which could be due | changes.

After resolving the configuration issue, you
must clear the alert manually. Otherwise,
the system deletes the alert according

to the parameters set for purging and
reclaiming space used for alerts in the
shoreware monitoring database. (The
default is three days.)

Collect all necessary logs and screen
shots before contacting the Mitel Technical
Support for further assistance if the
problem persists.

Switch Alerts

The following table describes the alerts related to switches. Messages are listed alphabetically within

each severity level.
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Table 77: Switch Alerts

Severity Level Description Cause Action and Clearing Status

Warning Inva}hd SV‘;!tCh Ihe SW'tCh Review the events associated to the alert,
gg?elgtgf lons cgﬁfig?ﬁgd with | a@nd modify the configuration of the switch

a characteristic | @s appropriate.

that does not . ) Lo

match what After correcting the configuration issue, you

the switch is must clear this alert manually. Otherwise,

reporting. the system deletes the alert according
to the parameters set for purging and
reclaiming space used for alerts in the
shoreware monitoring database. (The
default is three days.)

Warning ]Ic:_’ossmle switch -rl;he fSV‘l"t(th Collect all necessary logs and screen
(;glt]r\tljvp?tl}gn. aﬁsat?elr?lptlr’:o shots before contacting the Mitel Technical

upgrade its Support for further assistance if the problem

firmware and has | persists.

resorted to an ) L

alternate booting | After resolving the switch issue so that the

method. switch boots normally, you must clear this
alert manually.

Warning Switch core The switch is Ensure that the switch is running in a
is operating operating at a . .
at an unsate temperature temperature-friendly environment.
temperature. level that is over | Thjs glert clears automatically if the switch’s

the switch’s

threshold. temperature returns to normal.
Collect all necessary logs and screen
shots before contacting the Mitel Technical
Support for further assistance if the problem
persists.

Warning Switch is ﬁ]trunlgtorr: . Review the events associated with the alert.
%é%%gexﬁwﬁs ex%gnlclar?cirlmsg If the identified trunk is causing issues in
trunks. unexpected the system, restart the switch.

behaviors. This alert clears automatically when the
trunk re-establishes expected behavior
and is back in service, or when the switch
is restarted. However, if this alert was
generated because you intentionally forced
all ports on a switch to the “Unavailable”
state, you can manually clear this alert.
Collect all necessary logs and screen
shots before contacting the Mitel Technical
Support for further assistance if the problem
persists.

Warning Switch is The fan on the

experiencing
issues with the
fan.

switch is having
trouble running
and may be too
old.

The fan or switch may need to be replaced.
Collect all necessary logs and screen

shots before contacting the Mitel Technical
Support for further assistance if the problem
persists.

This alert clears automatically if the fan
begins running at normal speed.
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Severity Level Description Cause Action and Clearing Status

Warning Switch is The switch is Collect all necessary logs and screen
%é%%g%ﬁﬁ?he %gigggggg shots before contacting the Mitel Technical
power supply. power failures. Support for further assistance if the problem

persists.
This alert clears automatically if the voltage
level of the switch returns to normal.

Warning Switch is The memory on | Ragtart the switch. Collect all necessary
experiencing the switch may .
memory issues. be corrupt, or an logs gnd screen shots before contacting

invalid memory the Mitel Technical Support for further
access may have | assistance if the problem persists.
occurred.
This alert clears automatically after the
switch is restarted.

Warning ?IX’VTRISQFIGS Ssg;gge Ig‘: fsavi\lnetgi}n Ensure that the managing server is
issues. an attempt connected to the network and that the

to upgrade managing server can communicate with
its firmware. the switch. Collect all necessary logs and
This could be screen shots before contacting the Mitel
a result of a Technical Support for further assistance if
disconnection .
between the the problem persists.
switch and its This alert clears automatically when the
managing server. | .. :

firmware upgrade is successful.

Warning SW't?‘h%S have NI? po;’tsa ¢ Reserve a port on a switch for an IP phone,
tr::?)cac?ty ror:‘al)lé’Imum ?P%%aoﬁes(;rre or if no ports can be reserved add a switch
phones. available on any | to the system. Refer to the MiVoice Connect

of the available | System Administration Guide or contact
switches. Mitel Technical Support for assistance.
After making the necessary configuration
changes (reserving a port for the phone
or assigning the phone to a switch that
has adequate port capacity for additional
phones), you must clear this alert manually.
Otherwise, the system deletes the alert
according to the parameters set for purging
and reclaiming space used for alerts in
the shoreware monitoring database. (The
default is three days.)

Warning The switch is The switch Restart the switch to initiate a firmware
not running a is running a
sufficient firmware | firmware version upgrade.
version. thatis not = This alert clears automatically when the

compatible with )
the version firmware upgrade has completed.
of the PBX.

This is typically
encountered

during an

upgrade,

because after the
Headquarters
server is

upgraded

switches require

an updated

firmware version.
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Severity Level Description Cause Action and Clearing Status
Warning TMS has detected | The switch is Review the events associated with the alert,
invalid switch having issues . : :
configurations. that are related and take corrective action as appropriate. If
to its IP address. | hecessary, contact Mitel Technical Support
for assistance.
If the switch is restarted, the alert clears
automatically. Otherwise, after taking
corrective action, you must clear the alert
manually.
Trunk Group Alerts

The following table describes the alerts related to trunk groups. Messages are listed alphabetically within
each severity level.

Table 78: Trunk Group Alerts

Severity Description Cause Action and Clearing Status
Level

Critical Trunk occupancy | A trynk on a switch Allocating more ports on the switch for
critical threshold | . . . .
has been is being used for a trunk usage will more evenly distribute the
exceeded. high volume of calls. trunk utilization load. Refer to the MiVoice

This situation could Connect System Administration Guide

occur for either of the | for more information, or contact Mitel

following reasons: Technical Support for assistance.

* An insufficient This alert clears automatically when the
number of ports are | trunk utilization percentage on the switch
allocated for use as | has sustained a level below the critical
trunks. threshold for 3 minutes.

e Outbound call
volume is high.

Warning gyltecrri]elr?cin gtergme(r?enntc?r? switth | Review the events associated to the
iss%es with %s unex?)ected bghaviors. glen. If_the identified trunk is causin.g
trunks. issues in the system, restart the switch.

Contact Mitel Technical Support for further
assistance.

This alert clears automatically when the
trunk reestablishes expected behavior and
is back in service, or when the switch is
restarted.

Warning Trunk occupancy | a rynk on a switch Allocating more ports on the switch for
warning threshold | . . : .
has been is being used for a trunk usage will more evenly distribute the
exceeded. high volume of calls. trunk utilization load. Refer to the MiVoice

This situation could Connect System Administration Guide

occur for either of the | for more information, or contact Mitel

following reasons: Technical Support for assistance.

¢ An insufficient This alert clears automatically when the
number of ports are |trunk utilization percentage on the switch
allocated for use as [ has sustained a level below the warning
trunks. threshold for 3 minutes.

¢ Outbound call
volume is high.
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Voice Quality Alerts

The following table describes the alerts related to voice quality. Messages are listed alphabetically within
each severity level.

Table 79: Voice Quality Alerts

Severity Level Description Cause Action and Clearing Status

Critical Call quality critical | A stream withina | ponitor the calls on the switch and any
threshold has been | call occurring over :
exceeded. a switch has been | @lerts from the same switch that could be

identified as having | related. If the issue consistently occurs

poor voice quality | or a possible issue is identified, collect all

(“bad call’). necessary logs and screen shots before
contacting the Mitel Technical Support for
further assistance if the problem persists.
Assuming that no “bad” calls occur over
the switch, this alert clears automatically
3 minutes after a “good” call occurs. (A
“good” call is one in which all streams of
the call are identified as having good voice
quality.)

Warning Call Quality A stream within @ | pionitor the calls on the switch and identify
warning threshold | call occurring over :
has been a switch has been | any alerts from the same switch that could
exceeded. identified as having | be related. If the issue occurs consistently

poor voice quality | or a possible issue is identified, collect all

(“bad call). necessary logs and screen shots before
contacting the Mitel Technical Support for
further assistance if the problem persists.
Assuming that no “bad” calls occur over
the switch, this alert clears automatically
3 minutes after a “good” call occurs. (A
“good” call is one in which all streams of
the call are identified as having good voice
quality.)

Warning Switch DSP is The switch Restart the switch. Collect all necessary
reaching its limit. has reported :

that its digital logs a_nd screen shots before contacting

signal process the Mitel Technical Support for further

is experiencing assistance if the problem persists.

Issues. This alert clears when the switch is
restarted.

Warning Switch is The switch has Restart the switch. Collect all necessary
experiencing reported that its :
issues with echo echo-suppression logs a_nd screen shots before contacting
cancellation. software is the Mitel Technical Support for further

experiencing assistance if the problem persists.
issues. . .
This alert clears automatically when the
switch reports that its echo-suppression
software has been corrected or when the
switch is restarted.
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Appendix C - DCOM Permissions

This chapter contains an overview of DCOM permissions.

* Overview
* Editing DCOM Permissions

Overview

Mitel systems have one HQ server and multiple remote servers. Applications running on remote servers
access data service components residing on the HQ server through Distributed Component Object Model
(DCOM). DCOM permissions are configured by the Installer when the servers are installed and by the
SP1Repair command line utility.

The following service logon accounts are available in Windows:

* Local System account: This account includes full system access, including the directory service on
domain controllers. Services logged onto the Local System account on domain controllers can access
the entire domain. Some services log onto the Local System account by default. Do not change default
service settings.

¢ Local Service account: This account is similar to authenticated user accounts. Services logged onto
the Local Service account have the same access rights as members of the Users group and access
network resources as null sessions with no credentials.

* Network Service account: This account is similar to authenticated user accounts. Services logged
onto this account have the same access rights as members of the Users group and access network
resources through the credentials of the computer account.

Editing DCOM Permissions

You can modify DCOM permissions on the HQ system by using the procedures in the following sections.

My Computer Properties

1. Open the My Computer Properties panel by selecting MMC > Component Services > Computers
> My Computer > Properties.

2. Open the Default Properties panel, and select Enable DCOM.

3. Open the COM Security panel:

a. Click Edit Default in the Access Permissions section and select the following permissions:

e SELF: Local Access — allow; Remote Access — allow
e SYSTEM: Local Access — allow; Remote Access — no selection.

Return to the My Computer Properties window by clicking OK.
b. Click Edit Default in the Launch and Activation Permissions section and select the following
permissions:

¢ Administrators: Local Launch — allow; Remote Launch — allow Local Activation — allow;
Remote Activation — allow

¢ INTERACTIVE: Local Launch — allow; Remote Launch — allow Local Activation — allow;
Remote Activation — allow

¢ SYSTEM: Local Launch — allow; Remote Launch — allow Local Activation — allow; Remote
Activation — allow

TriggerServer Properties

1. Open the TriggerServer Properties window by selecting MMC > Component Services >
Computers > My Computer > DCOM Config > Trigger Server > Properties.

2. Open the General panel, and set Authentication level to Default.

Open the Location panel, and select Run application on this computer.

4. Open the Security panel

w
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5.

a. Click Edit in the Launch and Activation Permissions section and select the following
permissions:

¢ Administrators: Local Launch — allow; Remote Launch — allow Local Activation — allow;
Remote Activation — allow

¢ ANONYMOUS LOGON: Local Launch — no selection; Remote Launch — no selection; Local
Activation — allow; Remote Activation — allow

e SYSTEM: Local Launch — allow; Remote Launch — allow Local Activation — allow; Remote
Activation — allow

Return to the TriggerServer Properties: Security panel by clicking OK.
b. Click Edit in the Configuration Permissions section and select the following permissions:

¢ Administrators: Full Control — allow; Read — allow
¢ SYSTEM GROUP: Full Control — allow; Read — allow
¢ CREATOR OWNER: Full Control — no selection; Read — no selection
¢ other Users: Full Control — no selection; Read — allow
Open the Identity panel and select The system account (services only).

ZinManager Properties

1.

ol

5.

Open the ZinManager Properties window by selecting MMC > Component Services > computers
> My Computer > DCOM Config > ZinManager > Properties.

Open the General panel, and set Authentication level to Default.

Open the Location panel, and select Run application on this computer.

Open the Security panel and complete the following steps:

a. Click Edit in the Launch and Activation Permissions section and select the following
permissions:

¢ Administrators: Local Launch — no selection; Remote Launch — no selection; Local Activation
— allow; Remote Activation — allow

e SYSTEM: Local Launch — no selection; Remote Launch — no selection; Local Activation —
allow; Remote Activation — allow

Return to the ZinManager Properties window by clicking OK.
b. Click Edit in the Configuration Permissions section. Select the following permissions:

¢ Administrators: Full Control — allow; Read — allow
¢ CREATOR OWNER: Full Control — no selection; Read — no selection
e SYSTEM: Full Control — allow; Read — allow

Return to the ZinManager Properties window by clicking OK.
Open the Identity panel, and select The system account (services only).

241



APPENDIX D - PORT USAGE

Appendix D - Port Usage

This appendix contains port usage information.

* Port Usage Tables

Port Usage Tables

The following sections provide port usage information for the Connect system. For easier printing and
viewing, the information is divided into three parts, as shown in the table below.

Table 80: Devices Included in Parts 1, 2, and 3

Originating Device

Destination Device

SG-Generation Switch

V-Switch & ST-Generation
Switch

Service Appliance
(Conferencing and IM)

IP Phone

MGCP Phone

Connect Client and Softphone

Connect Client for Web and
Softphone

ECC Supervisor Client

Linux DVS

Windows DVS

Headquarters Server

Mobility Client (SMC)

Mobility Router (SMR)

D&M Server (Standalone)

Edge Gateway

Other (such as SIP endpoints)

Destination Devices Shown in Part 1 ( Table 81: Port Usage — Part 1

on page 243)

Destination Devices Shown in Part 2 ( Table 82: Port Usage — Part 2

SG Switch

V- Switch and ST Switch

Service Appliance (Conferencing and IM)
IP Phone

MGCP Phone

on page 252)

Destination Devices Shown in Part 3 ( Table 83: Port Usage — Part 3

ECC Supervisor Client
Mobility Client (SMC)
Mobility Router (SMR)
D&M Server (Standalone)
Edge Gateway

on page 256)

Connect Client Softphone
Connect Client for Web Softphone
Linux DVS

Windows DVS

Headquarters Server

Other

Port Usage Part 1

The following table contains the first part of the port usage information for the Connect system.
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Table 81: Port Usage — Part 1

Media Stream

UDP
10000-20000
RTP
(configurable)

IP Path Trace

ubP
33434+255

Media Stream

UDP
10000-20000
RTP
(configurable)

IP Path Trace

ubpP
33434+255

Media Stream

UDP
10000-20000
RTP
(configurable)

IP Path Trace

ubP
33434+255

Originating Destination Device
Devi
evice SG Switch V-Switch Service IP Phone | MGCP Phone
ST SwitchApgliance(Conferenging
and IM)

Switch Call Control Call Control Call Control Media Stream | Call Control
UDP 5440 UDP 5440 UDP 5440 UDP UDP 2427
— Location — Location — Location 10000-10128 MGCP
Service Service Service RTP Media Stream
UDP5441— |UDP5441— |UDP 5441 | (configurable) UDP
Call Control Call Control Call Control IP Path Trace 10000-10128
UDP 5443 - UDP 5443 - UDP 5443 - UDP RTP
Bandwidth Bandwidth Bandwidth 33434+255 (configurable)
Manager Manager Manager IP Path Trace
UDP 5445 UDP 5445 UDP 5445 UDP
— Admission — Admission — Admission 33434+255
Control Control Control
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Originating Destination Device
Device SG Switch V-Switch Service IP Phone | MGCP Phone
ST SwitchApgliance(Conferenging
and IM)
V-Switch Call Control Call Control Call Control Media Stream | Call Control

UDP 5440 UDP 5440 UDP 5440 UDP UDP 2427
— Location — Location — Location 10000-10128 MGCP
Service Service Service RTP Media Stream
UDP5441— |UDP5441— |UDP5441—  |(configurable) UDP
Call Control Call Control Call Control IP Path Trace 10000-10128
UDP 5443 — UDP 5443 — UDP 5443 — UDP RTP
Bandwidth Bandwidth Bandwidth 33434+255 (configurable)
Manager Manager Manager IP Path Trace
UDP 5445 UDP 5445 UDP 5445 UDP
— Admission — Admission — Admission 33434+255
Control Control Control
Media Stream |Media Stream |Media Stream
UDP UDP UDP
10000-20000 10000-20000 10000-20000
RTP RTP RTP
(configurable) | (configurable) [ (configurable)
IP Path Trace |IP Path Trace |[IP Path Trace
UDP UDP UDP
33434+255 33434+255 33434+255

Transport:

TCP 5432 —

Xprt

SMTP

TCP 25 -

SMTP

V-Switch Transport:

TCP 5432 —

Xprt

SMTP

TCP 25 -

SMTP
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Originating Destination Device
Device SG Switch V-Switch Service IP Phone | MGCP Phone
ST SwitchApgliance(Conferenging
and IM)
Service Call Control Call Control Call Control Media Stream |Media Stream
&p:r:'f*:r‘:scin UDP 5440 UDP 5440 UDP 5440 UDP UDP
and IM) 9|_ Location — Location — Location 10000-10128 10000-10128
Service Service Service RTP RTP
UDP 5441 — UDP 5441 — UDP 5441 — (configurable) | (configurable)
Call Control Call Control Call Control IP Path Trace |[IP Path Trace
UDP 5443 — UDP 5443— UDP 5443 — UDP ICMP
Bandwidth Bandwidth Bandwidth 33434+255 33434+255
Manager Manager Manager
UDP 5445— UDP 5445 UDP 5445
Admission — Admission — Admission
Control Control Control
Media Stream |Media Stream |Media Stream
UDP UDP UDP
10000-20000 10000-20000 10000-20000
RTP RTP RTP
(configurable) | (configurable) [ (configurable)
IP Path Trace [IP Path Trace
UDP UDP
33434+255 33434+255
Service CMCA (Web
Appliance Share):
(Conferencing TCP/UDP 5450
and IM) .
Ping Sync
TCP 80 HTTP
Web share
TCP 443
HTTPS Web
share
Transport
TCP 5432 —
Xprt
SMTP
TCP 25 -

SMTP
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Originating Destination Device
Device SG Switch V-Switch Service IP Phone | MGCP Phone
ST SwitchApgliance(Conferenging
and IM)
IP Phone Call Control Call Control Media Stream |Peer SW Media Stream
TCP 5061 SIPS | TCP 5061 SIPS | UDP Update UDP
Media Stream | Media Stream 10000-20000 TCP 80 HTTP | 10000-10550
RTP Media Stream RTP
UDP UbDP (configurable) (configurable)
10000-20000 10000-20000 UDP
RTP RTP IP Path Trace 10000-10128 IP Path Trace
(configurable) | (configurable) [ICMP RTP ICMP
IP Path Trace | IP Path Trace Traceroute (configurable) | Traceroute
ICMP ICMP IP Path Trace
Traceroute Traceroute ICMP
Traceroute
MGCP Phone | c4)1 control Call Control Media Stream |Media Stream |Media Stream
UDP 2727 UDP 2727 UDP UDP UDP
MGCP MGCP 10000-20000 10000-10128 10000-10550
. . RTP RTP RTP
Media Stream | Media Stream (configurable) | (configurable) [ (configurable)
uDP UDP IP Path Trace |IP Path Trace |IP Path Trace
10000-20000 10000-20000
RTP RTP ICMP ICMP ICMP
(configurable) | (configurable) [ Traceroute Traceroute Traceroute
IP Path Trace |IP Path Trace
ICMP ICMP
Traceroute Traceroute
gﬁg:“:’g:‘ d Media Stream |Media Stream |Media Stream |Media Stream |Media Stream
Softphone UDP UDP UDP UDP UDP
10000-20000 10000-20000 10000-20000 10000-10550 10000-10550
RTP RTP RTP SRTP RTP
(configurable) | (configurable) | (configurable)
IP Path Trace
ICMP
33434+500
Linux DVS Port Mapper |Port Mapper | Call Control Media Stream | Media Stream
TCP 111 RPC |TCP 111 RPC | TMS RPC: UDP UDP
Port Mapper Port Mapper UDP 5458 |1:{9r(|)1?0-10128 |1:{(_)r(?:§)0-10550
UDP 111 RPC |UDP 111 RPC [SUNRPC (configurable) | (configurable)
Port Mapper Port Mapper Broadcast 9 9
IP Path Trace |IP Path Trace
Call Control
i UDP UDP
TMS RPC: 33434+255 33434+255
UDP 5458
SUNRPC

Broadcast
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Originating Destination Device
Device SG Switch V-Switch Service IP Phone | MGCP Phone
ST SwitchApgliance(Conferenging
and IM)
LinuxDVS | call Control | SoftSwitch SoftSwitch
UDP 2427 UDP 5440 UDP 5440
MGCP — Media |- Location — Location
proxy Service Service
UDP 5440 UDP 5441 - UDP 5441 —
— Location Call Control Call Control
Service UDP 5443 — | UDP 5443 —
UDP 5441 — Bandwidth Bandwidth
Call Control Manager Manager
UDP 5443 - UDP 5445 UDP 5445
Bandwidth — Admission — Admission
Manager Control Control
UDP 5445 TCP 5452 TCP 5452
— Admission RPC/ NCC RPC/ NCC
Control commands commands
TCP 5452 UDP 5453 - UDP 5453 —
RPC NCC Broadcasts Broadcasts
commands Transport Transport
EEJZ fgﬁs‘ TCP 5432~  |TCP 5432 —
CDS CDSs
Linux DVS Configuration |WSS call IP Path Trace
Control (for control UDP
VxYVorks (MGCP) 334344255
switches Only)
TCP 2727 - CAS-XMPP
TCP WSS to switch
1024-65535 Media Stream TCP 5222 —
— Firmware XMPP/TLS

download (Burn
flash)

WSS call
control
(MGCP)

TCP 2727 —
WSS to switch

Media Stream

UDP
10000-20000
RTP
(configurable)

IP Path Trace

UbP
33434+255

UDP
10000-20000
RTP
(configurable)

IP Path Trace

ubpP
33434+255
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Originating Destination Device
Device SG Switch V-Switch Service IP Phone | MGCP Phone
ST SwitchApgliance(Conferenging
and IM)
\II)V\ilrédows Port Mapper |Port Mapper | Call Control Media Stream | Media Stream
TCP 111 RPC |[TCP 111 RPC |TMS RPC: UDP UDP
Port Mapper Port Mapper UDP 5458 ;2'?0-10128 |1R(')|'OF?0-10550
UDP 111 RPC |UDP 111 RPC |SUNRPC (configurable) | (configurable)
Port Mapper Port Mapper Broadcast 9 9
IP Path Trace |[IP Path Trace
Call Control
) UDP UDP
TMS RPC: 33434+255 | 33434+255
UDP 5458
SUNRPC
Broadcast
‘6V\i,’§d°ws Call Control | SoftSwitch SoftSwitch
UDP 2427 UDP 5440 UDP 5440
MGCP — Media |- Location — Location
proxy Service Service
UDP 5440 UDP 5441 — UDP 5441 —
— Location Call Control Call Control
Service UDP 5443 -  |UDP 5443 -
UDP 5441 — Bandwidth Bandwidth
Call Control Manager Manager
UDP 5443 — UDP 5445 UDP 5445
Bandwidth — Admission — Admission
Manager Control Control
UDP 5445 TCP 5452 TCP 5452
— Admission RPC/ NCC RPC/ NCC
Control Commands Commands
TCP 5452 UDP 5453 — UDP 5453 —
RPC NCC Broadcasts Broadcasts
commands Transport Transport
gr%z d5;5si’s‘ TCP 5432 — | TCP 5432 —
CDS CDS
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Originating Destination Device
Device SG Switch V-Switch Service IP Phone | MGCP Phone
ST SwitchApgliance(Conferenging
and IM)
\II)V\ilrédows Configuration |WSS call Transport
Control (for control TCP 5432 —
VxWorks (MGCP) cDS
switches only) TCP 2727 — P Path Trace
TCP WSS to switch
1024-65535 . UDP
— Firmware Media Stream 33434+255
download UbDP
(Burnflash) 10000-20000
RTP
WSS call )
control (configurable)
(MGCP) IP Path Trace
TCP 2727 - uUDP
WSS to switch | 33434+255
Media Stream
UDP
10000-20000
RTP
(configurable)
IP Path Trace
UDP
33434+255
g:?\fieiuarters Port Mapper |Port Mapper | Call Control Media Stream |Media Stream
TCP 111 RPC |TCP 111 RPC |TMS RPC UDP UDP
Port Mapper Port Mapper UDP 5458 |1Q(')|'(|)300_10128 ;3'?0_10550
UDP 111 RPC [UDP 111 RPC |SUNRPC (configurable) | (configurable)
Port Mapper Port Mapper Broadcast 9 9
SoftSwitch IP Path Trace
Call Control
) IP Path Trace |UDP
TMS RPC: UDP 33434+255
UDP 5458
SUNRPC 33434+255

Broadcast
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Originating Destination Device
Devi
evice SG Switch V-Switch Service IP Phone | MGCP Phone
ST SwitchApgliance(Conferenging
and IM)
Headquarters | ca)| Control | Soft Switch | Soft Switch
Server
UDP 2427 UDP 2427 UDP 2427
MGCP — Media | MGCP — Media | MGCP — Media
proxy proxy proxy
UDP 5440 UDP 5440 UDP 5440
- Location - Location - Location
Service Service Service
UDP 5441 — UDP 5441 — UDP 5441 —
Call Control Call Control Call Control
UDP 5443 — UDP 5443 — UDP 5443 —
Bandwidth Bandwidth Bandwidth
Manager Manager Manager
UDP 5445 UDP 5445 UDP 5445
— Admission — Admission — Admission
Control Control Control
TCP 5452 TCP 5452 TCP 5452
RPC NCC RPC NCC RPC NCC
commands commands commands
UDP 5453 — UDP 5453 — UDP 5453 —
Broadcasts Broadcasts Broadcasts
g:?\fieiuarters Configuration |Transport Transport
Control TCP5432-  |TCP 5432 —
TCP CDS CDS
10F2.4_65535 Media Stream |IP Path Trace
— Firmware
download. UDP UDP
(Burnflash) 10000-20000 33434+255
RTP
WSS call )
control (configurable)
(MGCP) WSS call
TCP 2727 - mgtgl,’l)
WSS to switch
. TCP 2727 —
Media Stream ||\ 55 {4 switch
UDP
10000-20000 IP Path Trace
RTP UDP
(configurable) | 33434+255
IP Path Trace
UDP
33434+255
Mobility NA NA ; : ;
Client (SMC) Media Stream |Media Stream |Media Stream

UDP
10000-20000
RTP
(configurable)

UDP
10000-10128
RTP
(configurable)

UDP
10000-10128
RTP
(configurable)
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Originating Destination Device
Device SG Switch V-Switch Service IP Phone | MGCP Phone
ST SwitchApgliance(Conferenging
and IM)
Mobility TCP 5061 - TCP 5061 - Media Stream |Media Stream |Media Stream
Router (SMR) SIPS SIPS
UDP UDP UDP
TCP/UDP 5060 | TCP/UDP 5060 | 10000-20000 10000-10128 10000-10550
- SIP -SIP RTP RTP RTP
Media Stream | Media Stream (configurable) | (configurable) [ (configurable)
10000-20000 | 10000-20000 9ing
RTP RTP TCP 5222 —
(configurable) | (configurable) | XMPP/TLS
DM Server TCP 22 - TCP 22 - NA TCP 22 - NA
(Standalone) |SSH (RpCap SSH (RpCap SSH (RpCap
Maintenance) Maintenance) Maintenance)
Edge TURN: TURN: TURN: TURN: TBD
Gateway
Media Stream |Media Stream |Media Stream |Media Stream
UDP UDP UDP UDP
10000-20000 10000-20000 10000-20000 10000-10128
RTP RTP RTP RTP
(configurable) | (configurable) |[(configurable) | (configurable)
Other(such | ssH SSH SSH SH Telnet
endpoints) | TCP 22 TCP 22 TCP 22 TCP 22 TCP 23
PAPI
TCP 8086

Port Usage Part 2

The following table contains the second part of the port usage information for the Connect system.
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Table 82: Port Usage — Part 2

Originating Destination Device
Devi
evice ECC Mobility Mobility D&M Server | Edge Gateway
Supervisor Client (SMC) | Router (SMR) | (Standalone)
Client
Switch NA Media Stream | SIP Lines and g}%" 5060 - | TURN
UDP Trunk Media Stream
42000-42100 UDP/TCP UDP
RTP 5060- SIP 10000-15000
P Path Trace |TCP 5061 - SRTP
UDP SIPS (configurable)
33434+255 UDP - 50000 IP Path Trace
I—_iErS](()e(;OO—SIP UDP
33434+255
Media Stream
UDP
15000-32000
IP Path Trace
UDP
33434+255
V-Switch NA Media Stream |NA NA TURN
UDP Media Stream
;153300-42100 UDP
10000-15000
IP Path Trace SRTP
UDP (configurable)
33434+255 IP Path Trace
UDP
33434+255
Service NA Media Stream | Media Stream | YDP 5060 - TURN
Appliance SIP
(Conferencing UDP UDP Media Stream
and IM) 42000-42100 | 15000-32000
RTP (RTP) ubP
10000-15000
IP Path Trace |IP Path Trace RTP
UDP UDP (configurable)
33434+255 33434+255 IP Path Trace
UDP
33434+255
IP Phone NA Media Stream |Media Stream |NA RAST (for
UDP UDP O::;ZE)T
42000-42100 15000-32000 P
RTP (SRTP) TCP/UDP
IP Path Trace |IP Path Trace 443 - RAST
(on external
ICMP ICMP interface)
Traceroute Traceroute
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Originating Destination Device
Devi
evice ECC Mobility Mobility D&M Server | Edge Gateway
Supervisor Client (SMC) | Router (SMR) | (Standalone)
Client
MGCP Phone | NA Media Stream |Media Stream |NA TURN
UDP UbDP Media Stream
42000-42100 15000-32000 UDP
RTP (SRTP) 10000-15000
IP Path Trace |IP Path Trace RTP
ICMP ICMP (configurable)
Traceroute Traceroute IP Path Trace
ICMP
Traceroute
Connect Client | NA Media Stream |Media Stream |NA TURN
and Softphone
UDP UDP Signaling
42000-42100 15000-32000 TCP/UDP 443
RTP (SRTP)
(configurable) = STUN and
9 Media
Media Stream
UDP
10000-15000
RTP
(configurable)
Reverse Proxy
TCP 443 —
HTTPS (Auth,
Bootstrapper,
CAS,
Conferencing)
Connect Client | NA NA NA NA
for Web and TURN
Softphone Signaling
TCP/UDP 443
—STUN &
Media

Media Stream

UDP
10000-15000
RTP
(configurable)

Reverse Proxy

TCP 443 -
HTTPS (Auth,
Bootstrapper,
CAS,
Conferencing)
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Originating Destination Device
Devi
evice ECC Mobility Mobility D&M Server | Edge Gateway
Supervisor Client (SMC) | Router (SMR) | (Standalone)
Client
ECC NA NA NA NA HAProxy (not
Supervisor .
Client available yet)
ECC
Supervisor
TCP
31451-31452
Mobility Client | NA ; NA NA
(SMC) Video Call Control
CMCP (Server) | TCP 5061 -
— TCP 5464 SIPS
CMCP (Client) | TCP/UDP 5060
— TCP 5465 - SIP
Media Stream | Management
UDP TCP: 80 - http
42000-42100 TCP: 443 —
RTP https
(configurable) P
RAST
TCP/UDP
443 — RAST
(on external
interface)
Media Stream
UDP
15000-32000
RTP
(configurable)
Linux DVS NA Media Stream |Media Stream |NA TURN:
UDP UDP Media Stream
42000-42100 15000-32000 UDP

RTP
(configurable)

IP Path Trace

uUbP
33434+255

RTP
(configurable)

IP Path Trace

UDP
33434+255

10000-15000
RTP
(configurable)

WSS Media
Control

UDP 2223 —
NG Allocator

IP Path Trace

ubpP
33434+255
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Originating Destination Device
Devi
evice ECC Mobility Mobility D&M Server | Edge Gateway
Supervisor Client (SMC) | Router (SMR) | (Standalone)
Client
Windows DVS | NA Media Stream |Media Stream |NA TURN:
UbDP UDP Media Stream
42000-42100 15000-32000
RTP RTP UDP
' ) 10000-15000
(configurable) | (configurable) RTP
IP Path Trace |IP Path Trace (configurable)
UDP UDP WSS Media
33434+255 33434+255 Control
UDP 2223 -
NG Allocator
IP Path Trace
UDP
33434+255
Headquarters | NA Media Stream |Media Stream |NA TURN:
Server
UDP UDP Media Stream
42000-42100 15000-32000
RTP RTP UDP
' ) 10000-15000
(configurable) | (configurable) RTP
IP Path Trace |IP Path Trace (configurable)
UDP UDP WSS Media
33434+255 33434+255 Control
UDP 2223 - NG
Allocator
IP Path Trace
UDP
33434+255
Mobility NA NA NA .
Router (SMR) Call Control TURN:
TCP 5061 - Media stream
SIPS UDP
TCP/UDP 5060 10000-20000
- SIP RTP
Media Stream (configurable)
UDP
42000-42100
RTP
(configurable)
D&M Server NA NA NA D&M Offline NA
(Standalone)
Upgrade -
TRANSIENT
TCP 4312 - Old

MySQL D&M
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Originating Destination Device
Devi
evice ECC Mobility Mobility D&M Server | Edge Gateway
Supervisor Client (SMC) | Router (SMR) | (Standalone)
Client
Edge Gateway | NA NA Media stream |NA TURN:
UDP Media Stream
; (_)I_Cl):())O-32000 UDP
(configurable) 10000-20000
RTP
(configurable)
Other (such as | NA NA SSH NA NA
SIP) endpoints
TCP 22

Port Usage Part 3

The following table contains the third part of the port usage information for the Connect system.

Table 83: Port Usage — Part 3

Originating Destination Device
Device Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone
Switch Media NA Port Mapper | Port Mapper | Port Mapper | Configuration
Stream TCP 111 TCP 111 TCP 111 Control
UDP10000- RPC Port RPC Port RPC Port UDP 162
10550 RTP Mapper Mapper Mapper SNMP TRAP
IP Path UDP 111 UDP 111 UDP 111 Call Control
UDP PP PP PP siP
33434+255 Call Control | Call Control | Call Control Media
TMS RPC: TMS RPC: TMS RPC: Stream
TCP 5457 TCP 5457 TCP 5457 UDP
NCC Event |[NCC Event [NCC Event
1024-65535
port port port
UDP 5458 UDP 5458 ELP — for
SUNRPC SUNRPC
Broadcast Broadcast IP Path
TcpiuDp | Trace
5500-5600 ICMP
33434+255
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Originating Destination Device
Devi
evice Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone

Switch SoftSwitch | SoftSwitch | SoftSwitch
UDP 5442 — |UDP 5442 — |UDP 5442 —
DRS DRS DRS
UDP 5443 — |UDP 5443 — |UDP 5443 —
Bandwidth Bandwidth Bandwidth
Manager Manager Manager
UDP 5445 UDP 5445 UDP 5445
— Admission |— Admission |- Admission
Control Control Control
UDP 5446 UDP 5446 UDP 5446
—DRS —DRS —DRS
keepalive keepalive keepalive
Configuration Configuration Configuration
Control Control Control
TCP 21 FTP |TCP 21 FTP |TCP 21 FTP
CTL—-Boot |CTL-Boot |CTL — Boot
files files files
TCP 20 FTP |TCP 20 FTP |TCP 20 FTP
DATA — Boot | DATA — Boot | DATA — Boot
files files files

Switch Media Media Media
Stream Stream Stream
UDP 10000- |UDP 10000- [UDP 10000-
20000 RTP |20000 RTP |20000 RTP
(configurable)| (configurable)| (configurable)
IP Path IP Path IP Path
Trace Trace Trace
UDP UDP UDP
334344255 |[33434+255 ([33434+255
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Originating Destination Device
Devi
evice Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone
V-Switch Media NA Port Mapper | Port Mapper | Port Mapper | Configuration
Stream TCP 111 TCP 111 TCP 111 Control
UDP10000- RPC Port RPC Port RPC Port UDP 67
10550 RTP Mapper Mapper Mapper DHCP
IP Path UDP 111 UDP 111 UDP 111 f/lzx?;nance
Trace RPC Port RPC Port RPC Port
Mapper Mapper Mapper UDP 162
UDP SNMP TRAP
33434+255 Call Control | Call Control | Call Control
TMSRPC:  |TMSRPC: |TmMsRpc: | C@ll Control
TCP 5457 TCP 5457 TCP 5457 LSJII%PMSeOc?ig
NCC Event |[NCC Event [NCC Event
Stream
port port port
UDP
UDP 5458 UDP 5458 UDP 5458 1024-65535
SUNRPC SUNRPC SUNRPC
Broadcast Broadcast Broadcast RTP — for
tcpupp | SP
5500-5600
V-Switch SoftSwitch | SoftSwitch | SoftSwitch | IP Path
UDP 5440 |UDP5440 |UDP 5440 |1race
— Location — Location — Location ICMP
Service Service Service 33434+255
UDP 5441 — |UDP 5441 — |UDP 5441 — SMTP
Call Control | Call Control | Call Control |[TCP 25
UDP 5442 — |UDP 5442 — |UDP 5442 — arﬁr'\c/ilTZrt
DRS DRS DRS , party
for Virtual
UDP 5443 — |UDP 5443 — [UDP 5443 — | Machine
Bandwidth Bandwidth Bandwidth notification)
Manager Manager Manager
UDP 5445 UDP 5445 UDP 5445
— Admission |— Admission |- Admission
Control Control Control
UDP 5446 UDP 5446 UDP 5446
—DRS —DRS —DRS
keepalive keepalive keepalive
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Originating Destination Device
Devi
evice Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone

V-Switch Database Database Database
TCP 4306 - |TCP 4306- |TCP 4306 -
MYSQLCC MYSQLCC MYSQLCC
TCP 4308 TCP 4308 TCP 4308
- MYSQL - MYSQL - MYSQL
config config config
Transport Transport Transport
TCP 5432 - | TCP 5432 - |TCP 5432 —
Xprt Xprt Xprt
Configuration Configuration Configuration
Control Control Control
TCP 21 FTP |TCP 21 FTP |TCP 21 FTP
CTL—-Boot |CTL—-Boot |CTL — Boot
files files files
TCP 20 FTP |TCP 20 FTP | TCP 20 FTP
DATA — Boot | DATA — Boot | DATA — Boot
files files files

V-Switch Media Media Media
Stream Stream Stream
UDP 10000- |UDP 10000- [UDP 10000-
20000 RTP |20000 RTP |20000 RTP
(configurable)| (configurable)| (configurable)
IP Path IP Path IP Path
Trace Trace Trace
UDP UDP UDP
334344255 |[33434+255 ([33434+255
SMTP SMTP SMTP
TCP 25 - TCP 25 - TCP 25 -
SMTP SMTP SMTP
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Originating Destination Device
Devi
evice Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone
Service Media Browser Call Control | Call Control | Call Control | Configuration
Appliance St determined Control
(Conferencing®tream dynamic port | TMS RPC: | TMS RPC: | TMS RPC: ontro
and IM) _ | (WebRTC)
EJ(I)I)SF;)O;_?_(; TCP 5457 TCP 5457 TCP 5457 LSJBI\F;ISE'SI'ZR AP
NCC Event |[NCC Event [NCC Event
IP Path port port port Call Control
Trace UDP 5458 |UDP 5458 |UDP 5458 |UDP 5060
UDP SUNRPC SUNRPC SUNRPC SIP
33434+255 Broadcast Broadcast Broadcast .
Media
SoftSwitch | SoftSwitch | TCP/UDP Stream
UDP 5440 UDP 5440 5500-5600 UDP
— Location — Location SoftSwitch | 1024-65535
Service Service UDP 5440 RTP — for
UDP 5441 — | UDP 5441 — |- Location SIP
Call Control [ Call Control [Service
UDP 5442 — | UDP 5442 — | UDP 5442 —
DRS DRS DRS
UDP 5443 — | UDP 5443 — | UDP 5442 —
Bandwidth Bandwidth DRS
Manager Manager
Service SoftSwitch | SoftSwitch | SoftSwitch | IP Path
Appliance Trace
(Conferencing UDP 5445 |UDP 5445 |UDP 5443 —
and IM) — Admission |— Admission |Bandwidth |ICMP
Control Control Manager 33434+255
UDP 5446 UDP 5446 UDP 5445 SMTP
- DRS —DRS — Admission | TCP 25
keepalive keepalive Control - SMTP
Database  |Database |UDP 544p | (third party
_DRS for email
TCP 4306 TCP 4306 keepalive notification)
MYSQLCC |MYsQLCC P
TCP 4308 |TCP43os | Database
- MYSQL - MYSQL TCP 4306
config config MYSQLCC
Transport Transport TCP 4308
TCP 5432 - |TCP 5432 — gol\:;i(SQL
CDS CDS 9
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Originating Destination Device
Devi
evice Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone
Service ABC ABC Transport
Appliance
(Conferencing TCP 80, 443 | TCP 80, 443 | TCP 5432 —
and IM) —ABC (for |-ABC (for |CDS
Exo-IM) Exo-IM) Conferencing
CAS CAS License
TCP TCP TCP 80 —
5447/5448— |5447/5448— |HTTP
CAS (for CAS (for Voice
Exo-IM) Exo-IM)
Prompts
ContgurationContguraton 21
FTP of phr
TCP 21 FTP | TCP 21 FTP |files
C_JTL — Boot QTL — Boot ABC
files files
TCP 20 FTP | TCP 20 FTP -I_-(;Fégo(f::ls
DATA — Boot | DATA — Boot
; . Exo-IM)
files files
IP Path IP Path
TraceUDP TraceUDP
33434+255 |33434+255
Service CAS
Appliance
(Conferencing TCP
and IM) 5447/5448—
CAS (for
Exo-IM)

Configuration
Control

TCP 21 FTP
CTL - Boot
files

TCP 20 FTP
DATA — Boot
files

IP Path
TraceUDP
33434+255
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Originating Destination Device
Devi
evice Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone
IPPhone | yedia NA Media Media Media Syslog
Stream UDP 10000~ | UDP 10000- |UDP 10000- | Se™Ve"
UDP10000- 20000 RTP |20000 RTP |20000 RTP |UDP 514
10550 RTP (configurable)| (configurable)| (configurable)| NTP Server
IP Path IP Path IP Path IP Path UDP 123
Trace Trace Trace Trace —This is
ICMP ICMP ICMP ICMP the default
port. Can be
Traceroute Traceroute Traceroute Traceroute .
. . . configurable.
File File File
Download/ Download/ Download/ UDP 61373
Linux DVS WinDVS WinHQ —RpCap end
Update Update Update of capture
TCP 80 TCP 80, 443 | TCP 80, 443
HTTP HTTPS HTTPS
TCP 443 ABC ABC
HTTPS TCP 80, 443 | TCP 80, 443
ABC HTTPS HTTPS
TCP 80, 443
HTTPS
IP Phone CAS CAS CAS
TCP TCP TCP
5447/5448 5447/5448 5447/5448
HTTPS HTTPS HTTPS
"P"t?o%'; Media NA Media Media Media NA
Stream Stream Stream Stream
UDP10000- UDP UDP UDP
10550 RTP 10000-20000 | 10000-20000 | 10000-20000
RTP RTP RTP
IP Path (configurable)| (configurable)| (configurable)
Trace 9 9 9
ICMP IP Path IP Path IP Path
Trace Trace Trace
Traceroute
ICMP ICMP ICMP
Traceroute Traceroute Traceroute
FTP FTP FTP
TCP 21 - TCP 21 - TCP 21 -
FTP FTP FTP
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Originating Destination Device
Devi
evice Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone
Connect Media NA Configuration Configuration Configuration NA
Client Stream (if Control Control Control
Softphone ream (i ontro ontro ontro
both clients
are on same TCP 5449, TCP 5449, TCP 5449,
5469 — TBD: | 5469 — TBD: (5469 — TBD:
network) —
Both audio & webproxy, webproxy, webproxy,
video Mgmt API- | Mgmt API- | Mgmt API-
TCP 80 TCP 80 TCP 80
UDP HTTP — HTTP — HTTP —
10000-10550 Online help | Online help [ Online help
(Fg)lzﬁ urable) WSS call WSS call WSS call
9 (MGCP) (MGCP) (MGCP)
TCP 4431 - |[TCP 4431- |TCP 4431 -
WSS nginx [WSS nginx | WSS nginx
TCP 7777 - |(TCP7777- |TCP 7777 -
WSS internal [ WSS internal | WSS internal
only only only
TCP 9090, TCP 9090, TCP 9090,
8181 - Mgmt 8181 - Mgmt [ 8181 - Mgmt
TCP 2427 TCP 2427 TCP 2427
- Switch to - Switch to - Switch to
WSS WSS WSS
Connect Media Media Media
Client St St St
Softphone ream ream ream
UDP UDP UDP

10000-20000
RTP
(configurable)

ABC

TCP 80, 443
HTTPS

CAS

TCP
5447/5448
HTTPS

Image
Download

TCP 80, 443

10000-20000
RTP
(configurable)

ABC

TCP 80, 443
HTTPS

CAS

TCP
5447/5448
HTTPS

Image
Download

TCP 80, 443

10000-20000
RTP
(configurable)

ABC

TCP 80, 443
HTTPS

CAS

TCP
5447/5448
HTTPS

Image
Download

TCP 80, 443
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Originating Destination Device
Devi
evice Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone
Hg(‘;i’; DVS | stream upp |NA SoftSwitch | SoftSwitch | SoftSwitch | Voice Mail
10000-10550 UDP 5440 |UDP5440 |uUDPsa4g | Nofification
RTP — Location — Location — Location TCP 25
(configurable) Service Service Service SMTP
IP Path TCP 5441 — | TCP 5441 — | TCP 5441 —
Trace Call Control | Call Control [ Call Control
UDP UDP 5443 — |UDP 5443 — |UDP 5443 —
33434+255 Bandwidth Bandwidth Bandwidth
Manager Manager Manager
UDP 5445 UDP 5445 UDP 5445
— Admission |— Admission |- Admission
Control Control Control
UDP 5446 UDP 5446 UDP 5446
—DRS —DRS —DRS
keepalive keepalive keepalive
Linux DVS ™S ™S ™S
Media
UDP UDP UDP
dynamic dynamic dynamic
[1024-65535] | [1024-65535] | [1024-65535]
— broadcast. |— broadcast. |- broadcast.
TMSTMS TMSTMS TMSTMS
disaster disaster disaster
recovery recovery recovery
TCP 5430 - |TCP 5430 - |TCP 5430 —
TMS/DTAS | TMS/DTAS | TMS/DTAS
interserver interserver interserver
communicatiohcommunicatiohcommunicatioh
Distributed |Distributed [ Distributed
Voice Mail Voice Mail Voice Mail
TCP 25 TCP 25 TCP 25
SMTP - SMTP - SMTP -
Voice Mail Voice Mail Voice Mail
transport transport transport
Transport Transport Transport
TCP 5432 - | TCP 5432 - | TCP 5432 —
Xprt Xprt Xprt
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Originating Destination Device
Devi
evice Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone
\6V\ilnsdows Stream UDP |NA SoftSwitch | SoftSwitch | SoftSwitch | Voice Mail
10000-10550 UDP5440 |UDP5440 |UDP 5440 | Nofification
RTP — Location — Location — Location TCP 25
(configurable) Service Service Service SMTP
IP Path TCP 5441 — | TCP 5441 — | TCP 5441 —
Trace Call Control | Call Control [ Call Control
UDP UDP 5443 — |UDP 5443 — |UDP 5443 —
33434+255 Bandwidth Bandwidth Bandwidth
Manager Manager Manager
UDP 5445 UDP 5445 UDP 5445
— Admission |— Admission |- Admission
Control Control Control
UDP 5446 UDP 5446 UDP 5446
—DRS —DRS —DRS
keepalive keepalive keepalive
Windows
DVS TMS TMS TMS
UDP UDP UDP
dynamic dynamic dynamic
[1024-65535] | [1024-65535] | [1024-65535]
— broadcast. |— broadcast. |- broadcast.
TMSTMS TMSTMS TMSTMS
disaster disaster disaster
recovery recovery recovery
TCP 5430 - |TCP 5430 - |TCP 5430 —
TMS/DTAS | TMS/DTAS | TMS/DTAS
interserver interserver interserver
communicatiohcommunicatiohcommunicatioh
Distributed |Distributed [ Distributed
Voice Mail Voice Mail Voice Mail
TCP 25 TCP 25 TCP 25
SMTP - SMTP - SMTP -
Voice Mail Voice Mail Voice Mail
transport transport transport
Transport Transport
TCP 5432 — | TCP 5432 —
Xprt Xprt
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Originating Destination Device
Devi
evice Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone
Windows
DVS Database
TCP 4308
— config
DB (RO via
ODBC for
DDB) (R11.x)
CAS
Session
Manager
(R11.x)
TCP 5449 —
TMS to Data
API to fulfill
CSR
Transport
TCP 5432 —
Xprt
HQ Server | s¢ream upp |NA SoftSwitch | SoftSwitch | CDR Offline |Voice Mail
10000-10550 UDP 5440 |UDP 5440 |TROrade- | Notification
RTP - Location - Location TCP 25
(configurable) Service Service TCP 4311 - | SMTP
IP Path TCP 5441 — | TCP 5441 — 8§RM€)/§QL CDR TCP
Trace Call Control | Call Control 3306 - CDR
UDP UDP 5443 — | UDP 5443 — 3?9':’:30;;"“‘* 220:1;:0@
33434+255 Bandwidth Bandwidth TRANSIENT | server
Manager Manager
UDP 5445 UDP 5445 TCP 4312 —
o o Old MySQL
— Admission |— Admission D&M DB
Control Control
UDP 5446 UDP 5446
—DRS —DRS
keepalive keepalive
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Originating Destination Device
Devi
evice Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone
HQ Server ™S ™S ThirdParty
Double-
ubp ubpP Take (If
dynamic dynamic Configured)
[1024-65535] | [1024-65535] g
— broadcast. |- broadcast. | TCP 8000
TMSTMS TMSTMS Heartbeat
disaster disaster Transmit
recovery recovery TCP 8005
TCP 5430 — | TCP 5430 — | Status
TMS/ DTAS | TMS/ DTAS | Transmit
Stats Report
WSS- WSS-
SoftPhone | SoftPhone
(Int Prod) (Int Prod)
TCP 4431 - | TCP 4431 —
WSS nginx [ WSS nginx
(Keypush (Keypush
from HQ Key | from HQ Key
Notifier) Notifier)
HQ Server Distributed | Distributed
Voice Mail Voice Mail
TCP 25 TCP 25
SMTP — SMTP —
Voice Mail Voice Mail
transport transport
Transport Transport
TCP 5432 — | TCP 5432 —
Xprt Xprt
ECC NA NA NA ECC NA NA
Supervisor s .
Client upervisor
TCP 31451 -
31452
Mobility : NA : : : NA
Client (SMC) gllt?g;am Media Media Media
UDP UDP UDP
UDP 10000- 10000-20000 | 10000-20000 | 10000-20000
10550 RTP RTP RTP RTP

(configurable)

(configurable)
ABC

TCP 80, 443
CAS

TCP
5447/5448

(configurable)
ABC

TCP 80, 443
CAS

TCP
5447/5448

(configurable)
ABC

TCP 80, 443
CAS

TCP
5447/5448
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Originating Destination Device
Devi
evice Connect Connect Linux DVS Windows HQ Server Other
Client and Client for DVS
Softphone Web and
Softphone
Mobility Media NA Media Media Media NA
Router Stream
(SMR) UDP UDP UDP
UDP 10000- 10000-20000 | 10000-20000 | 10000-20000
10550 RTP RTP RTP RTP
(configurable) (configurable)| (configurable)| (configurable)
ABC ABC ABC
TCP 443 TCP 443 TCP 443
HTTPS HTTPS HTTPS
CAS CAS CAS
TCP TCP TCP
5447/5448 5447/5448 5447/5448
HTTP(S) HTTP(S) HTTP(S)
Data API
TCP
5449/4430
HTTP(S)
Edge TURN: TURN: TURN: TURN: TURN: NA
Gateway
Media Browser Media Media Media
Stream determined Stream Stream Stream
UDP ‘(j\)’vr;ab“%ﬁcp)o” UDP UDP UDP
10000-10550 10000-10550 | 10000-10550 | 10000-10550
RTP RTP RTP RTP
(configurable) (configurable)| (configurable)| (configurable)
TCP 22 TCP 5478
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Appendix E - Connect System Logs

This appendix contains information about Connect System Logs.

» System Logs

System Logs

Table 84: System Logs

server - used for
troubleshooting
Development
systems. Can be
used to troubleshoot
performance.

Log file name Module Location Description Debug Setting
bootlog Switch VMB Switch bootup No debug setting. The log is
log. Captures always on.
initialization,
upgrade, and other
functions.
caswebsrv CAS HQ/DVS Internal CAS web Contact Support for debugs per

specific issue.

CheckDatabase | DB HQ Runs at installer
(beginning of
installation). Check
DB compatibility
during upgrade.

No setting available. Runs at
installer time.

ConnectSync ConnectSync |HQ MiVoice Connect
service used to
push data to the
MiCloud for HYBRID
deployments.

HKEY_LOCAL_MACHI NE

\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Connect Sync
\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

The default log level is 1, and
logging levels are a mask
with 0x2 and 0x4, the higher
levels of internal logging. 0x8
is the HTTP logging where,
the service logs are all HTTP
requests in full text format.

access Voicemail.
Interactions from
applications such as
CAS, VMEMSync,
CSISVMService

to Voicemail are
captured.

CSISSvr CSIS HQ/DVS CSIS server log Contact Support for debugs per
specific issue.
csisvm CsSIS HQ/DVS Interface to Contact Support for debugs per

specific issue.

CSISVMEwVt CSIS HQ/DVS Voicemail events
sent through CSIS.

Contact Support for debugs per
specific issue.
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Log file name Module Location Description Debug Setting
Database DB HQ/DVS Runs during No setting available. Runs at
installation (this is installer time.
the actual upgrade
log).
dbhs Voicemail HQ/DVS/ VOicema” Stat_US HKEY_L&AL_NAC"" NE
VMB reporting to Director \ SOETWARE. Sh |
(Mailbox status and orel1ne
other runtime status). | Tel ewor ks\ | ogsvc
\ Loggi ng
Level = 0x1
PriMaskLF = OxFFF
Turn on level only on Support's
request.
dbq DB HQ/DVS/ DBQuery log. ODBC
VMB/UCB queries to database {4 gg?b\p\ogé\l‘éhmm: .NE
from applications oreline
such as CAS, Tel ewor ks\ Dat aSer vi ces
Voicemail, and TMS. |\ DBQuer y\ Loggi ng
Level = 0x1
PriMaskLF = OxFFF
Turn on level only on Support's
request.
VMB/UCB Updates;queries .
to database from \ SOFTWARE\ Shor el i ne
applications such as Tel ewor ks\ Dat aSer vi ces
CAS, Voicemail, and |\ DBUpdat e\ Loggi ng
TMS.
Level = Ox1
PriMaskLF = OxFFF
Turn on level only on Support’s
request.
dbusvc DB HQ/DVS DB Update service. | ey LOCAL MACHI NE
(wherever DB Update requests \ SOETWARE\ Sh I
we have DB | go through this oreline
or DDB) service. Tel ewor ks\ Dat aSer vi ces
\ DBUpdat eSvc\ Loggi ng
Level = Ox1
PriMaskLF = OxFFF
Turn on level only on Support’s
request.
director2_dm D&M HQ D&M

HKEY _LOCAL_MACHI NE

\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Svr AppMsgSvce
\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

Turn on level only on Support’s
request.
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Log file name

Module

Location

Description

Debug Setting

director2_uc

Director2,
D&M

HQ

D2 and D&M

HKEY_LOCAL_MACHI NE

\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Svr AppMsgSvec
\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

Turn on level only on Support’s
request.

Director2

Data API,
SessionMgr

HQ/DVS

Data APl and
SessionMgr

HKEY_LOCAL_MACHI NE

\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Svr AppMsgSvc
\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

Turn on level only on Support’s
request.

DistributedDB

DB

HQ/DVS

Backup of HQ DB
(nightly backup).
On DVS it is mostly
blank.

No setting available. Runs at
installer time.

DRS

DRS

HQ/DVS

Main DRS
operations, LSP ping
and DN resolution
covered in this log.

HKEY _LOCAL_MACHI NE

\ SOFTWARE\ Shor el i ne

Tel ewor ks\ Di stri but ed
Rout i ng Servi ce\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

0x0100 and smaller control
DRS.log

0x0200 and larger control
DRSTrans.log

0x0010 logs DRS-ping keep-
alives.

DRSTran

DRS

HQ/DVS

ShoreSIP and switch
related logging are
covered here.

HKEY _LOCAL_MACHI NE

\ SOFTWARE\ Shor el i ne

Tel ewor ks\ Di stri buted
Rout i ng Servi ce\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

0x0100 and smaller control
DRS.log

0x0200 and larger control
DRSTrans.log

0x0010 logs DRS-ping keep-
alives.
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Log file name Module Location Description Debug Setting
DSTrace DRS HQ/DVS S%I\a/lltgratcjzgrifgsr HKEY LOCAL_MACHI NE
(DDB update on \ SOFTWARE\ Shor el i ne
DVS). Most reads Tel ewor ks\ Dat aSer vi ces
go through DBQuery _
and get captured in~ | DebugLevel=0x1
dbgq log. Set Debuglevel=0x5 for query
level details.
EventWatch Event HQ The log for the HKEY LOCAL_MACHI NE
Notification service that performs \ SOETWARE\ Sh ¥
email notification for oretine
NT events. Tel ewor ks\ Dat aSer vi ces
Debuglevel=0x1
Set Debuglevel=0x5 for details.
evt Trigger HQ/DVS Sg;vaict:ghtg:tthe HKEY LOCAL_MACHI NE
triggers from the \ SOFTWARE\ Shor el i ne
database to the Tel ewor ks\ Event Syst em
applications. \ Loggi ng
Level = 0x1
PriMaskLF = OxFFF
Turn on level only on Support’s
request.
s 1S HQ/DVS Microsoft 1IS web Contact Support for debugs per
server specific issue.
Install_ShorewarglrStaller HQ/DVS Installer log file HKLM SOFTWARE\ Pol i ci es
\'M crosoft\ Wndows
\Installer
Set key Logging with
type REG_SZ and Value
“voicewarmup!”
¢ Gives information about the
step the installer is at, and
the values of the properties.
In case of a rollback, it gives
information about when the
rollback happens
* Gives more information
about the files and the
sequence of actions.
¢ Gives detailed information
about the functions installer
performs on the machine.
IPBX Switch HQ/DVS Switch level logs/

events sent to the
server.

HKEY_LOCAL_MACHI NE
\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Tel ephony
Management Server
\ STSTSPI \ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

272




APPENDIX E - CONNECT SYSTEM LOGS

Log file name Module Location Description Debug Setting
ipds CAS HQ/DVS CAS main log Contact Support for debugs per
specific issue.
kmessages Kernel VMB/UCB Linux kernel No debug setting available. The
messages log is always on.
LogLibTrace LogLib HQ/DVS/ Trace for logger No setting available.The log is
VMB/UCB always on.
LogLibTraceX |LogLib HQ/DVS Trace for logger for | No setting available. The log is
logging from TapiSrv. [ always on.
LogSvc LogLib HQ/DVS LogSvc helps VMB | Likey LOCAL MACHI NE
switches do remote — = :
IOgglng (thlS is \ SOFTWARE\ Shor el i ne
unused). In addition, |Tel ewor ks\ | ogsvc
both VMB and UCB |\ Loggi ng
switches also log
their NT events Level = 0x1
B o | PrivaskLF = OcFFF
event log. Turn on level only on
developer's request.
MakeCDR System Mgmt | HQ Run by installer for No setting available. Runs at
new install/upgrade. [installer time.
messages Kernel VMB/UCB Linux kernel No debug setting available. The
messages + user log is always on.
level system log
messages.
mon_log Switch VMB System resource No debug setting available. The
usage by individual |log is always on.
modules/process.
mon_nand_log | Switch VMB System Nand usage | No debug setting available. The
log is always on.
MonitoringAgentYDI&M HQ Log from Monitoring | To turn on this log, enable
agent that lives on switch level setting.
switch to report call
quality.
MonitoringServiceD&M ;gélgg‘llgﬂne D&M log HKEY LOCAL_MACH NE
server \ SOFTWARE\ Sho_r eli ne
Tel ewor ks\ Moni t ori ng
Servi ce\ Loggi ng
Level=0x1
PriMaskLF=0xFFF
Turn on level if developer
recommends.
engine. \ SOFTWARE\ Shor el i ne
Tel ewor ks\ QVai | Servi ce
\ Loggi ng
Level=0x1
PriMaskLF=0xFFF
Turn on level if Support
recommends.
gmail-cleanup | Qmail VMB/UCB Qmail cleanup No setting available. The log is

log (logs internal
cleanup).

always on.
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Log file name Module Location Description Debug Setting
RegLibTrace RegLib HQ/DVS/ Trace for registry No setting available. The log is
VMB/UCB library always on.
RegLibTraceX |RegLib HQ/DVS Trace for registry No setting available. The log is
library from TapiSrv [ always on.
Wireshark trace for :
P-phone and switch. \ SOFTWARE\ Shor el i ne .
Actual Wireshark Tel ewor ks\ RpCap\ Loggi ng
trace is on the Level=0x1
switch/p-phone. evel=Ux
PriMaskLF=0xFFF
Turn on level if Support
recommends.
SAMS System Mgmt | HQ ﬁzgoiltﬂ(i%ing,R%%M HKEY LOCAL_MACHI NE
to G+ bridge. |\ SOFTWARE\ Shor el i ne
For example, Tel ewor ks\ Svr AppMsgSvc
AnyPhone). \ Loggi ng
Level = 0x1
PriMaskLF = OxFFF
Turn on level only on Support’s
request.
SC Workgroup HQ/DVS WG puts a call on No debug setting. The log is
queue (technically always on.
park the call on
its own number,
try to unpark. WG
extension from
another extension
will show list of
calls in WG queue)
if agent is not
available. ;All these
activities related to
queuing WG call get
logged in SC logs.
SDMS System Mgmt | HQ Z:anrli\c/l)girzzzslllerfcr)?'nshone HKEY LOCAL_MACHI NE
D . P1OM® |\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Dat a Servi ces
Set DebuglLevel=0x5.
smgr SerViceSMgr VMB/UCB |r_r:ra'|t:|1); See:\éhcaets HKEY_L(I:AL_Np\CHl NE
T re \ SOFTWARE\ Shor el i ne
processes. Tel ewor ks\ Ser vi cesMyr
\ Loggi ng
Level = 0x1
PriMaskLF = OxFFF
Turn on level only on Support’s
request.
SMTP SMTP HQ/DVS Microsoft SMTP log | Use Microsoft IIS manager to

turn on this log.
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Log file name

Module

Location

Description

Debug Setting

SoftSw

Soft Switch

HQ/DVS

Soft switch log on
Windows server.

HKEY_LOCAL_MACHI NE
\ Sof t war e\ Shor el i ne
Tel ewor ks\ Sof t Swi t ch

Create a key called
TelnetEnabled and set it to 1.

telnet <softswitch-ip> 2323

To get the SHELL access, turn
on the appropriate switch trace.

STCTSP

ShoreTapi

VMB/UCB

Legacy ShoreTapi
interface for
Voicemail (VMB) and
Conferencing (UCB).

HKEY_LOCAL_MACHI NE
\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Tel ephony
Managenment Server

\ STCTSP\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

Set Level =0x1F for TAPI
signaling debugging.

STCTSPI

ShoreTapi

HQ/DVS

ShoreTapi interface
for CAS, Workgroup.

HKEY _LOCAL_MACHI NE
\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Tel ephony
Managenent Server
\ STCTSPI \ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

Set Level =0x1F for TAPI
signaling debugging.

STMedia

Switch media

uCB

Switch media log file.

HKEY_LOCAL_NMACHI NE
\ SOFTWARE\ Shor el i ne
Tel ewor ks\ STMedi a

\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

Turn on level only on Support’s
request.

stpi

ShoreTapi

HQ/DVS

ShoreTapi client side
log for CAS, WG.

HKEY_LOCAL_MACHI NE
\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Shor eTapi
\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

Set Level =0x1F for TAPI
signaling debugging.
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Log file name Module Location Description Debug Setting

STSTSP TAPI HQ/DVS/ TAPI Path entry point | ikey LOCAL MACHI NE

VMB/UCB into TMS. \ SOFTWARE\ Shor el i ne
Tel ewor ks\ Tel ephony
Managenment Server
\ STSTSPI \ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

Set Level =0x1F for TAPI
signaling debugging.

\ SOFTWARE\ Shor el i ne
Tel ewor ks\ STTS\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

Set Level =0x1F for TAPI
signaling debugging.

SysMgmt System Mgmt | HQ/DVS SysMgmtSvc (former | ikey LOCAL MACHI NE

oty P S 1\ SOFTWARE Shor el i ne
Tel ewor ks\ Syswgnt
\ Loggi ng

Level = Ox1
PriMaskLF = OxFFF
Set Level =0xFF for debugging.

TAPI Microsoft HQ/DVS Microsoft portion of HKEY LOCAL MACH NE

TAPI the TapiSrv.. \ Sof t war e\ M cr osof t

\ Traci ng\tapi srv

Set FileDirectory to a directory
(For example, C:\Tmp) where
you want the TAPI logs - default
location is C:\Windows\Tracing

Set EnableFileTracing = 1
Set FileTracingMask = Oxffffffff

Tapi32 APl side HQ/DVS Application (For HKEY LOCAL MACHI NE
Microsoft example, Voicemail) \ Sof twar e\ M cr osof t

TAPI TAPI API side. , ,

\ Traci ng\t api 32

Set FileDirectory to a directory

(For example, C:\Tmp) where

you want the TAPI logs - default

location is C:\Windows\Tracing

Set EnableFileTracing = 1
Set FileTracingMask = Oxffffffff
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00001
0000007
D7
000007
07
00007

Log file name Module Location Description Debug Setting
Legacy TAPI = = :
interface for \ SOFTWARE\ Shor el i ne
Voicemail, ECC Tel ewor ks\ Tel ephony
ProSves/Third Party | Management Ser ver
applications. \ Tapi Srv\ Loggi ng
Level = 0x1
PriMaskLF = OxFFF
Set Level =0x1F for TAPI
signaling debugging.
media driver driver \ SOETWARE\ Shor el i ne
Tel ewor ks\ TDI Medi a
"LogTapiWaveToFile"=dword:000
"TapiWaveDebugl evel"=dword:0
"Playdebuglevel"=dword:000000
"SipWaveDebugLevel"=dword:0(
"loctiDebugLevel"=dword:00000(
"RecordDebugl evel"=dword:000
Lower the debugs once
debugging is complete.
TmsCDR System Mgmt | HQ Call accounting No setting available. Runs at
service installer time.
TMSCDRArchivgd System Mgmt | HQ Backup to archive No setting available. Runs at
server (nightly) installer time.
TmsCDS TMS HQ/DVS TMS call data HKEY LOCAL MACHI NE
service - plumbing = = .
layer. Used for \ SOFTWARE\ Shor el i ne
low level call tuple | Tel ewor ks\ Tel ephony
and CDR data Managenent Server\ CDS
debugging. \ Loggi ng
Level = Ox1
PriMaskLF = OxFFF
Turn on level only on Support’s
request.
TmsDTAS DTAS HQ/DVS TMS distributed

telephony log -
plumbing layer. Used
for TAPI debugging.

HKEY _LOCAL_MACHI NE
\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Tel ephony
Managenment Server
\ Tms DTAS\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

Set Level=0x1F on Support’s
request for debugging TAPI
level problems.
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Log file name Module Location Description Debug Setting

TmsHeapStatus |App®DBC HQ/DVS TMS updates to HKEY LOCAL MACH NE
heap status DB to \ SOETWARE\ Sh I
report runtime status orel1ne
to Director, D&M. Tel ewor ks\ Tel ephony

Managenment Server

\ TmsHeapSt at us_ODBC

\ Loggi ng

Level = 0x1

PriMaskLF = OxFFF

Turn on level only on Support's
request.

TmsMain TMS HQ/DVS TMS main log. All HKEY LOCAL MACHI NE
the TMS processing \ SOETWARE\ Sh ¥
is divided into small oretine
steps and the steps Tel ewor ks\ Tel ephony
are executed here. Managenment Server\ Main

\ Loggi ng

Level = OxF

PriMaskLF = OxFFF

Set Level =0x3F for TMS level
debugging.

TmsMgmt TMS HQ/DVS TMS Management HKEY LOCAL MACHI NE
log. Captures TMS = = :
reporting runtime \ SOFTWARE\ Shor el i ne
status on switches, | Tel ewor ks\ Tel ephony
devices, trunks, and | Management Server
others. \ TmsMgnt \ Loggi ng

Level = OxF

PriMaskLF = OxFFF

Set Level =0x3F for TMS level
debugging.

TmsNcc TMS HQ/DVS TMS to switch HKEY LOCAL MACHI NE
%%Tjgil:]g%zmon \ SOFTWARE\ Shor el i ne
debugging using Tel ewor ks\ Tel ephony
GUID. Managenent Server\ NCC

\ Loggi ng

Level = Ox1

PriMaskLF = OxFFF

Set Level =0x1F for TMS switch
debugging.

TMSPerf TMS HQ/DVS/ TMS sub-task

VMB/UCB level performance HKEY_LOCAL_MACHI NE

debugging. Useful
to debug low level
delays in TMS.

\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Tel ephony
Management Server

\ Tms TCC\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF

Set Level =0x1F for TMS switch
debugging.
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Log file name Module Location Description Debug Setting

TMSTCC TMS HQ/DVS/ TMS TAPI call
VMB/UCB | control log. Useful for {"gg?\L/\AOgé\LghNACH: NE

tracing end to end orel1ne
call flows. This log | Tel ewor ks\ Tel ephony
is not generated by | Management Server
default. Set elevated |\ TnsPer f\ Loggi ng
log level for it to be
generated. Level = 0x1

PriMaskLF = OxFFF

Set Level =0x1F for TMS switch
debugging.

Uninstall_Shorewamnstlerver HQ/DVS Installer log file HKLM SOFTWARE\ Pol i ci es

\' M crosoft\ W ndows
\Installer

Set key Logging ;with
type REG_SZ and Value
“voicewarmup!”

¢ Gives information about the
step the installer is at, and
the values of the properties.
In case of a rollback, it gives
information about when the
rollback happens.

¢ Gives more information
about the files and the
sequence of actions

¢ Gives detailed information
about the functions installer
performs on the machine.

Vmail Voicemail HQ/DVS/ Voicemail log. HKEY LOCAL MACH NE

VMB Useful for Voicemail _
call debugging \ SOFTWARE\ Shor el i ne

(recording, playback, | Tel ewor ks\ Voi cenai |
find me, AA menus, |\Logging

account code, and
other features). Level = 0x1

PriMaskLF = OxFFF

Increase debug level as
recommended by Support.

VMCAS CAS HQ/DVS Reusable VMCAS Contact Support for debugs per
library applications specific issue.
such as CAS,

VMEmSync are used
to talk to Voicemail.

VMEMSync VMEmSync |[HQ/DVS Voicemail to external | LxEy LOCAL MACHI NE

mail server (For :
example, Gmail) \ SOFTWARE\ Shor el i ne

sync. Tel ewor ks\ VimEnSync
\ Loggi ng

Level = Ox1
PriMaskLF = OxFFF
Set Level =0xFF for debugging.
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Log file name

Module

Location

Description

Debug Setting

VMStats

Voicemail

HQ/DVS

The Voicemail
mailbox starts
debugging.

HKEY_LOCAL_MACHI NE
\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Voi cemi |
\ Loggi ng

Level = OxF
PriMaskLF = OxFFF

Setting Vmail log level to OxF
generates VMStats log file.

WavAPI

Windows
media driver

HQ/DVS

Windows media
driver

HKEY _LOCAL_MACHI NE
\ SOFTWARE\ Shor el i ne
Tel ewor ks\ TDI Medi a

"LogWaveAPIToFile"=dword:000
"WaveAPIDebuglLevel"=dword:0
"Playdebuglevel"=dword:000000
"SipWaveDebugLevel"=dword:0(
"loctiDebugLevel"=dword:00000(
"RecordDebugl evel"=dword:000

Lower the debugs once
debugging is complete.

D0O001
000007
D7
000007
07
00007

WG

Workgroup

HQ/DVS

Workgroup log

HKEY_LOCAL_NMACHI NE
\ SOFTWARE\ WGSvc\ Loggi ng

Level = Ox1F
PriMaskLF = OxFFF

xprt

Transport

HQ/DVS/
VMB/UCB

Transport log. Useful
to debug box to

box communication
issues.

HKEY _LOCAL_MACHI NE
\ SOFTWARE\ Shor el i ne
Tel ewor ks\ Transport
\ Loggi ng

Level = 0x1
PriMaskLF = OxFFF
and

Set Level =0xF for debugging,
OxFF for pipe level debugging.
This can be intrusive.

Zin

System Mgmt

HQ

COM+ (all legacy
business logic)

for example,
AnyPhone;logic

in Visual;Basic,
Voicemail backup
time update in C++.

HKEY_LOCAL_NMACHI NE
\ SOFTWARE\ Shor el i ne
Tel ewor ks

Key: ZinDebuglLevel=0x3 for
debug traces.
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